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IMPORTANT!

READ CAREFULLY BEFORE USE.

KEEP THIS GUIDE FOR FUTURE REFERENCE.

This is a User’s Guide for a series of products. Not all products support all firmware features. Screenshots 
and graphics in this book may differ slightly from your product due to differences in your product 
firmware or your computer operating system. Every effort has been made to ensure that the information 
in this manual is accurate.

Related Documentation
• CLI Reference Guide

This guide explains how to use the Command-Line Interface (CLI) to configure the Switch.

Note: It is recommended you use the Web Configurator to configure the Switch.

• Web Configurator Online Help

Click the help icon in any screen for help in configuring that screen and supplementary information.

• More Information

Go to support.zyxel.com to find other information on the Switch.
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CHAPTER 1
Getting to Know Your Switch

This chapter introduces the main features and applications of the Switch.

1.1  Introduction 
Your Switch is a stackable, layer-3, Gigabit Ethernet (GbE) switch with two power slots for dual power 
supply modules. The Switch comes with 4 GbE dual personality interfaces. A dual personality interface 
includes one Gigabit port and one slot for a SFP module with one port active at a time. The Switch 
provides four SFP+ slots for uplink. The last two SFP+ slots can also be used for stacking. When working in 
stacking mode, the Switch can operate together with other XGS4600 stackable switches and allows you 
to remotely manage them from one switch using one single IP address. By integrating router functions, 
the Switch performs wire-speed layer-3 routing in addition to layer-2 switching. 

This User’s Guide covers the following models: XGS4600-32, XGS4600-32F and XGS4600-52F.   

With its built-in web configurator, including the Zyxel One Network (ZON) Neighbor Management feature 
(Section 7.4 on page 72), viewing, managing and configuring the Switch and its neighboring devices is 
easy. In addition, the Switch can also be managed via Telnet, any terminal emulator program on the 
console port, or third-party SNMP management.

In addition, Zyxel offers a proprietary software program called Zyxel One Network (ZON) Utility, it is a 
utility tool that assists you to set up and maintain network devices in a more simple and efficient way. 
You can download the ZON Utility at www.zyxel.com and install it on a PC. For more information on ZON 
Utility see Section 7.3 on page 68.

See the datasheet for a full list of software features available on the Switch.

1.1.1  Bridging Example
In this example the Switch connects different company departments (RD and Sales) to the corporate 
backbone. It can alleviate bandwidth contention and eliminate server and network bottlenecks. All 

Table 1   Switch Comparison Table
FEATURES XGS4600-32 XGS4600-32F XGS4600-52F
Stacking Mode

24 10/100/1000Base-T Ethernet 
ports

24 SFP slots

48 SFP slots

4 GbE Combo ports (Dual 
Personality Interfaces)

4 10GbE SFP+ slots
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users that need high bandwidth can connect to high-speed department servers via the Switch. You can 
provide a super-fast uplink connection by using the 10 Gigabit uplink ports on the Switch.

Figure 1   Bridging Application 

1.1.2  High Performance Switching Example
The Switch is ideal for connecting two geographically dispersed networks that need high bandwidth. In 
the following example, a company uses the 10 Gigabit uplink ports to connect the headquarters to a 
branch office network. Within the headquarters network, a company can use trunking to group several 
physical ports into one logical higher-capacity link. Trunking can be used if for example, it is cheaper to 
use multiple lower-speed links than to under-utilize a high-speed, but more costly, single-port link.

Figure 2   High Performance Switching 

1.1.3  Gigabit Ethernet to the Desktop 
The Switch is an ideal solution for small networks which demand high bandwidth for a group of heavy 
traffic users. You can connect computers and servers directly to the Switch’s port or connect other 
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switches to the Switch. Use the 10 Gigabit uplink ports to provide high speed access to a data server 
and the Internet. The uplink ports support a fiber-optic connection which alleviates the distance 
limitations of copper cabling. 

In this example, all computers can share high-speed applications on the server and access the Internet. 
To expand the network, simply add more networking devices such as switches, routers, computers, print 
servers and so on. 

Figure 3   Gigabit to the Desktop 

1.1.4  IEEE 802.1Q VLAN Application Example
A VLAN (Virtual Local Area Network) allows a physical network to be partitioned into multiple logical 
networks. Stations on a logical network belong to one or more groups. With VLAN, a station cannot 
directly talk to or hear from stations that are not in the same group(s) unless such traffic first goes through 
a router.

For more information on VLANs, refer to Chapter 9 on page 112.

1.1.4.1  Tag-based VLAN Example
Ports in the same VLAN group share the same frame broadcast domain, thus increasing network 
performance by reducing broadcast traffic. VLAN groups can be modified at any time by adding, 
moving or changing ports without any re-cabling. 

Shared resources such as a server can be used by all ports in the same VLAN as the server. In the 
following figure only ports that need access to the server need to be part of VLAN 1. Ports can belong to 
other VLAN groups too.
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Figure 4   Shared Server Using VLAN Example 

1.1.5  IPv6 Support
IPv6 (Internet Protocol version 6), is designed to enhance IP address size and features. The increase in 
IPv6 address size to 128 bits (from the 32-bit IPv4 address) allows up to 3.4 x 1038 IP addresses. At the time 
of writing, the Switch supports the following features.

• Static address assignment and stateless auto-configuration

• Neighbor Discovery Protocol (a protocol used to discover other IPv6 devices in a network)

• Remote Management using ping SNMP, telnet, HTTP and FTP services

• ICMPv6 to report errors encountered in packet processing and perform diagnostic functions, such as 
"ping”

• IPv4/IPv6 dual stack; the Switch can run IPv4 and IPv6 at the same time

• DHCPv6 client and relay

• Multicast Listener Discovery (MLD) snooping and proxy

For more information on IPv6, refer to Appendix C on page 588 and the CLI Reference Guide.

1.1.6  Stacking Mode
The Switch can work in stacking mode and directly connect to other switches. The switches then 
operate together and act as a single switch or a virtual chassis. The stackable switches can be 
managed from a master switch in the stack. See Section 8.9 on page 105 for more information about 
stacking.

Note: To set the Switch to stacking mode, go to the Basic Setting > Stacking > Configuration 
screen (see Section 8.9.3 on page 108).

Note: When the Switch is in stacking mode, it uses the default static IP address 192.168.1.1.
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Figure 5   Stacking Example 

1.2  Ways to Manage the Switch
Use any of the following methods to manage the Switch.

• Web Configurator. This is recommended for everyday management of the Switch using a (supported) 
web browser. See Chapter 4 on page 39. 

• Command Line Interface. Line commands offer an alternative to the Web Configurator and may be 
necessary to configure advanced features. See the CLI Reference Guide. 

• FTP. Use File Transfer Protocol for firmware upgrades and configuration backup/restore. See Section 
55.11 on page 509. 

• SNMP. The device can be monitored and/or managed by an SNMP manager. See Section 56.3 on 
page 513. 

1.3  Good Habits for Managing the Switch
Do the following things regularly to make the Switch more secure and to manage the Switch more 
effectively.

• Change the password. Use a password that’s not easy to guess and that consists of different types of 
characters, such as numbers and letters.

• Write down the password and put it in a safe place.

• Back up the configuration (and make sure you know how to restore it). Restoring an earlier working 
configuration may be useful if the device becomes unstable or even crashes. If you forget your 
password, you will have to reset the Switch to its factory default settings. If you backed up an earlier 
configuration file, you would not have to totally re-configure the Switch. You could simply restore your 
last configuration.
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CHAPTER 2
Hardware Installation and

Connection

This chapter shows you how to install and connect the Switch. 

2.1  Freestanding Installation 

1 Make sure the Switch is clean and dry.

2 Set the Switch on a smooth, level surface strong enough to support the weight of the Switch and the 
connected cables. Make sure there is a power outlet nearby. 

3 Make sure there is enough clearance around the Switch to allow air circulation and the attachment of 
cables and the power cord. 

4 Remove the adhesive backing from the rubber feet.

5 Attach the rubber feet to each corner on the bottom of the Switch. These rubber feet help protect the 
Switch from shock or vibration and ensure space between devices when stacking. 

Figure 6   Attaching Rubber Feet    

Note: Do NOT block the ventilation holes. Leave space between devices when stacking.

Note: For proper ventilation, allow at least 4 inches (10 cm) of clearance at the front and 3.4 
inches (8 cm) at the back of the Switch. This is especially important for enclosed rack 
installations.
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2.2  Mounting the Switch on a Rack 
This section lists the rack mounting requirements and precautions and describes the installation steps. 

2.2.1  Rack-mounted Installation Requirements
• Two mounting brackets.

• Eight M3 flat head screws and a #2 Philips screwdriver.

• Four M5 flat head screws and a #2 Philips screwdriver. 

Failure to use the proper screws may damage the unit. 

2.2.1.1  Precautions 
• Make sure the rack will safely support the combined weight of all the equipment it contains. The 

maximum weight a bracket can hold is 21.5 Kg.

• Make sure the position of the Switch does not make the rack unstable or top-heavy. Take all 
necessary precautions to anchor the rack securely before installing the unit.

2.2.2  Attaching the Mounting Brackets to the Switch

1 Position a mounting bracket on one side of the Switch, lining up the four screw holes on the bracket with 
the screw holes on the side of the Switch.   

Figure 7   Attaching the Mounting Brackets 

2 Using a #2 Philips screwdriver, install the M3 flat head screws through the mounting bracket holes into 
the Switch.

3 Repeat steps 1 and 2 to install the second mounting bracket on the other side of the Switch.

4 You may now mount the Switch on a rack. Proceed to the next section.
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2.2.3  Mounting the Switch on a Rack

1 Position a mounting bracket (that is already attached to the Switch) on one side of the rack, lining up 
the two screw holes on the bracket with the screw holes on the side of the rack. 

Figure 8   Mounting the Switch on a Rack  

2 Using a #2 Philips screwdriver, install the M5 flat head screws through the mounting bracket holes into 
the rack. 

3 Repeat steps 1 and 2 to attach the second mounting bracket on the other side of the rack. 

Note: Make sure you tighten all the four screws to prevent the Switch from getting slanted.
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CHAPTER 3
Hardware Overview

This chapter describes the front panel and rear panel of the Switch and shows you how to make the 
hardware connections. 

3.1  Front Panel Connections 
The figure below shows the front panel of the Switch. 

Figure 9   Front Panel: XGS4600-32 

Figure 10   Front Panel: XGS4600-32F 

Figure 11   Front Panel: XGS4600-52F 

The following table describes the ports. 

Table 2   Front Panel Connections  
CONNECTOR DESCRIPTION
24 10/100/
1000Base-T RJ-45 
Ethernet Ports or 24 
SFP Slots or 48 SFP 
Slots

Connect these ports to a computer, a hub, an Ethernet switch or router.

4 GbE Combo Ports 
(Dual Personality 
Interfaces)

Each interface has one 1000Base-T copper RJ-45 port and one SFP slot, with one port active 
at a time.

• 4 1000Base-T Ports:

Connect these ports to a computer, an Ethernet switch or router.

• 4 SFP Slots:
Use Small Form-Factor Pluggable (SFP) transceivers in these ports for fiber-optic 
connections to an Ethernet switch or router. 

4 SFP+ Slots Use SFP+ transceivers in these ports for high-bandwidth backbone connections. You can 
also insert an SFP+ Direct Attach Copper (DAC) in the SFP+ slot.
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3.1.1  Ethernet Ports
The Switch has 1000Base-T auto-negotiating, auto-crossover Ethernet ports. In 10/100/1000 Mbps Gigabit 
Ethernet, the speed can be 10 Mbps, 100 Mbps or 1000 Mbps. The duplex mode can be full duplex at 
100 Mbps and full duplex only at 1000 Mbps. 

An auto-negotiating port can detect and adjust to the optimum Ethernet speed (10/100/1000 Mbps) 
and full duplex mode of the connected device.

An auto-crossover (auto-MDI/MDI-X) port automatically works with a straight-through or crossover 
Ethernet cable.

3.1.1.1  Default Ethernet Settings
The factory default negotiation settings for the Ethernet ports on the Switch are:

• Speed: Auto

• Duplex: Auto

• Flow control: Off

• Dual Personality Interface: Fiber-optic module first

3.1.2  SFP/SFP+ Slots 
These are four slots for Small Form-Factor Pluggable (SFP) or SFP+ modules, such as an SFP/SFP+ 
transceiver. The SFP+ (SFP Plus) is an enhanced version of the SFP and supports data rates of 10 Gbps. A 
transceiver is a single unit that houses a transmitter and a receiver. Use a transceiver to connect a fiber-
optic cable to the Switch. The Switch does not come with transceivers. You must use transceivers that 
comply with the Small Form-Factor Pluggable (SFP) Transceiver MultiSource Agreement (MSA). See the 
SFF committee’s INF-8074i specification Rev 1.0 for details. 

You can change transceivers while the Switch is operating. You can use different transceivers to 
connect to Ethernet switches with different types of fiber-optic connectors. 

• Type: SFP or SFP+ connection interface 

RJ-45 out-of-band 
Management Port

Connect to a computer using an RJ-45 Ethernet cable for local configuration of the Switch.

Console Port 
(XGS4600-32/32F)

Only connect this port to your computer (using an RS-232 cable) if you want to configure the 
Switch using the command line interface (CLI) via the console port. 

Reset If you are locked out from the Switch or configuration changes cause the Switch to behave 
abnormally and you don't have a backup configuration file or have not saved Config 1, 
Config 2, or Custom Default then you must use the Reset button.

Insert a pin to press the Reset button and release after six seconds to have the Switch 
automatically reboot and restore the factory default configuration file. You will then have to 
make all your configurations again on the Switch.

If you insert a pin to press the Reset button and release before six seconds then the Switch 
will automatically reboot only without restoring the factory default configuration file.

1 second- - - - - - -Reboot- - - - - - -6 seconds- - - - - - - -Reboot and Reset to Factory Defaults- - - 

Table 2   Front Panel Connections  (continued)
CONNECTOR DESCRIPTION
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• Connection speed: 1 or 10 Gigabit per second (Gbps) 

To avoid possible eye injury, do not look into an operating fiber-optic 
module’s connectors. 

3.1.2.1  Transceiver Installation   
Use the following steps to install a transceiver. 

1 Insert the transceiver into the slot with the exposed section of PCB board facing down. 

Figure 12   Transceiver Installation Example 

2 Press the transceiver firmly until it clicks into place.

3 The Switch automatically detects the installed transceiver. Check the LEDs to verify that it is functioning 
properly.

Figure 13   Installed Transceiver 

3.1.2.2  Transceiver Removal   
Use the following steps to remove a transceiver.

1 Open the transceiver’s latch (latch styles vary).

Figure 14   Opening the Transceiver’s Latch Example 

2 Pull the transceiver out of the slot.
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Figure 15   Transceiver Removal Example 

3.1.3  Dual Personality Interfaces
There are 4 Dual Personality interfaces, comprising 4 1000Base-T/SFP combo ports. For each interface 
you can connect either to the 1000Base-T port or the SFP port. The SFP ports have priority over the 
1000Base-T ports. This means that if a SFP port and the corresponding 1000Base-T port are connected at 
the same time, the 1000Base-T port will be disabled.

3.1.4  Management Port
The 1000Base-T Ethernet MGMT (management) port is used for local management. Connect directly to 
this port using an Ethernet cable. You can configure the Switch via Telnet or the web configurator. 

The default IP address of the management port is 192.168.0.1 with a subnet mask of 255.255.255.0.

3.1.5  Console Port 
For local management, you can use a computer with terminal emulation software configured to the 
following parameters:

• VT100 terminal emulation

• 115200 bps

• No parity, 8 data bits, 1 stop bit

• No flow control

Connect the male 9-pin end of the RS-232 console cable to the console port of the Switch. Connect the 
female end to a serial port (COM1, COM2 or other COM port) of your computer.

3.2  Rear Panel
The following figures show the rear panels of the Switch. The rear panels contain:

• Two power modules with power receptacles (A and B) 

• XGS4600-52F: A console port for configuring the Switch using the command line interface
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Figure 16   Rear Panel: XGS4600-32  

Figure 17   Rear Panel: XGS4600-32F  

Figure 18   Rear Panel: XGS4600-52F (AC model)  

Figure 19   Rear Panel: XGS4600-52F (DC model)  

3.2.1  Grounding
Grounding is a safety measure to have unused electricity return to the ground. It prevents damage to 
the Switch, and protects you from electrocution.

Note: The Switch must be grounded by qualified service personnel.

1 Remove the M4 ground screw from the Switch’s rear panel. 

2 Secure a green/yellow ground cable (16 AWG or smaller) to the Switch's rear panel using the M4 ground 
screw.

3 Attach the other end of the cable to the ground, either to the same ground electrode as the rack you 
installed the device on or to the main grounding electrode of the building.

Follow your country's regulations and safety instructions to electrically ground the device properly.

Warning! Connect the ground cable before you connect any other 
cables or wiring.

B A

AB

AB
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Figure 20   Grounding

3.2.2  AC Power Connection (AC Models Only)
Make sure you are using the correct power source and that no objects obstruct the airflow of the fans. 

The Switch uses two power supply modules, one of which is redundant, so if one power module fails the 
system can operate on the remaining module.

Connecting the Power

Use the following procedures to connect the Switch to a power source after you have installed it in a 
rack.

Note: Use the included power cord for the AC power connection.

1 Connect the female end of the power cord to the AC power socket.

2 Connect the other end of the cord to a power outlet.

Disconnecting the Power

The power input connectors can be disconnected from the power source individually.

1 Disconnect the power cord from the power outlet.

2 Disconnect the power cord from the AC power socket.

3.2.3  DC Power Connection (DC Models Only)
The Switch uses a single ETB series terminal block plug with four pins. Use two wires to connect to a single 
terminal pair, one wire for the positive terminal and one wire for the negative terminal.

Note: The current rating of the power wires must be greater than 20 Amps. The power supply 
to which the Switch connects must have a built-in circuit breaker or switch to toggle the 
power.
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Note: When installing the Switch power wire, push the wire firmly into the terminal as deep as 
possible and make sure that no exposed (bare) wire can be seen or touched.

Exposed power wire is dangerous. Use extreme care when connecting 
a DC power source to the device.

To connect a power supply:

1 Use a screwdriver to loosen the terminal block captive screws.

2 Connect one end of a power wire to the Switch’s RTN (return) pin and tighten the captive screw.

3 Connect the other end of the power wire to the positive terminal on the power supply.

4 Connect one end of a power wire to the Switch’s -48V (input) pin and tighten the captive screw.

5 Connect the other end of the power wire to the negative terminal on the power supply.

6 Insert the terminal block plug in the Switch’s terminal block header.

3.3  LEDs    
The following table describes the LEDs. 

Table 3   LEDs  
LED COLOR STATUS DESCRIPTION
PWR Green On The system is receiving power from the power module in the first power 

slot.

Amber Blinking The power module in the first power slot detects that the power system is 
under 10.8 voltage or not connected.

Off The system is not receiving power from the power module in the first 
power slot.

PWR2 Green On The system is receiving power from the power module in the second 
power slot.

Amber Blinking The power module in the second power slot detects that the power 
system is under 10.8 voltage or not connected.

Off The system is not receiving power from the power module in the second 
power slot.

SYS (System) Green Blinking The system is rebooting and performing self-diagnostic tests.

On The system is on and functioning properly.

Red On The system is functioning abnormally.

Off The power is off or the system is not ready/malfunctioning.

FAN Green On The fan is functioning properly.

Amber On The fan is not functioning at a proper speed or malfunctioning.

Off The fan is removed or the Switch is off. 
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LOCATOR Blue On The firmware update is in progress. Do not turn off or reset the Switch.

Blinking Shows the actual location of the Switch between several devices in a 
rack.

Off The locator function is disabled or the Switch is off.

MAST 
(Master)

Green On The Switch is acting as a standalone switch or the master in stacking.

Off The Switch is acting as a non-master member in a stack or it is in 
standalone mode.

Amber On There is an error occurred when the Switch is selected as the master 
member in a stack.

10/100/1000Base-T Ethernet Ports

1-28  

Link/ACT 

Green 
(Right) 

Blinking The port is receiving or transmitting data at 10 or 1000 Mbps.

On The port has a successful 10 or 1000 Mbps connection.

Amber 
(Left)

Blinking The port is receiving or transmitting data 100 Mbps.

On The port has a successful 100 Mbps connection.

Off This link is disconnected or the port is disabled.

1G SFP Slots 

25-28 

Link/ACT 

Green

(Right)

Blinking The port is receiving or transmitting data at 1000 Mbps.

On The port has a successful 1000 Mbps connection.

Off This link is disconnected.

Amber 
(Left)

Blinking The port is receiving or transmitting data at 100 Mbps.

On The port has a successful 100 Mbps connection.

Off This link is disconnected.

1G/10G SFP+ Slots

29-32 or 49-
52

LNK/ACT 

Green

(Left)

Blinking The port is receiving or transmitting data at 1000 Mbps.

On The port has a successful 1000 Mbps connection.

Blue

(Right)

Blinking The port is receiving or transmitting data 10 Gbps.

On The port has a successful 10 Gbps connection.

Off This link is disconnected.

MGMT 
(Manageme
nt)

Green 
(Right)

Blinking The system is transmitting or receiving to/from an Ethernet device at 10/
1000 Mbps through the MGMT port.

On The MGMT port is connected at 10/1000 Mbps.

Amber 
(Left)

Blinking The system is transmitting or receiving to/from an Ethernet device at 100 
Mbps through the MGMT port.

On The MGMT port is connected at 100 Mbps.

Off The MGMT port is not connected to an Ethernet device, or the port is 
disabled. 

STACK ID The LED is showing the Stack ID number of the Switch. 

ID 0 means it is a standalone Switch.

Table 3   LEDs  (continued)
LED COLOR STATUS DESCRIPTION
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CHAPTER 4
The Web Configurator

This section introduces the configuration and functions of the web configurator. 

4.1  Introduction
The web configurator is an HTML-based management interface that allows easy Switch setup and 
management via Internet browser. Supported browsers at the time of writing are:

• IE 8 or later

• Chrome 34.0.1847.131 or later

• Firefox 29.0.1 or later

• Opera 21.0 or later

• Safari 5.1.7 or later

The recommended screen resolution is 1024 by 768 pixels. In order to use the web configurator you need 
to allow:

• Web browser pop-up windows from your device. Web pop-up blocking is enabled by default in some 
browsers.

• JavaScript (enabled by default).

• Java permissions (enabled by default).

4.2  System Login     

1 Start your web browser.

2 The Switch is a DHCP client by default. Type “http://DHCP-assigned IP” in the Location or Address field. 
Press [ENTER]. 

If the Switch is not connected to a DHCP server, type “http://” and the static IP address of the Switch (for 
example, the default management IP address is 192.168.1.1 through an in-band (non-MGMT) port and 
192.168.0.1 through the MGMT port) in the Location or Address field. Press [ENTER]. Your computer must 
be in the same subnet in order to access this website address.

3 The login screen appears. The default username is admin and associated default password is 1234.
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Figure 21   Web Configurator: Login 

4 Click Login to view the first web configurator screen.

5 If you didn’t change the default administrator password and/or SNMP community values, a warning 
screen displays each time you log into the web configurator. Click Password / SNMP to open a screen 
where you can change the administrator and SNMP passwords simultaneously. Otherwise, click Ignore 
to close it.

Figure 22   Web Configurator: Warning 

Figure 23   Web Configurator: Password/SNMP 
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Change the default administrator and/or SNMP passwords, and then click Apply to save your changes. 

4.3  The Web Configurator Layout  
The Status screen is the first screen that displays when you access the web configurator. This guide uses 
the XGS4600-32 screens as an example. The screens may vary slightly for different models.

The following figure shows the navigating components of a web configurator screen. 

Table 4   Web Configurator: Password/SNMP 
LABEL DESCRIPTION
Administrator

This is the default administrator account with the “admin” user name. You cannot change the default administrator 
user name. Only the administrator has read/write access.

Old Password Type the existing system password (1234 is the default password when shipped).

New Password Enter your new system password. 

Retype to confirm Retype your new system password for confirmation

General Setting

Use this section to specify the SNMP version and community (password) values.

Version Select the SNMP version for the Switch. The SNMP version on the Switch must match the version 
on the SNMP manager. Choose SNMP version 2c (v2c), SNMP version 3 (v3) or both (v3v2c). 

Note: SNMP version 2c is backwards compatible with SNMP version 1.
Get Community Enter the Get Community string, which is the password for the incoming Get- and GetNext- 

requests from the management station.

The Get Community string is only used by SNMP managers using SNMP version 2c or lower.

Set Community Enter the Set Community string, which is the password for the incoming Set- requests from the 
management station. 

The Set Community string is only used by SNMP managers using SNMP version 2c or lower.

Trap Community Enter the Trap Community string, which is the password sent with each trap to the SNMP 
manager.

The Trap Community string is only used by SNMP managers using SNMP version 2c or lower.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 24   The Web Configurator Layout 

A - Click the menu items to open submenu links, and then click on a submenu link to open the screen in 
the main window.

B, C, D, E, F- These are quick links which allow you to perform certain tasks no matter which screen you 
are currently working in.

B - Click this link to update the information in the screen you are viewing currently.

C - Click this link to save your configuration into the Switch’s nonvolatile memory. Nonvolatile memory is 
saved in the configuration file from which the Switch booted from and it stays the same even if the 
Switch’s power is turned off. See Section 55.3 on page 498 for information on saving your settings to a 
specific configuration file.

D - Click this link to go to the status page of the Switch.

E - Click this link to log out of the web configurator.

F - Click this link to display web help pages. The help pages provide descriptions for all of the 
configuration screens.

G - Click this link to go to the ZON Neighbor Management screen where you can see and manage 
neighbor devices learned by the Switch.

A
G

B C D E F
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In the navigation panel, click a main link to reveal a list of submenu links. 

The following table describes the links in the navigation panel. 

Table 5   Navigation Panel Sub-links Overview 

BASIC SETTING ADVANCED 
APPLICATION IP APPLICATION MANAGEMENT

Table 6   Navigation Panel Links  
LINK DESCRIPTION 
Basic Settings

System Info This link takes you to a screen that displays general system and hardware monitoring 
information. 

General Setup This link takes you to a screen where you can configure general identification information and 
time settings for the Switch.

Switch Setup This link takes you to a screen where you can set up global Switch parameters such as VLAN 
type, MAC address learning, GARP and priority queues.

IP Setup This link takes you to a screen where you can configure the IP address, subnet mask 
(necessary for Switch management) and set up to 128 IP routing domains. 
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Port Setup This link takes you to screens where you can configure speed, flow control and priority settings 
for individual Switch ports.

Interface Setup This link takes you to a screen where you can create virtual interfaces on the Switch.

IPv6 This link takes you to a screen where you can enable an IPv6 interface and configure the IPv6 
settings on the Switch.

Loopback 
Interface

This link takes you to a screen where you can configure the IPv4 loopback interface settings 
on the Switch.

Stacking This link takes you to a screen where you can view and configure stacking system for the 
Switch.

DNS This link takes you to a screen where you can configure DNS (domain name server) IP 
addresses.

Advanced Application

VLAN This link takes you to screens where you can configure port-based or 802.1Q VLAN 
(depending on what you configured in the Switch Setup menu). You can also configure a 
protocol based VLAN or a subnet based VLAN in these screens.

Static MAC 
Forwarding

This link takes you to screens where you can configure static MAC addresses for a port. These 
static MAC addresses do not age out.

Static Multicast 
Forwarding

This link takes you to a screen where you can configure static multicast MAC addresses for 
port(s). These static multicast MAC addresses do not age out.

Filtering This link takes you to a screen to set up filtering rules. 

Spanning Tree 
Protocol

This link takes you to screens where you can configure the RSTP/MRSTP/MSTP to prevent 
network loops. 

Bandwidth Control This link takes you to screens where you can cap the maximum bandwidth allowed on a port.

Broadcast Storm 
Control

This link takes you to a screen to set up broadcast filters. 

Mirroring This link takes you to screens where you can copy traffic from one port or ports to another port 
in order that you can examine the traffic from the first port without interference.

Link Aggregation This link takes you to screen where you can logically aggregate physical links to form one 
logical, higher-bandwidth link.

Port Authentication This link takes you to a screen where you can configure IEEE 802.1x port authentication as well 
as MAC authentication for clients communicating via the Switch.

Port Security This link takes you to a screen where you can activate MAC address learning and set the 
maximum number of MAC addresses to learn on a port. 

Time Range This link takes you to a screen where you can configure time range for time-oriented features 
like Classifier.

Classifier This link takes you to screens where you can configure the Switch to group packets based on 
the specified criteria. 

Policy Rule This link takes you to a screen where you can configure the Switch to perform special 
treatment on the grouped packets. 

Queuing Method This link takes you to a screen where you can configure queuing with associated queue 
weights for each port.

VLAN Stacking This link takes you to screens where you can activate and configure VLAN stacking.

Multicast This link takes you to screen where you can configure various multicast features, IGMP 
snooping, MLD snooping-proxy and create multicast VLANs.

AAA This link takes you to a screen where you can configure authentication, authorization and 
accounting services via external servers. The external servers can be either RADIUS (Remote 
Authentication Dial-In User Service) or TACACS+ (Terminal Access Controller Access-Control 
System Plus).

Table 6   Navigation Panel Links  (continued)
LINK DESCRIPTION 
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IP Source Guard This link takes you to screens where you can configure filtering of unauthorized DHCP and ARP 
packets in your network.

Loop Guard This link takes you to a screen where you can configure protection against network loops that 
occur on the edge of your network. 

VLAN Mapping This link takes you to screens where you can configure VLAN mapping settings on the Switch.

Layer 2 Protocol 
Tunneling 

This link takes you to a screen where you can configure L2PT (Layer 2 Protocol Tunneling) 
settings on the Switch.

sFlow This link takes you to screens where you can configure sFlow settings on the Switch.

PPPoE This link takes you to screens where you can configure how the Switch gives a PPPoE 
termination server additional subscriber information that the server can use to identify and 
authenticate a PPPoE client.

Errdisable This link takes you to a screens where you can view errdisable status and configure errdisable 
settings in CPU protection, errdisable detect, and errdisable recovery.

MAC Pinning This link takes you to a screen where you can set specific ports to have priority over other ports 
in MAC address learning.

Private VLAN This link takes you to a screen where you can block traffic between ports in a VLAN on the 
Switch.

Green Ethernet This link takes you to a screen where you can configure the Switch to reduce port power 
consumption.

LLDP This link takes you to a screen where you can configure LLDP settings.

Anti-Arpscan This link takes you to screens where you can enable anti-arpscan on the Switch and ports, 
and view the port state. You can also create trusted hosts, view blocked hosts and unblock 
them.

BPDU Guard This link takes you to screens where you can enable BPDU guard on the Switch and ports, and 
view the port state.

OAM This link takes you to screens where you can enable Ethernet OAM on the Switch, view the 
configuration of ports on which Ethernet OAM is enabled and perform remote-loopback 
tests.

ZULD This link takes you to screens where you can enable Zyxel Unidirectional Link Detection (ZULD) 
on a port and configure related settings.

NLB This link takes you to screens where you can configure Network Load Balancing (NLB) on the 
Switch.

Wol Relay This link takes you to a screen where you can configure Wake-on-LAN (WoL) relay settings to 
send magic packets to devices across subnets.

IP Application

Static Routing This link takes you to a screen where you can configure static routes. A static route defines 
how the Switch should forward traffic by configuring the TCP/IP parameters manually.

Policy Routing This link takes you to screens where you can configure policy routing rules.

RIP This link takes you to screens where you can configure the RIP (Routing Information Protocol) 
direction and versions for IPv4 as well as IPv6 RIP timers and the method of preventing routing 
loops.

OSPF This link takes you to screens where you can view the OSPF status and configure OSPF settings 
for IPv4 and IPv6.

IGMP This link takes you to a screen where you can configure the IGMP settings.

DVMRP This link takes you to a screen where you can configure the DVMRP (Distance Vector 
Multicast Routing Protocol) settings. 

DiffServ This link takes you to screens where you can enable DiffServ, configure marking rules and set 
DSCP-to-IEEE802.1p mappings. 

DHCP This link takes you to screens where you can configure the DHCP settings. 

Table 6   Navigation Panel Links  (continued)
LINK DESCRIPTION 
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4.3.1  Change Your Password   
After you log in for the first time, it is recommended you change the default administrator password. 
Click Management > Access Control > Logins to display the next screen. 

VRRP This link takes you to screens where you can configure redundant virtual router for your 
network. 

Router Setup This link takes you to a screen where you can enable Equal-Cost MultiPath (ECMP) routing 
and set the criteria the Switch uses to determine the routing path for a packet.

ARP Setup This link takes you to screens where you can configure ARP learning mode on a per-port basis 
and create static ARP entries which do not age out.

Management

Maintenance This link takes you to screens where you can perform firmware and configuration file 
maintenance, reboot the system, set the CPU and Mbuf (Memory Buffer) thresholds and 
download the log reports, and save the certificate of a certification authority that you trust, 
from your computer to the Switch.

Access Control This link takes you to screens where you can change the system login password and configure 
SNMP and remote management. 

Diagnostic This link takes you to screens where you can ping IP addresses, run traceroute, test port(s).

System Log This link takes you to a screen where you can view system logs.

Syslog Setup This link takes you to a screen where you can setup system logs and a system log server.

Cluster 
Management

This link takes you to a screen where you can configure clustering management and view its 
status.

MAC Table This link takes you to a screen where you can view the MAC address and VLAN ID of a device 
attach to a port. You can also view what kind of MAC address it is.

IP Table This link takes you to a screen where you can view the IP addresses and VLAN ID of a device 
attached to a port.You can also view what kind of device it is.

ARP Table This link takes you to a screen where you can view the MAC address – IP address resolution 
table.

Routing Table This link takes you to a screen where you can view the IPv4 or the IPv6 routing tables. 

Path MTU Table This link takes you to a screen where you can view the IPv6 path MTU table.

Configure Clone This link takes you to a screen where you can copy attributes of one port to (an)other port(s). 

IPv6 Neighbor 
Table 

This link takes you to a screen where you can view the Switch’s IPv6 neighbor table.

Port Status This link takes you to a screen where you can view the port statistics and monitor the 
connected SFP transceiver’s parameters.

Service Register This link takes you to a screen where you can view the status of your service registrations and 
upgrade licenses.

Table 6   Navigation Panel Links  (continued)
LINK DESCRIPTION 
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Figure 25   Change Administrator Login Password 

4.4  Saving Your Configuration
When you are done modifying the settings in a screen, click Apply to save your changes back to the 
run-time memory. Settings in the run-time memory are lost when the Switch’s power is turned off.

Click the Save link in the upper right hand corner of the web configurator to save your configuration to 
nonvolatile memory. Nonvolatile memory refers to the Switch’s storage that remains even if the Switch’s 
power is turned off. 

Note: Use the Save link when you are done with a configuration session.

4.5  Switch Lockout   
You could block yourself (and all others) from using in-band-management (managing through the data 
ports) if you do one of the following:

1 Delete the management VLAN (default is VLAN 1).

2 Delete all port-based VLANs with the CPU port as a member. The “CPU port” is the management port of 
the Switch.

3 Filter all traffic to the CPU port.

4 Disable all ports.

5 Misconfigure the text configuration file.

6 Forget the password and/or IP address.
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7 Prevent all services from accessing the Switch. 

8 Change a service port number but forget it.

Note: Be careful not to lock yourself and others out of the Switch. If you do lock yourself out, 
try using out-of-band management (via the management port) to configure the 
Switch.

4.6  Resetting the Switch   
If you lock yourself (and others) from the Switch or forget the administrator password, you will need to 
reload the factory-default configuration file or reset the Switch back to the factory defaults.

4.6.1  Reload the Configuration File 
Uploading the factory-default configuration file replaces the current configuration file with the factory-
default configuration file. This means that you will lose all previous configurations and the speed of the 
console port will be reset to the default of 9600bps with 8 data bit, no parity, one stop bit and flow 
control set to none. The password will also be reset to “1234” and the IP address to 192.168.1.1 or DHCP-
assigned IP. 

To upload the configuration file, do the following:

1 Connect to the console port using a computer with terminal emulation software. See Section 3.2 on 
page 34 for details.

2 Disconnect and reconnect the Switch’s power to begin a session. When you reconnect the Switch’s 
power, you will see the initial screen. 

3 When you see the message “Press any key to enter Debug Mode within 3 seconds ...” press 
any key to enter debug mode.

4 Type atlc after the “Enter Debug Mode” message.

5 Wait for the “Starting XMODEM upload” message before activating XMODEM upload on your 
terminal.

6 After a configuration file upload, type atgo to restart the Switch.
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Figure 26   Resetting the Switch: Via the Console Port 

The Switch is now reinitialized with a default configuration file including the default password of “1234”.

4.7  Logging Out of the Web Configurator 
Click Logout in a screen to exit the web configurator. You have to log in with your password again after 
you log out. This is recommended after you finish a management session for security reasons.

Figure 27   Web Configurator: Logout Screen 

4.8  Help 
The web configurator’s online help has descriptions of individual screens and some supplementary 
information. 

Click the Help link from a web configurator screen to view an online help description of that screen.

Bootbase Version: V1.00 | 02/21/2016 15:43:29                                             
RAM: Size = 1048576 Kbytes                          
FLASH: 64M          

ZyNOS Version: V4.60(ABBI.0) | 09/06/2018 11:41:8                                              

Press any key to enter debug mode within 1 second.
.....................................
Enter Debug Mode
ras> atlc
Starting XMODEM upload (CRC mode)....
CCCCCCCCCCCCCCCC
Total  393216 bytes received.
Erasing..
................................................................
OK
ras> atgo
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CHAPTER 5
Initial Setup Example

5.1  Overview
This chapter shows how to set up the Switch for an example network. 

The following lists the configuration steps for the initial setup:

• Creating a VLAN

• Setting Port VID

• Configuring Switch Management IP Address

5.1.1  Creating a VLAN 
VLANs confine broadcast frames to the VLAN group in which the port(s) belongs. You can do this with 
port-based VLAN or tagged static VLAN with fixed port members. 

In this example, you want to configure port 1 as a member of VLAN 2. 

Figure 28   Initial Setup Network Example: VLAN 

1 Click Advanced Application > VLAN > VLAN Configuration in the navigation panel and click the Static 
VLAN Setup link.   
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2 In the Static VLAN screen, select 
ACTIVE, enter a descriptive name 
in the Name field and enter 2 in 
the VLAN Group ID field for the 
VLAN2 network. 

Note: The VLAN Group ID field in this screen and the VID field in the IP Setup screen refer to the 
same VLAN ID. 

3 Since the VLAN2 network is connected to port 1 on the Switch, select Fixed to configure port 1 to be a 
permanent member of the VLAN only. 

4 To ensure that VLAN-unaware devices (such as computers and hubs) can receive frames properly, clear 
the TX Tagging check box to set the Switch to remove VLAN tags before sending. 

5 Click Add to save the settings to the run-time memory. Settings in the run-time memory are lost when the 
Switch’s power is turned off.

5.1.2  Setting Port VID 
Use PVID to add a tag to incoming untagged frames received on that port so that the frames are 
forwarded to the VLAN group that the tag defines. 

In the example network, configure 2 as the port VID on port 1 so that any untagged frames received on 
that port get sent to VLAN 2.
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Figure 29   Initial Setup Network Example: Port VID 

1 Click Advanced Applications > VLAN > 
VLAN Configuration in the navigation 
panel. Then click the VLAN Port Setup 
link. 

2 Enter 2 in the PVID field for port 1 and 
click Apply to save your changes back 
to the run-time memory. Settings in the 
run-time memory are lost when the 
Switch’s power is turned off.

5.1.3  Configuring Switch Management IP Address
The default management IP address of the Switch is 192.168.1.1. You can configure another IP address in 
a different subnet for management purposes. The following figure shows an example. 
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Figure 30   Initial Setup Example: Management IP Address 

1 Connect your computer to any Ethernet port on the Switch. Make sure your computer is in the same 
subnet as the Switch. 

2 Open your web browser and enter 192.168.1.1 (the default IP address) in the address bar to access the 
web configurator. See Section 4.2 on page 39 for more information.

3 Click Basic Setting > IP Setup > IP Configuration 
in the navigation panel. 

4 Configure the related fields in the IP 
Configuration screen. 

5 For the VLAN2 network, enter 192.168.2.1 as the 
IP address and 255.255.255.0 as the subnet 
mask. 

6 In the VID field, enter the ID of the VLAN group 
to which you want this management IP address 
to belong. This is the same as the VLAN ID you 
configure in the Static VLAN screen. 

7 Click Add to save your changes back to the 
run-time memory. Settings in the run-time 
memory are lost when the Switch’s power is 
turned off.
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CHAPTER 6
Tutorials

6.1  Overview
This chapter provides some examples of using the web configurator to set up and use the Switch. The 
tutorials include:

• How to Use DHCPv4 Snooping on the Switch

• How to Use DHCPv4 Relay on the Switch

• How to Use Auto Configuration via a DHCP Server on the Switch

6.2  How to Use DHCPv4 Snooping on the Switch
You only want DHCP server A connected to port 5 to assign IP addresses to all devices in VLAN network 
(V). Create a VLAN containing ports 5, 6 and 7. Connect a computer M to the Switch for management. 

Figure 31   Tutorial: DHCP Snooping Tutorial Overview

Note: For related information about DHCP snooping, see Section 27.5 on page 282.

The settings in this tutorial are as the following.

1 Access the Switch through http://192.168.1.1 by default. Log into the Switch by entering the username 
(default: admin) and password (default: 1234).

Table 7   Tutorial: Settings in this Tutorial
HOST PORT CONNECTED VLAN PVID DHCP SNOOPING PORT TRUSTED
DHCP Server (A) 5 1 and 100 100 Yes

DHCP Client (B) 6 1 and 100 100 No

DHCP Client (C) 7 1 and 100 100 No
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2 Go to Advanced Application > VLAN > VLAN Configuration > Static VLAN Setup, and create a VLAN with 
ID of 100. Add ports 5, 6 and 7 in the VLAN by selecting Fixed in the Control field as shown.

Deselect Tx Tagging because you don’t want outgoing traffic to contain this VLAN tag.

Click Add.

Figure 32   Tutorial: Create a VLAN and Add Ports to It

3 Go to Advanced Application > VLAN > VLAN Configuration > VLAN Port Setup, and set the PVID of the 
ports 5, 6 and 7 to 100. This tags untagged incoming frames on ports 5, 6 and 7 with the tag 100.

Figure 33   Tutorial: Tag Untagged Frames

4 Go to Advanced Application > IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > 
Configure, activate and specify VLAN 100 as the DHCP VLAN as shown. Click Apply.
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Figure 34    Tutorial: Specify DHCP VLAN

5 Click the Port link at the top right corner. 

6 The DHCP Snooping Port Configure screen appears. Select Trusted in the Server Trusted state field for port 
5 because the DHCP server is connected to port 5. Keep ports 6 and 7 Untrusted because they are 
connected to DHCP clients. Click Apply.

Figure 35    Tutorial: Set the DHCP Server Port to Trusted

7 Go to Advanced Application > IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > 
Configure > VLAN, show VLAN 100 by entering 100 in the Start VID and End VID fields and click Apply. 
Then select Yes in the Enabled field of the VLAN 100 entry shown at the bottom section of the screen. 

If you want to add more information in the DHCP request packets such as source VLAN ID or system 
name, you can also select an Option82 Profile in the entry. See Section 27.6.2 on page 288.
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Figure 36   Tutorial: Enable DHCP Snooping on this VLAN

8 Click Save at the top right corner of the web 
configurator to save the configuration permanently.

9 Connect your DHCP server to port 5 and a computer (as DHCP client) to either port 6 or 7. The computer 
should be able to get an IP address from the DHCP server. If you put the DHCP server on port 6 or 7, the 
computer will not able to get an IP address.

10 To check if DHCP snooping works, go to Advanced Application > IP Source Guard > IPv4 Source Guard 
Setup, you should see an IP assignment with the type DHCP-Snooping as shown.

Figure 37   Tutorial: Check the Binding If DHCP Snooping Works

You can also telnet. Use the command “show dhcp snooping binding” to see the DHCP snooping 
binding table as shown next.

6.3  How to Use DHCPv4 Relay on the Switch
This tutorial describes how to configure your Switch to forward DHCP client requests to a specific DHCP 
server. The DHCP server can then assign a specific IP address based on the information in the DHCP 
requests.

6.3.1  DHCP Relay Tutorial Introduction
In this example, you have configured your DHCP server (192.168.2.3) and want to have it assign a 
specific IP address (say 172.16.1.18) to DHCP client A based on the system name, VLAN ID and port 
number in the DHCP request. Client A connects to the Switch’s port 2 in VLAN 102.

sysname# show dhcp snooping binding
         MacAddress        IpAddress         Lease           Type  VLAN   Port
  -----------------  ---------------  ------------  -------------  ----  -----
  00:02:00:00:00:1c       10.10.1.16   6d23h59m20s  dhcp-snooping   100      7
  Total number of bindings: 1
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Figure 38   Tutorial: DHCP Relay Scenario

6.3.2  Creating a VLAN
Follow the steps below to configure port 2 as a member of VLAN 102.

1 Access the web configurator through the Switch’s management port.

2 Go to Basic Setting > Switch Setup and set the VLAN type to 802.1Q. Click Apply to save the settings to 
the run-time memory. 

Figure 39   Tutorial: Set VLAN Type to 802.1Q 

3 Click Advanced Application > VLAN > VLAN Configuration > Static VLAN Setup.

4 In the Static VLAN screen, select ACTIVE, enter a descriptive name (VLAN 102 for example) in the Name 
field and enter 102 in the VLAN Group ID field.

5 Select Fixed to configure port 2 to be a permanent member of this VLAN.
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6 Clear the TX Tagging check box to set the Switch to remove VLAN tags before sending. 

7 Click Add to save the settings to the run-time memory. Settings in the run-time memory are lost when the 
Switch’s power is turned off.

Figure 40   Tutorial: Create a Static VLAN 

8 Click the VLAN Configuration link in the Static VLAN Setup screen and then the VLAN Port Setup link in the 
VLAN Configuration screen.

Figure 41   Tutorial: Click the VLAN Port Setting Link 

9 Enter 102 in the PVID field for port 2 to add a tag to incoming untagged frames received on that port so 
that the frames are forwarded to the VLAN group that the tag defines.

10 Click Apply to save your changes back to the run-time memory. 
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Figure 42   Tutorial: Add Tag for Frames Received on Port 2 

11 Click the Save link in the upper right corner of the web configurator to save your configuration 
permanently. 

6.3.3  Configuring DHCPv4 Relay
Follow the steps below to enable DHCP relay on the Switch and allow the Switch to add relay agent 
information (such as the VLAN ID) to DHCP requests.

1 Click IP Application > DHCP > DHCPv4 and then the Global link to open the DHCP Relay screen.

2 Select the Active check box.

3 Enter the DHCP server’s IP address (192.168.2.3 in this example) in the Remote DHCP Server 1 field.

4 Select default1 or default2 in the Option 82 Profile field.

5 Click Apply to save your changes back to the run-time memory. 

Figure 43   Tutorial: Set DHCP Server and Relay Information 

6 Click the Save link in the upper right corner of the web configurator to save your configuration 
permanently.

7 The DHCP server can then assign a specific IP address based on the DHCP request.
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6.3.4  Troubleshooting
Check the client A’s IP address. If it did not receive the IP address 172.16.1.18, make sure:

1 Client A is connected to the Switch’s port 2 in VLAN 102.

2 You configured the correct VLAN ID, port number and system name for DHCP relay on both the DHCP 
server and the Switch.

3 You clicked the Save link on the Switch to have your settings take effect.

6.4  How to Use Auto Configuration via a DHCP Server on 
the Switch

Follow the steps below to set up configurations on a DHCP server, TFTP server, and the Switch, so you 
can load an auto configuration file automatically from a TFTP server when you reboot the Switch.

Note that you can set up a DHCP server and TFTP server either on the same device or different devices. 
Also, make sure the Switch can communicate with the TFTP server.

Note: Steps order could vary according to different programs you use.

Note: You need to set up configurations on a DHCP server and TFTP server first to use auto 
configuration.

Setting up a DHCP Server

1 Set up a dynamic IP addresses pool so the DHCP server will assign an IP address to the Switch in that 
range.

2 Set up a TFTP server IP address, so the Switch will know where to load the auto configuration file.

3 Set up the filename of the auto configuration file, so the Switch will know which file to load when you 
reboot the Switch.

• Enter the filename of an auto configuration file. The Switch will load this auto configuration file 
when rebooting with DHCP option 60 disabled.

• If you want to load the auto configuration file with DHCP option 60 enabled and a Vendor Class 
Identifier assigned when you reboot the Switch, follow the instruction below. Otherwise, skip this 
step.
Enter the filename of the an auto configuration file. Set up a Vendor Class Identifier. To have the 
Switch load this auto configuration file, two conditions listed above must be met. Please refer to 
the following steps to see how to set up a Vendor Class Identifier on the Switch.

Setting up a TFTP Server

1 Select a directory on the TFTP server.

2 Put the configuration files in that directory.
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Setting up the Switch

1 Open the web configurator. Go to the Management > Maintenance screen, and click the Click Here 
button next to the Auto Configuration field. 

Figure 44   Tutorial: Auto Configuration Screen

2 Select the check box in the Active field to enable auto configuration. Select DHCP in the Mode field, 
and enter the VLAN ID where the DHCP server belongs to in the DHCP VLAN ID field. Click Apply to save 
your changes. See Section 55.8 on page 504 for more information about auto configuration.

Figure 45   Tutorial: Enable Auto Configuration

3 Go to the Basic Setting > IP Setup > IP Configuration screen. Select the check box in the DHCP Client 
field. 

4 If you want to load the auto configuration file with DHCP option 60 enabled and a Vendor Class 
Identifier assigned when you reboot the Switch, follow the instruction below. Otherwise, skip this step.
In the Basic Setting > IP Setup > IP Configuration screen, select the check box in the Option-60 field, and 
enter a Vendor Class Identifier in the Class-ID field. In this example, we use “ZyxelCorp”. Click Apply to 
save your changes. See Section 8.4 on page 85 for more information.
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Figure 46   Tutorial: Enable DHCP Client & Option 60

5 You need to save the current configuration in a configuration file, so the Switch will load the auto 
configuration file from the TFTP server automatically when rebooting. Go to the Management > 
Maintenance screen. Click the Config 1, Config2, or Custom Default button next to the Save 
Configuration field. See Section 55.3 on page 498 for more information.

6 Click the same button next to Reboot System field to reboot the Switch, and load the auto configuration 
setting as configured before. For example, if you save the auto configuration setting to Config 1, you 
need to click the Config 1 button next to the Reboot System field. See Section 55.4 on page 499 for more 
information.
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Figure 47   Tutorial: Save Configuration & Reboot System

7 Go to the Management > System Log screen to see if auto configuration was performed successfully.

Figure 48   Tutorial: Log

8 Check the screens to see if it’s the configuration file you want to load. If it’s not, go through the steps 
above to check your configurations. If it is, click Save at the top right corner of the web configurator to 
save the configuration permanently.

Figure 49   Tutorial: Save
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CHAPTER 7
Status and ZON Utility

7.1  Overview
This chapter describes the screens for System Status, ZON Utility, and ZON Neighbor Management.

7.2  Status
The Status screen displays when you log into the Switch or click Status at the top right corner of the web 
configurator. The Status screen displays general device information, system status, and its IP addresses.

Figure 50   Status
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The following table describes the fields in the above screen. 

Table 8   Status
LABEL DESCRIPTION
Device Information

Device Type This field displays the model name of this Switch.

System Name This field displays the name used to identify the Switch on any network.

Boot Version This field displays the version number and date of the boot module that is currently on the 
Switch.

System Location This field displays the geographic location of your Switch. You can change the setting in 
the Basic Setting > General Setup screen.

Firmware Version This field displays the version number and date of the firmware the Switch is currently 
running. 

System Time This field displays the current date and time in the UAG. The format is mm-dd-yyyy 
hh:mm:ss.

Hardware Version This field displays the hardware version number of the Switch. The integer is the model 
version, and the decimal is the version of the hardware change. For example, V1.0 is a 
hardware version for the Switch where 1 identifies the XGS4600 Series, and .0 is the first 
hardware change.

System Up Time This field displays how long the Switch has been running since it last restarted or was turned 
on.

MAC Address This field displays the MAC addresses of the Switch. 

Login Timeout (mins) This field displays how many minutes a management session can be left idle before the 
session times out. After it times out you have to log in with your password again. 

Serial Number This field displays the serial number of this Switch. The serial number is used for device 
tracking and control.

Registration MAC 
Address

This field displays the MAC address of the Switch that you must use to register at myZyxel.

Service Status This field displays the service name (Advance Routing for example) if a service license is 
enabled at myZyxel or Not Licensed if the service license is not enabled. It also shows the 
amount of time that remains if you enabled a trial license (Advance Routing | Trial 30 
day(s) 0 hour(s) for example).

Go to the Management > Service Register screen to see the subscription services available 
for your Switch.

Stacking topology 
(Stacking mode)

This field displays whether the current topology is Chain or Ring.

Detail Click this link to go to the Basic Setting > System Info screen to check other detailed 
information, such as system resource usage and the Switch temperature, fan speeds or 
voltage.

IP Address Information

IPv4 Address This field displays the Switch’s current IPv4 address.

Subnet Mask This field displays the Switch’s subnet mask.

Default Gateway This field displays the IP address of the Switch’s default gateway.

IP Setup Click the link to go to the Basic Setting > IP Setup screen.

IPv6 Global Unicast 
Address

This field displays the Switch’s IPv6 global unicast address.

IPv6 Link-Local 
Address

This field displays the Switch’s IPv6 link-local address.

IPv6 configuration Click the link to go to the Basic Setting > IPv6 screen.
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7.3  Zyxel One Network (ZON) Utility 
ZON Utility is a program designed to help you deploy and manage a network more efficiently. It detects 
devices automatically and allows you to do basic settings on devices in the network without having to 
be near it.

The ZON Utility issues requests via Zyxel Discovery Protocol (ZDP) and in response to the query, the device 
responds back with basic information including IP address, firmware version, location, system and model 
name in the same broadcast domain. The information is then displayed in the ZON Utility screen and you 
can perform tasks like basic configuration of the devices and batch firmware upgrade in it. You can 
download the ZON Utility at www.zyxel.com and install it on a PC (Windows operating system).

7.3.1  Requirements
Before installing the ZON Utility on your PC, please make sure it meets the requirements listed below.

Operating System

At the time of writing, the ZON Utility is compatible with:

• Windows 7 (both 32-bit / 64-bit versions)

• Windows 8 (both 32-bit / 64-bit versions)

• Windows 8.1 (both 32-bit / 64-bit versions)

• Window 10 (both 32-bit / 64-bit versions)

Note: To check for your Windows operating system version, right-click on My Computer > 
Properties. You should see this information in the General tab.

Hardware

Here are the minimum hardware requirements to use the ZON Utility on your PC. 

• Core i3 processor

• 2GB RAM

• 100MB free hard disk

• WXGA (Wide XGA 1280x800)

Device Status and 
Quick Configuration

This section shows whether a feature is enabled or not on the Switch. You can click a 
feature’s Setting link to go to the configuration screen for the feature.

Hover your cursor over a red exclamation mark to display information about the feature.

Note: The Stacking Status field is displayed only on the Switch with stacking 
support.

Quick Links This section provides the shortcut link to a specific configuration screen.

Table 8   Status
LABEL DESCRIPTION
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7.3.2  Run the ZON Utility

1 Double-click the ZON Utility to run it.

2 The first time you run the ZON Utility, you will see if your device and firmware version support the ZON 
Utility. Click the OK button to close this screen.

Figure 51   Supported Devices and Versions

If you want to check the supported models and firmware versions later, you can click the Show 
information about ZON icon in the upper right hand corner of the screen. Then select the Supported 
model and firmware version link. If your device is not listed here, see the device release notes for ZON 
utility support. The release notes are in the firmware zip file on the Zyxel web site.

Figure 52   ZON Utility Screen

3 Select a network adapter to which your supported devices are connected.
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Figure 53   Network Adapter

4 Click the Go button for the ZON Utility to discover all supported devices in your network.

Figure 54   Discovery

5 The ZON Utility screen shows the devices discovered.

Figure 55   ZON Utility Screen

6 Select a device and then use the icons to perform actions. Some functions may not be available for 
your devices.

The following table describes the icons numbered from left to right in the ZON Utility screen.

1 2 3 4 5 6 7 8 9 10 11 12 13

Table 9   ZON Utility Icons
ICON DESCRIPTION
1 IP configuration Change the selected device’s IP address.

2 Renew IP Address Update a DHCP-assigned dynamic IP address.
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The following table describes the fields in the ZON Utility main screen.

3 Reboot Device Use this icon to restart the selected device(s). This may be useful when troubleshooting 
or upgrading new firmware.

4 Reset Configuration to 
Default

If you forget your password or cannot access the Web Configurator, you can use this 
icon to reload the factory-default configuration file. This means that you will lose all 
configurations that you had previously.

5 Locator LED Use this icon to locate the selected device by causing its Locator LED to blink.

6 Web GUI Use this to access the selected device web configurator from your browser. You will 
need a username and password to log in.

7 Firmware Upgrade Use this icon to upgrade new firmware to selected device(s) of the same model. Make 
sure you have downloaded the firmware from the Zyxel website to your computer and 
unzipped it in advance.

8 Change Password Use this icon to change the admin password of the selected device. You must know 
the current admin password before changing to a new one.

9 Configure NCC 
Discovery

You must have Internet access to use this feature. Use this icon to enable or disable the 
Nebula Control Center (NCC) discovery feature on the selected device. If it’s enabled, 
the selected device will try to connect to the NCC. Once the selected device is 
connected to and has registered in the NCC, it’ll go into the Nebula cloud 
management mode.

10 ZAC Use this icon to run the Zyxel AP Configurator of the selected AP.

11 Clear and Rescan Use this icon to clear the list and discover all devices on the connected network again.

12 Save Configuration Use this icon to save configuration changes to permanent memory on a selected 
device.

13 Settings Use this icon to select a network adaptor for the computer on which the ZON utility is 
installed, and the utility language.

Table 10   ZON Utility Fields
LABEL DESCRIPTION
Type This field displays an icon of the kind of device discovered. 

Model This field displays the model name of the discovered device.

Firmware Version This field displays the firmware version of the discovered device.

MAC Address This field displays the MAC address of the discovered device.

IP Address This field displays the IP address of an internal interface on the discovered device that 
first received an ZDP discovery request from the ZON utility.

System Name This field displays the system name of the discovered device.

Location This field displays where the discovered device is.

Status This field displays whether changes to the discovered device have been done 
successfully. As the Switch does not support IP Configuration, Renew IP address and 
Flash Locator LED, this field displays “Update failed”, “Not support Renew IP address” 
and “Not support Flash Locator LED” respectively.

NCC Discovery This field displays if the discovered device supports the Nebula Control Center (NCC) 
discovery feature. If it’s enabled, the selected device will try to connect to the NCC. 
Once the selected device is connected to and has registered in the NCC, it’ll go into 
the Nebula cloud management mode.

Serial Number Enter the admin password of the discovered device to display its serial number.

Hardware Version This field displays the hardware version of the discovered device.

Table 9   ZON Utility Icons
ICON DESCRIPTION
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7.4  ZON Neighbor Management Screen 
The ZON Neighbor Management screen allows you to view and manage the Switch’s neighboring 
devices more conveniently. It uses Layer Link Discovery Protocol (LLDP) to discover all neighbor devices 
connected to the Switch including non-Zyxel devices. You can perform tasks on the neighboring 
devices like login, reboot (turn the power off and then back on again), and reset to factory default 
settings in the Neighbor Management screen. For more information on LLDP, see Section 37.2 on page 
356.

Click Status > Neighbor to see the following screen.

Figure 56    Status > Neighbor

The following table describes the fields in the above screen. 

Table 11   Status > Neighbor
LABEL DESCRIPTION
Local

Port This shows the port of the Switch, on which the neighboring device is discovered.

Desc. This shows the port description of the Switch.

PoE Draw This shows the power consumption that the neighboring device connected to this port 
draws from the Switch. This allows you to plan and use within the power budget of the 
Switch.

Remote

Port This show the number of the neighbor device’s port which is connected to the Switch.

Desc. This shows the description of the neighbor device’s port which is connected to the Switch.

Model This shows the model name of the neighbor device. This field will show “-” for non-Zyxel 
devices.

System Name This shows the system name of the neighbor device.

Location This shows the geographic location of the neighbor device.

Firmware This shows the firmware version of the neighbor device. This field will show “-” for non-Zyxel 
devices.

IP This shows the IP address of the neighbor device. The IP address is a hyper link that you can 
click to log into and manage the neighbor device through its web configurator. This field 
will show “-” for non-Zyxel devices.

MAC This shows the MAC address of the neighbor device. This field will show “-” for non-Zyxel 
devices.



Chapter 7 Status and ZON Utility

XGS4600 Series User’s Guide

73

PWR Cycle Click the Cycle button to turn OFF the power of the neighbor device and turn it back ON 
again. A count down button (from 5 to 0) starts.

Note: The Switch must support power sourcing (PSE) or the network device is a 
powered device (PD).

Note: If multiple neighbor devices use the same port, the Cycle button is 
displayed only on the first device, others will show “-” instead.

Reset to Default Click the Reset button to reset the neighbor device to its factory default settings. A warning 
message “Are you sure you want to load factory default?” appears prompting you to 
confirm the action. After confirming the action a count down button (from 5 to 0) starts.

Note: The Switch must support power sourcing (PSE) or the network device is a 
powered device (PD).

Note: If multiple neighbor devices use the same port, the Reset button is not 
available and will show “-” instead.

Note: You can only reset Zyxel products.

Table 11   Status > Neighbor
LABEL DESCRIPTION
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CHAPTER 8
Basic Setting

This chapter describes how to configure the Basic Setting screens.

8.1  System Information   
In the navigation panel, click Basic Setting > System Info to display the screen as shown. 

You can check the firmware version number and monitor the Switch temperature, fan speeds and 
voltage in this screen. 

Figure 57   Basic Setting > System Info (Standalone Mode) 
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Figure 58   Basic Setting > System Info (Stacking Mode) 

The following table describes the labels in these screens. 

Table 12   Basic Setting > System Info (Standalone and Stacking Modes) 
LABEL DESCRIPTION
System Name This field displays the descriptive name of the Switch for identification purposes. 

Product Model This field displays the product model of the Switch. Use this information when searching for 
firmware upgrade or looking for other support information in the website. 

ZyNOS F/W 
Version

This field displays the version number of the Switch 's current firmware including the date created.

Ethernet 
Address 

This field refers to the Ethernet MAC (Media Access Control) address of the Switch. 

CPU Utilization CPU utilization quantifies how busy the system is. Current (%) displays the current percentage of 
CPU utilization. 

Memory 
Utilization

Memory Utilization shows how much DRAM memory is available and in use. It also displays the 
current percentage of memory utilization.

Name This field displays the name of memory pool.

Total This field displays the total number of bytes in this memory pool.

Used This field displays the number of bytes being used in this memory pool.

Utilization This field displays the percentage (%) of memory being used in this memory pool.

Hardware Monitor (Standalone Mode)  

Temperature 
Unit 

The Switch has temperature sensors that are capable of detecting and reporting if the 
temperature rises above the threshold. You may choose the temperature unit (Centigrade or 
Fahrenheit) in this field. 

Temperature BOARD, MAC and PHY refer to the location of the temperature sensors on the Switch printed 
circuit board.

Current This shows the current temperature at this sensor.

MAX This field displays the maximum temperature measured at this sensor.

MIN This field displays the minimum temperature measured at this sensor.

Threshold This field displays the upper temperature limit at this sensor.
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8.1.1  System Information Stacking Hardware Monitor 
Click a slot number in the System Information screen to display more detailed hardware information on 
a Switch. 

Status This field displays Normal for temperatures below the threshold and Error for those above.

Fan Speed 
(RPM)

A properly functioning fan is an essential component (along with a sufficiently ventilated, cool 
operating environment) in order for the device to stay within the temperature threshold. Each fan 
has a sensor that is capable of detecting and reporting if the fan speed falls below the threshold 
shown.

Current This field displays this fan's current speed in Revolutions Per Minute (RPM).

MAX This field displays this fan's maximum speed measured in Revolutions Per Minute (RPM).

MIN This field displays this fan's minimum speed measured in Revolutions Per Minute (RPM). "<41" is 
displayed for speeds too small to measure (under 2000 RPM).

Threshold This field displays the minimum speed at which a normal fan should work.

Status Normal indicates that this fan is functioning above the minimum speed. Error indicates that this 
fan is functioning below the minimum speed. 

Voltage (V) The power supply for each voltage has a sensor that is capable of detecting and reporting if the 
voltage falls out of the tolerance range.

Current This is the current voltage reading.

MAX This field displays the maximum voltage measured at this point.

MIN This field displays the minimum voltage measured at this point.

Threshold This field displays the percentage tolerance of the voltage with which the Switch still works.

Status Normal indicates that the voltage is within an acceptable operating range at this point; 
otherwise Error is displayed.

Power Source This field lists which power sources can be connected.

Status Active indicates the Switch is currently operating from the power source. Otherwise, N/A is 
displayed.

Hardware Status (Stacking Mode)   

Slot This number identifies the Switch in the stack. Click the number to see more detailed information 
on the Switch.

Name This is the system name of the Switch in the stack.

Voltage This shows if the power supply voltage sensor is within normal tolerance range.

Temperature This shows if the temperature sensors on the Switch printed circuit board are within normal 
tolerance range.

Fan This shows if the fan sensors are within normal tolerance range.

Power Source This shows if the Switch is properly operating from the connected power source.

Table 12   Basic Setting > System Info (Standalone and Stacking Modes) (continued)
LABEL DESCRIPTION
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Figure 59   Basic Setting > System Info > Hardware Monitor (Stacking Mode) 

The following table describes the labels in this screen. 

Table 13   Basic Setting > System Info > Hardware Monitor (Stacking Mode) 
LABEL DESCRIPTION
SLOT  This number identifies the Switch in the stack.

Temperature Unit The Switch has temperature sensors that are capable of detecting and reporting if the 
temperature rises above the threshold. You may choose the temperature unit (Centigrade or 
Fahrenheit) in this field. 

Temperature BOARD, PHY, CPU and MAC refer to the location of the temperature sensors on the Switch 
printed circuit board.

Current This shows the current temperature at this sensor.

MAX This field displays the maximum temperature measured at this sensor.

MIN This field displays the minimum temperature measured at this sensor.

Threshold This field displays the upper temperature limit at this sensor.

Status This field displays Normal for temperatures below the threshold and Error for those above.

Fan Speed (RPM) A properly functioning fan is an essential component (along with a sufficiently ventilated, cool 
operating environment) in order for the device to stay within the temperature threshold. Each 
fan has a sensor that is capable of detecting and reporting if the fan speed falls below the 
threshold shown. 

Current This field displays this fan's current speed in Revolutions Per Minute (RPM).

MAX This field displays this fan's maximum speed measured in RPM.

MIN This field displays this fan's minimum speed measured in RPM. “<41" is displayed for speeds too 
small to measure (under 2000 RPM).

Threshold This field displays the minimum speed at which a normal fan should work.

Status Normal indicates that this fan is functioning above the minimum speed. Error indicates that this 
fan is functioning below the minimum speed. 

Voltage (V) The power supply for each voltage has a sensor that is capable of detecting and reporting if 
the voltage falls out of the tolerance range.

Current This is the current voltage reading.
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8.2  General Setup  
Use this screen to configure general settings such as the system name and time. Click Basic Setting > 
General Setup in the navigation panel to display the screen as shown. 

Figure 60   Basic Setting > General Setup 

The following table describes the labels in this screen. 

MAX This field displays the maximum voltage measured at this point.

MIN This field displays the minimum voltage measured at this point.

Threshold This field displays the percentage tolerance of the voltage with which the Switch still works.

Status Normal indicates that the voltage is within an acceptable operating range at this point; 
otherwise Error is displayed.

Power Source This field lists which power sources can be connected.

Status Active indicates the Switch is currently operating from the power source. Otherwise, N/A is 
displayed.

Table 13   Basic Setting > System Info > Hardware Monitor (Stacking Mode) (continued)
LABEL DESCRIPTION

Table 14   Basic Setting > General Setup 
LABEL DESCRIPTION
System Name Type a descriptive name for identification purposes. This name consists of up to 64 printable 

ASCII characters; spaces are allowed.

Location Type the geographic location of your Switch. You can use up to 32 printable ASCII 
characters; spaces are allowed.

Contact Person's 
Name

Type the name of the person in charge of this Switch. You can use up to 32 printable ASCII 
characters; spaces are allowed.
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Use Time Server 
when Bootup

Type the time service protocol that your timeserver uses. Not all time servers support all 
protocols, so you may have to use trial and error to find a protocol that works. The main 
differences between them are the time format. 

When you select the Daytime (RFC 867) format, the Switch displays the day, month, year and 
time with no time zone adjustment. When you use this format, it is recommended that you 
use a Daytime timeserver within your geographical time zone. 

Time (RFC-868) format displays a 4-byte integer giving the total number of seconds since 
2016/01/01 at 0:0:0. 

NTP (RFC-1305) is similar to Time (RFC-868). 

If you select None, enter the time manually. Each time you turn on the Switch, the time and 
date will be reset to 2016-01-01 0:0.

Time Server IP 
Address

Type the IP address or domain name of your timeserver. The Switch searches for the 
timeserver for up to 60 seconds. If you select a timeserver that is unreachable, then this 
screen will appear locked for 60 seconds. Please wait.

Current Time This field displays the time you open this menu (or refresh the menu).

New Time 
(hh:min:ss)

Enter the new time in hour, minute and second format. The new time then appears in the 
Current Time field after you click Apply.

Current Date This field displays the date you open this menu.

New Date (yyyy-
mm-dd)

Enter the new date in year, month and day format. The new date then appears in the 
Current Date field after you click Apply.

Time Zone Select the time difference between UTC (Universal Time Coordinated, formerly known as 
GMT, Greenwich Mean Time) and your time zone from the drop-down list box. 

Daylight Saving 
Time

Daylight saving is a period from late spring to early fall when many countries set their clocks 
ahead of normal local time by one hour to give more daytime light in the evening.

Select this option if you use Daylight Saving Time.

Start Date Configure the day and time when Daylight Saving Time starts if you selected Daylight Saving 
Time. The time is displayed in the 24 hour format. Here are a couple of examples:

Daylight Saving Time starts in most parts of the United States on the second Sunday of March. 
Each time zone in the United States starts using Daylight Saving Time at 2 A.M. local time. So in 
the United States you would select Second, Sunday, March and 2:00.

Daylight Saving Time starts in the European Union on the last Sunday of March. All of the time 
zones in the European Union start using Daylight Saving Time at the same moment (1 A.M. 
GMT or UTC). So in the European Union you would select Last, Sunday, March and the last 
field depends on your time zone. In Germany for instance, you would select 2:00 because 
Germany's time zone is one hour ahead of GMT or UTC (GMT+1). 

End Date Configure the day and time when Daylight Saving Time ends if you selected Daylight Saving 
Time. The time field uses the 24 hour format. Here are a couple of examples:

Daylight Saving Time ends in the United States on the last Sunday of October. Each time zone 
in the United States stops using Daylight Saving Time at 2 A.M. local time. So in the United 
States you would select First, Sunday, November and 2:00.

Daylight Saving Time ends in the European Union on the last Sunday of October. All of the 
time zones in the European Union stop using Daylight Saving Time at the same moment (1 
A.M. GMT or UTC). So in the European Union you would select Last, Sunday, October and the 
last field depends on your time zone. In Germany for instance, you would select 2:00 
because Germany's time zone is one hour ahead of GMT or UTC (GMT+1). 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 14   Basic Setting > General Setup (continued)
LABEL DESCRIPTION
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8.3  Switch Setup 

8.3.1  Introduction to VLANs 
A VLAN (Virtual Local Area Network) allows a physical network to be partitioned into multiple logical 
networks. Devices on a logical network belong to one group. A device can belong to more than one 
group. With VLAN, a device cannot directly talk to or hear from devices that are not in the same 
group(s); the traffic must first go through a router.

In MTU (Multi-Tenant Unit) applications, VLAN is vital in providing isolation and security among the 
subscribers. When properly configured, VLAN prevents one subscriber from accessing the network 
resources of another on the same LAN, thus a user will not see the printers and hard disks of another user 
on the same network. 

VLAN also increases network performance by limiting broadcasts to a smaller and more manageable 
logical broadcast domain. In traditional switched environments, all broadcast packets go to each and 
every individual port. With VLAN, all broadcasts are confined to a specific broadcast domain. 

Note: VLAN is unidirectional; it only governs outgoing traffic.

See Chapter 9 on page 112 for information on port-based and 802.1Q tagged VLANs. 

Click Basic Setting > Switch Setup in the navigation panel to display the screen as shown. The VLAN 
setup screens change depending on whether you choose 802.1Q or Port Based in the VLAN Type field in 
this screen (in Standalone mode). Refer to the chapter on VLAN.

Figure 61   Basic Setting > Switch Setup 
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The following table describes the labels in this screen. 

Table 15   Basic Setting > Switch Setup 
LABEL DESCRIPTION
VLAN Type 
(Standalone 
mode only)

Choose 802.1Q or Port Based. The VLAN Setup screen changes depending on whether you 
choose 802.1Q VLAN type or Port Based VLAN type in this screen. See Chapter 9 on page 112 
for more information. The Switch does not have port-based VLAN available in stacking mode 
(Active is enabled in Basic Setting > Stacking > Configuration), so this field does not display in 
stacking mode.

Bridge Control 
Protocol 
Transparency 

Select Active to allow the Switch to handle bridging control protocols (STP, for example). You 
also need to define how to treat a BPDU in the Port Setup screen. 

MAC Address 
Learning

MAC address learning reduces outgoing traffic broadcasts. For MAC address learning to 
occur on a port, the port must be active.

Aging Time Enter a time from 10 to 1000000 seconds. This is how long all dynamically learned MAC 
addresses remain in the MAC address table before they age out (and must be relearned).

ARP Aging Time This is how long dynamically learned ARP entries remain in the ARP table before they age out 
(and must be relearned). 

Aging Time Enter a time from 60 to 1000000 seconds. The setting here applies to ARP entries which are 
newly added in the ARP table after you click Apply.

GARP Timer: Switches join VLANs by making a declaration. A declaration is made by issuing a Join message using 
GARP. Declarations are withdrawn by issuing a Leave message. A Leave All message terminates all registrations. 
GARP timers set declaration timeout values. See Chapter 9 on page 112 for more background information.

Join Timer Join Timer sets the duration of the Join Period timer for GVRP in milliseconds. Each port has a 
Join Period timer. The allowed Join Time range is between 100 and 65535 milliseconds; the 
default is 200 milliseconds. See Chapter 9 on page 112 for more background information.

Leave Timer Leave Time sets the duration of the Leave Period timer for GVRP in milliseconds. Each port has 
a single Leave Period timer. Leave Time must be two times larger than Join Timer; the default is 
600 milliseconds.

Leave All Timer Leave All Timer sets the duration of the Leave All Period timer for GVRP in milliseconds. Each 
port has a single Leave All Period timer. Leave All Timer must be larger than Leave Timer.

Priority Queue Assignment

IEEE 802.1p defines up to eight separate traffic types by inserting a tag into a MAC-layer frame that contains bits to 
define class of service. Frames without an explicit priority tag are given the default priority of the ingress port. Use 
the following fields to configure the priority level-to-physical queue mapping. 

The Switch has eight physical queues that you can map to the 8 priority levels. On the Switch, traffic assigned to 
higher index queues gets through faster while traffic in lower index queues is dropped if the network is congested. 

Priority Level (The following descriptions are based on the traffic types defined in the IEEE 802.1d standard (which 
incorporates the 802.1p).

Priority 7 Typically used for network control traffic such as router configuration messages.

Priority 6 Typically used for voice traffic that is especially sensitive to jitter (jitter is the variations in delay).

Priority 5 Typically used for video that consumes high bandwidth and is sensitive to jitter.

Priority 4 Typically used for controlled load, latency-sensitive traffic such as SNA (Systems Network 
Architecture) transactions.

Priority 3 Typically used for “excellent effort” or better than best effort and would include important 
business traffic that can tolerate some delay.

Priority 2 This is for “spare bandwidth”. 

Priority 1 This is typically used for non-critical “background” traffic such as bulk transfers that are 
allowed but that should not affect other applications and users. 

Priority 0 Typically used for best-effort traffic.



 Chapter 8 Basic Setting

XGS4600 Series User’s Guide

82

8.4  IP Setup   
Use the IP Setup screen to configure the default gateway device, the default domain name server and 
add IP domains. 

8.4.1   IP Interfaces
The Switch needs an IP address for it to be managed over the network. The factory default IP address is 
192.168.1.1. The subnet mask specifies the network number portion of an IP address. The factory default 
subnet mask is 255.255.255.0.

On the Switch, an IP address is not bound to any physical ports. Since each IP address on the Switch 
must be in a separate subnet, the configured IP address is also known as IP interface (or routing 
domain). In addition, this allows routing between subnets based on the IP address without additional 
routers. 

You can configure multiple routing domains on the same VLAN as long as the IP address ranges for the 
domains do not overlap. To change the IP address of the Switch in a routing domain, simply add a new 
routing domain entry with a different IP address in the same subnet. 

You can configure up to 256 IP domains which are used to access and manage the Switch from the 
ports belonging to the pre-defined VLAN(s). 

Note: You must configure a VLAN first. Each VLAN can have multiple management IP 
addresses, and you can log into the Switch via different management IP addresses 
simultaneously.

Figure 62   Basic Setting > IP Setup

The following table describes the labels in this screen. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 15   Basic Setting > Switch Setup (continued)
LABEL DESCRIPTION

Table 16   Basic Setting > IP Setup 
LABEL DESCRIPTION
Index This field displays the index number of an entry. 

IP Address This field displays IP address of the Switch in the IP domain. 

IP Subnet Mask This field displays the subnet mask of the Switch in the IP domain. 
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8.4.2   IP Status Details 
Use this screen to view IP status details. Click a number in the Index column in the IP Status screen to 
display the screen as shown next.

Figure 63   Basic Setting > IP Setup > IP Status Details: Static

The following table describes the labels in this screen. 

Figure 64   Basic Setting > IP Setup > IP Status Details: DHCP

VID This field displays the VLAN identification number of the IP domain on the Switch.

Type This shows whether this IP address is dynamically assigned from a DHCP server or manually 
assigned (Static).

Renew Click this to renew the dynamic IP address.

Release Click this to release the dynamic IP address.

Table 16   Basic Setting > IP Setup (continued)
LABEL DESCRIPTION

Table 17   Basic Setting > IP Setup > IP Status Details: Static 
LABEL DESCRIPTION
Type This shows whether the IP address is dynamically assigned from a DHCP server or manually 

assigned (Static or DHCP).

VID This is the VLAN identification number to which an IP routing domain belongs.

IP Address This is the IP address of your Switch in dotted decimal notation for example 192.168.1.1.

IP Subnet Mask This is the IP subnet mask of your Switch in dotted decimal notation for example 255.255.255.0.
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The following table describes the labels in this screen. 

8.4.3   IP Configuration
Use this screen to configure the default gateway device, the default domain name server and add IP 
domains.

Table 18   Basic Setting > IP Setup > IP Status Details: DHCP 
LABEL DESCRIPTION
Type This shows whether the IP address is dynamically assigned from a DHCP server or manually 

assigned (Static or DHCP).

VID This is the VLAN identification number to which an IP routing domain belongs.

IP Address This is the IP address of your Switch in dotted decimal notation for example 192.168.1.1.

IP Subnet Mask This is the IP subnet mask of your Switch in dotted decimal notation for example 255.255.255.0.

Lease Time This displays the length of time in seconds that this interface can use the current dynamic IP 
address from the DHCP server.

Renew Time This displays the length of time from the lease start that the Switch will request to renew its 
current dynamic IP address from the DHCP server. 

Rebind Time This displays the length of time from the lease start that the Switch will request to get any 
dynamic IP address from the DHCP server.

Lease Time Start This displays the date and time that the current dynamic IP address assignment from the DHCP 
server began. You should configure date and time in Basic Setting > General Setup.

Lease Time End This displays the date and time that the current dynamic IP address assignment from the DHCP 
server will end. You should configure date and time in Basic Setting > General Setup.

Default 
Gateway

This displays the IP address of the default gateway assigned by the DHCP server. 0.0.0.0 means 
no gateway is assigned.

DNS Server This displays the IP address of the primary and secondary DNS servers assigned by the DHCP 
server. 0.0.0.0 means no DNS server is assigned.
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Figure 65   Basic Setting > IP Setup > IP Configuration

The following table describes the labels in this screen. 

Table 19   Basic Setting > IP Setup > IP Configuration 
LABEL DESCRIPTION
Default 
Gateway

Type the IP address of the default outgoing gateway in dotted decimal notation, for example 
192.168.1.254.

Default 
Management

Specify which traffic flow (In-Band or Out-of-band) the Switch is to send packets originating 
from itself (such as SNMP traps) or packets with unknown source. 

Select Out-of-band to have the Switch send the packets to the management port labelled 
MGMT. This means that device(s) connected to the other port(s) do not receive these packets. 

Select In-Band to have the Switch send the packets to all ports except the management port 
(labelled MGMT) to which connected device(s) do not receive these packets. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.
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Out-of-band Management IP Address

Use these fields to set the settings for the out-of-band management port. 

IP Address Enter the out-of-band management IP address of your Switch in dotted decimal notation. For 
example, 192.168.0.1. 

IP Subnet 
Mask

Enter the IP subnet mask of your Switch in dotted decimal notation, for example, 255.255.255.0. 

Default 
Gateway

Enter the IP address of the default outgoing gateway in dotted decimal notation, for example, 
192.168.0.254 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

IP Interface

Use these fields to create or edit IP routing domains on the Switch. 

DHCP Client Select this option if you have a DHCP server that can assign the Switch an IP address, subnet 
mask, a default gateway IP address and a domain name server IP address automatically.

Option-60 DHCP Option 60 is used by the Switch for identification to the DHCP server using the VCI 
(Vendor Class Identifier) on the DHCP server. The Switch adds it in the initial DHCP discovery 
message that a DHCP client broadcasts in search of an IP address. The DHCP server can assign 
different IP addresses or options to clients with the specific VCI or reject the request from clients 
without the specific VCI.

Select this and enter the device identity you want the Switch to add in the DHCP discovery 
frames that go to the DHCP server. This allows the Switch to identify itself to the DHCP server.

Class-ID Type a string of up to 32 characters to identify this Switch to the DHCP server. For example, Zyxel-
TW.

Static IP 
Address

Select this option if you don’t have a DHCP server or if you wish to assign static IP address 
information to the Switch. You need to fill in the following fields when you select this option. 

IP Address Enter the IP address of your Switch in dotted decimal notation, for example, 192.168.1.1. This is 
the IP address of the Switch in an IP routing domain. 

IP Subnet 
Mask

Enter the IP subnet mask of an IP routing domain in dotted decimal notation, for example, 
255.255.255.0.

VID Enter the VLAN identification number to which an IP routing domain belongs. 

Add Click this to create a new entry.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Index This field displays the index number of an entry. 

IP Address This field displays IP address of the Switch in the IP domain. 

IP Subnet Mask This field displays the subnet mask of the Switch in the IP domain. 

VID This field displays the VLAN identification number of the IP domain on the Switch.

Type This field displays the type of IP address status.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Table 19   Basic Setting > IP Setup > IP Configuration (continued)
LABEL DESCRIPTION
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8.5  Port Setup 
Use this screen to configure Switch port settings. Click Basic Setting > Port Setup in the navigation panel 
to display the configuration screen. 

Figure 66   Basic Setting > Port Setup (Standalone mode) 

Delete Click Delete to remove the selected entry from the summary table.

Note: Deleting all IP subnets locks you out of the Switch. 
Cancel Click Cancel to clear the check boxes.

Table 19   Basic Setting > IP Setup > IP Configuration (continued)
LABEL DESCRIPTION
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Figure 67   Basic Setting > Port Setup (Stacking mode) 

The following table describes the labels in this screen. 

Table 20   Basic Setting > Port Setup 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This is the port index number. In stacking mode, the first number is the slot ID and the second is 
the port number. * means all ports.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to enable a port. The factory default for all ports is enabled. A port must 

be enabled for data transmission to occur.

Name Type a descriptive name that identifies this port. You can enter up to 64 alpha-numerical 
characters. 

Note: Due to space limitations, the port name may be truncated in some web 
configurator screens. 
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8.6  Interface Setup
An IPv6 address is configured on a per-interface basis. The interface can be a physical interface (for 
example, an Ethernet port) or a virtual interface (for example, a VLAN). The Switch supports the VLAN 
interface type for IPv6 and loopback interface type for IPv4 at the time of writing.

Speed/Duplex Select the speed and the duplex mode of the Ethernet connection on this port. The choices are 
Auto, 10M/Full Duplex and 100M/Full Duplex for a 100Base-T connection. 1G/Full Duplex is 
supported by both 1000Base-T and 1000Base-X connections. 10G/Full Duplex and Auto-1G are 
only supported by the 10 Gigabit Ethernet connections on the Switch that has a 10 Gigabit 
interface. 

Selecting Auto or Auto-1G (auto-negotiation) allows one port to negotiate with a peer port 
automatically to obtain the connection speed and/or duplex mode that both ends support. 
When auto-negotiation is turned on, a port on the Switch negotiates with the peer 
automatically to determine the connection speed and duplex mode. If the peer port does not 
support auto-negotiation or turns off this feature, the Switch determines the connection speed 
by detecting the signal on the cable and using half duplex mode. When the Switch’s auto-
negotiation is turned off, a port uses the pre-configured speed and duplex mode when making 
a connection, thus requiring you to make sure that the settings of the peer port are the same in 
order to connect. If you select Auto-1G on a 10 Gigabit port, the port connects at 1 Gbps in full 
duplex mode with auto-negotiation enabled. The peer port must also support auto-negotiation.

Flow Control A concentration of traffic on a port decreases port bandwidth and overflows buffer memory 
causing packet discards and frame losses. Flow Control is used to regulate transmission of signals 
to match the bandwidth of the receiving port. 

The Switch uses IEEE 802.3x flow control in full duplex mode and backpressure flow control in half 
duplex mode.

IEEE 802.3x flow control is used in full duplex mode to send a pause signal to the sending port, 
causing it to temporarily stop sending signals when the receiving port memory buffers fill. 

Back Pressure flow control is typically used in half duplex mode to send a "collision" signal to the 
sending port (mimicking a state of packet collision) causing the sending port to temporarily stop 
sending signals and resend later. Select Flow Control to enable it.

802.1p Priority This priority value is added to incoming frames without a (802.1p) priority queue tag. See Priority 
Queue Assignment in Table 15 on page 81 for more information.

BPDU Control Configure the way to treat BPDUs received on this port. You must activate bridging control 
protocol transparency in the Switch Setup screen first.

Select Peer to process any BPDU (Bridge Protocol Data Units) received on this port. 

Select Tunnel to forward BPDUs received on this port.

Select Discard to drop any BPDU received on this port.

Select Network to process a BPDU with no VLAN tag and forward a tagged BPDU.

Media Type You can insert either an SFP+ transceiver or an SFP+ Direct Attach Copper (DAC) cable into the 
10 Gigabit interface of the Switch.

Select the media type (sfp_plus or dac10g) of the SFP+ module that is attached to the 10 
Gigabit interface.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 20   Basic Setting > Port Setup (continued)
LABEL DESCRIPTION
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Use this screen to set IPv4 loopback interfaces for routing protocols or IPv6 interfaces on which you can 
configure an IPv6 address to access and manage the Switch. Click Basic Setting > Interface Setup in the 
navigation panel to display the configuration screen. 

Figure 68   Basic Setting > Interface Setup 

The following table describes the labels in this screen. 

8.7  IPv6
Use this screen to view the IPv6 interface status and configure Switch’s management IPv6 addresses. 
See Appendix C on page 588 for more information about IPv6. 

Table 21   Basic Setting > Interface Setup 
LABEL DESCRIPTION
Interface Type Select the type of interface for which you want to configure. The Switch supports the loopback 

interface type for IPv4 and the VLAN interface type for IPv6 at the time of writing.

Interface ID Specify a unique identification number (from 1 to 4094) for the VLAN interface or a unique 
identification number (from 0 to 7) for the loopback interface.

Note: To have IPv6 function properly, you should configure a static VLAN with the 
same ID number in the Advanced Setup > VLAN screens.

Add Click this to create a new entry.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Index This field displays the index number of an entry. 

Interface Type This field displays the type of interface.

Interface ID This field displays the identification number of the interface.

Interface This field displays the interface’s descriptive name which is generated automatically by the 
Switch. The name is from a combination of the interface type and ID number.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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Click Basic Setting > IPv6 in the navigation panel to display the IPv6 status screen as shown next. 

Figure 69   Basic Setting > IPv6 Status 

The following table describes the labels in this screen. 

8.7.1  IPv6 Interface Status
Use this screen to view a specific IPv6 interface status and detailed information. Click an interface index 
number in the Basic Setting > IPv6 screen. The following screen opens.

Table 22   Basic Setting > IPv6 Status 
LABEL DESCRIPTION
Index This field displays the index number of an IPv6 interface. Click on an index number to view more 

interface details.

Interface This is the name of the IPv6 interface you created.

Active This field displays whether the IPv6 interface is activated or not.
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Figure 70   Basic Setting > IPv6 Interface Status 

The following table describes the labels in this screen. 

Table 23   Basic Setting > IPv6 Interface Status 
LABEL DESCRIPTION
IPv6 Active This field displays whether the IPv6 interface is activated or not.

MTU Size This field displays the Maximum Transmission Unit (MTU) size for IPv6 packets on this interface.

ICMPv6 Rate 
Limit Bucket Size

This field displays the maximum number of ICMPv6 error messages which are allowed to transmit 
in a given time interval. If the bucket is full, subsequent error messages are suppressed.

ICMPv6 Rate 
Limit Error 
Interval

This field displays the time period (in milliseconds) during which ICMPv6 error messages of up to 
the bucket size can be transmitted. 0 means no limit.

Link Local 
Address

This field displays the Switch’s link-local IP address and prefix generated by the interface. It also 
shows whether the IP address is preferred, which means it is a valid address and can be used as 
a sender or receiver address.

Global Unicast 
Address(es)

This field displays the Switch’s global unicast address to identify this interface.

Joined Group 
Address(es)

This field displays the IPv6 multicast addresses of groups the Switch’s interface joins.
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8.7.2  IPv6 Configuration
Use this screen to configure IPv6 settings on the Switch. Click the IPv6 Configuration link in the Basic 
Setting > IPv6 screen. The following screen opens.

ND DAD Active This field displays whether Neighbor Discovery (ND) Duplicate Address Detection (DAD) is 
enabled on the interface.

Number of DAD 
Attempts

This field displays the number of consecutive neighbor solicitations the Switch sends for this 
interface. 

NS-Interval 
(millisecond)

This field displays the time interval (in milliseconds) at which neighbor solicitations are re-sent for 
this interface.

ND Reachable 
Time 
(millisecond)

This field displays how long (in milliseconds) a neighbor is considered reachable for this interface.

DHCPv6 Client 
Active 

This field displays whether the Switch acts as a DHCPv6 client to get an IPv6 address from a 
DHCPv6 server.

Identity 
Association 

An Identity Association (IA) is a collection of addresses assigned to a DHCP client, through which 
the server and client can manage a set of related IP addresses. Each IA must be associated 
with exactly one interface. 

IA Type The IA type is the type of address in the IA. Each IA holds one type of address. IA_NA means an 
identity association for non-temporary addresses and IA_TA is an identity association for 
temporary addresses.

IAID Each IA consists of a unique IAID and associated IP information.

T1 This field displays the DHCPv6 T1 timer. After T1, the Switch sends the DHCPv6 server a Renew 
message.

An IA_NA option contains the T1 and T2 fields, but an IA_TA option does not. The DHCPv6 server 
uses T1 and T2 to control the time at which the client contacts with the server to extend the 
lifetimes on any addresses in the IA_NA before the lifetimes expire. 

T2 This field displays the DHCPv6 T2 timer. If the time T2 is reached and the server does not respond, 
the Switch sends a Rebind message to any available server.

State This field displays the state of the TA. It shows

• Active when the Switch obtains addresses from a DHCpv6 server and the TA is created.
• Renew when the TA’s address lifetime expires and the Switch sends out a Renew message.
• Rebind when the Switch doesn’t receive a response from the original DHCPv6 server and 

sends out a Rebind message to another DHCPv6 server.

SID This field displays the DHCPv6 server’s unique ID.

Address This field displays the Switch’s global address which is assigned by the DHCPv6 server.

Preferred 
Lifetime 

This field displays how long (in seconds) that the global address remains preferred.

Valid 
Lifetime 

This field displays how long (in seconds) that the global address is valid.

DNS This field displays the DNS server address assigned by the DHCPv6 server.

Domain List This field displays the address record when the Switch queries the DNS server to resolve domain 
names.

Restart DHCPv6 
Client 

Click Click Here to send a new DHCP request to the DHCPv6 server and update the IPv6 
address and DNS information for this interface.

Table 23   Basic Setting > IPv6 Interface Status (continued)
LABEL DESCRIPTION
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Figure 71   Basic Setting > IPv6 > IPv6 Configuration 

The following table describes the labels in this screen. 

8.7.3  IPv6 Global Setup
Use this screen to configure the global IPv6 settings. Click the link next to IPv6 Global Setup in the IPv6 
Configuration screen to display the screen as shown next.

Figure 72   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Global Setup 

Table 24   Basic Setting > IPv6 > IPv6 Configuration 
LABEL DESCRIPTION
IPv6 Global Setup Click the link to go to a screen where you can configure the global IPv6 settings on the 

Switch.

IPv6 Interface Setup Click the link to go to a screen where you can enable an IPv6 interface on the Switch.

IPv6 Addressing

IPv6 Link-Local 
Address Setup

Click the link to go to a screen where you can configure the IPv6 link-local address for an 
interface.

IPv6 Global 
Address Setup

Click the link to go to a screen where you can configure the IPv6 global address for an 
interface.

IPv6 Neighbor 
Discovery

IPv6 Neighbor 
Discovery Setup

Click the link to go to a screen where you can configure the IPv6 neighbor discovery 
settings.

IPv6 Router 
Discovery Setup

Click the link to go to a screen where you can configure the IPv6 router discovery settings.

IPv6 Prefix Setup Click the link to go to a screen where you can configure the Switch’s IPv6 prefix list.

IPv6 Neighbor Setup Click the link to go to a screen where you can create a static IPv6 neighbor entry in the 
Switch’s IPv6 neighbor table.

DHCPv6 Client Setup Click the link to go to a screen where you can configure the Switch DHCP settings.
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The following table describes the labels in this screen. 

8.7.4  IPv6 Interface Setup
Use this screen to turn on or off an IPv6 interface and enable stateless autoconfiguration on it. Click the 
link next to IPv6 Interface Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 73   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Interface Setup 

The following table describes the labels in this screen. 

Table 25   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Global Setup 
LABEL DESCRIPTION
IPv6 Hop Limit Specify the maximum number of hops (from 1 to 255) in router advertisements. This is the 

maximum number of hops on which an IPv6 packet is allowed to transmit before it is 
discarded by an IPv6 router, which is similar to the TTL field in IPv4.

ICMPv6 Rate Limit 
Bucket Size

Specify the maximum number of ICMPv6 error messages (from 1 to 200) which are allowed 
to transmit in a given time interval. If the bucket is full, subsequent error messages are 
suppressed.

ICMPv6 Rate Limit 
Error Interval

Specify the time period (from 0 to 2147483647 milliseconds) during which ICMPv6 error 
messages of up to the bucket size can be transmitted. 0 means no limit.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Table 26   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Interface Setup 
LABEL DESCRIPTION
Interface Select the IPv6 interface you want to configure.

Active Select this option to enable the interface.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

Active This field displays whether the IPv6 interface is activated or not.
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8.7.5  IPv6 Link-Local Address Setup
A link-local address uniquely identifies a device on the local network (the LAN). It is similar to a “private IP 
address” in IPv4. You can have the same link-local address on multiple interfaces on a device. A link-
local unicast address has a predefined prefix of fe80::/10. 

Use this screen to configure the interface’s link-local address and default gateway. Click the link next to 
IPv6 Link-Local Address Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 74   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Link-Local Address Setup 

The following table describes the labels in this screen. 

8.7.6  IPv6 Global Address Setup
Use this screen to configure the interface’s IPv6 global address. Click the link next to IPv6 Global Address 
Setup in the IPv6 Configuration screen to display the screen as shown next.

Table 27   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Link-Local Address Setup 
LABEL DESCRIPTION
Interface Select the IPv6 interface you want to configure.

Link-Local Address Manually configure a static IPv6 link-local address for the interface.

Default Gateway Set the default gateway IPv6 address for the interface. When an interface cannot find a 
routing information for a frame’s destination, it forwards the packet to the default 
gateway.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

IPv6 Link-Local 
Address

This is the static IPv6 link-local address for the interface.

IPv6 Default Gateway This is the default gateway IPv6 address for the interface.
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Figure 75   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Global Address Setup 

The following table describes the labels in this screen. 

8.7.7  IPv6 Neighbor Discovery Setup
Use this screen to configure neighbor discovery settings for each interface. Click the link next to IPv6 
Neighbor Discovery Setup in the IPv6 Configuration screen to display the screen as shown next.

Table 28   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Global Address Setup 
LABEL DESCRIPTION
Interface Select the IPv6 interface you want to configure.

IPv6 Global Address Manually configure a static IPv6 global address for the interface.

Prefix Length Specify an IPv6 prefix length that specifies how many most significant bits (start from the 
left) in the address compose the network address.

EUI-64 Select this option to have the interface ID be generated automatically using the EUI-64 
format.

Add Click Add to create a new entry or update an existing one.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

IPv6 Global Address/
Prefix Length

This field displays the IPv6 global address and prefix length for the interface.

EUI-64 This shows whether the interface ID of the global address is generated using the EUI-64 
format.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in 
the table heading row to select all entries. 

Delete Check the entry(ies) that you want to remove and then click Delete to remove the 
selected entry(ies) from the summary table. 

Cancel Click Cancel to clear the check boxes.
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Figure 76   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Neighbor Discovery Setup 

The following table describes the labels in this screen. 

8.7.8  IPv6 Router Discovery Setup
Use this screen to configure router discovery settings for each interface. Click the link next to IPv6 Router 
Discovery Setup in the IPv6 Configuration screen to display the screen as shown next.

Table 29   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Neighbor Discovery Setup 
LABEL DESCRIPTION
Interface Select the IPv6 interface you want to configure.

DAD Attempts The Switch uses Duplicate Address Detection (DAD) with neighbor solicitation and 
advertisement messages to check whether an IPv6 address is already in use before 
assigning it to an interface, such as the link-local address it creates through stateless 
address autoconfiguration.

Specify the number of consecutive neighbor solicitations (from 0 to 600) the Switch sends 
for this interface. Enter 0 to turn off DAD.

NS Interval Specify the time interval (from 1000 to 3600000 milliseconds) at which neighbor solicitations 
are re-sent for this interface.

Reachable Time Specify how long (from 1000 to 3600000 milliseconds) a neighbor is considered reachable 
for this interface.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

DAD Attempts This field displays the number of consecutive neighbor solicitations the Switch sends for this 
interface. 

NS Interval This field displays the time interval (in milliseconds) at which neighbor solicitations are re-
sent for this interface.

Reachable Time This field displays how long (in milliseconds) a neighbor is considered reachable for this 
interface.
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Figure 77   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Router Discovery Setup 

The following table describes the labels in this screen. 

Table 30   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Router Discovery Setup 
LABEL DESCRIPTION
Interface Select the IPv6 interface you want to configure.

Flags Select the Managed Config Flag option to have the Switch set the “managed address 
configuration” flag (the M flag) to 1 in IPv6 router advertisements, which means IPv6 hosts 
use DHCPv6 to obtain IPv6 stateful addresses. Deselect the option to set the flag to 0 and 
the host will not use DHCPv6 to obtain IPv6 stateful addresses.

Select the Other Config Flag option to have the Switch set the “Other stateful 
configuration” flag (the O flag) to 1 in IPv6 router advertisements, which means IPv6 hosts 
use DHCPv6 to obtain additional configuration settings, such as DNS information. Deselect 
the option to set the flag to 0 and the host will not use DHCPv6 to obtain additional 
configuration settings.

Minimum Interval Specify the minimum time interval (from 3 to 1350 seconds) at which the Switch sends 
router advertisements for this interface.

Note: The minimum time interval cannot be greater than three-quarters of the 
maximum time interval.

Maximum Interval Specify the maximum time interval (from 4 to 1800 seconds) at which the Switch sends 
router advertisements for this interface.

Lifetime Specify how long (from 0 to 9000 seconds) the router in router advertisements can be used 
as a default router for this interface.

Suppress Select this option to set the Switch to not send router advertisements and responses to 
router solicitations on this interface.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

Flags This field displays whether IPv6 hosts use DHCPv6 to obtain IPv6 stateful addresses (M) and/
or additional configuration settings (O).
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8.7.9  IPv6 Prefix Setup
Use this screen to configure the Switch’s IPv6 prefix list for each interface. Click the link next to IPv6 Prefix 
Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 78   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Prefix Setup 

The following table describes the labels in this screen. 

Minimum Interval This field displays the minimum time interval at which the Switch sends router 
advertisements for this interface.

Maximum Interval This field displays the maximum time interval at which the Switch sends router 
advertisements for this interface.

Lifetime This field displays how long the router in router advertisements can be used as a default 
router for this interface.

Suppress This field displays whether the Switch sends router advertisements and responses to router 
solicitations on this interface (No) or not (Yes).

Table 30   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Router Discovery Setup (continued)
LABEL DESCRIPTION

Table 31   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Prefix Setup 
LABEL DESCRIPTION
Interface Select the IPv6 interface you want to configure.

Prefix Set the IPv6 prefix that the Switch includes in router advertisements for this interface.

Prefix Length Set the prefix length that the Switch includes in router advertisements for this interface.

Valid Lifetime Specify how long (from 0 to 4294967295 seconds) the prefix is valid for on-link 
determination.

Preferred Lifetime Specify how long (from 0 to 4294967295 seconds) that addresses generated from the prefix 
via stateless address autoconfiguration remain preferred.

The preferred lifetime cannot exceed the valid lifetime.
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8.7.10  IPv6 Neighbor Setup
Use this screen to create a static IPv6 neighbor entry in the Switch’s IPv6 neighbor table to store the 
neighbor information permanently. Click the link next to IPv6 Neighbor Setup in the IPv6 Configuration 
screen to display the screen as shown next.

Figure 79   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Neighbor Setup 

Flags Select No-Autoconfig Flag to not allow IPv6 hosts to use this prefix for stateless address 
autoconfiguration. 

Select No-Onlink Flag to not allow the specified prefix to be used for on-link determination.

Select No-Advertise Flag to set the Switch to not include the specified IPv6 prefix, prefix 
length in router advertisements for this interface.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if 
it is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

Prefix/Prefix Length This field displays the IPv6 prefix and prefix length that the Switch includes in router 
advertisements for this interface.

Valid Lifetime This field displays the IPv6 prefix valid lifetime.

Preferred Lifetime This field displays the preferred lifetime of an IPv6 address generated from the prefix.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in 
the table heading row to select all entries.

Delete Check the entry(ies) that you want to remove and then click Delete to remove the 
selected entry(ies) from the summary table. 

Cancel Click Cancel to clear the check boxes.

Table 31   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Prefix Setup (continued)
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

8.7.11  DHCPv6 Client Setup
Use this screen to configure the Switch’s DHCP settings when it is acting as a DHCPv6 client. Click the link 
next to IPv6 Neighbor Setup in the IPv6 Configuration screen to display the screen as shown next.

Table 32   Basic Setting > IPv6 > IPv6 Configuration > IPv6 Neighbor Setup 
LABEL DESCRIPTION
Interface Type Select the type of IPv6 interface for which you want to configure. The Switch supports the 

VLAN interface type for IPv6 at the time of writing.

Interface ID Specify a unique identification number (from 1 to 4094) for the interface. 

Note: A static IPv6 neighbor entry displays in the Management > IPv6 Neighbor 
Table screen only when the interface ID is also created in the Basic Setup > 
Interface Setup screen.

Note: To have IPv6 function properly, you should configure a static VLAN with 
the same ID number in the Advanced Setup > VLAN screens.

Neighbor Address Specify the IPv6 address of the neighboring device which can be reached through the 
interface.

MAC Specify the MAC address of the neighboring device which can be reached through the 
interface.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if 
it is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

Neighbor Address This field displays the IPv6 address of the neighboring device which can be reached 
through the interface

MAC This field displays the MAC address of the neighboring device which can be reached 
through the interface.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in 
the table heading row to select all entries.

Delete Check the entry(ies) that you want to remove and then click Delete to remove the 
selected entry(ies) from the summary table. 

Cancel Click Cancel to clear the check boxes.
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Figure 80   Basic Setting > IPv6 > IPv6 Configuration > DHCPv6 Client Setup 

The following table describes the labels in this screen. 

Table 33   Basic Setting > IPv6 > IPv6 Configuration > DHCPv6 Client Setup 
LABEL DESCRIPTION
Interface Select the IPv6 interface you want to configure.

IA Type Select IA-NA to set the Switch to get a non-temporary IP address from the DHCPv6 server 
for this interface. 

Optionally, you can also select Rapid-Commit to have the Switch send its DHCPv6 Solicit 
message with a Rapid Commit option to obtain information from the DHCPv6 server by a 
rapid two-message exchange. The Switch discards any Reply messages that do not 
include a Rapid Commit option. The DHCPv6 server should also support the Rapid Commit 
option to have it work well.

Options Select DNS to have the Switch obtain DNS server IPv6 addresses and/or select Domain-List 
to have the Switch obtain a list of domain names from the DHCP server.

Information Refresh 
Minimum

Specify the time interval (from 600 to 4294967295 seconds) at which the Switch exchanges 
other configuration information with a DHCPv6 server again.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPv6 interface you created.

IA-NA This field displays whether the Switch obtains a non-temporary IP address from the DHCPv6 
server.

Rapid-Commit This field displays whether the Switch obtains information from the DHCPv6 server by a 
rapid two-message exchange.

DNS This field displays whether the Switch obtains DNS server IPv6 addresses from the DHCPv6 
server.

Domain-List This field displays whether the Switch obtains a list of domain names from the DHCP server.

Information Refresh 
Minimum

This field displays the time interval (in seconds) at which the Switch exchanges other 
configuration information with a DHCPv6 server again.
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8.8  Loopback Interface
The loopback interface is a virtual interface which can be assigned an IP address and used by routing 
protocols. The loopback interface does not need to be connected to any devices and will always be 
available if the Switch is functioning normally and connected to a network. You can enable multiple 
loopback interfaces on the Switch, and each loopback interface must be uniquely identified. 

The Switch can use a loopback interface address as the source address of all packets that originate 
from the Switch. Filters can then be applied to the loopback address to protect the system.

Click the link next to IPv4 Loopback Interface in the Basic Setting > Loopback Interface screen. The 
following screen opens.

Figure 81   Basic Setting > Loopback Interface 

8.8.1  IPv4 Loopback Interface 
Use this screen to configure IPv4 loopback interfaces on the Switch. 

Figure 82   Basic Setting > Loopback Interface > IPv4 Loopback Interface 

The following table describes the labels in this screen. 

Table 34   Basic Setting > Loopback Interface > IPv4 Loopback Interface 
LABEL DESCRIPTION
Loopback 
Interface ID

Select the ID of loopback interface you want to configure.

Active Select this option to enable the interface.

Name Enter a descriptive name for the IPv4 loopback interface for identification purposes. This name 
consists of up to 64 printable characters; spaces are allowed.

IP Address Enter the IP address of your Switch in dotted decimal notation, for example, 192.168.1.1. This is 
the IP address of the Switch in an IP routing domain.



Chapter 8 Basic Setting

XGS4600 Series User’s Guide

105

8.9  Stacking
Stacking is directly connecting Switches to form a larger system that behaves as a single Switch or a 
virtual chassis with increased port density.

Figure 83   Switch Stacking Concept

The last two SFP ports of your Switch are dedicated for Switch stacking. These are the Switches that 
support stacking at the time of writing. 

Note: Up to 4 Switches per stack are allowed.

You can manage each Switch in the stack from a master Switch using its web configurator or console. 
Each Switch supports up to two stacking channels. Use the master Switch to assign a ‘slot ID’ for each 
‘linecard’ non-master Switch. ‘Slot’ refers to a Switch in the ‘virtual chassis’ stack.

IP Subnet Mask Enter the IP subnet mask of an IP routing domain in dotted decimal notation, for example, 
255.255.255.0.

Add Click this to create a new entry.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to the factory defaults.

Clear Click Clear to begin configuring this screen afresh.

ID This field displays the identification number of the interface.

Active This field displays whether the IPv4 loopback interface is activated or not.

Name This field displays the descriptive name for this IPv4 loopback interface.

IP Address This field displays IP address of the Switch in the IP domain.

IP Subnet Mask This field displays the subnet mask of the Switch in the IP domain.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 34   Basic Setting > Loopback Interface > IPv4 Loopback Interface (continued)
LABEL DESCRIPTION

Table 35   Switch Stacking
MODELS WITH STACKING SUPPORT
XGS4600-32

XGS4600-32F

XGS4600-52F
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The advantages of stacking are:

• High port density - for example, two 24-port Switches can become one 48-port logical Switch

• Centralized management - log into a single IP address of the master switch to control all Switches in 
the stacking system using the web configurator, CLI, SNMP or FTP

• Redundancy - Data redundancy allows traffic to be forwarded even if one Switch in the stack fails. 
Management redundancy lets you still manage the stack even if one Switch in the stack fails

• Modularity and hot-swappable - you can add, remove, or replace Switches to increase or decrease 
the stack with minimum disruption to ongoing network traffic.

You can build a Switch stack using a ring or chain topology. In a ring topology, the last Switch is 
connected to the first.

Figure 84   Stacking Topology

8.9.1  Stacking Status
Click Basic Setting > Stacking in the navigation panel to display the Stacking Status screen as shown 
next.

Figure 85   Basic Setting > Stacking Status 

The following table describes the labels in this screen. 

Table 36   Basic Setting > Stacking > Stacking Status 
LABEL DESCRIPTION
Slot ‘Slot’ refers to a Switch in the ‘virtual chassis’ stack. This field displays the slot ID of the stacked 

Switch. You can click the ID number to go to the Stacking Slot Status screen.

Name This field displays the model name of the stacked Switch.
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8.9.2  Stacking Slot 
Click Basic Setting > Stacking > Stacking Status > Slot number in the navigation panel to display the 
Stacking Slot Status screen as shown next.

Figure 86   Basic Setting > Stacking > Stacking Status > Slot number

The following table describes the labels in this screen. 

Status This field displays whether the stacked Switch is active or inactive in a stack system. 

Init means the slot ID is being initialized by the master Switch.

active* means the Switch is in the stack, but some items failed to initiate. See the system logs for 
details. If the Switch is not a master, disconnect and reconnect the stacking port and wait. 
Restart the Switch if it still displays active*. If the Switch is a master, restart it or choose another 
master.

MAC address This field displays the MAC address of the stacked Switch.
Role This field displays whether the Switch is a master, backup or linecard. There’s only one master 

and one backup Switch in the stacking mode; all others are linecard Switches.

Stacking Topology: Ring/Chain

Slot No. This field displays the slot ID number of the stacked Switch.

Stacking Channel1

Neighbor This field displays the neighbor Switch that is connected using slot channel 1 of the Switch. 

Speed This field displays the Ethernet speed of stacking channel 1 of the Switch.

Stacking Channel2

Neighbor This field displays the neighbor Switch that is connected to slot channel 2 of the Switch. 

Speed This field displays the Ethernet speed of stacking channel 2 of the Switch.

Table 36   Basic Setting > Stacking > Stacking Status (continued)
LABEL DESCRIPTION

Table 37   Basic Setting > Stacking > Stacking Status > Slot number 
LABEL DESCRIPTION
Slot This field displays the slot ID of the Switch.

Stacking This field displays whether the Switch is active in the stacking system.

Role This field displays whether the stacked Switch is a master or linecard Switch.
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8.9.3  Stacking Configuration
A supported Switch can change between stacking and standalone mode by selecting the Active 
check box in the Basic Setting > Stacking > Configuration screen. 

Note: When you change modes, all configurations except user accounts, but including 
running configuration, config01 and config02 will be erased and the Switch will reboot 
with a new config01. Therefore, you should back up previous configurations if you want 
to reload them later.

Note: When the Switch is in stacking mode, it uses the default static IP address 192.168.1.1.

Stacking will automatically choose a master Switch in a stack but you can overwrite that by actively 
forcing a Switch to become a master Switch. In the Stacking Configuration screen, click Force Master 
Mode to choose the master Switch. This master Switch will have the highest priority over all other stacked 
Switches even when they have same priority value.

If two or more Switches have Force Master Mode enabled, then the Switch will use System Priority to 
determine which is master. If they have the same System Priority, then the Switch with the longest up-
time is selected. Uptime is measured in increments of 10 minutes. The Switch with the higher number of 

Force Master 
Mode

This field displays whether the Force Master Mode is enabled or disabled on this Switch. The 
Active Force Master Mode forces this Switch to become a master Switch. This Switch will have 
the highest priority over all other Switch in the stack. If two Switches are set as masters, they will 
have the same priority level, but the Switch that has the longest active run-time will be selected 
as the master Switch automatically.

Priority This field displays the priority level of the Switch. A higher number represents higher priority.

Slot ID After 
Reboot

This field displays the slot ID of the Switch after a reboot. You can save the slot ID of the Switch 
after a reboot by clicking Freeze in the Stacking Configuration screen. See Section 8.9.3 on 
page 108.

Stacking Status This field displays whether the stacked Switch is active or inactive in a stack system. 

Init means the slot ID is being initialized by the master Switch.

active* means the Switch is in the stack, but some items failed to initiate. See the system logs for 
details. If the Switch is not a master, disconnect and reconnect the stacking port and wait. 
Restart the Switch if it still displays active*. If the Switch is a master, restart it or choose another 
master.

Master Capable This field displays whether the Switch has capacity to become a master Switch. Auto means the 
stack system master election process will determine if the Switch can be assigned as a master 
Switch.

Stacking MAC 
Address

This field displays the stacking Switch MAC address.

Stacking 
Channel 1

This field displays the status of the port stacking channel 1 of the Switch. It will display up for 
active or down for inactive.

Stacking 
Channel 2

This field displays the status of the port stacking channel 2 of the Switch. It will display up for 
active or down for inactive.

Stacking Up 
Time

This field displays the time that the active Switch in a stack has been running.

ZyNOS version 
*Running/Flash

This field displays the ZyNOS firmware that is currently running on the Switch.

Table 37   Basic Setting > Stacking > Stacking Status > Slot number (continued)
LABEL DESCRIPTION
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increments is selected. If they have the same uptime, then the Switch with the lowest MAC address will 
be the master.

This is the master election priority in a stack system:

1 Active Force Master Mode

2 Highest Stacking Priority

3 Longest System Up Time 

4 Lowest MAC Address

Note: Master election occurs when a stacking port link status changes (up / down). The link 
status changes when (for example):

- a stacking port cable is disconnected

- a Switch in the stack reboots (as happens after you change stacking mode to 
standalone)

- you add a Switch to the stack or 

- a Switch in the stack shuts down.

Use the following procedure to create a stack:

1 Select a Switch to be the master. Change its mode to stacking mode. You will see a message asking you 
to confirm the change. Click OK to confirm and the Switch will reboot automatically using a new 
config01 and the default static IP address 192.168.1.1. 

2 After reboot completes, the master LED will turn on.

3 Configure the Switch stacking priority to a high value, such as 63.

4 Change a second Switch to stacking mode and wait for it to finish rebooting automatically. This master 
LED will also turn on.

5 Connect the two Switches using the stacking ports for the Switch defined.

6 The second Switch master LED will then turn off, and its Sys LED will blink while it's initializing. Please wait 
until it stops blinking, indicating that it has joined the stack. 

7 Repeat steps 4 to 6 to connect other Switches to the stack.
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When the Switch is in Stacking mode, the web configurator will change port and VLAN port settings to 
support the stacking mode. See Section 8.5 on page 87 and Section 9.7 on page 117 for details on the 
port settings.

Click Basic Setting > Stacking > Configuration to see the following screen.

Figure 87   Basic Setting > Stacking > Configuration

The following table describes the labels in this screen. 

Table 38   Basic Setting > Stacking > Configuration 
LABEL DESCRIPTION
Active Select the Active check box to put the Switch in stacking mode. This will erase the running 

configuration, config01 and config02. The master Switch’s login will remain unchanged. If you 
want to reload a previous configuration, please back one up first.

Apply Click Apply to activate the stacking mode.

Cancel Click Cancel to clear the Active check box. 

Force Master 
Mode

Select the Force Master Mode check box to force this Switch to become a master Switch.

System Priority Enter a number (from1 to 63) to assign a priority for the stacking Switch. The higher the number, 
the higher the priority.

Apply Click Apply to save the Active Force Master Mode and System Priority fields.

Cancel Click Cancel to clear the Active Force Master Mode and System Priority fields.

Slot ID Freeze Click the Freeze button to have the Switch retain its slot ID after reboot.

Slot This field displays the slot or port channel of the stacked Switch.

MAC Address This field displays the MAC address of the stacked Switch.

Type This field displays the model name of the Switch.

Slot ID After 
Reboot

Choose Auto to have a new slot ID assigned after reboot. If you want to keep the original slot ID 
after reboot, you can click Freeze or select an ID in the Slot ID After Reboot list box.

Apply Click Apply to save the Slot ID After reboot field.

Cancel Click Cancel to clear the Slot ID After reboot field.
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8.10  DNS
DNS (Domain Name System) is for mapping a domain name to its corresponding IP address and vice 
versa. Use the DNS screen to configure and view the default DNS servers on the Switch.

Figure 88   Basic Setting > DNS

The following table describes the labels in this screen. 

Table 39   Basic Setting > DNS 
LABEL DESCRIPTION
Static Domain Name Server

Preference This is the priority of the DNS server address.

Server Address Enter a domain name server IPv6/IPv4 address in order to be able to use a domain name 
instead of an IP address.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Domain Name Server Table

Index This field displays priority of the DNS server address.

Server Address This field displays the IP address of the DNS server.

Source This field displays whether the DNS server address is configured manually (Static) or 
obtained automatically using DHCPv4/DHCPv6 (Dynamic).
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CHAPTER 9
VLAN

The type of screen you see here depends on the VLAN Type you selected in the Switch Setup screen 
which is only available in standalone mode. The Switch does not support port-based VLANs in stacking 
mode. This chapter shows you how to configure 802.1Q tagged and port-based VLANs.

9.1  Introduction to IEEE 802.1Q Tagged VLANs     
A tagged VLAN uses an explicit tag (VLAN ID) in the MAC header to identify the VLAN membership of a 
frame across bridges - they are not confined to the switch on which they were created. The VLANs can 
be created statically by hand or dynamically through GVRP. The VLAN ID associates a frame with a 
specific VLAN and provides the information that switches need to process the frame across the network. 
A tagged frame is four bytes longer than an untagged frame and contains two bytes for the TPID (Tag 
Protocol Identifier, residing within the type/length field of the Ethernet frame) and two bytes for the TCI 
(Tag Control Information, starting after the source address field of the Ethernet frame). 

The CFI (Canonical Format Indicator) is a single-bit flag, always set to zero for Ethernet switches. If a 
frame received at an Ethernet port has a CFI set to 1, then that frame should not be forwarded as it is to 
an untagged port. The remaining twelve bits define the VLAN ID, giving a possible maximum number of 
4,096 VLANs. Note that user priority and VLAN ID are independent of each other. A frame with VID 
(VLAN Identifier) of null (0) is called a priority frame, meaning that only the priority level is significant and 
the default VID of the ingress port is given as the VID of the frame. Of the 4096 possible VIDs, a VID of 0 is 
used to identify priority frames and the value 4095 (FFF) is reserved, so the maximum possible number of 
VLAN configurations is 4,094. 

9.1.1  Forwarding Tagged and Untagged Frames 
Each port on the Switch is capable of passing tagged or untagged frames. To forward a frame from an 
802.1Q VLAN-aware switch to an 802.1Q VLAN-unaware switch, the Switch first decides where to 
forward the frame and then strips off the VLAN tag. To forward a frame from an 802.1Q VLAN-unaware 
switch to an 802.1Q VLAN-aware switch, the Switch first decides where to forward the frame, and then 
inserts a VLAN tag reflecting the ingress port's default VID. The default PVID is VLAN 1 for all ports, but this 
can be changed.

A broadcast frame (or a multicast frame for a multicast group that is known by the system) is duplicated 
only on ports that are members of the VID (except the ingress port itself), thus confining the broadcast to 
a specific domain. 

TPID 

2 Bytes

User Priority 

3 Bits

CFI

1 Bit

VLAN ID

12 bits
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9.2  Automatic VLAN Registration 
GARP and GVRP are the protocols used to automatically register VLAN membership across switches. 

9.2.1  GARP 
GARP (Generic Attribute Registration Protocol) allows network switches to register and de-register 
attribute values with other GARP participants within a bridged LAN. GARP is a protocol that provides a 
generic mechanism for protocols that serve a more specific application, for example, GVRP. 

9.2.1.1  GARP Timers 
Switches join VLANs by making a declaration. A declaration is made by issuing a Join message using 
GARP. Declarations are withdrawn by issuing a Leave message. A Leave All message terminates all 
registrations. GARP timers set declaration timeout values.

9.2.2  GVRP
GVRP (GARP VLAN Registration Protocol) is a registration protocol that defines a way for switches to 
register necessary VLAN members on ports across the network. Enable this function to permit VLAN 
groups beyond the local Switch.

Please refer to the following table for common IEEE 802.1Q VLAN terminology.

Table 40   IEEE 802.1Q VLAN Terminology 
VLAN PARAMETER TERM DESCRIPTION
VLAN Type Permanent VLAN This is a static VLAN created manually.

Dynamic VLAN This is a VLAN configured by a GVRP registration/deregistration 
process.

VLAN Administrative 
Control 

Registration Fixed Fixed registration ports are permanent VLAN members.

Registration Forbidden Ports with registration forbidden are forbidden to join the 
specified VLAN.

Normal Registration Ports dynamically join a VLAN using GVRP.

VLAN Tag Control Tagged Ports belonging to the specified VLAN tag all outgoing frames 
transmitted.

Untagged Ports belonging to the specified VLAN don't tag all outgoing 
frames transmitted.

VLAN Port Port VID This is the VLAN ID assigned to untagged frames that this port 
received.

Acceptable Frame 
Type 

You may choose to accept both tagged and untagged 
incoming frames, just tagged incoming frames or just untagged 
incoming frames on a port.

Ingress filtering If set, the Switch discards incoming frames for VLANs that do not 
have this port as a member.
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9.3  Port VLAN Trunking 
Enable VLAN Trunking on a port to allow frames belonging to unknown VLAN groups to pass through 
that port. This is useful if you want to set up VLAN groups on end devices without having to configure the 
same VLAN groups on intermediary devices.

The following figure describes VLAN Trunking. Suppose you want to create VLAN groups 1 and 2 (V1 and 
V2) on devices A and B. Without VLAN Trunking, you must configure VLAN groups 1 and 2 on all 
intermediary switches C, D and E; otherwise they will drop frames with unknown VLAN group tags. 
However, with VLAN Trunking enabled on a port(s) in each intermediary switch you only need to create 
VLAN groups in the end devices (A and B). C, D and E automatically allow frames with VLAN group tags 
1 and 2 (VLAN groups that are unknown to those switches) to pass through their VLAN trunking port(s).

Figure 89   Port VLAN Trunking 

9.4  Select the VLAN Type 
Select a VLAN type in the Basic Setting > Switch Setup screen. VLAN Type is not applicable in Stacking 
mode.

Figure 90   Switch Setup: Select VLAN Type 

9.5  802.1Q Static VLAN
Make sure 802.1Q is selected in the Basic Setting > Switch Setup screen. 

Use a static VLAN to decide whether an incoming frame on a port should be

• sent to a VLAN group as normal depending on its VLAN tag. 

• sent to a group whether it has a VLAN tag or not. 

• blocked from a VLAN group regardless of its VLAN tag. 

You can also tag all outgoing frames (that were previously untagged) from a port with the specified 
VID. 
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9.5.1  VLAN Status 
See Section 9.1 on page 112 for more information on 802.1Q VLAN. Click Advanced Application > VLAN 
from the navigation panel to display the VLAN Status screen as shown next. 

Figure 91   Advanced Application > VLAN: VLAN Status 

The following table describes the labels in this screen. 

Table 41   Advanced Application > VLAN: VLAN Status 
LABEL DESCRIPTION
VLAN Search by 
VID

Enter an existing VLAN ID number(s) (separated by a comma) and click Search to display only 
the specified VLAN(s) in the list below.

Leave this field blank and click Search to display all VLANs configured on the Switch.

The Number of 
VLAN

This is the number of VLANs that match the searching criteria and display in the list below.

This field displays only when you use the Search button to look for certain VLANs.

Index This is the VLAN index number. Click on an index number to view more VLAN details.

VID This is the VLAN identification number that was configured in the Static VLAN screen.

Name This fields shows the descriptive name of the VLAN.

Tagged Port This field shows the tagged ports that are participating in the VLAN.

Untagged Port This field shows the untagged ports that are participating in the VLAN.

Elapsed Time This field shows how long it has been since a normal VLAN was registered or a static VLAN was 
set up.

Status This field shows how this VLAN was added to the Switch.

• Dynamic - using GVRP
• Static - manually added as a normal VLAN
• Private - manually added as a private VLAN (primary, isolated or community)
• Voice - manually added as a Voice VLAN
• RMirror - manually added as a remote port mirroring VLAN
• MVR - added via Multicast VLAN Registration (MVR)

Change Pages Click Previous or Next to show the previous/next screen if all status information cannot be seen 
in one screen.
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9.5.2  VLAN Details
Use this screen to view detailed port settings and status of the VLAN group. See Section 9.1 on page 112 
for more information on 802.1Q VLAN. Click on an index number in the VLAN Status screen to display 
VLAN details.

Figure 92   Advanced Application > VLAN > VLAN Detail

The following table describes the labels in this screen. 

Table 42   Advanced Application > VLAN > VLAN Detail 
LABEL DESCRIPTION
VLAN Status Click this to go to the VLAN Status screen.

VID This is the VLAN identification number that was configured in the Static VLAN screen.

Slot ‘Slot’ refers to a Switch in the ‘virtual chassis’ stack. This field displays the slot ID of the stacked 
Switch. 

Port Number This column displays the ports that are participating in a VLAN. A tagged port is marked as T, an 
untagged port is marked as U and ports not participating in a VLAN are marked as “–“. 

Elapsed Time This field shows how long it has been since a normal VLAN was registered or a static VLAN was 
set up.

Status This field shows how this VLAN was added to the Switch.

• Dynamic - using GVRP
• Static - manually added as a normal VLAN
• Private - manually added as a private VLAN (primary, isolated or community)
• Voice - manually added as a Voice VLAN
• RMirror - manually added as a remote port mirroring VLAN
• MVR - added via Multicast VLAN Registration (MVR)

Private VLAN 
Status

These fields show private VLAN information for the selected VLAN. See Section 35.1 on page 
348 for more information on private VLANs.

Primary VLAN This field shows the primary VLAN ID in the selected VLAN.

Secondary 
VLAN

This field shows the secondary VLAN ID in the selected VLAN.

Type This field shows the type of private VLAN: Primary, Community or Isolated.

Port List This shows the ports mapped to the private VLAN using the Advanced Application > Private 
VLAN or Advanced Application > VLAN > Static VLAN screen.

Change Pages Click Previous or Next to show the previous/next screen if all status information cannot be seen 
in one screen.
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9.6  Private VLAN Status  
Use this screen to view all private VLANs created on the Switch. Click Advanced Application > VLAN > 
Private VLAN Status to see the following screen.

Figure 93   Advanced Application > VLAN > Private VLAN Status

The following table describes the labels in this screen. 

9.7  VLAN Configuration  
Use this screen to view IEEE 802.1Q VLAN parameters for the Switch. Click Advanced Application > VLAN 
> VLAN Configuration to see the following screen.

Figure 94   Advanced Application > VLAN > VLAN Configuration

Table 43   Advanced Application > VLAN > Private VLAN Status 
LABEL DESCRIPTION
Private VLAN 
Status

These fields show information for the all private VLANs. See also Advanced Application > Private 
VLAN.

Primary 
VLAN

This field shows the primary VLAN ID in a private VLAN.

Secondary 
VLAN

This field shows the secondary VLAN ID in a private VLAN.

Type This field shows the type of private VLAN: Primary, Community or Isolated.

Port List This shows the ports mapped to the private VLAN using the Advanced Application > Private 
VLAN or Advanced Application > VLAN > Static VLAN screen.

Change Pages Use the Previous and Next buttons to display different pages.
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The following table describes the labels in the above screen. 

9.7.1  Configure a Static VLAN     
Use this screen to configure a static VLAN for the Switch. Click the Static VLAN Setup link in the VLAN 
Configuration screen to display the screen as shown next. 

Table 44   Advanced Application > VLAN > VLAN Configuration
LABEL DESCRIPTION
Static VLAN Setup Click Click Here to configure the Static VLAN for the Switch.

VLAN Port Setup Click Click Here to configure the VLAN Port for the Switch.

Subnet Based VLAN Setup Click Click Here to configure the Subnet Based VLAN for the Switch.

Protocol Based VLAN Setup Click Click Here to configure the Protocol Based VLAN for the Switch.

Voice VLAN Setup Click Click Here to configure the Voice VLAN for the Switch.

MAC Based VLAN Setup Click Click Here to configure the MAC Based VLAN for the Switch.
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Figure 95   Advanced Application > VLAN > VLAN Configuration > Static VLAN Setup  

The following table describes the related labels in this screen.   

Table 45   Advanced Application > VLAN > VLAN Configuration > Static VLAN Setup 
LABEL DESCRIPTION
ACTIVE Select this check box to activate the VLAN settings.  

Name Enter a descriptive name for the VLAN group for identification purposes. This name consists of 
up to 64 printable characters; spaces are allowed.

VLAN Group ID Enter the VLAN ID for this static entry; the valid range is between 1 and 4094.

VLAN Type Select Normal (static) or Private. For Private VLANs, select Primary, Isolated or Community.
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9.7.2  Configure VLAN Port Settings    
Use the VLAN Port Setting screen to configure the static VLAN (IEEE 802.1Q) settings on a port. See 
Section 9.1 on page 112 for more information on 802.1Q VLAN. Click the VLAN Port Setup link in the VLAN 
Configuration screen.

Association VLAN 
List

Primary private VLANs can associate with several (secondary) Community private VLANs and 
up to one (secondary) Isolated private VLAN. 

You only configure VLAN Association List for Primary private VLANs. Use a dash to associate 
consecutive VLANs and a comma (no spaces) to associate non-consecutive VLANs. For 
example, 51-53 includes 51, 52 and 53, but 51,53 does not include 52.

Secondary private VLANs can only be associated with one primary private VLAN.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port The port number identifies the port you are configuring. In stacking mode, the first number 
represents the slot and the second the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Control Select Normal for the port to dynamically join this VLAN group using GVRP. This is the default 

selection.

Select Fixed for the port to be a permanent member of this VLAN group.

Select Forbidden if you want to prohibit the port from joining this VLAN group.

Tagging Select TX Tagging if you want the port to tag all outgoing frames transmitted with this VLAN 
Group ID.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

VID This field displays the ID number of the VLAN group. Click the number to edit the VLAN settings. 

Active This field indicates whether the VLAN settings are enabled (Yes) or disabled (No). 

Name This field displays the descriptive name for this VLAN group. 

VLAN Type This field displays the Normal or Private (Primary, Isolated or Community) type VLAN configured 
in the top part of this screen.

Association VLAN 
List

This field displays which secondary private VLANs are associated with a primary private VLAN 
configured in the top part of this screen.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table. 

Cancel Click Cancel to clear the Delete check boxes.

Table 45   Advanced Application > VLAN > VLAN Configuration > Static VLAN Setup (continued)
LABEL DESCRIPTION
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Figure 96   Advanced Application > VLAN > VLAN Configuration > VLAN Port Setup (Standalone mode) 

Figure 97   Advanced Application > VLAN > VLAN Configuration > VLAN Port Setup (Stacking mode) 
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The following table describes the labels in this screen.  

9.7.3  Subnet Based VLANs 
Subnet based VLANs allow you to group traffic into logical VLANs based on the source IP subnet you 
specify. When a frame is received on a port, the Switch checks if a tag is added already and the IP 
subnet it came from. The untagged packets from the same IP subnet are then placed in the same 

Table 46   Advanced Application > VLAN > VLAN Configuration > VLAN Port Setup: Standalone/Stacking 
mode 
LABEL DESCRIPTION
GVRP GVRP (GARP VLAN Registration Protocol) is a registration protocol that defines a way for 

switches to register necessary VLAN members on ports across the network. 

Select this check box to permit VLAN groups beyond the local Switch.

SLOT1 This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch.

Port This field displays the port number of the Switch. In stacking mode, the first number 
represents the slot and the second the port number. Please note that the default stacking 
ports (the last two ports of your Switch) cannot be configured. They are reserved for stacking 
only.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to 
set the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Ingress Check If this check box is selected for a port, the Switch discards incoming frames for VLANs that do 

not include this port in its member set.

Clear this check box to disable ingress filtering. 

PVID A PVID (Port VLAN ID) is a tag that adds to incoming untagged frames received on a port so 
that the frames are forwarded to the VLAN group that the tag defines.

Enter a number between 1 and 4094 as the port VLAN ID.

GVRP Select this check box to allow GVRP on this port. 

Acceptable Frame 
Type 

Specify the type of frames allowed on a port. Choices are All, Tag Only and Untag Only.

Select All from the drop-down list box to accept all untagged or tagged frames on this port. 
This is the default setting. 

Select Tag Only to accept only tagged frames on this port. All untagged frames will be 
dropped.

Select Untag Only to accept only untagged frames on this port. All tagged frames will be 
dropped. Note that when the Switch is in stacking mode and the master Switch has VLAN1, 
all other ports will be configured to untagged port.

VLAN Trunking Enable VLAN Trunking on ports connected to other switches or routers (but not ports directly 
connected to end users) to allow frames belonging to unknown VLAN groups to pass 
through the Switch.

Isolation Select this to allows this port to communicate only with the CPU management port and the 
ports on which the isolation feature is not enabled.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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subnet based VLAN. One advantage of using subnet based VLANs is that priority can be assigned to 
traffic from the same IP subnet.

Note: Subnet based VLAN applies to un-tagged packets and is applicable only when you use 
IEEE 802.1Q tagged VLAN.

For example, an ISP (Internet Service Provider) may divide different types of services it provides to 
customers into different IP subnets. Traffic for voice services is designated for IP subnet 172.16.1.0/24, 
video for 192.168.1.0/24 and data for 10.1.1.0/24. The Switch can then be configured to group incoming 
traffic based on the source IP subnet of incoming frames.

You can then configure a subnet based VLAN with priority 6 and VID of 100 for traffic received from IP 
subnet 172.16.1.0/24 (voice services). You can also have a subnet based VLAN with priority 5 and VID of 
200 for traffic received from IP subnet 192.168.1.0/24 (video services). Lastly, you can configure VLAN 
with priority 3 and VID of 300 for traffic received from IP subnet 10.1.1.0/24 (data services). All untagged 
incoming frames will be classified based on their source IP subnet and prioritized accordingly. That is, 
video services receive the highest priority and data the lowest. 

Figure 98   Subnet Based VLAN Application Example 

9.7.3.1  Configuring Subnet Based VLAN     
Click the Subnet Based VLAN Setup link in the VLAN Configuration screen to display the configuration 
screen as shown.
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Figure 99   Advanced Application > VLAN > VLAN Configuration > Subnet Based VLAN Setup 

The following table describes the labels in this screen. 

Table 47   Advanced Application > VLAN > VLAN Configuration > Subnet Based VLAN Setup 
LABEL DESCRIPTION
Active Select this check box to activate this subnet based VLANs on the Switch.

DHCP-Vlan 
Override

When DHCP snooping is enabled DHCP clients can renew their IP address through the DHCP 
VLAN or via another DHCP server on the subnet based VLAN.

Select this checkbox to force the DHCP clients in this IP subnet to obtain their IP addresses 
through the DHCP VLAN. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Active Select this check box to activate the IP subnet VLAN you are creating or editing.

Name Enter up to 32 alphanumeric characters to identify this subnet based VLAN.

IP Enter the IP address of the subnet for which you want to configure this subnet based VLAN.

Mask-Bits Enter the bit number of the subnet mask. To find the bit number, convert the subnet mask to 
binary format and add all the 1’s together. Take “255.255.255.0” for example. 255 converts to 
eight 1s in binary. There are three 255s, so add three eights together and you get the bit number 
(24). 

VID Enter the ID of a VLAN with which the untagged frames from the IP subnet specified in this 
subnet based VLAN are tagged. This must be an existing VLAN which you defined in the 
Advanced Application > VLAN > Static VLAN screen.

Priority Select the priority level that the Switch assigns to frames belonging to this VLAN.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Index This is the index number identifying this subnet based VLAN. Click on any of these numbers to 
edit an existing subnet based VLAN.

Active This field shows whether the subnet based VLAN is active or not.
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9.7.4  Protocol Based VLANs 
Protocol based VLANs allow you to group traffic into logical VLANs based on the protocol you specify. 
When an upstream frame is received on a port (configured for a protocol based VLAN), the Switch 
checks if a tag is added already and its protocol. The untagged packets of the same protocol are then 
placed in the same protocol based VLAN. One advantage of using protocol based VLANs is that priority 
can be assigned to traffic of the same protocol.

Note: Protocol based VLAN applies to un-tagged packets and is applicable only when you 
use IEEE 802.1Q tagged VLAN.

For example, ports 1, 2, 3 and 4 belong to static VLAN 100, and ports 4, 5, 6, 7 belong to static VLAN 120. 
You can configure a protocol based VLAN A with priority 2 for ARP traffic received on port 1, 2 and 3. 
You can also have a protocol based VLAN B with priority 3 for Apple Talk traffic received on port 6 and 
7. All upstream ARP traffic from port 1, 2 and 3 will be grouped together, and all upstream Apple Talk 
traffic from port 6 and 7 will be in another group and have higher priority than ARP traffic when they go 
through the uplink port to a backbone switch C.

Figure 100   Protocol Based VLAN Application Example 

9.7.4.1  Configuring Protocol Based VLAN     
Click the Protocol Based VLAN Setup link in the VLAN Configuration screen to display the configuration 
screen as shown. 

Name This field shows the name the subnet based VLAN.

IP This field shows the IP address of the subnet for this subnet based VLAN. 

Mask-Bits This field shows the subnet mask in bit number format for this subnet based VLAN. 

VID This field shows the VLAN ID of the frames which belong to this subnet based VLAN.

Priority This field shows the priority which is assigned to frames belonging to this subnet based VLAN.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click this to delete the subnet based VLANs which you marked for deletion. 

Cancel Click Cancel to clear the check boxes.

Table 47   Advanced Application > VLAN > VLAN Configuration > Subnet Based VLAN Setup (continued)
LABEL DESCRIPTION
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Figure 101   Advanced Application > VLAN > VLAN Configuration > Protocol Based VLAN Setup

The following table describes the labels in this screen. 

Table 48   Advanced Application > VLAN > VLAN Configuration > Protocol Based VLAN Setup 
LABEL DESCRIPTION
Active Select this check box to activate this protocol based VLAN.

Port Type a port number to be included in this protocol based VLAN. In stacking mode, the first box 
field is the slot ID and the second field is the port number.

This port must belong to a static VLAN in order to participate in a protocol based VLAN. See 
Chapter 9 on page 112 for more details on setting up VLANs.

Name Enter up to 32 alphanumeric characters to identify this protocol based VLAN.

Ethernet-type Use the drop down list box to select a predefined protocol to be included in this protocol based 
VLAN or select Others and type the protocol number in hexadecimal notation. For example, the 
IP protocol in hexadecimal notation is 0800, and Novell IPX protocol is 8137.

Note: Protocols in the hexadecimal number range of 0x0000 to 0x05ff are not allowed 
to be used for protocol based VLANs.

VID Enter the ID of a VLAN to which the port belongs. This must be an existing VLAN which you 
defined in the Advanced Application > VLAN > Static VLAN screen.

Priority Select the priority level that the Switch will assign to frames belonging to this VLAN.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Index This is the index number identifying this protocol based VLAN. Click on any of these numbers to 
edit an existing protocol based VLAN.

Active This field shows whether the protocol based VLAN is active or not.

Port This field shows which port belongs to this protocol based VLAN. In stacking mode, the first 
number represents the slot and the second the port number.

Name This field shows the name the protocol based VLAN.

Ethernet-type This field shows which Ethernet protocol is part of this protocol based VLAN. 

VID This field shows the VLAN ID of the port.



Chapter 9 VLAN

XGS4600 Series User’s Guide

127

9.7.4.2  Create an IP-based VLAN Example
This example shows you how to create an IP VLAN which includes ports 1, 4 and 8. Follow these steps 
using the screen below:

1 Activate this protocol based VLAN.

2 Type the port number you want to include in this protocol based VLAN. Type 1.

3 Give this protocol-based VLAN a descriptive name. Type IP-VLAN.

4 Select the protocol. Leave the default value IP.

5 Type the VLAN ID of an existing VLAN. In our example we already created a static VLAN with an ID of 5. 
Type 5. 

6 Leave the priority set to 0 and click Add. 

Figure 102   Protocol Based VLAN Configuration Example 

To add more ports to this protocol based VLAN.

1 Click the index number of the protocol based VLAN entry. Click 1

2 Change the value in the Port field to the next port you want to add. 

3 Click Add. 

Priority This field shows the priority which is assigned to frames belonging to this protocol based VLAN.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click this to delete the protocol based VLANs which you marked for deletion. 

Cancel Click Cancel to clear the check boxes.

Table 48   Advanced Application > VLAN > VLAN Configuration > Protocol Based VLAN Setup 
LABEL DESCRIPTION

example
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9.8  Voice VLAN 
Voice VLAN ensures that the sound quality of an IP phone is preserved from deteriorating when the data 
traffic on the Switch ports is high. It groups the voice traffic with defined priority into an assigned VLAN 
which enables the separation of voice and data traffic coming onto the Switch port.

You can set priority level to the Voice VLAN and add MAC address of IP phones from specific 
manufacturers by using its ID from the Organizationally Unique Identifiers (OUI).

Click the Voice VLAN Setup link in the VLAN Configuration screen to display the configuration screen as 
shown. 

Figure 103   Advanced Application > VLAN > VLAN Configuration > Voice VLAN Setup

The following table describes the fields in the above screen. 

Table 49   Advanced Application > VLAN > VLAN Configuration > Voice VLAN Setup

LABEL DESCRIPTION
Voice VLAN Global Setup

Voice VLAN Click the Voice VLAN radio button if you want to enable the Voice VLAN feature. Type a 
VLAN ID number in the box next to the radio button that is associated with the Voice 
VLAN. Click Disable radio button if you do not want to enable the Voice VLAN feature.

Priority Select the priority level of the Voice VLAN from 0 to 7. Default setting is 5.The higher the 
numeric value you assign, the higher the priority for this Voice VLAN.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses 
these changes if it is turned off or loses power, so use the Save link on the top navigation 
panel to save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to default settings.

Voice VLAN OUI Setup

OUI address Type the IP Phone manufacturer’s OUI MAC address. The first three byes is the 
manufacturer identifier, the last three bytes is a unique station ID.

OUI mask Type the IP Phone manufacturer's OUI mask address.
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9.9  MAC Based VLAN
The MAC-based VLAN feature assigns incoming untagged packets to a VLAN and classifies the traffic 
based on the source MAC address of the packet. When untagged packets arrive at the switch, the 
source MAC address of the packet is looked up in a MAC to VLAN mapping table. If an entry is found, 
the corresponding VLAN ID is assigned to the packet. The assigned VLAN ID is verified against the VLAN 
table. If the VLAN is valid, ingress processing on the packet continues; otherwise, the packet is dropped.

This feature allows users to change ports without having to reconfigure the VLAN. You can assign priority 
to the MAC-based VLAN and define a MAC to VLAN mapping table by entering a specified source 
MAC address in the MAC-based VLAN setup screen. You can also delete a MAC-based VLAN entry in 
the same screen.

Click the MAC-based VLAN Setup link in the VLAN Configuration screen to see the following screen.

Figure 104   Advanced Application > VLAN > VLAN Configuration > MAC-based VLAN Setup

Description Type an description up to 32 characters for the Voice VLAN device. For example: 
Siemens.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel 
to save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Index This field displays the index number of the Voice VLAN.

OUI address This field displays the OUI address of the Voice VLAN.

OUI mask This field displays the OUI mask address of the Voice VLAN.

Description This field displays the description of the Voice VLAN with OUI address.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in 
the table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 49   Advanced Application > VLAN > VLAN Configuration > Voice VLAN Setup

LABEL DESCRIPTION
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The following table describes the fields in the above screen. 

9.10  Port-based VLAN Setup (Standalone Mode)    
Port-based VLANs are VLANs where the packet forwarding decision is based on the destination MAC 
address and its associated port.

Port-based VLANs require allowed outgoing ports to be defined for each port. Therefore, if you wish to 
allow two subscriber ports to talk to each other, for example, between conference rooms in a hotel, you 
must define the egress (an egress port is an outgoing port, that is, a port through which a data packet 
leaves) for both ports.

Port-based VLANs are specific only to the Switch on which they were created. 

Note: When you activate port-based VLAN, the Switch uses a default VLAN ID of 1. You 
cannot change it.

Note: In screens (such as IP Setup and Filtering) that require a VID, you must enter 1 as the VID. 

The port-based VLAN setup screen is shown next. The CPU management port forms a VLAN with all 
Ethernet ports.

9.10.1  Configure a Port-based VLAN 
Select Port Based as the VLAN Type in the Switch Setup screen and then click VLAN from the navigation 
panel to display the following screen. Select either All Connected or Port Isolated from the drop-down 
list depending on your VLAN and VLAN security requirements. If VLAN members need to communicate 

Table 50   Advanced Application > VLAN > VLAN Configuration > MAC-based VLAN Setup

LABEL DESCRIPTION
Name Type a name up to 32 alpha numeric characters for the MAC-based VLAN entry.

MAC Address Type a MAC address that is bind to the MAC-based VLAN entry. This is the source MAC 
address of the data packet that is looked up when untagged packets arrive at the Switch.

VID Type an ID (from 1 to 4094) for the VLAN ID that is associated with the MAC-based VLAN 
entry.

Priority Type a priority (0-7) for the MAC-based VLAN entry.The higher the numeric value you assign, 
the higher the priority for this MAC-based VLAN entry.

Add Click Add to save the new MAC-based VLAN entry.

Cancel Click Cancel to clear the fields in the MAC-based VLAN entry.

Index This field displays the index number of the MAC-based VLAN entry.

Name This field displays the name of the MAC-based VLAN entry.

MAC Address This field displays the source MAC address that is bind to the MAC-based VLAN entry.

VID This field displays the VLAN ID of the MAC-based VLAN entry.

Priority This field displays the priority level of the MAC-based VLAN entry.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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directly with each other, then select All Connected. Select Port Isolated if you want to restrict users from 
communicating directly. Click Apply to save your settings.

The following screen shows users on a port-based, all-connected VLAN configuration.

Figure 105   Advanced Application > VLAN > Port Based VLAN Setup (All Connected) 

The following screen shows users on a port-based, port-isolated VLAN configuration.
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Figure 106   Advanced Application > VLAN: Port Based VLAN Setup (Port Isolation) 
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The following table describes the labels in this screen. 

Table 51   Advanced Application > VLAN: Port Based VLAN Setup 
LABEL DESCRIPTION
Setting Wizard Choose All connected or Port isolation.

All connected means all ports can communicate with each other, that is, there are no virtual 
LANs. All incoming and outgoing ports are selected. This option is the most flexible but also the 
least secure.

Port isolation means that each port can only communicate with the CPU management port 
and cannot communicate with each other. All incoming ports are selected while only the CPU 
outgoing port is selected. This option is the most limiting but also the most secure.

After you make your selection, click Apply (top right of screen) to display the screens as 
mentioned above. You can still customize these settings by adding/deleting incoming or 
outgoing ports, but you must also click Apply at the bottom of the screen.

Incoming These are the ingress ports; an ingress port is an incoming port, that is, a port through which a 
data packet enters. If you wish to allow two subscriber ports to talk to each other, you must 
define the ingress port for both ports. The numbers in the top row denote the incoming port for 
the corresponding port listed on the left (its outgoing port). CPU refers to the Switch 
management port. By default it forms a VLAN with all Ethernet ports. If it does not form a VLAN 
with a particular port then the Switch cannot be managed from that port.

Outgoing These are the egress ports. An egress port is an outgoing port, that is, a port through which a 
data packet leaves. If you wish to allow two subscriber ports to talk to each other, you must 
define the egress port for both ports. CPU refers to the Switch management port. By default it 
forms a VLAN with all Ethernet ports. If it does not form a VLAN with a particular port then the 
Switch cannot be managed from that port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 10
Static MAC Forward Setup

Use these screens to configure static MAC address forwarding.

10.1  Overview
This chapter discusses how to configure forwarding rules based on MAC addresses of devices on your 
network.

10.2  Configuring Static MAC Forwarding     
A static MAC address is an address that has been manually entered in the MAC address table. Static 
MAC addresses do not age out. When you set up static MAC address rules, you are setting static MAC 
addresses for a port. This may reduce the need for broadcasting.

Static MAC address forwarding together with port security allows only computers in the MAC address 
table on a port to access the Switch. See Chapter 19 on page 206 for more information on port security.

Click Advanced Application > Static MAC Forwarding in the navigation panel to display the 
configuration screen as shown. 

Figure 107   Advanced Application > Static MAC Forwarding (Standalone mode)
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Figure 108   Advanced Application > Static MAC Forwarding (Stacking mode) 

The following table describes the labels in this screen. 

Table 52   Advanced Application > Static MAC Forwarding 
LABEL DESCRIPTION
Active Select this check box to activate your rule. You may temporarily deactivate a rule without 

deleting it by clearing this check box.  

Name Enter a descriptive name for identification purposes for this static MAC address forwarding rule.

MAC Address Enter the MAC address in valid MAC address format, that is, six hexadecimal character pairs. 

Note: Static MAC addresses do not age out.
VID Enter the VLAN identification number.

Port Enter the port where the MAC address entered in the previous field will be automatically 
forwarded. In stacking mode, the first box field is the slot ID and the second field is the port 
number.

Add Click this to create a new entry or to update an existing one.

This saves your rule to the Switch’s run-time memory. The Switch loses this rule if it is turned off or 
loses power, so use the Save link on the top navigation panel to save your changes to the non-
volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index Click an index number to modify a static MAC address rule for a port.

Active This field displays whether this static MAC address forwarding rule is active (Yes) or not (No). You 
may temporarily deactivate a rule without deleting it. 

Name This field displays the descriptive name for identification purposes for this static MAC address-
forwarding rule.

MAC Address This field displays the MAC address that will be forwarded and the VLAN identification number 
to which the MAC address belongs. 

VID This field displays the ID number of the VLAN group.

Port This field displays the port where the MAC address shown in the next field will be forwarded. In 
stacking mode, the first number represents the slot and the second the port number.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 
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Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 52   Advanced Application > Static MAC Forwarding (continued)
LABEL DESCRIPTION
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CHAPTER 11
Static Multicast Forward

Setup

Use these screens to configure static multicast address forwarding.

11.1  Static Multicast Forwarding Overview
A multicast MAC address is the MAC address of a member of a multicast group. A static multicast 
address is a multicast MAC address that has been manually entered in the multicast table. Static 
multicast addresses do not age out. Static multicast forwarding allows you (the administrator) to forward 
multicast frames to a member without the member having to join the group first.

If a multicast group has no members, then the switch will either flood the multicast frames to all ports or 
drop them. You can configure this in the Advanced Application > Multicast > IPv4 Multicast > IGMP 
Snooping screen (see Section 25.3.1 on page 242). Figure 109 shows such unknown multicast frames 
flooded to all ports. With static multicast forwarding, you can forward these multicasts to port(s) within a 
VLAN group. Figure 110 shows frames being forwarded to devices connected to port 3. Figure 111 shows 
frames being forwarded to ports 2 and 3 within VLAN group 4.

Figure 109   No Static Multicast Forwarding  
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Figure 110   Static Multicast Forwarding to A Single Port

Figure 111   Static Multicast Forwarding to Multiple Ports  

11.2  Configuring Static Multicast Forwarding
Use this screen to configure rules to forward specific multicast frames, such as streaming or control 
frames, to specific port(s).

Click Advanced Application > Static Multicast Forwarding to display the configuration screen as shown.
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Figure 112   Advanced Application > Static Multicast Forwarding 

The following table describes the labels in this screen. 

Table 53   Advanced Application > Static Multicast Forwarding 
LABEL DESCRIPTION
Active Select this check box to activate your rule. You may temporarily deactivate a rule without 

deleting it by clearing this check box.  

Name Type a descriptive name (up to 32 printable ASCII characters) for this static multicast MAC 
address forwarding rule. This is for identification only.

MAC Address Enter a multicast MAC address which identifies the multicast group. The last binary bit of the first 
octet pair in a multicast MAC address must be 1. For example, the first octet pair 00000001 is 01 
and 00000011 is 03 in hexadecimal, so 01:00:5e:00:00:0A and 03:00:5e:00:00:27 are valid 
multicast MAC addresses.

VID You can forward frames with matching destination MAC address to port(s) within a VLAN group. 
Enter the ID that identifies the VLAN group here. If you don’t have a specific target VLAN, enter 
1.

Port Enter the port(s) where frames with destination MAC address that matched the entry above are 
forwarded. You can enter multiple ports separated by (no space) comma (,) or hyphen for a 
range. For example, enter “3-5” for ports 3, 4, and 5. Enter “3,5,7” for ports 3, 5, and 7. 

In stacking mode, the first number represents the slot and the second the port number. Enter 1/
1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 and port 28 for the Switch in slot 2, for example.

Add Click this to create a new entry or to update an existing one.

This saves your rule to the Switch’s run-time memory. The Switch loses this rule if it is turned off or 
loses power, so use the Save link on the top navigation panel to save your changes to the non-
volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values. 

Clear Click Clear to reset the fields to the factory defaults.

Index Click an index number to modify a static multicast MAC address rule for port(s).

Active This field displays whether a static multicast MAC address forwarding rule is active (Yes) or not 
(No). You may temporarily deactivate a rule without deleting it. 

Name This field displays the descriptive name for identification purposes for a static multicast MAC 
address-forwarding rule.

MAC Address This field displays the multicast MAC address that identifies a multicast group. 

VID This field displays the ID number of a VLAN group to which frames containing the specified 
multicast MAC address will be forwarded.
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Port This field displays the port(s) within a identified VLAN group to which frames containing the 
specified multicast MAC address will be forwarded.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 53   Advanced Application > Static Multicast Forwarding (continued)
LABEL DESCRIPTION
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CHAPTER 12
Filtering

This chapter discusses MAC address port filtering.

12.1  Configure a Filtering Rule  
Configure the Switch to filter traffic based on the traffic’s source, destination MAC addresses and/or 
VLAN group (ID).

Click Advanced Application > Filtering in the navigation panel to display the screen as shown next. 

Figure 113   Advanced Application > Filtering 

The following table describes the related labels in this screen. 

Table 54   Advanced Application > Filtering 
LABEL DESCRIPTION
Active Make sure to select this check box to activate your rule. You may temporarily deactivate a rule 

without deleting it by deselecting this check box.

Name Type a descriptive name (up to 32 printable ASCII characters) for this rule. This is for identification 
only.

Action Select Discard source to drop frames from the source MAC address (specified in the MAC field). 
The Switch can still send frames to the MAC address.

Select Discard destination to drop frames to the destination MAC address (specified in the MAC 
address). The Switch can still receive frames originating from the MAC address.

Select Discard source and Discard destination to block traffic to/from the MAC address specified 
in the MAC field.
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MAC Type a MAC address in a valid MAC address format, that is, six hexadecimal character pairs.

VID Type the VLAN group identification number.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays the index number of the rule. Click an index number to change the settings. 

Active This field displays Yes when the rule is activated and No when is it deactivated.

Name This field displays the descriptive name for this rule. This is for identification purposes only.

MAC Address This field displays the source/destination MAC address with the VLAN identification number to 
which the MAC address belongs. 

VID This field displays the VLAN group identification number.

Action This field displays Discard source, Discard destination, or Discard both depending on what you 
configured above.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the table 
heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).

Table 54   Advanced Application > Filtering (continued)
LABEL DESCRIPTION
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CHAPTER 13
Spanning Tree Protocol

The Switch supports Spanning Tree Protocol (STP), Rapid Spanning Tree Protocol (RSTP) and Multiple 
Spanning Tree Protocol (MSTP) as defined in the following standards. 

• IEEE 802.1D Spanning Tree Protocol

• IEEE 802.1w Rapid Spanning Tree Protocol

• IEEE 802.1s Multiple Spanning Tree Protocol

The Switch also allows you to set up multiple STP configurations (or trees). Ports can then be assigned to 
the trees.

13.1  STP/RSTP Overview  
(R)STP detects and breaks network loops and provides backup links between switches, bridges or 
routers. It allows a Switch to interact with other (R)STP-compliant switches in your network to ensure that 
only one path exists between any two stations on the network.

The Switch uses IEEE 802.1w RSTP (Rapid Spanning Tree Protocol) that allows faster convergence of the 
spanning tree than STP (while also being backwards compatible with STP-only aware bridges). In RSTP, 
topology change information is directly propagated throughout the network from the device that 
generates the topology change. In STP, a longer delay is required as the device that causes a topology 
change first notifies the root bridge and then the root bridge notifies the network. Both RSTP and STP flush 
unwanted learned addresses from the filtering database. In RSTP, the port states are Discarding, 
Learning, and Forwarding. 

Note: In this user’s guide, “STP” refers to both STP and RSTP.

13.1.1  STP Terminology 
The root bridge is the base of the spanning tree. 

Path cost is the cost of transmitting a frame onto a LAN through that port. The recommended cost is 
assigned according to the speed of the link to which a port is attached. The slower the media, the 
higher the cost.  

Table 55   STP Path Costs

LINK SPEED RECOMMENDED 
VALUE

RECOMMENDED 
RANGE ALLOWED RANGE

Path Cost 4Mbps 250 100 to 1000 1 to 65535

Path Cost 10Mbps 100 50 to 600 1 to 65535

Path Cost 16Mbps 62 40 to 400 1 to 65535

Path Cost 100Mbps 19 10 to 60 1 to 65535
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On each bridge, the bridge communicates with the root through the root port. The root port is the port 
on this Switch with the lowest path cost to the root (the root path cost). If there is no root port, then this 
Switch has been accepted as the root bridge of the spanning tree network.

For each LAN segment, a designated bridge is selected. This bridge has the lowest cost to the root 
among the bridges connected to the LAN. 

13.1.2  How STP Works 
After a bridge determines the lowest cost-spanning tree with STP, it enables the root port and the ports 
that are the designated ports for connected LANs, and disables all other ports that participate in STP. 
Network packets are therefore only forwarded between enabled ports, eliminating any possible 
network loops.

STP-aware switches exchange Bridge Protocol Data Units (BPDUs) periodically. When the bridged LAN 
topology changes, a new spanning tree is constructed.

Once a stable network topology has been established, all bridges listen for Hello BPDUs (Bridge Protocol 
Data Units) transmitted from the root bridge. If a bridge does not get a Hello BPDU after a predefined 
interval (Max Age), the bridge assumes that the link to the root bridge is down. This bridge then initiates 
negotiations with other bridges to reconfigure the network to re-establish a valid network topology.

13.1.3  STP Port States 
STP assigns five port states to eliminate packet looping. A bridge port is not allowed to go directly from 
blocking state to forwarding state so as to eliminate transient loops. 

13.1.4  Multiple RSTP  
MRSTP (Multiple RSTP) is Zyxel’s proprietary feature that is compatible with RSTP and STP. With MRSTP, you 
can have more than one spanning tree on your Switch and assign port(s) to each tree. Each spanning 
tree operates independently with its own bridge information.

Path Cost 1Gbps 4 3 to 10 1 to 65535

Path Cost 10Gbps 2 1 to 5 1 to 65535

Table 55   STP Path Costs

LINK SPEED RECOMMENDED 
VALUE

RECOMMENDED 
RANGE ALLOWED RANGE

Table 56   STP Port States
PORT STATE DESCRIPTION
Disabled STP is disabled (default).

Blocking Only configuration and management BPDUs are received and processed.

Listening All BPDUs are received and processed.

Note: The listening state does not exist in RSTP.
Learning All BPDUs are received and processed. Information frames are submitted to the learning process 

but not forwarded.

Forwarding All BPDUs are received and processed. All information frames are received and forwarded.
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In the following example, there are two RSTP instances (MRSTP1 and MRSTP2) on switch A.

Figure 114   MRSTP Network Example 

To set up MRSTP, activate MRSTP on the Switch and specify which port(s) belong to which spanning tree.

Note: Each port can belong to one STP tree only. 

13.1.5  Multiple STP 
Multiple Spanning Tree Protocol (IEEE 802.1s) is backwards compatible with STP/RSTP and addresses the 
limitations of existing spanning tree protocols (STP and RSTP) in networks to include the following 
features: 

• One Common and Internal Spanning Tree (CIST) that represents the entire network’s connectivity. 

• Grouping of multiple bridges (or switching devices) into regions that appear as one single bridge on 
the network. 

• A VLAN can be mapped to a specific Multiple Spanning Tree Instance (MSTI). MSTI allows multiple 
VLANs to use the same spanning tree. 

• Load-balancing is possible as traffic from different VLANs can use distinct paths in a region. 

13.1.5.1  MSTP Network Example
The following figure shows a network example where two VLANs are configured on the two switches. If 
the switches are using STP or RSTP, the link for VLAN 2 will be blocked as STP and RSTP allow only one link 
in the network and block the redundant link. 

Figure 115   STP/RSTP Network Example 
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With MSTP, VLANs 1 and 2 are mapped to different spanning trees in the network. Thus traffic from the 
two VLANs travel on different paths. The following figure shows the network example using MSTP. 

Figure 116   MSTP Network Example 

13.1.5.2  MST Region 
An MST region is a logical grouping of multiple network devices that appears as a single device to the 
rest of the network. Each MSTP-enabled device can only belong to one MST region. When BPDUs enter 
an MST region, external path cost (of paths outside this region) is increased by one. Internal path cost (of 
paths within this region) is increased by one when BPDUs traverse the region. 

Devices that belong to the same MST region are configured to have the same MSTP configuration 
identification settings. These include the following parameters:

• Name of the MST region

• Revision level as the unique number for the MST region

• VLAN-to-MST Instance mapping 

13.1.5.3  MST Instance 
An MST Instance (MSTI) is a spanning tree instance. VLANs can be configured to run on a specific MSTI. 
Each created MSTI is identified by a unique number (known as an MST ID) known internally to a region. 
Thus an MSTI does not span across MST regions. 

The following figure shows an example where there are two MST regions. Regions 1 and 2 have 2 
spanning tree instances. 
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Figure 117   MSTIs in Different Regions 

13.1.5.4  Common and Internal Spanning Tree (CIST) 
A CIST represents the connectivity of the entire network and it is equivalent to a spanning tree in an STP/
RSTP. The CIST is the default MST instance (MSTID 0). Any VLANs that are not members of an MST instance 
are members of the CIST. In an MSTP-enabled network, there is only one CIST that runs between MST 
regions and single spanning tree devices. A network may contain multiple MST regions and other 
network segments running RSTP. 

Figure 118   MSTP and Legacy RSTP Network Example 

13.2  Spanning Tree Protocol Status Screen
Click Advanced Application > Spanning Tree Protocol to see the screen as shown.
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Figure 119   Advanced Application > Spanning Tree Protocol (Standalone mode) 

Figure 120   Advanced Application > Spanning Tree Protocol (Stacking mode) 

This screen differs depending on which STP mode (RSTP, MRSTP or MSTP) you configure on the Switch. This 
screen is described in detail in the section that follows the configuration section for each STP mode. 
Click Configuration to activate one of the STP standards on the Switch.

13.3  Spanning Tree Configuration 
Use the Spanning Tree Configuration screen to activate one of the STP modes on the Switch. Click 
Configuration in the Advanced Application > Spanning Tree Protocol.

Figure 121   Advanced Application > Spanning Tree Protocol > Configuration 
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The following table describes the labels in this screen. 

13.4  Configure Rapid Spanning Tree Protocol   
Use this screen to configure RSTP settings, see Section 13.1 on page 143 for more information on RSTP. 
Click RSTP in the Advanced Application > Spanning Tree Protocol screen. 

Figure 122   Advanced Application > Spanning Tree Protocol > RSTP (Standalone mode) 

Table 57   Advanced Application > Spanning Tree Protocol > Configuration 
LABEL DESCRIPTION
Spanning Tree 
Mode

You can activate one of the STP modes on the Switch.

Select Rapid Spanning Tree, Multiple Rapid Spanning Tree or Multiple Spanning Tree. See 
Section 13.1 on page 143 for background information on STP.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 123   Advanced Application > Spanning Tree Protocol > RSTP (Stacking mode) 

The following table describes the labels in this screen. 

Table 58   Advanced Application > Spanning Tree Protocol > RSTP 
LABEL DESCRIPTION
Status Click Status to display the RSTP Status screen (see Figure 124 on page 152).

Active Select this check box to activate RSTP. Clear this checkbox to disable RSTP.

Note: You must also activate Rapid Spanning Tree in the Advanced Application > 
Spanning Tree Protocol > Configuration screen to enable RSTP on the Switch.

Bridge Priority Bridge priority is used in determining the root switch, root port and designated port. The switch 
with the highest priority (lowest numeric value) becomes the STP root switch. If all switches 
have the same priority, the switch with the lowest MAC address will then become the root 
switch. Select a value from the drop-down list box. 

The lower the numeric value you assign, the higher the priority for this bridge.

Bridge Priority determines the root bridge, which in turn determines Hello Time, Max Age and 
Forwarding Delay.

Hello Time This is the time interval in seconds between BPDU (Bridge Protocol Data Units) configuration 
message generations by the root switch. The allowed range is 1 to 10 seconds.
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Max Age This is the maximum time (in seconds) a switch can wait without receiving a BPDU before 
attempting to reconfigure. All switch ports (except for designated ports) should receive BPDUs 
at regular intervals. Any port that ages out STP information (provided in the last BPDU) 
becomes the designated port for the attached LAN. If it is a root port, a new root port is 
selected from among the switch ports attached to the network. The allowed range is 6 to 40 
seconds.

Forwarding Delay This is the maximum time (in seconds) a switch will wait before changing states. This delay is 
required because every switch must receive information about topology changes before it 
starts to forward frames. In addition, each port needs time to listen for conflicting information 
that would make it return to a blocking state; otherwise, temporary data loops might result. 
The allowed range is 4 to 30 seconds.

As a general rule:

Note: 2 * (Forward Delay - 1) >= Max Age >= 2 * (Hello Time + 1)
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to activate RSTP on this port. 

Edge Select this check box to configure a port as an edge port when it is directly attached to a 
computer. An edge port changes its initial STP port state from blocking state to forwarding 
state immediately without going through listening and learning states right after the port is 
configured as an edge port or when its link status changes.

Note: An edge port becomes a non-edge port as soon as it receives a Bridge 
Protocol Data Unit (BPDU).

Root Guard Select this check box to enable root guard on this port in order to prevent the switch(es) 
attached to the port from becoming the root bridge. 

With root guard enabled, a port is blocked when the Switch receives a superior BPDU on it. The 
Switch allows traffic to pass through this port again when the switch connected to the port 
stops to send superior BPDUs. 

Priority Configure the priority for each port here.

Priority decides which port should be disabled when more than one port forms a loop in a 
switch. Ports with a higher priority numeric value are disabled first. The allowed range is 
between 0 and 255 and the default value is 128.

Path Cost Path cost is the cost of transmitting a frame on to a LAN through that port. It is recommended 
to assign this value according to the speed of the bridge. The slower the media, the higher the 
cost - see Table 55 on page 143 for more information.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 58   Advanced Application > Spanning Tree Protocol > RSTP (continued)
LABEL DESCRIPTION
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13.5  Rapid Spanning Tree Protocol Status   
Click Advanced Application > Spanning Tree Protocol in the navigation panel to display the status 
screen as shown next. See Section 13.1 on page 143 for more information on RSTP.

Note: This screen is only available after you activate RSTP on the Switch. 

Figure 124   Advanced Application > Spanning Tree Protocol > Status: RSTP (Standalone mode)

Figure 125   Advanced Application > Spanning Tree Protocol > Status: RSTP (Stacking mode)

The following table describes the labels in this screen. 

Table 59   Advanced Application > Spanning Tree Protocol > Status: RSTP 
LABEL DESCRIPTION
Configuration Click Configuration to specify which STP mode you want to activate. Click RSTP to edit RSTP 

settings on the Switch. 

Bridge Root refers to the base of the spanning tree (the root bridge). Our Bridge is this Switch. This 
Switch may also be the root bridge.

Bridge ID This is the unique identifier for this bridge, consisting of the bridge priority plus the MAC 
address. This ID is the same for Root and Our Bridge if the Switch is the root switch.

Hello Time 
(second)

This is the time interval (in seconds) at which the root switch transmits a configuration 
message. The root bridge determines Hello Time, Max Age and Forwarding Delay.



Chapter 13 Spanning Tree Protocol

XGS4600 Series User’s Guide

153

Max Age (second) This is the maximum time (in seconds) a switch can wait without receiving a configuration 
message before attempting to reconfigure.

Forwarding Delay 
(second)

This is the time (in seconds) the root switch will wait before changing states (that is, listening to 
learning to forwarding). See Section 13.1.3 on page 144 for information on port states.

Note: The listening state does not exist in RSTP.
Cost to Bridge This is the path cost from the root port on this Switch to the root switch. 

Port ID This is the priority and number of the port on the Switch through which this Switch must 
communicate with the root of the Spanning Tree.

Topology 
Changed Times

This is the number of times the spanning tree has been reconfigured.

Time Since Last 
Change

This is the time since the spanning tree was last reconfigured.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the number of the port on the Switch. 

Port State This field displays the port state in STP.

• Discarding - The port does not forward/process received frames or learn MAC addresses, 
but still listens for BPDUs.

• Learning - The port learns MAC addresses and processes BPDUs, but does not forward 
frames yet.

• Forwarding - The port is operating normally. It learns MAC addresses, processes BPDUs and 
forwards received frames.

Port Role This field displays the role of the port in STP.

• Root - A forwarding port on a non-root bridge, which has the lowest path cost and is the 
best port from the non-root bridge to the root bridge. A root bridge does not have a root 
port. 

• Designated - A forwarding port on the designated bridge for each connected LAN 
segment. A designated bridge has the lowest path cost to the root bridge among the 
bridges connected to the LAN segment. All the ports on a root bridge (root switch) are 
designated ports.

• Alternate - A blocked port, which has a best alternate path to the root bridge. This path is 
different from using the root port. The port moves to the forwarding state when the 
designated port for the LAN segment fails.

• Backup - A blocked port, which has a backup/redundant path to a LAN segment where 
a designated port is already connected when a switch has two links to the same LAN 
segment.

• Disabled - Not strictly part of STP. The port can be disabled manually.

Designated Bridge 
ID

This field displays the identifier of the designated bridge to which this port belongs when the 
port is a designated port. Otherwise, it displays the identifier of the designated bridge for the 
LAN segment to which this port is connected.

Designated Port ID This field displays the priority and number of the bridge port (on the designated bridge), 
through which the designated bridge transmits the stored configuration messages.

Designated Cost This field displays the path cost to the LAN segment to which the port is connected when the 
port is a designated port. Otherwise, it displays the path cost to the root bridge from the 
designated port for the LAN segment to which this port is connected,

Root Guard State This field displays the state of the port on which root guard is enabled.

• Root-inconsistent - the Switch receives superior BPDUs on the port and blocks the port.
• Forwarding - the Switch unblocks and allows the port to forward frames again.

Table 59   Advanced Application > Spanning Tree Protocol > Status: RSTP (continued)
LABEL DESCRIPTION
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13.6  Configure Multiple Rapid Spanning Tree Protocol   
To configure MRSTP, click MRSTP in the Advanced Application > Spanning Tree Protocol screen. See 
Section 13.1 on page 143 for more information on MRSTP.

Figure 126   Advanced Application > Spanning Tree Protocol > MRSTP (Standalone mode) 



Chapter 13 Spanning Tree Protocol

XGS4600 Series User’s Guide

155

Figure 127   Advanced Application > Spanning Tree Protocol > MRSTP (Stacking mode) 

The following table describes the labels in this screen. 

Table 60   Advanced Application > Spanning Tree Protocol > MRSTP 
LABEL DESCRIPTION
Status Click Status to display the MRSTP Status screen (see Figure 128 on page 157).

Tree This is a read only index number of the STP trees.

Active Select this check box to activate an STP tree. Clear this checkbox to disable an STP tree.

Note: You must also activate Multiple Rapid Spanning Tree in the Advanced 
Application > Spanning Tree Protocol > Configuration screen to enable MRSTP 
on the Switch.

Bridge Priority Bridge priority is used in determining the root switch, root port and designated port. The switch 
with the highest priority (lowest numeric value) becomes the STP root switch. If all switches 
have the same priority, the switch with the lowest MAC address will then become the root 
switch. Select a value from the drop-down list box. 

The lower the numeric value you assign, the higher the priority for this bridge.

Bridge Priority determines the root bridge, which in turn determines Hello Time, Max Age and 
Forwarding Delay.

Hello Time This is the time interval in seconds between BPDU (Bridge Protocol Data Units) configuration 
message generations by the root switch. The allowed range is 1 to 10 seconds.
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Max Age This is the maximum time (in seconds) a switch can wait without receiving a BPDU before 
attempting to reconfigure. All switch ports (except for designated ports) should receive BPDUs 
at regular intervals. Any port that ages out STP information (provided in the last BPDU) 
becomes the designated port for the attached LAN. If it is a root port, a new root port is 
selected from among the Switch ports attached to the network. The allowed range is 6 to 40 
seconds.

Forwarding Delay This is the maximum time (in seconds) a switch will wait before changing states. This delay is 
required because every switch must receive information about topology changes before it 
starts to forward frames. In addition, each port needs time to listen for conflicting information 
that would make it return to a blocking state; otherwise, temporary data loops might result. 
The allowed range is 4 to 30 seconds.

As a general rule:

Note: 2 * (Forward Delay - 1) >= Max Age >= 2 * (Hello Time + 1)
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to activate STP on this port. 

Edge Select this check box to configure a port as an edge port when it is directly attached to a 
computer. An edge port changes its initial STP port state from blocking state to forwarding 
state immediately without going through listening and learning states right after the port is 
configured as an edge port or when its link status changes.

Note: An edge port becomes a non-edge port as soon as it receives a Bridge 
Protocol Data Unit (BPDU).

Root Guard Select this check box to enable root guard on this port in order to prevent the switch(es) 
attached to the port from becoming the root bridge. 

With root guard enabled, a port is blocked when the Switch receives a superior BPDU on it. The 
Switch allows traffic to pass through this port again when the switch connected to the port 
stops to send superior BPDUs. 

Priority Configure the priority for each port here.

Priority decides which port should be disabled when more than one port forms a loop in the 
Switch. Ports with a higher priority numeric value are disabled first. The allowed range is 
between 0 and 255 and the default value is 128.

Path Cost Path cost is the cost of transmitting a frame on to a LAN through that port. It is recommended 
that you assign this value according to the speed of the bridge. The slower the media, the 
higher the cost - see Table 55 on page 143 for more information.

Tree Select which STP tree configuration this port should participate in.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 60   Advanced Application > Spanning Tree Protocol > MRSTP (continued)
LABEL DESCRIPTION
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13.7  Multiple Rapid Spanning Tree Protocol Status    
Click Advanced Application > Spanning Tree Protocol in the navigation panel to display the status 
screen as shown next. See Section 13.1 on page 143 for more information on MRSTP. 

Note: This screen is only available after you activate MRSTP on the Switch. 

Figure 128   Advanced Application > Spanning Tree Protocol > Status: MRSTP (Standalone mode)

Figure 129   Advanced Application > Spanning Tree Protocol > Status: MRSTP (Stacking mode)

The following table describes the labels in this screen.  

Table 61   Advanced Application > Spanning Tree Protocol > Status: MRSTP 
LABEL DESCRIPTION
Configuration Click Configuration to specify which STP mode you want to activate. Click MRSTP to edit 

MRSTP settings on the Switch. 

Tree Select which STP tree configuration you want to view. 

Bridge Root refers to the base of the spanning tree (the root bridge). Our Bridge is this Switch. This 
Switch may also be the root bridge.
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Bridge ID This is the unique identifier for this bridge, consisting of bridge priority plus MAC address. This ID 
is the same for Root and Our Bridge if the Switch is the root switch. 

Hello Time 
(second)

This is the time interval (in seconds) at which the root switch transmits a configuration 
message. The root bridge determines Hello Time, Max Age and Forwarding Delay.

Max Age (second) This is the maximum time (in seconds) a switch can wait without receiving a configuration 
message before attempting to reconfigure.

Forwarding Delay 
(second)

This is the time (in seconds) the root switch will wait before changing states (that is, listening to 
learning to forwarding).

Note: The listening state does not exist in RSTP.
Cost to Bridge This is the path cost from the root port on this Switch to the root switch. 

Port ID This is the priority and number of the port on the Switch through which this Switch must 
communicate with the root of the Spanning Tree.

Topology 
Changed Times

This is the number of times the spanning tree has been reconfigured.

Time Since Last 
Change

This is the time since the spanning tree was last reconfigured.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the number of the port on the Switch. 

Port State This field displays the port state in STP.

• Discarding - The port does not forward/process received frames or learn MAC addresses, 
but still listens for BPDUs.

• Learning - The port learns MAC addresses and processes BPDUs, but does not forward 
frames yet.

• Forwarding - The port is operating normally. It learns MAC addresses, processes BPDUs and 
forwards received frames.

Port Role This field displays the role of the port in STP.

• Root - A forwarding port on a non-root bridge, which has the lowest path cost and is the 
best port from the non-root bridge to the root bridge. A root bridge does not have a root 
port. 

• Designated - A forwarding port on the designated bridge for each connected LAN 
segment. A designated bridge has the lowest path cost to the root bridge among the 
bridges connected to the LAN segment. All the ports on a root bridge (root switch) are 
designated ports.

• Alternate - A blocked port, which has a best alternate path to the root bridge. This path is 
different from using the root port. The port moves to the forwarding state when the 
designated port for the LAN segment fails.

• Backup - A blocked port, which has a backup/redundant path to a LAN segment where 
a designated port is already connected when a switch has two links to the same LAN 
segment.

• Disabled - Not strictly part of STP. The port can be disabled manually.

Designated Bridge 
ID

This field displays the identifier of the designated bridge to which this port belongs when the 
port is a designated port. Otherwise, it displays the identifier of the designated bridge for the 
LAN segment to which this port is connected.

Designated Port ID This field displays the priority and number of the bridge port (on the designated bridge), 
through which the designated bridge transmits the stored configuration messages.

Designated Cost This field displays the path cost to the LAN segment to which the port is connected when the 
port is a designated port. Otherwise, it displays the path cost to the root bridge from the 
designated port for the LAN segment to which this port is connected.

Root Guard State This field displays the state of the port on which root guard is enabled.

• Root - inconsistent - the Switch receives superior BPDUs on the port and blocks the port.
• Forwarding - the Switch unblocks and allows the port to forward frames again.

Table 61   Advanced Application > Spanning Tree Protocol > Status: MRSTP (continued)
LABEL DESCRIPTION
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13.8  Configure Multiple Spanning Tree Protocol  
To configure MSTP, click MSTP in the Advanced Application > Spanning Tree Protocol screen. See Section 
13.1.5 on page 145 for more information on MSTP.

Figure 130   Advanced Application > Spanning Tree Protocol > MSTP (Standalone mode) 
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Figure 131   Advanced Application > Spanning Tree Protocol > MSTP (Stacking mode) 

The following table describes the labels in this screen. 

Table 62   Advanced Application > Spanning Tree Protocol > MSTP 
LABEL DESCRIPTION
Status Click Status to display the MSTP Status screen (see Figure 134 on page 164).

Active Select this check box to activate MSTP on the Switch. Clear this checkbox to disable MSTP on 
the Switch.

Note: You must also activate Multiple Spanning Tree in the Advanced Application > 
Spanning Tree Protocol > Configuration screen to enable MSTP on the Switch.

Hello Time This is the time interval in seconds between BPDU (Bridge Protocol Data Units) configuration 
message generations by the root switch. The allowed range is 1 to 10 seconds.
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MaxAge This is the maximum time (in seconds) a switch can wait without receiving a BPDU before 
attempting to reconfigure. All switch ports (except for designated ports) should receive BPDUs 
at regular intervals. Any port that ages out STP information (provided in the last BPDU) 
becomes the designated port for the attached LAN. If it is a root port, a new root port is 
selected from among the Switch ports attached to the network. The allowed range is 6 to 40 
seconds.

Forwarding Delay This is the maximum time (in seconds) a switch will wait before changing states. This delay is 
required because every switch must receive information about topology changes before it 
starts to forward frames. In addition, each port needs time to listen for conflicting information 
that would make it return to a blocking state; otherwise, temporary data loops might result. 
The allowed range is 4 to 30 seconds. As a general rule:

Note: 2 * (Forward Delay - 1) >= Max Age >= 2 * (Hello Time + 1)
Maximum hops Enter the number of hops (between 1 and 255) in an MSTP region before the BPDU is 

discarded and the port information is aged. 

Configuration 
Name

Enter a descriptive name (up to 32 characters) of an MST region. 

Revision Number Enter a number to identify a region’s configuration. Devices must have the same revision 
number to belong to the same region. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Instance Use this section to configure MSTI (Multiple Spanning Tree Instance) settings.

Instance Enter the number you want to use to identify this MST instance on the Switch. The Switch 
supports instance numbers 0-16. 

Bridge Priority Set the priority of the Switch for the specific spanning tree instance. The lower the number, the 
more likely the Switch will be chosen as the root bridge within the spanning tree instance. 

Enter priority values between 0 and 61440 in increments of 4096 (thus valid values are 4096, 
8192, 12288, 16384, 20480, 24576, 28672, 32768, 36864, 40960, 45056, 49152, 53248, 57344 and 
61440). 

VLAN Range Enter the start of the VLAN ID range that you want to add or remove from the VLAN range edit 
area in the Start field. Enter the end of the VLAN ID range that you want to add or remove 
from the VLAN range edit area in the End field. 

Next click:

• Add - to add this range of VLAN(s) to be mapped to the MST instance. 
• Remove - to remove this range of VLAN(s) from being mapped to the MST instance. 
• Clear - to remove all VLAN(s) from being mapped to this MST instance. 

Enabled VLAN(s) This field displays which VLAN(s) are mapped to this MST instance. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to add this port to the MST instance. 

Table 62   Advanced Application > Spanning Tree Protocol > MSTP (continued)
LABEL DESCRIPTION
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13.8.1  Multiple Spanning Tree Protocol Port Configuration 
To configure MSTP ports, click Port in the Advanced Application > Spanning Tree Protocol > MSTP screen.

Figure 132   Advanced Application > Spanning Tree Protocol > MSTP > Port (Standalone mode) 

Priority Configure the priority for each port here.

Priority decides which port should be disabled when more than one port forms a loop in the 
Switch. Ports with a higher priority numeric value are disabled first. The allowed range is 
between 0 and 255 and the default value is 128.

Path Cost Path cost is the cost of transmitting a frame on to a LAN through that port. It is recommended 
to assign this value according to the speed of the bridge. The slower the media, the higher the 
cost - see Table 55 on page 143 for more information.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses this change if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Instance This field displays the ID of an MST instance. 

VLAN This field displays the VID (or VID ranges) to which the MST instance is mapped. 

Active Port This field display the ports configured to participate in the MST instance.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).

Table 62   Advanced Application > Spanning Tree Protocol > MSTP (continued)
LABEL DESCRIPTION
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Figure 133   Advanced Application > Spanning Tree Protocol > MSTP > Port (Stacking mode) 

The following table describes the labels in this screen. 

Table 63   Advanced Application > Spanning Tree Protocol > MSTP > Port 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Edge Select this check box to configure a port as an edge port when it is directly attached to a 

computer. An edge port changes its initial STP port state from blocking state to forwarding 
state immediately without going through listening and learning states right after the port is 
configured as an edge port or when its link status changes.

Note: An edge port becomes a non-edge port as soon as it receives a Bridge 
Protocol Data Unit (BPDU).

Root Guard Select this check box to enable root guard on this port in order to prevent the switch(es) 
attached to the port from becoming the root bridge. 

With root guard enabled, a port is blocked when the Switch receives a superior BPDU on it. The 
Switch allows traffic to pass through this port again when the switch connected to the port 
stops to send superior BPDUs. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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13.9  Multiple Spanning Tree Protocol Status   
Click Advanced Application > Spanning Tree Protocol in the navigation panel to display the status 
screen as shown next. See Section 13.1.5 on page 145 for more information on MSTP. 

Note: This screen is only available after you activate MSTP on the Switch. 

Figure 134   Advanced Application > Spanning Tree Protocol > Status: MSTP (Standalone mode)
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Figure 135   Advanced Application > Spanning Tree Protocol > Status: MSTP (Stacking mode)

The following table describes the labels in this screen. 

Table 64   Advanced Application > Spanning Tree Protocol > Status: MSTP 
LABEL DESCRIPTION
Configuration Click Configuration to specify which STP mode you want to activate. Click MSTP to edit MSTP 

settings on the Switch. 

CST This section describes the Common Spanning Tree settings. 

Bridge Root refers to the base of the spanning tree (the root bridge). Our Bridge is this Switch. This 
Switch may also be the root bridge.

Bridge ID This is the unique identifier for this bridge, consisting of bridge priority plus MAC address. This ID 
is the same for Root and Our Bridge if the Switch is the root switch. 

Hello Time 
(second)

This is the time interval (in seconds) at which the root switch transmits a configuration 
message.

Max Age (second) This is the maximum time (in seconds) a switch can wait without receiving a configuration 
message before attempting to reconfigure.

Forwarding Delay 
(second)

This is the time (in seconds) the root switch will wait before changing states (that is, listening to 
learning to forwarding).

Cost to Bridge This is the path cost from the root port on this Switch to the root switch. 

Port ID This is the priority and number of the port on the Switch through which this Switch must 
communicate with the root of the Spanning Tree.

Configuration 
Name

This field displays the configuration name for this MST region.
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Revision Number This field displays the revision number for this MST region. 

Configuration 
Digest

A configuration digest is generated from the VLAN-MSTI mapping information. 

This field displays the 16-octet signature that is included in an MSTP BPDU. This field displays the 
digest when MSTP is activated on the system. 

Topology 
Changed Times

This is the number of times the spanning tree has been reconfigured.

Time Since Last 
Change

This is the time since the spanning tree was last reconfigured.

Instance: These fields display the MSTI to VLAN mapping. In other words, which VLANs run on each 
spanning tree instance.

Instance This field displays the MSTI ID.

VLAN This field displays which VLANs are mapped to an MSTI.

MSTI Select the MST instance settings you want to view.

Bridge Root refers to the base of the MST instance. Our Bridge is this Switch. This Switch may also be 
the root bridge.

Bridge ID This is the unique identifier for this bridge, consisting of bridge priority plus MAC address. This ID 
is the same for Root and Our Bridge if the Switch is the root switch. 

Internal Cost This is the path cost from the root port in this MST instance to the regional root switch. 

Port ID This is the priority and number of the port on the Switch through which this Switch must 
communicate with the root of the MST instance.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the number of the port on the Switch. 

Port State This field displays the port state in STP.

• Discarding - The port does not forward/process received frames or learn MAC addresses, 
but still listens for BPDUs.

• Learning - The port learns MAC addresses and processes BPDUs, but does not forward 
frames yet.

• Forwarding - The port is operating normally. It learns MAC addresses, processes BPDUs and 
forwards received frames.

Port Role This field displays the role of the port in STP.

• Root - A forwarding port on a non-root bridge, which has the lowest path cost and is the 
best port from the non-root bridge to the root bridge. A root bridge does not have a root 
port. 

• Designated - A forwarding port on the designated bridge for each connected LAN 
segment. A designated bridge has the lowest path cost to the root bridge among the 
bridges connected to the LAN segment. All the ports on a root bridge (root switch) are 
designated ports.

• Alternate - A blocked port, which has a best alternate path to the root bridge. This path is 
different from using the root port. The port moves to the forwarding state when the 
designated port for the LAN segment fails.

• Backup - A blocked port, which has a backup/redundant path to a LAN segment where 
a designated port is already connected when a switch has two links to the same LAN 
segment.

• Disabled - Not strictly part of STP. The port can be disabled manually.

Designated Bridge 
ID

This field displays the identifier of the designated bridge to which this port belongs when the 
port is a designated port. Otherwise, it displays the identifier of the designated bridge for the 
LAN segment to which this port is connected.

Designated Port ID This field displays the priority and number of the bridge port (on the designated bridge), 
through which the designated bridge transmits the stored configuration messages.

Table 64   Advanced Application > Spanning Tree Protocol > Status: MSTP (continued)
LABEL DESCRIPTION
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Designated Cost This field displays the path cost to the LAN segment to which the port is connected when the 
port is a designated port. Otherwise, it displays the path cost to the root bridge from the 
designated port for the LAN segment to which this port is connected.

Root Guard State This field displays the state of the port on which root guard is enabled.

• Root - inconsistent - the Switch receives superior BPDUs on the port and blocks the port.
• Forwarding - the Switch unblocks and allows the port to forward frames again.

Table 64   Advanced Application > Spanning Tree Protocol > Status: MSTP (continued)
LABEL DESCRIPTION
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CHAPTER 14
Bandwidth Control

This chapter shows you how to cap the maximum bandwidth using the Bandwidth Control screen.

14.1  Bandwidth Control Overview  
Bandwidth control means defining a maximum allowable bandwidth for incoming and/or out-going 
traffic flows on a port. 

14.1.1  CIR and PIR
The Committed Information Rate (CIR) is the guaranteed bandwidth for the incoming traffic flow on a 
port. The Peak Information Rate (PIR) is the maximum bandwidth allowed for the incoming traffic flow on 
a port when there is no network congestion.

The CIR and PIR should be set for all ports that use the same uplink bandwidth. If the CIR is reached, 
packets are sent at the rate up to the PIR. When network congestion occurs, packets through the 
ingress port exceeding the CIR will be marked for drop.

Note: The CIR should be less than the PIR.

Note: The sum of CIRs cannot be greater than or equal to the uplink bandwidth. 

14.2  Bandwidth Control Setup
Click Advanced Application > Bandwidth Control in the navigation panel to bring up the screen as 
shown next.
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Figure 136   Advanced Application > Bandwidth Control (Standalone mode) 

Figure 137   Advanced Application > Bandwidth Control (Stacking mode)
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The following table describes the related labels in this screen. 

Table 65   Advanced Application > Bandwidth Control 
LABEL DESCRIPTION
Active Select this check box to enable bandwidth control on the Switch. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Ingress Rate

Active Select this check box to activate commit rate limits on this port. 

Commit 
Rate

Specify the guaranteed bandwidth allowed in kilobits per second (Kbps) for the incoming traffic 
flow on a port. The commit rate should be less than the peak rate. The sum of commit rates 
cannot be greater than or equal to the uplink bandwidth. 

Active Select this check box to activate peak rate limits on this port. 

Peak Rate Specify the maximum bandwidth allowed in kilobits per second (Kbps) for the incoming traffic 
flow on a port. 

Active Select this check box to activate egress rate limits on this port. 

Egress Rate Specify the maximum bandwidth allowed in kilobits per second (Kbps) for the out-going traffic 
flow on a port. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 15
Broadcast Storm Control

This chapter introduces and shows you how to configure the broadcast storm control feature. 

15.1  Broadcast Storm Control Setup 
Broadcast storm control limits the number of broadcast, multicast and destination lookup failure (DLF) 
packets the Switch receives per second on the ports. When the maximum number of allowable 
broadcast, multicast and/or DLF packets is reached per second, the subsequent packets are 
discarded. Enable this feature to reduce broadcast, multicast and/or DLF packets in your network. You 
can specify limits for each packet type on each port.

Click Advanced Application > Broadcast Storm Control in the navigation panel to display the screen as 
shown next.

Figure 138   Advanced Application > Broadcast Storm Control (Standalone mode) 
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Figure 139   Advanced Application > Broadcast Storm Control (Stacking mode) 

The following table describes the labels in this screen. 

Table 66   Advanced Application > Broadcast Storm Control 
LABEL DESCRIPTION
Active Select this check box to enable traffic storm control on the Switch. Clear this check box to 

disable this feature.   

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Broadcast (pkt/s) Select this option to enable and specify how many broadcast packets the Switch accepts per 

second on the port.

The Switch will generate a trap and/or log when the actual rate is higher than the specified 
threshold.

Multicast (pkt/s) Select this option to enable and specify how many multicast packets the Switch accepts per 
second on the port.

The Switch will generate a trap and/or log when the actual rate is higher than the specified 
threshold.

DLF (pkt/s) Select this option to enable and specify how many destination lookup failure (DLF) packets the 
Switch accepts per second on the port.
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Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 66   Advanced Application > Broadcast Storm Control (continued)
LABEL DESCRIPTION
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CHAPTER 16
Mirroring

This chapter discusses port mirroring setup screens.

16.1  Port Mirroring 
Port mirroring allows you to copy a traffic flow to a monitor port (the port you copy the traffic to) in order 
that you can examine the traffic from the monitor port without interference. 

The Switch supports both local port mirroring and remote port mirroring. 

In local port mirroring, the mirroring ports (through which traffic you copy passes) and the monitor port 
are on the same device. 

In remote port mirroring (RMirror), the mirroring ports and monitor port can be on different devices in a 
network. You can use it to monitor multiple switches across your network. The traffic from the source 
device’s mirroring port(s) is sent to a reflector port for VLAN tagging and copied to the connected 
port(s). Traffic are then carried over the specified remote port mirroring (RMirror) VLAN and sent to the 
destination device’s monitor port through the connected ports that connect to other switches.
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Single-Destination RMirror

If the mirrored traffic is forwarded to one single destination switch, you can disable the reflector port. The 
Switch adds RMirror VLAN tag and forwards mirrored traffic from the mirroring port to the connected 
port directly.

Multi-Destination RMirror

If you configure more than one connected port on the source switch to forward the mirrored traffic to 
multiple destination switches, you must enable a reflector port on the source switch. 
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Port Rules in Port Mirroring

The following table shows the rule for a port in remote port mirroring. For example, a port on the source 
device can be a mirroring port in both RMirror VLAN 1 and RMirror VLAN 2. But when the port is the 
source device’s mirroring port in RMirror VLAN 1, it cannot be the reflector port or monitor port in another 
RMirror VLAN.  

The following table shows the rule for a port used in both local port mirroring and remote port mirroring. 
For example, the RMirror mirroring port on the source device can also be used as the mirroring port in 
local port mirroring. But it cannot be the monitor port in local port mirroring.  

16.1.1  Local Port Mirroring
Click Advanced Application > Mirroring in the navigation panel to display the Mirroring screen. Use this 
screen to select a monitor port and specify the traffic flow to be copied to the monitor port. 

Table 67   Port Rules between Different Remote Port Mirroring VLANs
RMIRROR VLAN 1

SOURCE 
MIRRORING 
PORT

SOURCE 
REFLECTOR 
PORT

CONNECTED 
PORT

SOURCE 
CONNECTED 
PORT IN 
SINGLE-
DESTINATION 
RMIRROR

DESTINATION 
MONITOR 
PORT

RMIRROR 
VLAN 2

SOURCE 
MIRRORING 
PORT

Y N Y N N

SOURCE 
REFLECTOR 
PORT

N N N N N

CONNECTED 
PORT

Y N Y Y N

SOURCE 
CONNECTED 
PORT IN 
SINGLE-
DESTINATION 
RMIRROR

N N Y N N

DESTINATION 
MONITOR 
PORT

N N N N N

Table 68   Port Rules between Remote and Local Port Mirroring
RMIRROR

SOURCE 
MIRRORING 
PORT

SOURCE 
REFLECTOR 
PORT

CONNECTED 
PORT

SOURCE 
CONNECTED 
PORT IN SINGLE-
DESTINATION 
RMIRROR

DESTINATION 
MONITOR 
PORT

LOCAL 
PORT 
MIRRORIN
G

MIRRORING 
PORT

Y N Y N N

MONITOR 
PORT

N N N N N
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Figure 140   Advanced Application > Mirroring (Standalone mode) 

Figure 141   Advanced Application > Mirroring (Stacking mode)
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The following table describes the labels in this screen. 

16.1.2  Remote Port Mirroring
Use this screen to create a remote port mirroring (RMirror) VLAN through which the mirrored traffic is 
forwarded.

Click the RMirror link in the Advanced Application > Mirroring screen. The following screen opens.

Figure 142   Advanced Application > Mirroring > RMirror 

Table 69   Advanced Application > Mirroring 
LABEL DESCRIPTION
Active Select this check box to activate port mirroring on the Switch. Clear this check box to disable the 

feature.   

Monitor Port The monitor port is the port you copy the traffic to in order to examine it in more detail without 
interfering with the traffic flow on the original port(s). Type the port number of the monitor port. In 
stacking mode, the first number represents the slot and the second the port number.

Slot 
(Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of the 
Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the second 
field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set the 
common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Mirrored Select this option to mirror the traffic on a port. 

Direction Specify the direction of the traffic to mirror by selecting from the drop-down list box. Choices are 
Egress (outgoing), Ingress (incoming) and Both.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these changes 
if it is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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The following table describes the labels in this screen. 

16.1.3  Source
Use this screen to configure the reflector port and specify the traffic flow to be copied to the monitor 
port when the Switch is the source device in remote port mirroring.

Click the Source link in the RMirror screen. The following screen opens.

Table 70   Advanced Application > Mirroring > RMirror 
LABEL DESCRIPTION
Active Select the option to enable the VLAN.

RMirror VLAN ID Specify the ID number of remote port mirroring (RMirror) VLAN.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

VLAN This field displays the ID number of the RMirror VLAN. Click on the VLAN ID number to change 
the settings.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Active This field displays whether the VLAN is enabled or not.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).
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Figure 143   Advanced Application > Mirroring > RMirror > Source (Standalone mode) 
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Figure 144   Advanced Application > Mirroring > RMirror > Source (Stacking mode) 

The following table describes the labels in this screen. 

Table 71   Advanced Application > Mirroring > RMirror > Source 
LABEL DESCRIPTION
RMirror VLAN ID Select the RMirror VLAN over which the mirrored traffic is forwarded.

Priority Enter the priority of the mirrored traffic.

Reflector Port Select the check box to enable the specified reflector port.

Enter the number of reflector port that adds the RMirror VLAN tag to all mirrored traffic and 
forwards traffic to the connected port(s) in the same RMirror VLAN.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to 
set the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Mirrored Select this option to mirror the traffic on a port. 
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16.1.4  Destination
Use this screen to specify the RMirror VLAN and configure the monitor port when the Switch is the 
destination device in remote port mirroring.

Click the Destination link in the RMirror screen. The following screen opens.

Figure 145   Advanced Application > Mirroring > RMirror > Destination 

The following table describes the labels in this screen. 

Direction Specify the direction of the traffic to mirror by selecting from the drop-down list box. 
Choices are Egress (outgoing), Ingress (incoming) and Both.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

VLAN This field displays the ID number of RMirror VLAN over which the mirrored traffic is 
forwarded.

Priority This field displays the priority of the mirrored traffic.

Mirror Port

Ingress This field displays the number of port(s) on which the incoming traffic is mirrored.

Egress This field displays the number of port(s) on which the outgoing traffic is mirrored.

Both This field displays the number of port(s) on which the incoming and outgoing traffic is 
mirrored.

Reflector Port This field displays whether the reflector port is enabled and the number of reflector port in 
this RMirror VLAN.

Table 71   Advanced Application > Mirroring > RMirror > Source (continued)
LABEL DESCRIPTION

Table 72   Advanced Application > Mirroring > RMirror > Destination 
LABEL DESCRIPTION
RMirror VLAN ID Select the RMirror VLAN over which the mirrored traffic is forwarded.

Monitor Port Specify the port to which you copy the traffic in order to examine it in more detail without 
interfering with the traffic flow on the original port(s). 

Tagging Select whether to add the RMirror VLAN tag to mirrored traffic on the monitor port.
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16.1.5  Connected Port
Use this screen to select the RMirror VLAN and specify the port(s) that helps forward mirrored traffic to 
other connected switches and/or receive mirrored traffic from other connected port in the same RMirror 
VLAN.

Click the Connected Port link in the RMirror screen. The following screen opens.

Figure 146   Advanced Application > Mirroring > RMirror > Connected Port (Standalone mode)

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

VLAN This field displays the ID number of RMirror VLAN over which the mirrored traffic is 
forwarded.

Monitor Port This field displays the number of port that receives the mirrored traffic from the source 
device for analysis.

Tagging This field displays whether the mirrored traffic is tagged with the RMirror VLAN ID.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in 
the table heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to begin configuring this screen afresh.

Table 72   Advanced Application > Mirroring > RMirror > Destination (continued)
LABEL DESCRIPTION
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Figure 147   Advanced Application > Mirroring > RMirror > Connected Port (Stacking mode) 

The following table describes the labels in this screen.  

Table 73   Advanced Application > Mirroring > RMirror > Connected Port 
LABEL DESCRIPTION
RMirror VLAN ID Select the RMirror VLAN over which the mirrored traffic is forwarded.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to 
set the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Connected Port When the Switch is a source device in remote port mirroring, select this option to have the 

port help forward mirrored traffic to the connected port of the intermediate or destination 
device in the same RMirror VLAN.

When the Switch is an intermediate device in remote port mirroring, select this option to 
have the port receive mirrored traffic from the connected source or another intermediate 
device or forward mirrored traffic to the connected destination or another intermediate 
device in the same RMirror VLAN.

When the Switch is a destination device in remote port mirroring, select this option to have 
the port receive mirrored traffic from the connected source or intermediate device in the 
same RMirror VLAN.
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Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the nonvolatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

VLAN This field displays the ID number of port mirroring VLAN over which the mirrored traffic is 
forwarded.

Connected Port This field displays the number of port(s) that helps forward mirrored traffic to other 
connected switches.

Table 73   Advanced Application > Mirroring > RMirror > Connected Port (continued)
LABEL DESCRIPTION
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CHAPTER 17
Link Aggregation

This chapter shows you how to logically aggregate physical links to form one logical, higher-bandwidth 
link.

17.1  Link Aggregation Overview 
Link aggregation (trunking) is the grouping of physical ports into one logical higher-capacity link. You 
may want to trunk ports if for example, it is cheaper to use multiple lower-speed links than to under-utilize 
a high-speed, but more costly, single-port link.

However, the more ports you aggregate then the fewer available ports you have. A trunk group is one 
logical link containing multiple ports.

The beginning port of each trunk group must be physically connected to form a trunk group. 

The Switch supports both static and dynamic link aggregation.

Note: In a properly planned network, it is recommended to implement static link aggregation 
only. This ensures increased network stability and control over the trunk groups on your 
Switch.

See Section 17.6 on page 194 for a static port trunking example.

17.2  Dynamic Link Aggregation 
The Switch adheres to the IEEE 802.3ad standard for static and dynamic (LACP) port trunking.

The Switch supports the link aggregation IEEE802.3ad standard. This standard describes the Link 
Aggregation Control Protocol (LACP), which is a protocol that dynamically creates and manages trunk 
groups. 

When you enable LACP link aggregation on a port, the port can automatically negotiate with the ports 
at the remote end of a link to establish trunk groups. LACP also allows port redundancy, that is, if an 
operational port fails, then one of the “standby” ports become operational without user intervention. 
Please note that: 

• You must connect all ports point-to-point to the same Ethernet switch and configure the ports for 
LACP trunking.

• LACP only works on full-duplex links. 

• All ports in the same trunk group must have the same media type, speed, duplex mode and flow 
control settings. 
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Configure trunk groups or LACP before you connect the Ethernet switch to avoid causing network 
topology loops.

17.2.1  Link Aggregation ID 
LACP aggregation ID consists of the following information. Port Priority and Port Number are 0 as it is the 
aggregator ID for the trunk group, not the individual port.        

17.3  Link Aggregation Status 
Click Advanced Application > Link Aggregation in the navigation panel. The Link Aggregation Status 
screen displays by default. See Section 17.1 on page 186 for more information.

Figure 148   Advanced Application > Link Aggregation Status 

Table 74   Link Aggregation ID: Local Switch
SYSTEM PRIORITY MAC ADDRESS KEY PORT PRIORITY PORT NUMBER
0000 00-00-00-00-00-00 0000 00 0000

Table 75   Link Aggregation ID: Peer Switch
SYSTEM PRIORITY MAC ADDRESS KEY PORT PRIORITY PORT NUMBER
0000 00-00-00-00-00-00 0000 00 0000
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The following table describes the labels in this screen. 

17.4  Link Aggregation Setting 
Click Advanced Application > Link Aggregation > Link Aggregation Setting to display the screen shown 
next. See Section 17.1 on page 186 for more information on link aggregation.

Table 76   Advanced Application > Link Aggregation Status 
LABEL DESCRIPTION
Group ID This field displays the group ID to identify a trunk group, that is, one logical link containing 

multiple ports.

Enabled Port These are the ports you have configured in the Link Aggregation screen to be in the trunk 
group.

The port number(s) displays only when this trunk group is activated and there is a port belonging 
to this group.

Synchronized 
Ports

These are the ports that are currently transmitting data as one logical link in this trunk group.

Aggregator ID Link Aggregator ID consists of the following: system priority, MAC address, key, port priority and 
port number. Refer to Section 17.2.1 on page 187 for more information on this field.

The ID displays only when there is a port belonging to this trunk group and LACP is also enabled 
for this group.

Criteria This shows the outgoing traffic distribution algorithm used in this trunk group. Packets from the 
same source and/or to the same destination are sent over the same link within the trunk. 

src-mac means the Switch distributes traffic based on the packet’s source MAC address. 

dst-mac means the Switch distributes traffic based on the packet’s destination MAC address. 

src-dst-mac means the Switch distributes traffic based on a combination of the packet’s 
source and destination MAC addresses.

src-ip means the Switch distributes traffic based on the packet’s source IP address. 

dst-ip means the Switch distributes traffic based on the packet’s destination IP address. 

src-dst-ip means the Switch distributes traffic based on a combination of the packet’s source 
and destination IP addresses.

Status This field displays how these ports were added to the trunk group. It displays:

• Static - if the ports are configured as static members of a trunk group.
• LACP - if the ports are configured to join a trunk group via LACP. 
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Figure 149   Advanced Application > Link Aggregation > Link Aggregation Setting (Standalone mode) 
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Figure 150   Advanced Application > Link Aggregation > Link Aggregation Setting (Stacking mode) 

The following table describes the labels in this screen. 

Table 77   Advanced Application > Link Aggregation > Link Aggregation Setting 
LABEL DESCRIPTION
Link 
Aggregation 
Setting

This is the only screen you need to configure to enable static link aggregation.

Group ID The field identifies the link aggregation group, that is, one logical link containing multiple ports.

Active Select this option to activate a trunk group.  
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17.5  Link Aggregation Control Protocol   
Click in the Advanced Application > Link Aggregation > Link Aggregation Setting > LACP to display the 
screen shown next. See Section 17.2 on page 186 for more information on dynamic link aggregation.

Criteria Select the outgoing traffic distribution type. Packets from the same source and/or to the same 
destination are sent over the same link within the trunk. By default, the Switch uses the src-dst-
mac distribution type. If the Switch is behind a router, the packet’s destination or source MAC 
address will be changed. In this case, set the Switch to distribute traffic based on its IP address to 
make sure port trunking can work properly.

Select src-mac to distribute traffic based on the packet’s source MAC address. 

Select dst-mac to distribute traffic based on the packet’s destination MAC address. 

Select src-dst-mac to distribute traffic based on a combination of the packet’s source and 
destination MAC addresses.

Select src-ip to distribute traffic based on the packet’s source IP address. 

Select dst-ip to distribute traffic based on the packet’s destination IP address. 

Select src-dst-ip to distribute traffic based on a combination of the packet’s source and 
destination IP addresses.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

Group Select the trunk group to which a port belongs.

Note: When you enable the port security feature on the Switch and configure port 
security settings for a port, you cannot include the port in an active trunk group.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 77   Advanced Application > Link Aggregation > Link Aggregation Setting (continued)
LABEL DESCRIPTION
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Figure 151   Advanced Application > Link Aggregation > Link Aggregation Setting > LACP (Standalone 
mode) 
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Figure 152   Advanced Application > Link Aggregation > Link Aggregation Setting > LACP (Stacking 
mode) 

The following table describes the labels in this screen. 

Table 78   Advanced Application > Link Aggregation > Link Aggregation Setting > LACP 
LABEL DESCRIPTION
Link 
Aggregation 
Control Protocol

Note: Do not configure this screen unless you want to enable dynamic link 
aggregation.

Active Select this checkbox to enable Link Aggregation Control Protocol (LACP). 

System Priority LACP system priority is a number between 1 and 65,535. The switch with the lowest system priority 
(and lowest port number if system priority is the same) becomes the LACP “server”. The LACP 
“server” controls the operation of LACP setup. Enter a number to set the priority of an active port 
using Link Aggregation Control Protocol (LACP). The smaller the number, the higher the priority 
level. 

Group ID The field identifies the link aggregation group, that is, one logical link containing multiple ports.

LACP Active Select this option to enable LACP for a trunk.
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17.6  Static Trunking Example
This example shows you how to create a static port trunk group for ports 2-5. 

1 Make your physical connections - make sure that the ports that you want to belong to the trunk group 
are connected to the same destination. The following figure shows ports 2-5 on switch A connected to 
switch B.

Figure 153   Trunking Example - Physical Connections

2 Configure static trunking - Click Advanced Application > Link Aggregation > Link Aggregation Setting. In 
this screen activate trunk group T1, select the traffic distribution algorithm used by this group and select 
the ports that should belong to this group as shown in the figure below. Click Apply when you are done.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
LACP Timeout Timeout is the time interval between the individual port exchanges of LACP packets in order to 

check that the peer port in the trunk group is still up. If a port does not respond after three tries, 
then it is deemed to be “down” and is removed from the trunk. Set a short timeout (one second) 
for busy trunked links to ensure that disabled ports are removed from the trunk group as soon as 
possible. 

Select either 1 second or 30 seconds.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 78   Advanced Application > Link Aggregation > Link Aggregation Setting > LACP (continued)
LABEL DESCRIPTION
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Figure 154   Trunking Example - Configuration Screen

Your trunk group 1 (T1) configuration is now complete.

example
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CHAPTER 18
Port Authentication

This chapter describes the IEEE 802.1x and MAC authentication methods.

18.1  Port Authentication Overview 
Port authentication is a way to validate access to ports on the Switch to clients based on an external 
server (authentication server). The Switch supports the following methods for port authentication:

• IEEE 802.1x - An authentication server validates access to a port based on a username and password 
provided by the user. At the time of writing, IEEE 802.1x is not supported by all operating systems. See 
your operating system documentation. If your operating system does not support 802.1x, then you 
may need to install 802.1x client software.

• MAC - An authentication server validates access to a port based on the MAC address and password 
of the client.

Both types of authentication use the RADIUS (Remote Authentication Dial In User Service, RFC 2138, 
2139) protocol to validate users. See Section 26.1.2 on page 264 for more information on configuring 
your RADIUS server settings. 

Note: If you enable IEEE 802.1x authentication and MAC authentication on the same port, the 
Switch performs IEEE 802.1x authentication first. If a user fails to authenticate via the IEEE 
802.1x method, then access to the port is denied.

18.1.1  IEEE 802.1x Authentication 
The following figure illustrates how a client connecting to an IEEE 802.1x authentication enabled port 
goes through a validation process. The Switch prompts the client for login information in the form of a 
user name and password after the client responds to its identity request. When the client provides the 
login credentials, the Switch sends an authentication request to a RADIUS server. The RADIUS server 
validates whether this client is allowed access to the port.   
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Figure 155   IEEE 802.1x Authentication Process 

18.1.2  MAC Authentication 
MAC authentication works in a very similar way to IEEE 802.1x authentication. The main difference is that 
the Switch does not prompt the client for login credentials. The login credentials are based on the 
source MAC address of the client connecting to a port on the Switch along with a password configured 
specifically for MAC authentication on the Switch.
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Figure 156   MAC Authentication Process 

18.2  Port Authentication Configuration 
To enable port authentication, first activate the port authentication method(s) you want to use (both on 
the Switch and the port(s)), then configure the RADIUS server settings in the AAA > Radius Server Setup 
screen. 

To activate a port authentication method, click Advanced Application > Port Authentication in the 
navigation panel. Select a port authentication method in the screen that appears.

Figure 157   Advanced Application > Port Authentication 

18.2.1  Activate IEEE 802.1x Security    
Use this screen to activate IEEE 802.1x security. In the Port Authentication screen click 802.1x to display 
the configuration screen as shown. 



Chapter 18 Port Authentication

XGS4600 Series User’s Guide

199

Figure 158   Advanced Application > Port Authentication > 802.1x (Standalone mode) 

Figure 159   Advanced Application > Port Authentication > 802.1x (Stacking mode)
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The following table describes the labels in this screen. 

18.2.2  Guest VLAN 
When 802.1x port authentication is enabled on the Switch and its ports, clients that do not have the 
correct credentials are blocked from using the port(s). You can configure your Switch to have one VLAN 
that acts as a guest VLAN. If you enable the guest VLAN (102 in the example) on a port (2 in the 

Table 79   Advanced Application > Port Authentication > 802.1x 
LABEL DESCRIPTION
Active Select this check box to permit 802.1x authentication on the Switch.

Note: You must first enable 802.1x authentication on the Switch before configuring 
it on each port.

EAPOL flood Select this check box to flood EAPoL packets to all ports in the same VLAN.

EAP over LAN (EAPOL) is a port authentication protocol used in IEEE 802.1x. It is used to 
encapsulate and transmit EAP packets between the supplicant (a client device that requests 
access to the network resources or services) and authenticator (the Switch) directly over the 
LAN. 

Note: EAPOL flood will not take effect when 802.1x authentication is enabled.
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to 
set the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this checkbox to permit 802.1x authentication on this port. You must first allow 802.1x 

authentication on the Switch before configuring it on each port.

Max-Req Specify the number of times the Switch tries to authenticate client(s) before sending 
unresponsive ports to the Guest VLAN.

This is set to 2 by default. That is, the Switch attempts to authenticate a client twice. If the 
client does not respond to the first authentication request, the Switch tries again. If the client 
still does not respond to the second request, the Switch sends the client to the Guest VLAN. 
The client needs to send a new request to be authenticated by the Switch again.

Reauth Specify if a subscriber has to periodically re-enter his or her username and password to stay 
connected to the port.

Reauth-period Specify the length of time required to pass before a client has to re-enter his or her username 
and password to stay connected to the port.

Quiet-period Specify the number of seconds the port remains in the HELD state and rejects further 
authentication requests from the connected client after a failed authentication exchange. 

Tx-period Specify the number of seconds the Switch waits for client’s response before re-sending an 
identity request to the client.

Supp-Timeout Specify the number of seconds the Switch waits for client’s response to a challenge request 
before sending another request.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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example), the user (A in the example) that is not IEEE 802.1x capable or fails to enter the correct 
username and password can still access the port, but traffic from the user is forwarded to the guest 
VLAN. That is, unauthenticated users can have access to limited network resources in the same guest 
VLAN, such as the Internet. The rights granted to the Guest VLAN depends on how the network 
administrator configures switches or routers with the guest network feature.

Figure 160   Guest VLAN Example

Use this screen to enable and assign a guest VLAN to a port. In the Port Authentication > 802.1x screen 
click Guest Vlan to display the configuration screen as shown.

Figure 161   Advanced Application > Port Authentication > 802.1x > Guest VLAN (Standalone mode) 
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Figure 162   Advanced Application > Port Authentication > 802.1x > Guest VLAN (Stacking mode) 

The following table describes the labels in this screen. 

Table 80   Advanced Application > Port Authentication > 802.1x > Guest VLAN 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this checkbox to enable the guest VLAN feature on this port.

Clients that fail authentication are placed in the guest VLAN and can receive limited services.

Guest Vlan A guest VLAN is a pre-configured VLAN on the Switch that allows non-authenticated users to 
access limited network resources through the Switch. You must also enable IEEE 802.1x 
authentication on the Switch and the associated ports. Enter the number that identifies the 
guest VLAN.

Make sure this is a VLAN recognized in your network.

Host-mode Specify how the Switch authenticates users when more than one user connect to the port 
(using a hub).

Select Multi-Host to authenticate only the first user that connects to this port. If the first user 
enters the correct credential, any other users are allowed to access the port without 
authentication. If the first user fails to enter the correct credential, they are all put in the guest 
VLAN. Once the first user who did authentication logs out or disconnects from the port, rest of 
the users are blocked until a user does the authentication process again.

Select Multi-Secure to authenticate each user that connects to this port. 
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18.2.3  Activate MAC Authentication 
Use this screen to activate MAC authentication. In the Port Authentication screen click MAC 
Authentication to display the configuration screen as shown.

Figure 163   Advanced Application > Port Authentication > MAC Authentication (Standalone mode) 

Multi-Secure Num If you set Host-mode to Multi-Secure, specify the maximum number of users (between 1 and 
24) that the Switch will authenticate on this port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 80   Advanced Application > Port Authentication > 802.1x > Guest VLAN (continued)
LABEL DESCRIPTION
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Figure 164   Advanced Application > Port Authentication > MAC Authentication (Stacking mode)  

The following table describes the labels in this screen. 

Table 81   Advanced Application > Port Authentication > MAC Authentication 
LABEL DESCRIPTION
Active Select this check box to permit MAC authentication on the Switch.

Note: You must first enable MAC authentication on the Switch before configuring it 
on each port.

Name Prefix Type the prefix that is appended to all MAC addresses sent to the RADIUS server for 
authentication. You can enter up to 32 printable ASCII characters.

If you leave this field blank, then only the MAC address of the client is forwarded to the RADIUS 
server. 

Delimiter Select the delimiter the RADIUS server uses to separate the pairs in MAC addresses used as the 
account username (and password). You can select Dash (-), Colon (:), or None to use no 
delimiters at all in the MAC address.

Case Select the case (Upper or Lower) the RADIUS server requires for letters in MAC addresses used 
as the account username (and password).

Password Type Select Static to have the Switch send the password you specify below or MAC-Address to use 
the client MAC address as the password.

Password Type the password the Switch sends along with the MAC address of a client for authentication 
with the RADIUS server. You can enter up to 32 printable ASCII characters.
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Timeout Specify the amount of time before the Switch allows a client MAC address that fails 
authentication to try and authenticate again. Maximum time is 3000 seconds.

When a client fails MAC authentication, its MAC address is learned by the MAC address table 
with a status of denied. The timeout period you specify here is the time the MAC address entry 
stays in the MAC address table until it is cleared. If you specify 0 for the timeout value, the 
Switch uses the Aging Time configured in the Switch Setup screen.

Note: If the Aging Time in the Switch Setup screen is set to a lower value, then it 
supersedes this setting. See Section 8.3 on page 80. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to permit MAC authentication on this port. You must first allow MAC 

authentication on the Switch before configuring it on each port.

Trusted-VLAN List Enter the ID number(s) of the trusted VLAN(s) (separated by a comma). If a client’s VLAN ID is 
specified here, the client can access the port and the connected networks without MAC 
authentication.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 81   Advanced Application > Port Authentication > MAC Authentication (continued)
LABEL DESCRIPTION
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CHAPTER 19
Port Security

This chapter shows you how to set up port security.

19.1  About Port Security
Port security allows only packets with dynamically learned MAC addresses and/or configured static 
MAC addresses to pass through a port on the Switch. The Switch can learn up to 32K MAC addresses in 
total with no limit on individual ports other than the sum cannot exceed 32K. 

For maximum port security, enable this feature, disable MAC address learning and configure static MAC 
address(es) for a port. It is not recommended you disable port security together with MAC address 
learning as this will result in many broadcasts. By default, MAC address learning is still enabled even 
though the port security is not activated.

19.2  Port Security Setup 
Click Advanced Application > Port Security in the navigation panel to display the screen as shown. 
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Figure 165   Advanced Application > Port Security (Standalone mode) 
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Figure 166   Advanced Application > Port Security (Stacking mode) 

The following table describes the labels in this screen. 

Table 82   Advanced Application > Port Security 
LABEL DESCRIPTION
Port List Enter the number of the port(s) (separated by a comma) on which you want to enable port 

security and disable MAC address learning. In stacking mode, the first number represents the 
slot and the second the port number. Enter 1/1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 
and port 28 for the Switch in slot 2, for example. After you click MAC freeze, all previously 
learned MAC addresses on the specified port(s) will become static MAC addresses and 
display in the Static MAC Forwarding screen.

MAC freeze Click MAC freeze to have the Switch automatically select the Active check boxes and clear 
the Address Learning check boxes only for the ports specified in the Port list.

Active Select this option to enable port security on the Switch. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some of the settings the same for all ports. Use this row first 
to set the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
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19.3  VLAN MAC Address Limit 
Use this screen to set the MAC address learning limit on per-port and per-VLAN basis. Click VLAN MAC 
Address Limit in the Advanced Application > Port Security screen to display the screen as shown. 

Figure 167   Advanced Application > Port Security > VLAN MAC Address Limit 

The following table describes the labels in this screen. 

Active Select this check box to enable the port security feature on this port. The Switch forwards 
packets whose MAC address(es) is in the MAC address table on this port. Packets with no 
matching MAC address(es) are dropped. 

Clear this check box to disable the port security feature. The Switch forwards all packets on this 
port.

Address Learning MAC address learning reduces outgoing broadcast traffic. For MAC address learning to occur 
on a port, the port itself must be active with address learning enabled.

Limited Number 
of Learned MAC 
Address 

Use this field to limit the number of (dynamic) MAC addresses that may be learned on a port. 
For example, if you set this field to "5" on port 2, then only the devices with these five learned 
MAC addresses may access port 2 at any one time. A sixth device must wait until one of the 
five learned MAC addresses ages out. MAC address aging out time can be set in the Switch 
Setup screen. The valid range is from “0” to “32K”. “0” means this feature is disabled.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 82   Advanced Application > Port Security (continued)
LABEL DESCRIPTION

Table 83   Advanced Application > Port Security > VLAN MAC Address Limit 
LABEL DESCRIPTION
Active Select this option to activate this rule. 

Port Enter the number of the port to which this rule is applied. In stacking mode, the first number 
represents the slot and the second the port number.

VID Enter the VLAN identification number.
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Limit Number Use this field to limit the number of (dynamic) MAC addresses that may be learned on a port in 
a specified VLAN. For example, if you set this field to "5" on port 2, then only the devices with 
these five learned MAC addresses may access port 2 at any one time. A sixth device would 
have to wait until one of the five learned MAC addresses aged out. MAC address aging out 
time can be set in the Switch Setup screen. The valid range is from “0” to “32K”. “0” means this 
feature is disabled.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays the index number of the rule. Click an index number to change the settings. 

Active This field displays Yes when the rule is activated and No when is it deactivated.

Port This field displays the number of the port to which this rule is applied.

VID This is the VLAN ID number to which the port belongs.

Limit Number This is the maximum number of MAC addresses which a port can learn in a VLAN.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected check box(es).

Table 83   Advanced Application > Port Security > VLAN MAC Address Limit (continued)
LABEL DESCRIPTION
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CHAPTER 20
Time Range

This chapter shows you how to set up a time range for time-oriented features on the Switch.

20.1  About Time Range
You can set a time range for time-oriented features such as Classifier ACL (Access Control List) rule 
which categorizes data packets into different network traffic flow. The advantage of the time range 
feature is that it allows you to schedule the active time of configurations. For example, see Section 21.2 
on page 213 to configure the classifier rule with time range.

The time range can be configured in two ways - Absolute and Periodic. Absolute is a fixed time range 
with a start and end time. Periodic is recurrence of a time range and doesn’t have an end time.

20.2  Time Range Setup
Click Advanced Application > Time Range in the navigation panel to display the screen as shown.

Figure 168   Advanced Application > Time Range 
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The following table describes the labels in this screen. 

Table 84   Advanced Application > Time Range 
LABEL DESCRIPTION
Name Type a name for this time range rule.

Type Select a time range type. Absolute is a fixed time range that has a set start and end date. 
Periodic is recurrence of a time range.

Absolute This sets a fixed time range.

Start Specify the year, month, day, hour and minute when the schedule begins.

End Specify the year, month, day, hour and minute when the schedule ends.

Periodic This section is available only when you set Type to Periodic.

Select the first option if you want to define a recurring schedule for a consecutive time period. 
You then select the day of the week, hour and minute when the schedule begins and ends 
respectively.

Select the second option if you want to define a recurring schedule for multiple non-
consecutive time periods. You need to select each day of the week the recurring schedule is 
effective. You also need to specify the hour and minute when the schedule begins and ends 
each day. The schedule begins and ends in the same day.

Add Click Add to save the time range you entered.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays the index number of the rule. Click an index number to change the settings. 

Name This field displays the name of the time range rule.

Type This field displays the type of the schedule.

Range This field displays the time period(s) to which this schedule applies.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).
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CHAPTER 21
Classifier

This chapter introduces and shows you how to configure the packet classifier on the Switch.

21.1  About the Classifier and QoS
Quality of Service (QoS) refers to both a network's ability to deliver data with minimum delay, and the 
networking methods used to control the use of bandwidth. Without QoS, all traffic data is equally likely 
to be dropped when the network is congested. This can cause a reduction in network performance and 
make the network inadequate for time-critical application such as video-on-demand.

A classifier groups traffic into data flows according to specific criteria such as the source address, 
destination address, source port number, destination port number or incoming port number. For 
example, you can configure a classifier to select traffic from the same protocol port (such as Telnet) to 
form a flow.

Configure QoS on the Switch to group and prioritize application traffic and fine-tune network 
performance. Setting up QoS involves two separate steps:

1 Configure classifiers to sort traffic into different flows. 

2 Configure policy rules to define actions to be performed for a classified traffic flow (refer to Chapter 22 
on page 222 to configure policy rules).

You can also configure policy routing to forward a classified traffic flow to a different gateway for cost 
savings and load sharing. See Chapter 45 on page 417 for how to configure policy routing.

21.2  Classifier Status
Use this screen to view the classifiers configured on the Switch and how many times the traffic matches 
the rules.

Click Advanced Application > Classifier in the navigation panel to display the configuration screen as 
shown.
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Figure 169   Advanced Application > Classifier > Classifier Status

The following table describes the labels in this screen.  

21.3  Classifier Configuration
Use the Classifier Configuration screen to define the classifiers. After you define the classifier, you can 
specify actions (or policy) to act upon the traffic that matches the rules. In the Classifier Status screen 
click Classifier Configuration to display the configuration screen as shown.

Table 85   Advanced Application > Classifier > Classifier Status
LABEL DESCRIPTION
Index This field displays the index number of the Classifier rule. 

Active This field displays Yes when the rule is activated and No when it is deactivated.

Weight This field displays the rule’s weight. This is to indicate a rule’s priority when the match order is set to 
manual in the Classifier > Classifier Global Setting screen. 

The higher the number, the higher the rule’s priority.

Name This field displays the name of the Classifier rule.

Match 
Count

This field displays the number of times a rule is applied. It displays '-' if the rule does not have count 
enabled.

Rule This field displays a summary of the classifier rule’s settings.

Any Select Any, then click Clear to clear the matched count for all classifiers.

Classifier Select Classifier, enter a classifier rule name and then click Clear to erase the recorded statistical 
information for that classifier, or select Any to clear statistics for all classifiers.
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Figure 170   Advanced Application > Classifier > Classifier Configuration 

The following table describes the labels in this screen. 

Table 86   Advanced Application > Classifier > Classifier Configuration 
LABEL DESCRIPTION
Active Select this option to enable this rule. 

Name Enter a descriptive name for this rule for identifying purposes. 

Weight Enter a number between 0 and 65535 to specify the rule’s weight. When the match order is in 
manual mode in the Classifier Global Setting screen, a higher weight means a higher priority.
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Log Select this option to have the Switch create a log message when the rule is applied and record 
the number of matched packets in a particular time interval.

Note: Make sure you also enable logging in the Classifier Global Setting screen.
Count Select this option to have the Switch count how many times the rule is applied.

Time Range Select the name of the pre-configured schedule that you want to apply to the rule. The rule will be 
active only at the scheduled date and/or time.

If you select None, the rule will be active all the time.

Ingress Port

Port Type the port number to which the rule should be applied. You may choose one port only or all 
ports (Any).

Trunk Select Any to apply the rule to all trunk groups.

To specify a trunk group, select the second choice and type a trunk group ID.

Packet 
Format

Specify the format of the packet. Choices are All, 802.3 tagged, 802.3 untagged, Ethernet II 
tagged and Ethernet II untagged.

A value of 802.3 indicates that the packets are formatted according to the IEEE 802.3 standards.

A value of Ethernet II indicates that the packets are formatted according to RFC 894, Ethernet II 
encapsulation.

Layer 2

Specify the fields below to configure a layer-2 classifier.

VLAN

VLAN Select Any to classify traffic from any VLAN or select the second option and specify the source 
VLAN ID in the field provided. 

Inner 
VLAN

Select Any to classify traffic from any inner VLAN (the customer's VLAN) or select the second option 
and specify the source VLAN ID in the field provided.

Priority

Priority Select Any to classify traffic from any priority level or select the second option and specify a priority 
level in the field provided.

Inner 
Priority

Select Any to classify traffic from any inner priority level or select the second option and specify a 
priority level in the field provided.

Ethernet Type Select an Ethernet type or select Others and enter the Ethernet type number in hexadecimal 
value. Refer to Table 88 on page 218 for information.

Source

MAC Address Select Any to apply the rule to all MAC addresses. 

To specify a source, select MAC/Mask to enter the source MAC address of the packet in valid 
MAC address format (six hexadecimal character pairs) and type the mask for the specified MAC 
address to determine which bits a packet’s MAC address should match. 

Enter “f” for each bit of the specified MAC address that the traffic’s MAC address should match. 
Enter “0” for the bit(s) of the matched traffic’s MAC address, which can be of any hexadecimal 
character(s). For example, if you set the MAC address to 00:13:49:00:00:00 and the mask to 
ff:ff:ff:00:00:00, a packet with a MAC address of 00:13:49:12:34:56 matches this criteria. If you leave 
the Mask field blank, the Switch automatically sets the mask to ff:ff:ff:ff:ff:ff.

Destination

Table 86   Advanced Application > Classifier > Classifier Configuration (continued)
LABEL DESCRIPTION



Chapter 21 Classifier

XGS4600 Series User’s Guide

217

MAC Address Select Any to apply the rule to all MAC addresses. 

To specify a source, select MAC/Mask to enter the source MAC address of the packet in valid 
MAC address format (six hexadecimal character pairs) and type the mask for the specified MAC 
address to determine which bits a packet’s MAC address should match. 

Enter “f” for each bit of the specified MAC address that the traffic’s MAC address should match. 
Enter “0” for the bit(s) of the matched traffic’s MAC address, which can be of any hexadecimal 
character(s). For example, if you set the MAC address to 00:13:49:00:00:00 and the mask to 
ff:ff:ff:00:00:00, a packet with a MAC address of 00:13:49:12:34:56 matches this criteria. If you leave 
the Mask field blank, the Switch automatically sets the mask to ff:ff:ff:ff:ff:ff.

Layer 3

Specify the fields below to configure a layer-3 classifier. 

IP Packet 
Length

Click Any to classify any size of packet length or manually enter a range of number (from/to) of 
packet size in the field provided.

DSCP IPv4/
IPv6

Select Any to classify traffic from any DSCP or select the second option and specify a DSCP 
(DiffServ Code Point) number between 0 and 63 in the field provided.

Precedence Select Any to classify traffic from any precedence or select the second option and specify an IP 
Precedence (the first 3 bits of the 8-bit ToS field) value between 0 and 7 in the field provided.

ToS Select Any to classify traffic from any ToS or select the second option and specify Type of Service 
(the last 5 bits of the 8-bit ToS field) value between 0 and 255 in the field provided.

IP Protocol Select an IPv4 protocol type or select Other and enter the protocol number in decimal value. 
Refer to Table 89 on page 219 for more information. 

You may select Establish Only for TCP protocol type. This means that the Switch will identify packets 
that initiate or acknowledge (establish) TCP connections. 

IPv6 Next 
Header

Select an IPv6 protocol type or select Other and enter an 8-bit next header in the IPv6 packet. The 
Next Header field is similar to the IPv4 Protocol field. The IPv6 protocol number ranges from 1 to 255.

You may select Establish Only for TCP protocol type. This means that the Switch will identify packets 
that initiate or acknowledge (establish) TCP connections. 

Source

IP Address/
Address Prefix

Enter a source IP address in dotted decimal notation. 

Specify the address prefix by entering the number of ones in the subnet mask. 

Destination

IP Address/
Address Prefix

Enter a destination IP address in dotted decimal notation. 

Specify the address prefix by entering the number of ones in the subnet mask. 

Layer 4

Specify the fields below to configure a layer-4 classifier. 

Source/
Destination 
Socket 
Number

Note: You must select either UDP or TCP in the IP Protocol field before you configure 
the socket numbers.

Select Any to apply the rule to all TCP/UDP protocol port numbers or select the second option 
and enter a TCP/UDP protocol port number.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes to 
the non-volatile memory when you are done configuring.

Table 86   Advanced Application > Classifier > Classifier Configuration (continued)
LABEL DESCRIPTION
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21.3.1  Viewing and Editing Classifier Configuration
To view a summary of the classifier configuration, scroll down to the summary table at the bottom of the 
Classifier screen. To change the settings of a rule, click a number in the Index field.

Note: When two rules conflict with each other, a higher layer rule has priority over a lower 
layer rule.

Figure 171   Advanced Application > Classifier > Classifier Configuration: Summary Table 

The following table describes the labels in this screen. 

The following table shows some other common Ethernet types and the corresponding protocol number. 

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults.

Table 86   Advanced Application > Classifier > Classifier Configuration (continued)
LABEL DESCRIPTION

Table 87   Advanced Application > Classifier > Classifier Configuration: Summary Table 
LABEL DESCRIPTION
Index This field displays the index number of the rule. Click an index number to edit the rule. 

Active This field displays Yes when the rule is activated and No when it is deactivated.

Weight The field displays the priority of the rule when the match order is in manual mode. A higher weight 
means a higher priority.

Name This field displays the descriptive name for this rule. This is for identification purposes only.

Rule This field displays a summary of the classifier rule’s settings.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the table 
heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 88   Common Ethernet Types and Protocol Number
ETHERNET TYPE PROTOCOL NUMBER
IP ETHII 0800

X.75 Internet 0801

NBS Internet 0802

ECMA Internet 0803

Chaosnet 0804

X.25 Level 3 0805

XNS Compat 0807

Banyan Systems 0BAD

BBN Simnet 5208
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Some of the most common IP ports are: 

21.4  Classifier Global Setting Configuration 
Use this screen to configure the match order and enable logging on the Switch. In the Classifier 
Configuration screen click Classifier Global Setting to display the configuration screen as shown.

Figure 172   Advanced Application > Classifier > Classifier Configuration > Classifier Global Setting 

The following table describes the labels in this screen. 

IBM SNA 80D5

AppleTalk AARP 80F3

Table 89   Common IP Ports
PORT NUMBER PORT NAME
21 FTP

23 Telnet

25 SMTP

53 DNS

80 HTTP

110 POP3

Table 88   Common Ethernet Types and Protocol Number
ETHERNET TYPE PROTOCOL NUMBER

Table 90   Advanced Application > Classifier > Classifier Configuration > Classifier Global Setting 
LABEL DESCRIPTION
Match 
Order

Select manual to have classifier rules applied according to the weight of each rule you configured in 
Advanced Application > Classifier > Classifier Configuration. 

Alternatively, select auto to have classifier rules applied according to the layer of the item 
configured in the rule. Layer-4 items have the highest priority, and layer-2 items has the lowest priority. 
For example, you configure a layer-2 item (VLAN ID) in classifier A and configure a layer-3 item 
(source IP address) in classifier B. When an incoming packet matches both classifier rules, classifier B 
has priority over classifier A.

Logging

Active Select this to allow the Switch to create a log when packets match a classifier rule during a defined 
time interval.

Interval Select the length of the time period (in seconds) to count matched packets for a classifier rule. Enter 
an integer from 0-65535. 0 means that no logging is done.
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21.5  Classifier Example
The following screen shows an example of configuring a classifier that identifies all traffic from MAC 
address 00:50:ba:ad:4f:81 on port 2. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these changes if 
it is turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 90   Advanced Application > Classifier > Classifier Configuration > Classifier Global Setting 
LABEL DESCRIPTION
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Figure 173   Classifier: Example 

After you have configured a classifier, you can configure a policy to define action(s) on the classified 
traffic flow. See Chapter 22 on page 222 for information on configuring a policy rule.

example
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CHAPTER 22
Policy Rule

This chapter shows you how to configure policy rules. 

22.1  Policy Rules Overview 
A classifier distinguishes traffic into flows based on the configured criteria (refer to Chapter 21 on page 
213 for more information). A policy rule ensures that a traffic flow gets the requested treatment in the 
network. 

22.1.1  DiffServ 
DiffServ (Differentiated Services) is a class of service (CoS) model that marks packets so that they 
receive specific per-hop treatment at DiffServ-compliant network devices along the route based on the 
application types and traffic flow. Packets are marked with DiffServ Code Points (DSCPs) indicating the 
level of service desired. This allows the intermediary DiffServ-compliant network devices to handle the 
packets differently depending on the code points without the need to negotiate paths or remember 
state information for every flow. In addition, applications do not have to request a particular service or 
give advanced notice of where the traffic is going.

22.1.2  DSCP and Per-Hop Behavior 
DiffServ defines a new DS (Differentiated Services) field to replace the Type of Service (TOS) field in the IP 
header. The DS field contains a 2-bit unused field and a 6-bit DSCP field which can define up to 64 
service levels. The following figure illustrates the DS field. 

DSCP is backward compatible with the three precedence bits in the ToS octet so that non-DiffServ 
compliant, ToS-enabled network device will not conflict with the DSCP mapping.

The DSCP value determines the forwarding behavior, the PHB (Per-Hop Behavior), that each packet 
gets across the DiffServ network. Based on the marking rule, different kinds of traffic can be marked for 
different kinds of forwarding. Resources can then be allocated according to the DSCP values and the 
configured policies.

22.2  Configuring Policy Rules 
You must first configure a classifier in the Classifier screen. Refer to Section 21.2 on page 213 for more 
information. 

DSCP (6 bits) Unused (2 bits)
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Click Advanced Application > Policy Rule in the navigation panel to display the screen as shown.

Figure 174   Advanced Application > Policy Rule 

The following table describes the labels in this screen. 

Table 91   Advanced Application > Policy Rule 
LABEL DESCRIPTION
Active Select this option to enable the policy.

Name Enter a descriptive name for identification purposes. 

Classifier(s) This field displays the active classifier(s) you configure in the Classifier screen. 

Select the classifier(s) to which this policy rule applies. To select more than one classifier, press 
[SHIFT] and select the choices at the same time. 
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Parameters

Set the fields below for this policy. You only have to set the field(s) that is related to the action(s) you configure in 
the Action field. 

General 

Egress Port Type the number of an outgoing port. In stacking mode, the first number represents the slot and 
the second the port number.

Priority Specify a priority level. 

DSCP Specify a DSCP (DiffServ Code Point) number between 0 and 63.

TOS Specify the type of service (TOS) priority level.

Metering You can configure the desired bandwidth available to a traffic flow. Traffic that exceeds the 
maximum bandwidth allocated (in cases where the network is congested) is called out-of-
profile traffic. 

Bandwidth Specify the bandwidth in kilobit per second (Kbps). Enter a number between 1 and 1000000.

Out-of-Profile 
DSCP

Specify a new DSCP number (between 0 and 63) if you want to replace or remark the DSCP 
number for out-of-profile traffic. 

Action

Specify the action(s) the Switch takes on the associated classified traffic flow.   

Forwarding Select No change to forward the packets.

Select Discard the packet to drop the packets.

Select Do not drop the matching frame previously marked for dropping to retain the frames 
that were marked to be dropped before.

Priority Select No change to keep the priority setting of the frames. 

Select Set the packet’s 802.1p priority and send the packet to priority queue to replace the 
packet’s 802.1p priority field with the value you set in the Priority field and put the packets in the 
designated queue.

Select Replace the 802.1p priority field with the IP TOS value and send the packet to priority 
queue to replace the packet’s 802.1p priority field with the value you set in the TOS field and 
put the packets in the designated queue.

Select Replace the 802.1p priority field with the inner 802.1p priority value and send the packet 
to priority queue to replace the packet’s 802.1p priority field with the existing customer priority 
level carried in the frames and put the packets in the designated queue.

Diffserv Select No change to keep the TOS and/or DSCP fields in the packets. 

Select Set the packet’s TOS field to set the TOS field with the value you configure in the TOS 
field. 

Select Replace the IP TOS with the 802.1p priority value to replace the TOS field with the value 
you configure in the Priority field.

Select Set the Diffserv Codepoint field in the frame to set the DSCP field with the value you 
configure in the DSCP field.

Outgoing Select Send the packet to the mirror port to send the packet to the mirror port. 

Select Send the packet to the egress port to send the packet to the egress port. 

Metering Select Enable to activate bandwidth limitation on the traffic flow(s) then set the actions to be 
taken on out-of-profile packets. 

Table 91   Advanced Application > Policy Rule (continued)
LABEL DESCRIPTION
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22.3  Policy Example
The figure below shows an example Policy screen where you configure a policy to limit bandwidth and 
discard out-of-profile traffic on a traffic flow classified using the Example classifier (refer to Section 21.5 
on page 220).

Out-of-profile 
action

Select the action(s) to be performed for out-of-profile traffic. 

Select Drop the packet to discard the out-of-profile traffic. 

Select Change the DSCP value to replace the DSCP field with the value specified in the Out of 
profile DSCP field. 

Select Set Out-Drop Precedence to mark out-of-profile traffic and drop it when network is 
congested.

Select Do not drop the matching frame previously marked for dropping to queue the frames 
that are marked to be dropped.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults.

Index This field displays the policy index number. Click an index number to edit the policy. 

Active This field displays Yes when policy is activated and No when is it deactivated.

Name This field displays the name you have assigned to this policy. 

Classifier(s) This field displays the name(s) of the classifier to which this policy applies.   

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 91   Advanced Application > Policy Rule (continued)
LABEL DESCRIPTION
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Figure 175   Policy Example 

example
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CHAPTER 23
Queuing Method

This chapter introduces the queuing methods supported.

23.1  Queuing Method Overview 
Queuing is used to help solve performance degradation when there is network congestion. Use the 
Queuing Method screen to configure queuing algorithms for outgoing traffic. See also Priority Queue 
Assignment in Switch Setup and 802.1p Priority in Port Setup for related information.

Queuing algorithms allow switches to maintain separate queues for packets from each individual 
source or flow and prevent a source from monopolizing the bandwidth. 

23.1.1  Strictly Priority
Strictly Priority (SP) services queues based on priority only. As traffic comes into the Switch, traffic on the 
highest priority queue, Q7 is transmitted first. When that queue empties, traffic on the next highest-
priority queue, Q6 is transmitted until Q6 empties, and then traffic is transmitted on Q5 and so on. If 
higher priority queues never empty, then traffic on lower priority queues never gets sent. SP does not 
automatically adapt to changing network requirements. 

23.1.2  Weighted Fair Queuing
Weighted Fair Queuing is used to guarantee each queue's minimum bandwidth based on its bandwidth 
weight (the number you configure in the Weight field) when there is traffic congestion. WFQ is activated 
only when a port has more traffic than it can handle. Queues with larger weights get more guaranteed 
bandwidth than queues with smaller weights. By default, the weight for Q0 is 1, for Q1 is 2, for Q2 is 3, and 
so on. The weights range from 1 to 15.

23.1.3  Weighted Round Robin Scheduling (WRR) 
Round Robin Scheduling services queues on a rotating basis and is activated only when a port has more 
traffic than it can handle. A queue is given an amount of bandwidth irrespective of the incoming traffic 
on that port. This queue then moves to the back of the list. The next queue is given an equal amount of 
bandwidth, and then moves to the end of the list; and so on, depending on the number of queues 
being used. This works in a looping fashion until a queue is empty. 

Weighted Round Robin Scheduling (WRR) uses the same algorithm as round robin scheduling, but 
services queues based on their priority and queue weight (the number you configure in the queue 
Weight field) rather than a fixed amount of bandwidth. WRR is activated only when a port has more 
traffic than it can handle. Queues with larger weights get more service than queues with smaller 
weights. This queuing mechanism is highly efficient in that it divides any available bandwidth across the 
different traffic queues and returns to queues that have not yet emptied. 
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23.2  Configuring Queuing 
Click Advanced Application > Queuing Method in the navigation panel.

Figure 176    Advanced Application > Queuing Method (Standalone mode) 
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Figure 177   Advanced Application > Queuing Method (Stacking mode) 

The following table describes the labels in this screen. 

Table 92   Advanced Application > Queuing Method 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Method Select SPQ (Strictly Priority Queuing), WFQ (Weighted Fair Queuing) or WRR (Weighted Round 

Robin).

Strictly Priority services queues based on priority only. When the highest priority queue empties, 
traffic on the next highest-priority queue begins. Q7 has the highest priority and Q0 the lowest.

Weighted Fair Queuing is used to guarantee each queue's minimum bandwidth based on their 
bandwidth weight (the number you configure in the Weight field). Queues with larger weights 
get more guaranteed bandwidth than queues with smaller weights.

Weighted Round Robin Scheduling services queues on a rotating basis based on their queue 
weight (the number you configure in the queue Weight field). Queues with larger weights get 
more service than queues with smaller weights.

Weight

Q0-Q7 

When you select WFQ or WRR enter the queue weight here. Bandwidth is divided across the 
different traffic queues according to their weights. 



 Chapter 23 Queuing Method

XGS4600 Series User’s Guide

230

Hybrid-SPQ 

Lowest-Queue

This field is applicable only when you select WFQ or WRR.

Select a queue (Q0 to Q7) to have the Switch use SPQ to service the subsequent queue(s) after 
and including the specified queue for the 1000Base-T, 1000Base-X and 10 Gigabit Ethernet ports. 
For example, if you select Q5, the Switch services traffic on Q5, Q6 and Q7 using SPQ.

Select None to always use WFQ or WRR.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 92   Advanced Application > Queuing Method (continued)
LABEL DESCRIPTION
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CHAPTER 24
VLAN Stacking

This chapter shows you how to configure VLAN stacking on your Switch. See the chapter on VLANs for 
more background information on Virtual LAN

24.1  VLAN Stacking Overview 
A service provider can use VLAN stacking to allow it to distinguish multiple customers VLANs, even those 
with the same (customer-assigned) VLAN ID, within its network.

Use VLAN stacking to add an outer VLAN tag to the inner IEEE 802.1Q tagged frames that enter the 
network. By tagging the tagged frames (“double-tagged” frames), the service provider can manage 
up to 4,094 VLAN groups with each group containing up to 4,094 customer VLANs. This allows a service 
provider to provide different service, based on specific VLANs, for many different customers. 

A service provider’s customers may require a range of VLANs to handle multiple applications. A service 
provider’s customers can assign their own inner VLAN tags on ports for these applications. The service 
provider can assign an outer VLAN tag for each customer. Therefore, there is no VLAN tag overlap 
among customers, so traffic from different customers is kept separate. 

24.1.1  VLAN Stacking Example
In the following example figure, both A and B are Service Provider’s Network (SPN) customers with VPN 
tunnels between their head offices and branch offices respectively. Both have an identical VLAN tag for 
their VLAN group. The service provider can separate these two VLANs within its network by adding tag 
37 to distinguish customer A and tag 48 to distinguish customer B at edge device 1 and then stripping 
those tags at edge device 2 as the data frames leave the network. 
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Figure 178   VLAN Stacking Example 

24.2  VLAN Stacking Port Roles
Each port can have three VLAN stacking “roles”, Normal, Access Port and Tunnel Port (the latter is for 
Gigabit ports only).

• Select Normal for “regular” (non-VLAN stacking) IEEE 802.1Q frame switching. 

• Select Access Port for ingress ports on the service provider's edge devices (1 and 2 in the VLAN 
stacking example figure). The incoming frame is treated as "untagged", so a second VLAN tag (outer 
VLAN tag) can be added.

Note: Static VLAN Tx Tagging MUST be disabled on a port where you choose Normal or 
Access Port.

• Select Tunnel Port (available for Gigabit ports only) for egress ports at the edge of the service 
provider's network. All VLANs belonging to a customer can be aggregated into a single service 
provider's VLAN (using the outer VLAN tag defined by the Service Provider’s (SP) VLAN ID (VID)).

Note: Static VLAN Tx Tagging MUST be enabled on a port where you choose Tunnel Port.

24.3  VLAN Tag Format
A VLAN tag (service provider VLAN stacking or customer IEEE 802.1Q) consists of the following three 
fields. 

Table 93   VLAN Tag Format
Type Priority VID
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Type is a standard Ethernet type code identifying the frame and indicates that whether the frame 
carries IEEE 802.1Q tag information. SP TPID (Service Provider Tag Protocol Identifier) is the service 
provider VLAN stacking tag type. Many vendors use 0x8100 or 0x9100. 

TPID (Tag Protocol Identifier) is the customer IEEE 802.1Q tag. 

• If the VLAN stacking port role is Access Port, then the Switch adds the SP TPID tag to all incoming 
frames on the service provider's edge devices (1 and 2 in the VLAN stacking example figure).

• If the VLAN stacking port role is Tunnel Port, then the Switch only adds the SP TPID tag to all incoming 
frames on the service provider's edge devices (1 and 2 in the VLAN stacking example figure) that 
have an SP TPID different to the one configured on the Switch. (If an incoming frame’s SP TPID is the 
same as the one configured on the Switch, then the Switch will not add the tag.) 

Priority refers to the IEEE 802.1p standard that allows the service provider to prioritize traffic based on the 
class of service (CoS) the customer has paid for. 

• On the Switch, configure priority level of the inner IEEE 802.1Q tag in the Port Setup screen.

• "0" is the lowest priority level and "7" is the highest.

VID is the VLAN ID. SP VID is the VID for the second (service provider’s) VLAN tag.

24.3.1  Frame Format
The frame format for an untagged Ethernet frame, a single-tagged 802.1Q frame (customer) and a 
“double-tagged” 802.1Q frame (service provider) is shown next.

Configure the fields as highlighted in the Switch VLAN Stacking screen. 

24.4  Configuring VLAN Stacking
Click Advanced Application > VLAN Stacking to display the screen as shown.

Table 94   Single and Double Tagged 802.1Q Frame Format
DA SA Len/Etype Data FCS Untagged 

Ethernet frame

DA SA TPID Priority VID Len/Etype Data FCS IEEE 802.1Q 
customer 
tagged frame

DA SA SPTPID Priority VID TPID Priority VID Len/Etype Data FCS Double-tagged 
frame

Table 95   802.1Q Frame 
DA Destination Address Priority 802.1p Priority

SA Source Address Len/Etype Length and type of Ethernet frame

(SP)TPID (Service Provider) Tag Protocol IDentifier Data Frame data

VID VLAN ID FCS Frame Check Sequence
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Figure 179   Advanced Application > VLAN Stacking (Standalone mode) 

Figure 180   Advanced Application > VLAN Stacking (Stacking mode)
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The following table describes the labels in this screen. 

24.4.1  Port-based Q-in-Q
Port-based Q-in-Q lets the Switch treat all frames received on the same port as the same VLAN flows 
and add the same outer VLAN tag to them, even they have different customer VLAN IDs.

Click Port-based QinQ in the Advanced Application > VLAN Stacking screen to display the screen as 
shown.

Table 96   Advanced Application > VLAN Stacking 
LABEL DESCRIPTION
Active Select this checkbox to enable VLAN stacking on the Switch. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of the 
Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the second 
field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set the 
common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Role Select Normal to have the Switch ignore frames received (or transmitted) on this port with VLAN 

stacking tags. Anything you configure in SPVID and Priority of the Port-based QinQ or the Selective 
QinQ screen are ignored.

Select Access Port to have the Switch add the SP TPID tag to all incoming frames received on this 
port. Select Access Port for ingress ports at the edge of the service provider's network.

Select Tunnel Port (available for Gigabit ports only) for egress ports at the edge of the service 
provider's network. Select Tunnel Port to have the Switch add the Tunnel TPID tag to all outgoing 
frames sent on this port.

In order to support VLAN stacking on a port, the port must be able to allow frames of 1526 Bytes 
(1522 Bytes + 4 Bytes for the second tag) to pass through it.

Tunnel TPID TPID is a standard Ethernet type code identifying the frame and indicates whether the frame 
carries IEEE 802.1Q tag information. Enter a four-digit hexadecimal number from 0000 to FFFF that 
the Switch adds in the outer VLAN tag of the frames sent on the tunnel port(s). The Switch also uses 
this to check if the received frames are double-tagged.

The value of this field is 0x8100 as defined in IEEE 802.1Q. If the Switch needs to communicate with 
other vendors’ devices, they should use the same TPID.

Note: You can define up to four different tunnel TPIDs (including 8100) in this screen at a 
time.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these changes 
if it is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 181   Advanced Application > VLAN Stacking > Port-based QinQ (Standalone mode) 

Figure 182   Advanced Application > VLAN Stacking > Port-based QinQ (Stacking mode) 
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The following table describes the labels in this screen. 

24.4.2  Selective Q-in-Q 
Selective Q-in-Q is VLAN-based. It allows the Switch to add different outer VLAN tags to the incoming 
frames received on one port according to their inner VLAN tags.

Note: Selective Q-in-Q rules are only applied to single-tagged frames received on the access 
ports. If the incoming frames are untagged or single-tagged but received on a tunnel 
port or cannot match any selective Q-in-Q rules, the Switch applies the port-based Q-
in-Q rules to them.

Click Selective QinQ in the Advanced Application > VLAN Stacking screen to display the screen as 
shown.

Figure 183   Advanced Application > VLAN Stacking > Selective QinQ 

Table 97   Advanced Application > VLAN Stacking > Port-based QinQ 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of the 
Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the second 
field is the port number. * means all ports (on the same Switch).

SPVID SPVID is the service provider’s VLAN ID (the outer VLAN tag). Enter the service provider ID (from 1 
to 4094) for frames received on this port. See Chapter 9 on page 112 for more background 
information on VLAN ID.

Priority Select a priority level (from 0 to 7). This is the service provider’s priority level that adds to the frames 
received on this port.

"0" is the lowest priority level and "7" is the highest.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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The following table describes the labels in this screen. 

Table 98   Advanced Application > VLAN Stacking > Selective QinQ 
LABEL DESCRIPTION
Active Check this box to activate this rule. 

Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 

Port The port number identifies the port you are configuring. In stacking mode, the first field is the slot ID 
and the second field is the port number.

CVID Enter a customer VLAN ID (the inner VLAN tag) from 1 to 4094. This is the VLAN tag carried in the 
packets from the subscribers.

SPVID SPVID is the service provider’s VLAN ID (the outer VLAN tag). Enter the service provider ID (from 1 to 
4094) for frames received on this port. See Chapter 9 on page 112 for more background information 
on VLAN ID.

Priority Select a priority level (from 0 to 7). This is the service provider’s priority level that adds to the frames 
received on this port.

"0" is the lowest priority level and "7" is the highest.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes to 
the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Index This is the number of the selective VLAN stacking rule. Click on an index number to change the 
settings.

Active This shows whether this rule is activated or not.

Name This is the descriptive name for this rule. 

Port This is the port number to which this rule is applied. In stacking mode, the first number represents the 
slot and the second the port number.

CVID This is the customer VLAN ID in the incoming packets. 

SPVID This is the service provider’s VLAN ID that adds to the packets from the subscribers.

Priority This is the service provider’s priority level in the packets.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the table 
heading row to select all entries. 

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the check boxes.
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CHAPTER 25
Multicast

This chapter shows you how to configure various multicast features. 

25.1  Multicast Overview 
Traditionally, IP packets are transmitted in one of either two ways - Unicast (1 sender to 1 recipient) or 
Broadcast (1 sender to everybody on the network). Multicast delivers IP packets to just a group of hosts 
on the network. 

IGMP (Internet Group Management Protocol) is a network-layer protocol used to establish membership 
in an IPv4 multicast group - it is not used to carry user data. Refer to RFC 1112, RFC 2236 and RFC 3376 for 
information on IGMP versions 1, 2 and 3 respectively.

The Multicast Listener Discovery (MLD) protocol (defined in RFC 2710) is derived from IPv4's Internet 
Group Management Protocol version 2 (IGMPv2). MLD uses ICMPv6 message types, rather than IGMP 
message types. MLDv1 is similar to IGMPv2 and MLDv2 is similar to IGMPv3. MLD allows an IPv6 switch or 
router to discover the presence of MLD listeners who wish to receive multicast packets and the IP 
addresses of multicast groups the hosts want to join on its network. 

MLD snooping and MLD proxy are analogous to IGMP snooping and IGMP proxy in IPv4. MLD filtering 
controls which multicast groups a port can join.

25.1.1  IP Multicast Addresses
In IPv4, a multicast address allows a device to send packets to a specific group of hosts (multicast 
group) in a different subnetwork. A multicast IP address represents a traffic receiving group, not 
individual receiving devices. IP addresses in the Class D range (224.0.0.0 to 239.255.255.255) are used for 
IP multicasting. Certain IP multicast numbers are reserved by IANA for special purposes (see the IANA 
website for more information). 

In IPv6, multicast addresses provide the same functionality as IPv4 broadcast addresses. Broadcasting is 
not supported in IPv6. A multicast address allows a host to send packets to all hosts in a multicast group. 
Multicast scope allows you to determine the size of the multicast group. A multicast address has a 
predefined prefix of ff00::/8. 

25.1.2  IGMP Filtering
With the IGMP filtering feature, you can control which IGMP groups a subscriber on a port can join. This 
allows you to control the distribution of multicast services (such as content information distribution) 
based on service plans and types of subscription. 

You can set the Switch to filter the multicast group join reports on a per-port basis by configuring an 
IGMP filtering profile and associating the profile to a port.
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25.1.3  IGMP Snooping 
The Switch can passively snoop on IGMP packets transferred between IP multicast routers/switches and 
IP multicast hosts to learn the IP multicast group membership. It checks IGMP packets passing through it, 
picks out the group registration information, and configures multicasting accordingly. IGMP snooping 
allows the Switch to learn multicast groups without you having to manually configure them.

The Switch forwards multicast traffic destined for multicast groups (that it has learned from IGMP 
snooping or that you have manually configured) to ports that are members of that group. IGMP 
snooping generates no additional network traffic, allowing you to significantly reduce multicast traffic 
passing through your Switch.

25.1.4  IGMP Snooping and VLANs
The Switch can perform IGMP snooping on up to 16 VLANs. You can configure the Switch to 
automatically learn multicast group membership of any VLANs. The Switch then performs IGMP 
snooping on the first 16 VLANs that send IGMP packets. This is referred to as auto mode. Alternatively, 
you can specify the VLANs that IGMP snooping should be performed on. This is referred to as fixed 
mode. In fixed mode the Switch does not learn multicast group membership of any VLANs other than 
those explicitly added as an IGMP snooping VLAN. 

25.1.5  MLD Snooping-Proxy
MLD snooping-proxy is a Zyxel-proprietary feature. IPv6 MLD proxy allows only one upstream interface on 
a switch, while MLD snooping-proxy supports more than one upstream port on a switch. The upstream 
port in MLD snooping-proxy can report group changes to a connected multicast router and forward 
MLD messages to other upstream ports. This helps especially when you want to have a network that uses 
STP to provide backup links between switches and also performs MLD snooping and proxy functions. 
MLD snooping-proxy, like MLD proxy, can minimize MLD control messages and allow better network 
performance.

In MLD snooping-proxy, if one upstream port is learned via snooping, all other upstream ports on the 
same device will be added to the same group. If one upstream port requests to leave a group, all other 
upstream ports on the same device will also be removed from the group.

In the following MLD snooping-proxy example, all connected upstream ports (1 ~7) are treated as one 
interface. The connection between ports 8 and 9 is blocked by STP to break the loop. If there is one 
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query from a router (X) or MLD Done or Report message from any upstream port, it will be broadcast to 
all connected upstream ports.  

25.1.6  MLD Messages
A multicast router or switch periodically sends general queries to MLD hosts to update the multicast 
forwarding table. When an MLD host wants to join a multicast group, it sends an MLD Report message 
for that address.

An MLD Done message is similar to an IGMP Leave message. When an MLD host wants to leave a 
multicast group, it can send a Done message to the router or switch. If the leave mode is not set to 
Immediate, the router or switch sends a group-specific query to the port on which the Done message is 
received to determine if other devices connected to this port should remain in the group.

25.2  Multicast Setup 
Use this screen to configure IGMP for IPv4 or MLD for IPv6 and set up multicast VLANs. Click Advanced 
Application > Multicast in the navigation panel. 

Figure 184   Advanced Application > Multicast Setup 



 Chapter 25 Multicast

XGS4600 Series User’s Guide

242

The following table describes the labels in this screen. 

25.3  IPv4 Multicast Status 
Click Advanced Application > Multicast > IPv4 Multicast to display the screen as shown. This screen 
shows the IPv4 multicast group information. See Section 25.1 on page 239 for more information on 
multicasting.

Figure 185   Advanced Application > Multicast > IPv4 Multicast 

The following table describes the labels in this screen. 

25.3.1  IGMP Snooping 
Click the IGMP Snooping link in the Advanced Application > Multicast > IPv4 Multicast screen to display 
the screen as shown. See Section 25.1 on page 239 for more information on multicasting.

Table 99   Advanced Application > Multicast Setup 
LABEL DESCRIPTION
IPv4 Multicast Click the link to open screens where you can configure IGMP snooping and IGMP filtering 

for IPv4.

IPv6 Multicast Click the link to open screens where you can configure MLD snooping and MLD filtering for 
IPv6.

MVR Click the link to open screens where you can create multicast VLANs.

Table 100   Advanced Application > Multicast > IPv4 Multicast 
LABEL DESCRIPTION
Index This is the index number of the entry.

VID This field displays the multicast VLAN ID. 

Port This field displays the port number that belongs to the multicast group. In stacking mode, the 
first number represents the slot and the second is the port number.

Multicast Group This field displays IP multicast group addresses.
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Figure 186   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping (Standalone mode) 

Figure 187   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping (Stacking mode) 
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The following table describes the labels in this screen. 

Table 101   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping 
LABEL DESCRIPTION
IGMP Snooping Use these settings to configure IGMP snooping.

Active Select Active to enable IGMP Snooping to forward group multicast traffic only to ports that 
are members of that group.

Querier Select this option to allow the Switch to send IGMP General Query messages to the VLANs with 
the multicast hosts attached.

Host Timeout Specify the time (from 1 to 16 711 450) in seconds that elapses before the Switch removes an 
IGMP group membership entry if it does not receive report messages from the port.

802.1p Priority Select a priority level (0-7) to which the Switch changes the priority in outgoing IGMP control 
packets. Otherwise, select No-Change to not replace the priority.

IGMP Filtering Select Active to enable IGMP filtering to control which IGMP groups a subscriber on a port 
can join. 

Note: If you enable IGMP filtering, you must create and assign IGMP filtering profiles 
for the ports that you want to allow to join multicast groups.

Unknown Multicast 
Frame

Specify the action to perform when the Switch receives an unknown multicast frame. Select 
Drop to discard the frame(s). Select Flooding to send the frame(s) to all ports. 

Reserved Multicast 
Group

The IP address range of 224.0.0.0 to 224.0.0.255 are reserved for multicasting on the local 
network only. For example, 224.0.0.1 is for all hosts on a local network segment and 224.0.0.9 is 
used to send RIP routing information to all RIP v2 routers on the same network segment. A 
multicast router will not forward a packet with the destination IP address within this range to 
other networks. See the IANA web site for more information. 

The layer-2 multicast MAC addresses used by Cisco layer-2 protocols, 01:00:0C:CC:CC:CC 
and 01:00:0C:CC:CC:CD, are also included in this group.

Specify the action to perform when the Switch receives a frame with a reserved multicast 
address. Select Drop to discard the frame(s). Select Flooding to send the frame(s) to all ports. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first field is the slot ID and the second 
field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Immed. Leave Select this option to set the Switch to remove this port from the multicast tree when an IGMP 

version 2 leave message is received on this port.

Select this option if there is only one host connected to this port. 

Normal Leave   Enter an IGMP normal leave timeout value (from 200 to 6,348,800) in miliseconds. Select this 
option to have the Switch use this timeout to update the forwarding table for the port. 

In normal leave mode, when the Switch receives an IGMP leave message from a host on a 
port, it forwards the message to the multicast router. The multicast router then sends out an 
IGMP Group-Specific Query (GSQ) message to determine whether other hosts connected to 
the port should remain in the specific multicast group. The Switch forwards the query message 
to all hosts connected to the port and waits for IGMP reports from hosts to update the 
forwarding table.

This defines how many seconds the Switch waits for an IGMP report before removing an IGMP 
snooping membership entry when an IGMP leave message is received on this port from a 
host.
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25.3.2  IGMP Snooping VLAN 
Click Advanced Application > Multicast > IPv4 Multicast in the navigation panel. Click the IGMP 
Snooping link and then the IGMP Snooping VLAN link to display the screen as shown. See Section 25.1.4 
on page 240 for more information on IGMP Snooping VLAN.

Fast Leave Enter an IGMP fast leave timeout value (from 200 to 6,348,800) in miliseconds. Select this 
option to have the Switch use this timeout to update the forwarding table for the port.  

In fast leave mode, right after receiving an IGMP leave message from a host on a port, the 
Switch itself sends out an IGMP Group-Specific Query (GSQ) message to determine whether 
other hosts connected to the port should remain in the specific multicast group. This helps 
speed up the leave process.

This defines how many seconds the Switch waits for an IGMP report before removing an IGMP 
snooping membership entry when an IGMP leave message is received on this port from a 
host.

Group Limited Select this option to limit the number of multicast groups this port is allowed to join.

Max Group Num. Enter the number of multicast groups this port is allowed to join. Once a port is registered in the 
specified number of multicast groups, any new IGMP join report frame(s) is dropped on this 
port.

Throttling IGMP throttling controls how the Switch deals with the IGMP reports when the maximum 
number of the IGMP groups a port can join is reached. 

Select Deny to drop any new IGMP join report received on this port until an existing multicast 
forwarding table entry is aged out.

Select Replace to replace an existing entry in the multicast forwarding table with the new 
IGMP report(s) received on this port.

IGMP Filtering 
Profile

Select the name of the IGMP filtering profile to use for this port. Otherwise, select Default to 
prohibit the port from joining any multicast group. 

You can create IGMP filtering profiles in the Multicast > IPv4 Multicast > IGMP Snooping > IGMP 
Filtering Profile screen.

IGMP Querier 
Mode

The Switch treats an IGMP query port as being connected to an IGMP multicast router (or 
server). The Switch forwards IGMP join or leave packets to an IGMP query port. 

Select Auto to have the Switch use the port as an IGMP query port if the port receives IGMP 
query packets.

Select Fixed to have the Switch always use the port as an IGMP query port. Select this when 
you connect an IGMP multicast server to the port.

Select Edge to stop the Switch from using the port as an IGMP query port. The Switch will not 
keep any record of an IGMP router being connected to this port. The Switch does not forward 
IGMP join or leave packets to this port. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 101   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping (continued)
LABEL DESCRIPTION
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Figure 188   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Snooping VLAN 

The following table describes the labels in this screen. 

Table 102   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Snooping VLAN 
LABEL DESCRIPTION
Mode Select auto to have the Switch learn multicast group membership information of any VLANs 

automatically.

Select fixed to have the Switch only learn multicast group membership information of the 
VLAN(s) that you specify below.

In either auto or fixed mode, the Switch can learn up to 16 VLANs (including up to five VLANs 
you configured in the MVR screen). For example, if you have configured one multicast VLAN 
in the MVR screen, you can only specify up to 15 VLANs in this screen.

The Switch drops any IGMP control messages which do not belong to these 16 VLANs.

Note: You must also enable IGMP snooping in the Multicast > IPv4 Multicast > IGMP 
Snooping screen first. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

VLAN Use this section of the screen to add VLANs upon which the Switch is to perform IGMP 
snooping.

Name Enter the descriptive name of the VLAN for identification purposes. 

VID Enter the ID of a static VLAN; the valid range is between 1 and 4094. 

Note: You cannot configure the same VLAN ID as in the MVR screen.
Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the index number of the IGMP snooping VLAN entry in the table.

Name This field displays the descriptive name for this VLAN group. 
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25.3.3  IGMP Filtering Profile 
An IGMP filtering profile specifies a range of multicast groups that clients connected to the Switch are 
able to join. A profile contains a range of multicast IP addresses which you want clients to be able to 
join. Profiles are assigned to ports (in the IGMP Snooping screen). Clients connected to those ports are 
then able to join the multicast groups specified in the profile. Each port can be assigned a single profile. 
A profile can be assigned to multiple ports. 

Click Advanced Application > Multicast > IPv4 Multicast in the navigation panel. Click the IGMP 
Snooping link and then the IGMP Filtering Profile link to display the screen as shown. 

Figure 189   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Filtering Profile 

The following table describes the labels in this screen. 

VID This field displays the ID number of the VLAN group. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Check the entry(ies) that you want to remove, then click the Delete button.

Cancel Click Cancel to clear the check boxes.

Table 102   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Snooping VLAN 
LABEL DESCRIPTION

Table 103   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Filtering Profile 
LABEL DESCRIPTION
Profile Name Enter a descriptive name for the profile for identification purposes. 

To configure additional rule(s) for a profile that you have already added, enter the profile 
name and specify a different IP multicast address range. 

Start Address Type the starting multicast IP address for a range of multicast IP addresses that you want to 
belong to the IGMP filter profile. 

End Address Type the ending multicast IP address for a range of IP addresses that you want to belong to 
the IGMP filter profile.

If you want to add a single multicast IP address, enter it in both the Start Address and End 
Address fields.
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25.4  IPv6 Multicast Status 
Click Advanced Application > Multicast > IPv6 Multicast to display the screen as shown. This screen 
shows the IPv6 multicast group information. See Section 25.1 on page 239 for more information on 
multicasting.

Figure 190   Advanced Application > Multicast > IPv6 Multicast 

The following table describes the labels in this screen. 

25.4.1  MLD Snooping-proxy 
Click the MLD Snooping-proxy link in the Advanced Application > Multicast > IPv6 Multicast screen to 
display the screen as shown. See Section 25.1 on page 239 for more information on multicasting.

Add Click this to create a new entry.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Clear Click Clear to reset the fields to the factory defaults.

Profile Name This field displays the descriptive name of the profile. 

Start Address This field displays the start of the multicast address range. 

End Address This field displays the end of the multicast address range. 

Delete Profile Select a profile’s check box to select a specific profile. Otherwise, select the check box in the 
table heading row to select all profiles. 

Delete Rule Select the check box(es) of the rule(s) that you want to remove from a profile.

Delete To delete the profile(s) and all the accompanying rules, select the profile(s) that you want to 
remove in the Delete Profile column, then click the Delete button. 

To delete a rule(s) from a profile, select the rule(s) that you want to remove in the Delete Rule 
column, then click the Delete button. 

Cancel Click Cancel to clear the Delete Profile/Delete Rule check boxes.

Table 103   Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Filtering Profile 
LABEL DESCRIPTION

Table 104   Advanced Application > Multicast > IPv6 Multicast 
LABEL DESCRIPTION
Index This is the index number of the entry.

VID This field displays the multicast VLAN ID. 

Port This field displays the port number that belongs to the multicast group. In stacking mode, the 
first number represents the slot and the second is the port number.

Multicast Group This field displays IP multicast group addresses.

Group Timeout This field displays the time (in seconds) that elapses before the Switch removes an MLD 
group membership entry if it does not receive report messages from the port.
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Figure 191   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy 

The following table describes the labels in this screen. 

25.4.2  MLD Snooping-proxy VLAN 
Click the MLD Snooping-proxy link and then the VLAN link in the Advanced Application > Multicast > 
IPv6 Multicast screen to display the screen as shown. See Section 25.1 on page 239 for more information 
on multicasting.

Figure 192   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > VLAN 

Table 105   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy 
LABEL DESCRIPTION
MLD Snooping-
proxy

Use these settings to configure MLD snooping-proxy.

Active Select Active to enable MLD snooping-proxy on the Switch to minimize MLD control messages 
and allow better network performance.

802.1p Priority Select a priority level (0-7) to which the Switch changes the priority in outgoing MLD messages. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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The following table describes the labels in this screen. 

Table 106   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > VLAN 
LABEL DESCRIPTION
VID Enter the ID number of the VLAN on which you want to enable MLD snooping-proxy and 

configure related settings.

Upstream

Query Interval Enter the amount of time (in miliseconds) between general query messages sent by the router 
connected to the upstream port. This value should be exactly the same as what’s configured 
in the connected multicast router.

This value is used to calculate the amount of time an MLD snooping membership entry 
(learned only on the upstream port) can remain in the forwarding table. 

When an MLD Report message is received, the Switch sets the timeout period of the entry to 
be T = (QI*RV) + MRD, where T = Timeout, QI = Query Interval, RV = Robustness Variable, and 
MRD = Maximum Response Delay.

Maximum 
Response Delay 

Enter the amount of time (in miliseconds) the router connected to the upstream port waits for 
a response to an MLD general query message. This value should be exactly the same as 
what’s configured in the connected multicast router.

This value is used to calculate the amount of time an MLD snooping membership entry 
(learned only on the upstream port) can remain in the forwarding table. 

When an MLD Report message is received, the Switch sets the timeout period of the entry to 
be T = (QI*RV) + MRD, where T = Timeout, QI = Query Interval, RV = Robustness Variable, and 
MRD = Maximum Response Delay.

When an MLD Done message is received, the Switch sets the entry’s lifetime to be the product 
of Last Member Query Interval and Robustness Variable

Robustness 
Variable 

Enter the number of queries. A multicast address entry (learned only on an upstream port by 
snooping) is removed from the forwarding table when there is no response to the configured 
number of queries sent by the router connected to the upstream port. This value should be 
exactly the same as what’s configured in the connected multicast router.

This value is used to calculate the amount of time an MLD snooping membership entry 
(learned only on the upstream port) can remain in the forwarding table.

Last Member 
Query Interval 

Enter the amount of time (in miliseconds) between the MLD group-specific queries sent by an 
upstream port when an MLD Done message is received. This value should be exactly the 
same as what’s configured in the connected multicast router.

This value is used to calculate the amount of time an MLD snooping membership entry 
(learned only on the upstream port) can remain in the forwarding table after a Done 
message is received.

When an MLD Done message is received, the Switch sets the entry’s lifetime to be the product 
of Last Member Query Interval and Robustness Variable.

Downstream 

Query Interval Enter the amount of time (in miliseconds) between general query messages sent by the 
downstream port.

Maximum 
Response Delay 

Enter the maximum time (in miliseconds) that the Switch waits for a response to a general 
query message sent by the downstream port.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to reset the fields to the factory defaults.
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25.4.3  MLD Snooping-proxy VLAN Port Role Setting 
Click the Port Role Setting link in the Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-
proxy > VLAN screen to display the screen as shown. See Section 25.1 on page 239 for more information 
on multicasting.

Figure 193   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > VLAN > Port Role 
Setting (Standalone mode) 

Index This is the index number of the MLD snooping-proxy VLAN entry in the table. Click on an index 
number to view more details or change the settings.

VID This field displays the ID number of the VLAN group. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry(ies) permanently. 

Cancel Click Cancel to clear the check boxes.

Table 106   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > VLAN 
LABEL DESCRIPTION
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Figure 194   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > VLAN > Port Role 
Setting (Stacking mode) 

The following table describes the labels in this screen. 

Table 107   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > VLAN > Port Role 
Setting 
LABEL DESCRIPTION
MLD Snooping-
proxy VLAN ID

Select the VLAN ID for which you want to configure a port’s MLD snooping-proxy settings.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Port Role A port on the Switch can be either a Downstream port or Upstream port in MLD. A 

downstream port connects to MLD hosts and acts as a multicast router to send MLD queries 
and listen to the MLD host’s Report and Done messages. An upstream port connects to a 
multicast router and works as a host to send Report or Done messages when receiving queries 
from a multicast router.

Otherwise, select None if the port is not joining a multicast group or does not belong to this 
VLAN.
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25.4.4  MLD Snooping-proxy Filtering 
Use this screen to configure the Switch’s MLD filtering settings. Click the MLD Snooping-proxy link and 
then the Filtering link in the Advanced Application > Multicast > IPv6 Multicast screen to display the 
screen as shown. See Section 25.1 on page 239 for more information on multicasting.

Figure 195   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > Filtering 
(Standalone mode) 

Leave Mode Select the leave mode for the specified downstream port(s) in this VLAN.

This specifies whether the Switch removes an MLD snooping membership entry (learned on a 
downstream port) immediately (Immediate) or wait for an MLD report before the leave 
timeout (Normal) or fast leave timeout (Fast) when an MLD leave message is received on this 
port from a host.

Leave Timeout Enter the MLD snooping normal leave timeout (in milliseconds) the Switch uses to update the 
forwarding table for the specified downstream port(s).

This defines how many seconds the Switch waits for an MLD report before removing an MLD 
snooping membership entry (learned on a downstream port) when an MLD Done message is 
received on this port from a host.

Fast Leave 
Timeout 

Enter the fast leave timeout (in milliseconds) for the specified downstream port(s).

This defines how many seconds the Switch waits for an MLD report before removing an MLD 
snooping membership entry (learned on a downstream port) when an MLD Done message is 
received on this port from a host.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Table 107   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > VLAN > Port Role 
Setting (continued)
LABEL DESCRIPTION
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Figure 196   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > Filtering 
(Stacking mode) 

The following table describes the labels in this screen. 

Table 108   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > Filtering 
LABEL DESCRIPTION
Active Select this option to enable MLD filtering on the Switch.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Group Limit Select this option to limit the number of multicast groups this port is allowed to join.

Max Group Num. Enter the number of multicast groups this port is allowed to join. Once a port is registered in the 
specified number of multicast groups, any new MLD Report message is dropped on this port.

Filtering Profile Select the name of the MLD filtering profile to use for this port. Otherwise, select Default to 
prohibit the port from joining any multicast group. 

You can create MLD filtering profiles in the Multicast > IPv6 Multicast > MLD Snooping-proxy > 
Filtering > Filtering Profile screen.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.
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25.4.5  MLD Snooping-proxy Filtering Profile 
Use this screen to create an MLD filtering profile and set the range of the multicast address(es). Click the 
Filtering Profile link in the Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > 
Filtering screen to display the screen as shown. 

Figure 197   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > Filtering > 
Filtering Profile 

The following table describes the labels in this screen. 

Table 109   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > Filtering > 
Filtering Profile 
LABEL DESCRIPTION
Profile Name Enter a descriptive name for the profile for identification purposes. 

To configure additional rule(s) for a profile that you have already added, enter the profile 
name and specify a different IP multicast address range. 

Start Address Type the starting multicast IPv6 address for a range of multicast IPv6 addresses that you want 
to belong to the MLD filtering profile. 

End Address Type the ending multicast IPv6 address for a range of IPv6 addresses that you want to belong 
to the MLD filtering profile.

If you want to add a single multicast IPv6 address, enter it in both the Start Address and End 
Address fields.

Add Click this to create a new entry.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Clear Click Clear to reset the fields to the factory defaults.

Profile Name This field displays the descriptive name of the profile. 

Start Address This field displays the start of the multicast IPv6 address range. 

End Address This field displays the end of the multicast IPv6 address range. 
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25.5  MVR Overview 
Multicast VLAN Registration (MVR) is designed for applications (such as Media-on-Demand (MoD)) that 
use multicast traffic across an Ethernet ring-based service provider network. 

MVR allows one single multicast VLAN to be shared among different subscriber VLANs on the network. 
While isolated in different subscriber VLANs, connected devices can subscribe to and unsubscribe from 
the multicast stream in the multicast VLAN. This improves bandwidth utilization with reduced multicast 
traffic in the subscriber VLANs and simplifies multicast group management. 

MVR only responds to IGMP join and leave control messages from multicast groups that are configured 
under MVR. Join and leave reports from other multicast groups are managed by IGMP snooping. 

The following figure shows a network example. The subscriber VLAN (1, 2 and 3) information is hidden 
from the streaming media server, S. In addition, the multicast VLAN information is only visible to the 
Switch and S. 

Figure 198   MVR Network Example 

25.5.1  Types of MVR Ports
In MVR, a source port is a port on the Switch that can send and receive multicast traffic in a multicast 
VLAN while a receiver port can only receive multicast traffic. Once configured, the Switch maintains a 
forwarding table that matches the multicast stream to the associated multicast group.

25.5.2  MVR Modes
You can set your Switch to operate in either dynamic or compatible mode. 

To delete the profile(s) and all the accompanying rules, select the profile(s) that you want to 
remove, then click the Delete button. You can select the check box in the table heading row 
to select all profiles.

To delete a rule(s) from a profile, select the rule(s) that you want to remove, then click the 
Delete button. 

Delete Click Delete button to permanently delete the entries you selected.

Cancel Click Cancel to clear the check boxes.

Table 109   Advanced Application > Multicast > IPv6 Multicast > MLD Snooping-proxy > Filtering > 
Filtering Profile (continued)
LABEL DESCRIPTION
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In dynamic mode, the Switch sends IGMP leave and join reports to the other multicast devices (such as 
multicast routers or servers) in the multicast VLAN. This allows the multicast devices to update the 
multicast forwarding table to forward or not forward multicast traffic to the receiver ports. 

In compatible mode, the Switch does not send any IGMP reports. In this case, you must manually 
configure the forwarding settings on the multicast devices in the multicast VLAN. 

25.5.3  How MVR Works
The following figure shows a multicast television example where a subscriber device (such as a 
computer) in VLAN 1 receives multicast traffic from the streaming media server, S, via the Switch. 
Multiple subscriber devices can connect through a port configured as the receiver on the Switch. 

When the subscriber selects a television channel, computer A sends an IGMP report to the Switch to join 
the appropriate multicast group. If the IGMP report matches one of the configured MVR multicast group 
addresses on the Switch, an entry is created in the forwarding table on the Switch. This maps the 
subscriber VLAN to the list of forwarding destinations for the specified multicast traffic. 

When the subscriber changes the channel or turns off the computer, an IGMP leave message is sent to 
the Switch to leave the multicast group. The Switch sends a query to VLAN 1 on the receiver port (in this 
case, an uplink port on the Switch). If there is another subscriber device connected to this port in the 
same subscriber VLAN, the receiving port will still be on the list of forwarding destination for the multicast 
traffic. Otherwise, the Switch removes the receiver port from the forwarding table. 

Figure 199   MVR Multicast Television Example 

25.6  General MVR Configuration 
Use the MVR screen to create multicast VLANs and select the receiver port(s) and a source port for 
each multicast VLAN. Click Advanced Application > Multicast > MVR to display the screen as shown 
next. 

Note: You can create up to five multicast VLANs and up to 256 multicast rules on the Switch.

Note: Your Switch automatically creates a static VLAN (with the same VID) when you create 
a multicast VLAN in this screen.
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Figure 200   Advanced Application > Multicast > MVR (Standalone mode) 
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Figure 201   Advanced Application > Multicast > MVR (Stacking mode) 

The following table describes the related labels in this screen. 

Table 110   Advanced Application > Multicast > MVR 
LABEL DESCRIPTION
Active Select this check box to enable MVR to allow one single multicast VLAN to be shared among 

different subscriber VLANs on the network. 

Group Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 

Multicast VLAN ID Enter the VLAN ID (1 to 4094) of the multicast VLAN. 

802.1p Priority Select a priority level (0-7) with which the Switch replaces the priority in outgoing IGMP or MLD 
control packets (belonging to this multicast VLAN). 

Mode Specify the MVR mode on the Switch. Choices are Dynamic and Compatible. 

Select Dynamic to send IGMP reports or MLD messages to all MVR source ports in the multicast 
VLAN. 

Select Compatible to set the Switch not to send IGMP reports or MLD messages. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.
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25.6.1  MVR Group Configuration 
All source ports and receiver ports belonging to a multicast group can receive multicast data sent to this 
multicast group.

Use this screen to configure MVR IP multicast group address(es). Click the Group Configuration link in the 
MVR screen.

Note: A port can belong to more than one multicast VLAN. However, IP multicast group 
addresses in different multicast VLANs cannot overlap.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Source Port Select this option to set this port as the MVR source port that sends and receives multicast 

traffic. All source ports must belong to a single multicast VLAN. 

Receiver Port Select this option to set this port as a receiver port that only receives multicast traffic. 

None Select this option to set the port not to participate in MVR. No MVR multicast traffic is sent or 
received on this port. 

Tagging Select this checkbox if you want the port to tag the VLAN ID in all outgoing frames transmitted. 

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

VLAN This field displays the multicast VLAN ID. Click on an index number to change the settings.

Active This field displays whether the multicast group is enabled or not. 

Name This field displays the descriptive name for this setting. 

Mode This field displays the MVR mode. 

Source Port This field displays the source port number(s). 

Receiver Port This field displays the receiver port number(s). 

802.1p This field displays the priority level.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete To delete a multicast VLAN(s), select the rule(s) that you want to remove, then click the Delete 
button. 

Cancel Click Cancel to clear the check boxes.

Table 110   Advanced Application > Multicast > MVR (continued)
LABEL DESCRIPTION
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Figure 202   Advanced Application > Multicast > MVR > Group Configuration

The following table describes the labels in this screen. 

Table 111   Advanced Application > Multicast > MVR > Group Configuration 
LABEL DESCRIPTION
Multicast VLAN 
ID

Select a multicast VLAN ID (that you configured in the MVR screen) from the drop-down list box. 

Group Name Enter a descriptive name for identification purposes.   

Start Address Enter the starting IP multicast address of the multicast group in dotted decimal notation. 

Refer to Section 25.1.1 on page 239 for more information on IP multicast addresses. 

End Address Enter the ending IP multicast address of the multicast group in dotted decimal notation.

Enter the same IP address as the Start Address field if you want to configure only one IP address 
for a multicast group. 

Refer to Section 25.1.1 on page 239 for more information on IP multicast addresses. 

Add Click this to create a new entry.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

MVLAN This field displays the multicast VLAN ID. 

Group Name This field displays the descriptive name for this setting. 

Start Address This field displays the starting IP address of the multicast group. 

End Address This field displays the ending IP address of the multicast group. 

Delete To delete the profile(s) and all the accompanying rules, select the profile(s) that you want to 
remove, then click the Delete button. You can select the check box in the table heading row to 
select all profiles.

To delete a rule(s) from a profile, select the rule(s) that you want to remove, then click the Delete 
button. 
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25.6.2  MVR Configuration Example
The following figure shows a network example where ports 1, 2 and 3 on the Switch belong to VLAN 1. In 
addition, port 7 belongs to the multicast group with VID 200 to receive multicast traffic (the News and 
Movie channels) from the remote streaming media server, S. Computers A, B and C in VLAN 1 are able 
to receive the traffic. 

Figure 203   MVR Configuration Example 

To configure the MVR settings on the Switch, create a multicast VLAN in the MVR screen and set the 
receiver and source ports. 

Figure 204   MVR Configuration Example 

Delete Select the entry(ies) that you want to remove, then click the Delete button to remove the 
selected entry(ies) from the table.

If you delete a multicast VLAN, all multicast groups in this VLAN will also be removed.

Cancel Select Cancel to clear the checkbox(es) in the table. 

Table 111   Advanced Application > Multicast > MVR > Group Configuration (continued)
LABEL DESCRIPTION

example
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To set the Switch to forward the multicast group traffic to the subscribers, configure multicast group 
settings in the Group Configuration screen. The following figure shows an example where two IPv4 
multicast groups (News and Movie) are configured for the multicast VLAN 200. 

Figure 205   MVR Group Configuration Example  

Figure 206   MVR Group Configuration Example 

example

example



XGS4600 Series User’s Guide

264

CHAPTER 26
AAA

This chapter describes how to configure authentication, authorization and accounting settings on the 
Switch.

26.1  Authentication, Authorization and Accounting (AAA)
Authentication is the process of determining who a user is and validating access to the Switch. The 
Switch can authenticate users who try to log in based on user accounts configured on the Switch itself. 
The Switch can also use an external authentication server to authenticate a large number of users.

Authorization is the process of determining what a user is allowed to do. Different user accounts may 
have higher or lower privilege levels associated with them. For example, user A may have the right to 
create new login accounts on the Switch but user B cannot. The Switch can authorize users based on 
user accounts configured on the Switch itself or it can use an external server to authorize a large number 
of users.

Accounting is the process of recording what a user is doing. The Switch can use an external server to 
track when users log in, log out, execute commands and so on. Accounting can also record system 
related actions such as boot up and shut down times of the Switch.   

The external servers that perform authentication, authorization and accounting functions are known as 
AAA servers. The Switch supports RADIUS (Remote Authentication Dial-In User Service, see Section 26.1.2 
on page 264) and TACACS+ (Terminal Access Controller Access-Control System Plus, see Section 26.1.2 
on page 264) as external authentication, authorization and accounting servers. 

Figure 207   AAA Server 

26.1.1  Local User Accounts
By storing user profiles locally on the Switch, your Switch is able to authenticate and authorize users 
without interacting with a network AAA server. However, there is a limit on the number of users you may 
authenticate in this way (See Chapter 56 on page 512). 

26.1.2  RADIUS and TACACS+ 
RADIUS and TACACS+ are security protocols used to authenticate users by means of an external server 
instead of (or in addition to) an internal device user database that is limited to the memory capacity of 
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the device. In essence, RADIUS and TACACS+ authentication both allow you to validate an unlimited 
number of users from a central location. 

The following table describes some key differences between RADIUS and TACACS+. 

26.2  AAA Screens 
The AAA screens allow you to enable authentication, authorization, accounting or all of them on the 
Switch. First, configure your authentication and accounting server settings (RADIUS, TACACS+ or both) 
and then set up the authentication priority, activate authorization and configure accounting settings.

Click Advanced Application > AAA in the navigation panel to display the screen as shown. 

Figure 208   Advanced Application > AAA

26.2.1  RADIUS Server Setup  
Use this screen to configure your RADIUS server settings. See Section 26.1.2 on page 264 for more 
information on RADIUS servers and Section 26.3 on page 272 for RADIUS attributes utilized by the 
authentication and accounting features on the Switch. Click on the RADIUS Server Setup link in the AAA 
screen to view the screen as shown. 

Table 112   RADIUS vs TACACS+ 
RADIUS TACACS+

Transport Protocol UDP (User Datagram Protocol) TCP (Transmission Control Protocol)

Encryption Encrypts the password sent for 
authentication.

All communication between the client (the 
Switch) and the TACACS server is encrypted.
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Figure 209   Advanced Application > AAA > RADIUS Server Setup 

The following table describes the labels in this screen. 

Table 113   Advanced Application > AAA > RADIUS Server Setup 
LABEL DESCRIPTION
Authentication 
Server

Use this section to configure your RADIUS authentication settings.

Mode This field only applies if you configure multiple RADIUS servers. 

Select index-priority and the Switch tries to authenticate with the first configured RADIUS 
server, if the RADIUS server does not respond then the Switch tries to authenticate with the 
second RADIUS server. 

Select round-robin to alternate between the RADIUS servers that it sends authentication 
requests to.

Timeout Specify the amount of time in seconds that the Switch waits for an authentication request 
response from the RADIUS server. 

If you are using index-priority for your authentication and you are using two RADIUS servers 
then the timeout value is divided between the two RADIUS servers. For example, if you set the 
timeout value to 30 seconds, then the Switch waits for a response from the first RADIUS server 
for 15 seconds and then tries the second RADIUS server. 

Index This is a read-only number representing a RADIUS server entry.

IP Address Enter the IP address of an external RADIUS server in dotted decimal notation.

UDP Port The default port of a RADIUS server for authentication is 1812. You need not change this value 
unless your network administrator instructs you to do so.

Shared Secret Specify a password (up to 32 alphanumeric characters) as the key to be shared between the 
external RADIUS server and the Switch. This key is not sent over the network. This key must be 
the same on the external RADIUS server and the Switch.

Delete Check this box if you want to remove an existing RADIUS server entry from the Switch. This entry 
is deleted when you click Apply.

Accounting 
Server

Use this section to configure your RADIUS accounting server settings. 

Timeout Specify the amount of time in seconds that the Switch waits for an accounting request 
response from the RADIUS accounting server. 
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26.2.2  TACACS+ Server Setup    
Use this screen to configure your TACACS+ server settings. See Section 26.1.2 on page 264 for more 
information on TACACS+ servers. Click on the TACACS+ Server Setup link in the Authentication and 
Accounting screen to view the screen as shown. 

Figure 210   Advanced Application > AAA > TACACS+ Server Setup 

Index This is a read-only number representing a RADIUS accounting server entry.

IP Address Enter the IP address of an external RADIUS accounting server in dotted decimal notation.

UDP Port The default port of a RADIUS accounting server for accounting is 1813. You need not change 
this value unless your network administrator instructs you to do so.

Shared Secret Specify a password (up to 32 alphanumeric characters) as the key to be shared between the 
external RADIUS accounting server and the Switch. This key is not sent over the network. This 
key must be the same on the external RADIUS accounting server and the Switch.

Delete Check this box if you want to remove an existing RADIUS accounting server entry from the 
Switch. This entry is deleted when you click Apply.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 113   Advanced Application > AAA > RADIUS Server Setup (continued)
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

26.2.3  AAA Setup
Use this screen to configure authentication, authorization and accounting settings on the Switch. Click 
on the AAA Setup link in the AAA screen to view the screen as shown. 

Table 114   Advanced Application > AAA > TACACS+ Server Setup 
LABEL DESCRIPTION
Authentication 
Server

Use this section to configure your TACACS+ authentication settings.

Mode This field is only valid if you configure multiple TACACS+ servers. 

Select index-priority and the Switch tries to authenticate with the first configured TACACS+ 
server, if the TACACS+ server does not respond then the Switch tries to authenticate with the 
second TACACS+ server. 

Select round-robin to alternate between the TACACS+ servers that it sends authentication 
requests to.

Timeout Specify the amount of time in seconds that the Switch waits for an authentication request 
response from the TACACS+ server. 

If you are using index-priority for your authentication and you are using two TACACS+ servers 
then the timeout value is divided between the two TACACS+ servers. For example, if you set 
the timeout value to 30 seconds, then the Switch waits for a response from the first TACACS+ 
server for 15 seconds and then tries the second TACACS+ server. 

Index This is a read-only number representing a TACACS+ server entry.

IP Address Enter the IP address of an external TACACS+ server in dotted decimal notation.

TCP Port The default port of a TACACS+ server for authentication is 49. You need not change this value 
unless your network administrator instructs you to do so.

Shared Secret Specify a password (up to 32 alphanumeric characters) as the key to be shared between the 
external TACACS+ server and the Switch. This key is not sent over the network. This key must be 
the same on the external TACACS+ server and the Switch.

Delete Check this box if you want to remove an existing TACACS+ server entry from the Switch. This 
entry is deleted when you click Apply.

Accounting 
Server

Use this section to configure your TACACS+ accounting settings. 

Timeout Specify the amount of time in seconds that the Switch waits for an accounting request 
response from the TACACS+ server. 

Index This is a read-only number representing a TACACS+ accounting server entry.

IP Address Enter the IP address of an external TACACS+ accounting server in dotted decimal notation.

TCP Port The default port of a TACACS+ accounting server is 49. You need not change this value unless 
your network administrator instructs you to do so.

Shared Secret Specify a password (up to 32 alphanumeric characters) as the key to be shared between the 
external TACACS+ accounting server and the Switch. This key is not sent over the network. This 
key must be the same on the external TACACS+ accounting server and the Switch.

Delete Check this box if you want to remove an existing TACACS+ accounting server entry from the 
Switch. This entry is deleted when you click Apply.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 211   Advanced Application > AAA > AAA Setup 

The following table describes the labels in this screen. 

Table 115   Advanced Application > AAA > AAA Setup 
LABEL DESCRIPTION
Authentication Use this section to specify the methods used to authenticate users accessing the Switch.

Privilege Enable These fields specify which database the Switch should use (first, second and third) to 
authenticate access privilege level for administrator accounts (users for Switch 
management). 

Configure the access privilege of accounts via commands (see the Ethernet Switch CLI 
Reference Guide) for local authentication. The TACACS+ and RADIUS are external servers. 
Before you specify the priority, make sure you have set up the corresponding database 
correctly first.

You can specify up to three methods for the Switch to authenticate the access privilege level 
of administrators. The Switch checks the methods in the order you configure them (first 
Method 1, then Method 2 and finally Method 3). You must configure the settings in the Method 
1 field. If you want the Switch to check other sources for access privilege level specify them in 
Method 2 and Method 3 fields.

Select local to have the Switch check the access privilege configured for local 
authentication.

Select radius or tacacs+ to have the Switch check the access privilege via the external 
servers.
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Login These fields specify which database the Switch should use (first, second and third) to 
authenticate administrator accounts (users for Switch management). 

Configure the local user accounts in the Access Control > Logins screen. The TACACS+ and 
RADIUS are external servers. Before you specify the priority, make sure you have set up the 
corresponding database correctly first.

You can specify up to three methods for the Switch to authenticate administrator accounts. 
The Switch checks the methods in the order you configure them (first Method 1, then Method 
2 and finally Method 3). You must configure the settings in the Method 1 field. If you want the 
Switch to check other sources for administrator accounts, specify them in Method 2 and 
Method 3 fields.

Select local to have the Switch check the administrator accounts configured in the Access 
Control > Logins screen.

Select radius to have the Switch check the administrator accounts configured via the RADIUS 
Server. 

Select tacacs+ to have the Switch check the administrator accounts configured via the 
TACACS+ Server. 

Authorization Use this section to configure authorization settings on the Switch.

Type Set whether the Switch provides the following services to a user.

• Exec: Allow an administrator which logs in the Switch through Telnet or SSH to have 
different access privilege level assigned via the external server.

• Dot1x: Allow an IEEE 802.1x client to have different bandwidth limit or VLAN ID assigned 
via the external server.

Active Select this to activate authorization for a specified event types.

Console Select this to allow an administrator which logs in the Switch through the console port to have 
different access privilege level assigned via the external server.

Method Select whether you want to use RADIUS or TACACS+ for authorization of specific types of 
events. 

RADIUS is the only method for IEEE 802.1x authorization.

Accounting Use this section to configure accounting settings on the Switch.

Update Period This is the amount of time in minutes before the Switch sends an update to the accounting 
server. This is only valid if you select the start-stop option for the Exec or Dot1x entries. 

Type The Switch supports the following types of events to be sent to the accounting server(s):

• System - Configure the Switch to send information when the following system events 
occur: system boots up, system shuts down, system accounting is enabled, system 
accounting is disabled 

• Exec - Configure the Switch to send information when an administrator logs in and logs 
out via the console port, telnet or SSH.

• Dot1x - Configure the Switch to send information when an IEEE 802.1x client begins a 
session (authenticates via the Switch), ends a session as well as interim updates of a 
session.

• Commands - Configure the Switch to send information when commands of specified 
privilege level and higher are executed on the Switch.

Active Select this to activate accounting for a specified event types.

Broadcast Select this to have the Switch send accounting information to all configured accounting 
servers at the same time.

If you don’t select this and you have two accounting servers set up, then the Switch sends 
information to the first accounting server and if it doesn’t get a response from the accounting 
server then it tries the second accounting server. 

Table 115   Advanced Application > AAA > AAA Setup (continued)
LABEL DESCRIPTION
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26.2.4  Vendor Specific Attribute
RFC 2865 standard specifies a method for sending vendor-specific information between a RADIUS server 
and a network access device (for example, the Switch). A company can create Vendor Specific 
Attributes (VSAs) to expand the functionality of a RADIUS server. 

The Switch supports VSAs that allow you to perform the following actions based on user authentication:

• Limit bandwidth on incoming or outgoing traffic for the port the user connects to.

• Assign account privilege levels (see the CLI Reference Guide for more information on account 
privilege levels) for the authenticated user.

The VSAs are composed of the following:

• Vendor-ID: An identification number assigned to the company by the IANA (Internet Assigned 
Numbers Authority). Zyxel’s vendor ID is 890.

• Vendor-Type: A vendor specified attribute, identifying the setting you want to modify.

• Vendor-data: A value you want to assign to the setting.

Note: Refer to the documentation that comes with your RADIUS server on how to configure 
VSAs for users authenticating via the RADIUS server. 

Mode The Switch supports two modes of recording login events. Select:

• start-stop - to have the Switch send information to the accounting server when a user 
begins a session, during a user’s session (if it lasts past the Update Period), and when a user 
ends a session.

• stop-only - to have the Switch send information to the accounting server only when a user 
ends a session. 

Method Select whether you want to use RADIUS or TACACS+ for accounting of specific types of 
events. 

TACACS+ is the only method for recording Commands type of event. 

Privilege This field is only configurable for Commands type of event. Select the threshold command 
privilege level for which the Switch should send accounting information. The Switch will send 
accounting information when commands at the level you specify and higher are executed 
on the Switch. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 115   Advanced Application > AAA > AAA Setup (continued)
LABEL DESCRIPTION



 Chapter 26 AAA

XGS4600 Series User’s Guide

272

The following table describes the VSAs supported on the Switch. Note that these attributes only work 
when you enable authorization (see Section 26.2.3 on page 268). 

26.2.5  Tunnel Protocol Attribute 
You can configure tunnel protocol attributes on the RADIUS server (refer to your RADIUS server 
documentation) to assign a port on the Switch to a VLAN based on IEEE 802.1x authentication. The port 
VLAN settings are fixed and untagged. This will also set the port’s VID. The following table describes the 
values you need to configure. Note that these attributes only work when you enable authorization (see 
Section 26.2.3 on page 268). 

26.3  Supported RADIUS Attributes
Remote Authentication Dial-In User Service (RADIUS) attributes are data used to define specific 
authentication, and accounting elements in a user profile, which is stored on the RADIUS server. This 
section lists the RADIUS attributes supported by the Switch.

Table 116   Supported VSAs 

FUNCTION ATTRIBUTE
Ingress Bandwidth 
Assignment   

Vendor-Id = 890 
Vendor-Type = 1 
Vendor-data = ingress rate (Kbps in decimal format) 

Egress Bandwidth 
Assignment

Vendor-Id = 890 
Vendor-Type = 2 
Vendor-data = egress rate (Kbps in decimal format) 

Privilege Assignment Vendor-ID = 890 
Vendor-Type = 3 
Vendor-Data = "shell:priv-lvl=N" 
or

Vendor-ID = 9 (CISCO)
Vendor-Type = 1 (CISCO-AVPAIR)
Vendor-Data = "shell:priv-lvl=N" 
where N is a privilege level (from 0 to 14). 

Note: If you set the privilege level of a login account differently on the RADIUS 
server(s) and the Switch, the user is assigned a privilege level from the 
database (RADIUS or local) the Switch uses first for user authentication. 

Table 117   Supported Tunnel Protocol Attribute

FUNCTION ATTRIBUTE
VLAN Assignment Tunnel-Type = VLAN(13)

Tunnel-Medium-Type = 802(6)
Tunnel-Private-Group-ID = VLAN ID 

Note: You must also create a VLAN with the specified VID on the Switch.

Note: The bolded values in this table are fixed values as defined in RFC 3580. 
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Refer to RFC 2865 for more information about RADIUS attributes used for authentication. Refer to RFC 
2866 and RFC 2869 for RADIUS attributes used for accounting.

This section lists the attributes used by authentication and accounting functions on the Switch. In cases 
where the attribute has a specific format associated with it, the format is specified.

26.3.1  Attributes Used for Authentication 
The following sections list the attributes sent from the Switch to the RADIUS server when performing 
authentication. 

26.3.1.1  Attributes Used for Authenticating Privilege Access
User-Name

- the format of the User-Name attribute is $enab#$, where # is the privilege level (1-14)
User-Password

NAS-Identifier

NAS-IP-Address

26.3.1.2  Attributes Used to Login Users
User-Name

User-Password

NAS-Identifier

NAS-IP-Address

26.3.1.3  Attributes Used by the IEEE 802.1x Authentication 
User-Name

NAS-Identifier

NAS-IP-Address

NAS-Port

NAS-Port-Type
- This value is set to Ethernet(15) on the Switch.

Calling-Station-Id

Frame-MTU

EAP-Message

State

Message-Authenticator

26.3.2  Attributes Used for Accounting
The following sections list the attributes sent from the Switch to the RADIUS server when performing 
authentication. 
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26.3.2.1  Attributes Used for Accounting System Events
NAS-IP-Address

NAS-Identifier

Acct-Status-Type

Acct-Session-ID
- The format of Acct-Session-Id is date+time+8-digit sequential number, for example, 
2007041917210300000001. (date: 2007/04/19, time: 17:21:03, serial number: 00000001)

Acct-Delay-Time

26.3.2.2  Attributes Used for Accounting Exec Events
The attributes are listed in the following table along with the time that they are sent (the difference 
between Console and Telnet/SSH Exec events is that the Telnet/SSH events utilize the Calling-Station-Id 
attribute): 

Table 118   RADIUS Attributes - Exec Events via Console
ATTRIBUTE START INTERIM-UPDATE STOP
User-Name   

NAS-Identifier   

NAS-IP-Address   

Service-Type   

Acct-Status-Type   

Acct-Delay-Time   

Acct-Session-Id   

Acct-Authentic   

Acct-Session-Time  

Acct-Terminate-Cause 

Table 119   RADIUS Attributes - Exec Events via Telnet/SSH
ATTRIBUTE START INTERIM-UPDATE STOP
User-Name   

NAS-Identifier   

NAS-IP-Address   

Service-Type   

Calling-Station-Id   

Acct-Status-Type   

Acct-Delay-Time   

Acct-Session-Id   

Acct-Authentic   

Acct-Session-Time  

Acct-Terminate-Cause 
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26.3.2.3  Attributes Used for Accounting IEEE 802.1x Events 
The attributes are listed in the following table along with the time of the session they are sent: 

Table 120   RADIUS Attributes - Exec Events via Console
ATTRIBUTE START INTERIM-UPDATE STOP
User-Name   

NAS-IP-Address   

NAS-Port   

Class   

Called-Station-Id   

Calling-Station-Id   

NAS-Identifier   

NAS-Port-Type   

Acct-Status-Type   

Acct-Delay-Time   

Acct-Session-Id   

Acct-Authentic   

Acct-Input-Octets  

Acct-Output-Octets  

Acct-Session-Time  

Acct-Input-Packets  

Acct-Output-Packets  

Acct-Terminate-Cause 

Acct-Input-Gigawords  

Acct-Output-Gigawords  
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CHAPTER 27
IP Source Guard

27.1  IP Source Guard Overview
IP source guard uses a binding table to distinguish between authorized and unauthorized DHCP and 
ARP packets in your network. A binding contains these key attributes:

• MAC address

• VLAN ID

• IP address

• Port number

When the Switch receives a DHCP or ARP packet, it looks up the appropriate MAC address, VLAN ID, IP 
address, and port number in the binding table. If there is a binding, the Switch forwards the packet. If 
there is not a binding, the Switch discards the packet.

The Switch builds the binding table by snooping DHCP packets (dynamic bindings) and from information 
provided manually by administrators (static bindings).

IP source guard consists of the following features:

• Static bindings. Use this to create static bindings in the binding table.

• DHCP snooping. Use this to filter unauthorized DHCP packets on the network and to build the binding 
table dynamically.

• ARP inspection. Use this to filter unauthorized ARP packets on the network.

If you want to use dynamic bindings to filter unauthorized ARP packets (typical implementation), you 
have to enable DHCP snooping before you enable ARP inspection.

27.1.1  What You Can Do
• Use the IP Source Guard screen (Section 27.2 on page 278) to look at the current bindings for DHCP 

snooping and ARP inspection.

• Use the IP Source Guard Static Binding screen (Section 27.4 on page 279) to manage static bindings 
for DHCP snooping and ARP inspection.

• Use the DHCP Snooping screen (Section 27.5 on page 282) to look at various statistics about the DHCP 
snooping database. 

• Use this DHCP Snooping Configure screen (Section 27.6 on page 284) to enable DHCP snooping on 
the Switch (not on specific VLAN), specify the VLAN where the default DHCP server is located, and 
configure the DHCP snooping database. 

• Use the DHCP Snooping Port Configure screen (Section 27.6.1 on page 286) to specify whether ports 
are trusted or untrusted ports for DHCP snooping.
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• Use the DHCP Snooping VLAN Configure screen (Section 27.6.2 on page 288) to enable DHCP 
snooping on each VLAN and to specify whether or not the Switch adds DHCP relay agent option 82 
information to DHCP requests that the Switch relays to a DHCP server for each VLAN. 

• Use the DHCP Snooping VLAN Port Configure screen (Section 27.6.3 on page 289) to apply a different 
DHCP option 82 profile to certain ports in a VLAN. 

• Use the ARP Inspection Status screen (Section 27.7 on page 290) to look at the current list of MAC 
address filters that were created because the Switch identified an unauthorized ARP packet.

• Use the ARP Inspection VLAN Status screen (Section 27.7.1 on page 291) to look at various statistics 
about ARP packets in each VLAN.

• Use the ARP Inspection Log Status screen (Section 27.7.2 on page 291) to look at log messages that 
were generated by ARP packets and that have not been sent to the syslog server yet. 

• Use the ARP Inspection Configure screen (Section 27.8 on page 292) to enable ARP inspection on the 
Switch. You can also configure the length of time the Switch stores records of discarded ARP packets 
and global settings for the ARP inspection log.

• Use the ARP Inspection Port Configure screen (Section 27.8.1 on page 294) to specify whether ports 
are trusted or untrusted ports for ARP inspection.

• Use the ARP Inspection VLAN Configure screen (Section 27.8.2 on page 296) to enable ARP inspection 
on each VLAN and to specify when the Switch generates log messages for receiving ARP packets 
from each VLAN.

•  Use the Advanced Application > IP Source Guard > IPv6 Source Binding Status screen (Section 27.10 
on page 297) to look at the current IPv6 dynamic and static bindings and to remove dynamic 
bindings based on IPv6 address and/or IPv6 prefix.

• Use the Advanced Application > IP Source Guard > IPv6 Static Binding Setup screen (Section 27.11 on 
page 298) to manually create an IPv6 source guard binding table and manage IPv6 static bindings.

• Use the Advanced Application > IP Source Guard > IPv6 Source Guard Policy Setup screen (Section 
27.12 on page 300) to have IPv6 source guard forward valid IPv6 addresses and/or IPv6 prefixes that 
are stored in the binding table and allow or block data traffic from all link-local addresses.

• Use the Advanced Application > IP Source Guard > IPv6 Source Guard Port Setup screen (Section 
27.13 on page 301) to apply configured IPv6 source guard policies to the ports you specify. 

• Use the Advanced Application > IP Source Guard > IPv6 Snooping Policy Setup screen (Section 27.14 
on page 303) to dynamically create an IPv6 source guard binding table using a DHCPv6 snooping 
policy. A DHCPv6 snooping policy lets the Switch sniff DHCPv6 packets sent from a DHCPv6 server to a 
DHCPv6 client when it is assigning an IPv6 address.

• Use the Advanced Application > IP Source Guard > IPv6 Snooping VLAN Setup screen (Section 27.15 
on page 304) to enable a DHCPv6 snooping policy on a specific VLAN interface.

• Use the Advanced Application > IP Source Guard > IPv6 DHCP Trust Setup screen (Section 27.16 on 
page 305) to specify which ports are trusted and untrusted for DHCP snooping.

27.1.2   What You Need to Know
The Switch builds the binding table by snooping DHCP packets (dynamic bindings) and from information 
provided manually by administrators (static bindings).

IP source guard consists of the following features:

• Static bindings. Use this to create static bindings in the binding table.

• DHCP snooping. Use this to filter unauthorized DHCP packets on the network and to build the binding 
table dynamically.

• ARP inspection. Use this to filter unauthorized ARP packets on the network.
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If you want to use dynamic bindings to filter unauthorized ARP packets (typical implementation), you 
have to enable DHCP snooping before you enable ARP inspection.

27.2  IP Source Guard
Use this screen to look at the current bindings for DHCP snooping and ARP inspection. Bindings are used 
by DHCP snooping and ARP inspection to distinguish between authorized and unauthorized packets in 
the network. The Switch learns the bindings by snooping DHCP packets (dynamic bindings) and from 
information provided manually by administrators (static bindings). To open this screen, click Advanced 
Application > IP Source Guard.

Figure 212   IP Source Guard  

The following table describes the labels in this screen. 

Table 121   IP Source Guard 
LABEL DESCRIPTION
IPv4 Source Guard 
Setup

Click the link to open screens where you can view and manage static bindings, configure 
DHCP snooping or ARP inspection and look at various statistics.

IPv6 Source Binding 
Status 

Click the link to open a screen where you can view the current IPv6 dynamic and static 
bindings or remove dynamic bindings based on IPv6 address and/or IPv6 prefix.

IPv6 Static Binding 
Setup 

Click the link to open a screen where you can manually create IPv6 source guard static 
binding entries.

IPv6 Source Guard 
Policy Setup 

Click the link to open a screen where you can define policies to have IPv6 source guard 
forward valid addresses and/or prefixes and allow or block data traffic from all link-local 
addresses.

IPv6 Source Guard 
Port Setup 

Click the link to open a screen where you can apply the configured IPv6 source guard 
policy to a port.

IPv6 Snooping Policy 
Setup 

Click the link to open a screen where you can set up DHCPv6 snooping policies for the 
binding table.

IPv6 Snooping VLAN 
Setup 

Click the link to open a screen where you can enable a DHCPv6 snooping policy on a 
specific VLAN interface.

IPv6 DHCP Trust Setup Click the link to open a screen where you can specify which ports are trusted for DHCPv6 
snooping.
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27.3  IPv4 Source Guard Setup 
Use this screen to look at the current bindings for DHCP snooping and ARP inspection. Bindings are used 
by DHCP snooping and ARP inspection to distinguish between authorized and unauthorized packets in 
the network. The Switch learns the bindings by snooping DHCP packets (dynamic bindings) and from 
information provided manually by administrators (static bindings). To open this screen, click Advanced 
Application > IP Source Guard > IPv4 Source Guard Setup.

Figure 213   Advanced Application > IP Source Guard > IPv4 Source Guard Setup 

The following table describes the labels in this screen. 

27.4  IPv4 Source Guard Static Binding
Use this screen to manage static bindings for DHCP snooping and ARP inspection. Static bindings are 
uniquely identified by the MAC address and VLAN ID. Each MAC address and VLAN ID can only be in 
one static binding. If you try to create a static binding with the same MAC address and VLAN ID as an 
existing static binding, the new static binding replaces the original one. To open this screen, click 
Advanced Application > IP Source Guard > IPv4 Source Guard Setup > Static Binding.

Table 122   Advanced Application > IP Source Guard > IPv4 Source Guard Setup 
LABEL DESCRIPTION
Index This field displays a sequential number for each binding.

IP Address This field displays the IP address assigned to the MAC address in the binding.

VLAN This field displays the source VLAN ID in the binding.

MAC Address This field displays the source MAC address in the binding.

Port This field displays the port number in the binding. If this field is blank, the binding applies to all 
ports.

Lease This field displays how many days, hours, minutes, and seconds the binding is valid; for 
example, 2d3h4m5s means the binding is still valid for 2 days, 3 hours, 4 minutes, and 5 
seconds. This field displays infinity if the binding is always valid (for example, a static binding).

Type This field displays how the Switch learned the binding.

static: This binding was learned from information provided manually by an administrator.

dhcp-snooping: This binding was learned by snooping DHCP packets.
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Figure 214   IP Source Guard > IPv4 Source Guard Setup > Static Binding (Standalone mode)

Figure 215   IP Source Guard > IPv4 Source Guard Setup > Static Binding (Stacking mode)
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The following table describes the labels in this screen. 

Table 123   IP Source Guard > IPv4 Source Guard Setup > Static Binding 
LABEL DESCRIPTION
ARP Freeze ARP Freeze allows you to automatically create static bindings from the current ARP 

entries (either dynamically learned or static ARP entries) until the Switch’s binding table is 
full.

Note: The ARP learning mode should be set to ARP-Request in the IP 
Application > ARP Setup > ARP Learning screen before you use the ARP 
Freeze feature.

Condition All - Select this and click ARP Freeze to have the Switch automatically add all the current 
ARP entries to the static bindings table.

Port List - Select this and enter the number of the port(s) (separated by a comma). In 
stacking mode, the first number represents the slot and the second the port number. 
Enter 1/1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 and port 28 for the Switch in slot 
2, for example.

ARP entries learned on the specified port(s) are added to the static bindings table after 
you click ARP Freeze. 

VLAN List - Select this and enter the ID number of the VLAN(s) (separated by a comma). 
ARP entries for the specified VLAN(s) are added to the static bindings table after you 
click ARP Freeze.

Static Binding

IP Address Enter the IP address assigned to the MAC address in the binding.

VLAN Enter the source VLAN ID in the binding.

MAC Address Enter the source MAC address in the binding. If this binding applies to all MAC addresses, 
select Any.

Port Specify the port(s) in the binding. If this binding has one port, select the first radio button 
and enter the port number in the field to the right. In stacking mode, the first field is the 
slot ID and the second field is the port number. If this binding applies to all ports, select 
Any. 

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes 
if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values above based on the last selected static binding or, if not 
applicable, to clear the fields above.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each binding. Click on an index number to 
view more details or change the settings.

IP Address This field displays the IP address assigned to the MAC address in the binding.

VLAN This field displays the source VLAN ID in the binding.

MAC Address This field displays the source MAC address in the binding.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and 
the second field is the port number.

Lease This field displays how long the binding is valid.

Type This field displays how the Switch learned the binding.

static: This binding was learned from information provided manually by an administrator.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in 
the table heading row to select all entries. 



 Chapter 27 IP Source Guard

XGS4600 Series User’s Guide

282

27.5  DHCP Snooping
Use this screen to look at various statistics about the DHCP snooping database. To open this screen, click 
Advanced Application > IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping.

Figure 216   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping

Delete Select the entry(ies) that you want to remove, then click the Delete button to remove 
the selected entry(ies) from the table.

Cancel Click this to clear the check boxes above.

Table 123   IP Source Guard > IPv4 Source Guard Setup > Static Binding (continued)
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

Table 124   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping 
LABEL DESCRIPTION
Database Status

This section displays the current settings for the DHCP snooping database. You can 
configure them in the DHCP Snooping Configure screen. See Section 27.6 on page 284.

Agent URL This field displays the location of the DHCP snooping database.

Write delay timer This field displays how long (in seconds) the Switch tries to complete a specific update 
in the DHCP snooping database before it gives up.

Abort timer This field displays how long (in seconds) the Switch waits to update the DHCP snooping 
database after the current bindings change.

This section displays information about the current update and the next update of the 
DHCP snooping database.

Agent running This field displays the status of the current update or access of the DHCP snooping 
database.

none: The Switch is not accessing the DHCP snooping database.

read: The Switch is loading dynamic bindings from the DHCP snooping database.

write: The Switch is updating the DHCP snooping database.

Delay timer expiry This field displays how much longer (in seconds) the Switch tries to complete the 
current update before it gives up. It displays Not Running if the Switch is not updating 
the DHCP snooping database right now.

Abort timer expiry This field displays when (in seconds) the Switch is going to update the DHCP snooping 
database again. It displays Not Running if the current bindings have not changed since 
the last update.

This section displays information about the last time the Switch updated the DHCP 
snooping database.

Last succeeded time This field displays the last time the Switch updated the DHCP snooping database 
successfully.

Last failed time This field displays the last time the Switch updated the DHCP snooping database 
unsuccessfully.

Last failed reason This field displays the reason the Switch updated the DHCP snooping database 
unsuccessfully.

This section displays historical information about the number of times the Switch 
successfully or unsuccessfully read or updated the DHCP snooping database.

Total attempts This field displays the number of times the Switch has tried to access the DHCP 
snooping database for any reason.

Startup failures This field displays the number of times the Switch could not create or read the DHCP 
snooping database when the Switch started up or a new URL is configured for the 
DHCP snooping database.

Successful transfers This field displays the number of times the Switch read bindings from or updated the 
bindings in the DHCP snooping database successfully.

Failed transfers This field displays the number of times the Switch was unable to read bindings from or 
update the bindings in the DHCP snooping database.

Successful reads This field displays the number of times the Switch read bindings from the DHCP 
snooping database successfully.

Failed reads This field displays the number of times the Switch was unable to read bindings from the 
DHCP snooping database.

Successful writes This field displays the number of times the Switch updated the bindings in the DHCP 
snooping database successfully.
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27.6  DHCP Snooping Configure
Use this screen to enable DHCP snooping on the Switch (not on specific VLAN), specify the VLAN where 
the default DHCP server is located, and configure the DHCP snooping database. The DHCP snooping 
database stores the current bindings on a secure, external TFTP server so that they are still available after 
a restart. To open this screen, click Advanced Application > IP Source Guard > IPv4 Source Guard Setup 
> DHCP Snooping > Configure.

Failed writes This field displays the number of times the Switch was unable to update the bindings in 
the DHCP snooping database.

Database detail

First successful access This field displays the first time the Switch accessed the DHCP snooping database for 
any reason.

Last ignored bindings 
counters

This section displays the number of times and the reasons the Switch ignored bindings 
the last time it read bindings from the DHCP binding database. You can clear these 
counters by restarting the Switch or using CLI commands. See the Ethernet Switch CLI 
Reference Guide.

Binding collisions This field displays the number of bindings the Switch ignored because the Switch 
already had a binding with the same MAC address and VLAN ID.

Invalid interfaces This field displays the number of bindings the Switch ignored because the port number 
was a trusted interface or does not exist anymore.

Parse failures This field displays the number of bindings the Switch ignored because the Switch was 
unable to understand the binding in the DHCP binding database.

Expired leases This field displays the number of bindings the Switch ignored because the lease time 
had already expired.

Unsupported vlans This field displays the number of bindings the Switch ignored because the VLAN ID does 
not exist anymore.

Last ignored time This field displays the last time the Switch ignored any bindings for any reason from the 
DHCP binding database.

Total ignored bindings 
counters

This section displays the reasons the Switch has ignored bindings any time it read 
bindings from the DHCP binding database. You can clear these counters by restarting 
the Switch or using CLI commands. See the Ethernet Switch CLI Reference Guide.

Binding collisions This field displays the number of bindings the Switch has ignored because the Switch 
already had a binding with the same MAC address and VLAN ID.

Invalid interfaces This field displays the number of bindings the Switch has ignored because the port 
number was a trusted interface or does not exist anymore.

Parse failures This field displays the number of bindings the Switch has ignored because the Switch 
was unable to understand the binding in the DHCP binding database.

Expired leases This field displays the number of bindings the Switch has ignored because the lease 
time had already expired.

Unsupported vlans This field displays the number of bindings the Switch has ignored because the VLAN ID 
does not exist anymore.

Table 124   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping (continued)
LABEL DESCRIPTION
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Figure 217   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure

The following table describes the labels in this screen. 

Table 125   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure 
LABEL DESCRIPTION
Active Select this to enable DHCP snooping on the Switch. You still have to enable DHCP snooping 

on specific VLAN and specify trusted ports.

Note: The Switch will drop all DHCP requests if you enable DHCP snooping and 
there are no trusted ports.

DHCP Vlan Select a VLAN ID if you want the Switch to forward DHCP packets to DHCP servers on a 
specific VLAN.

Note: You have to enable DHCP snooping on the DHCP VLAN too.

You can select an option 82 profile in the DHCP Snooping VLAN Configure screen (Section 
27.6.2 on page 288) to help the DHCP servers distinguish between DHCP requests from 
different VLAN.

Select Disable if you do not want the Switch to forward DHCP packets to a specific VLAN.

Database If Timeout interval is greater than Write delay interval, it is possible that the next update is 
scheduled to occur before the current update has finished successfully or timed out. In this 
case, the Switch waits to start the next update until it completes the current one.

Agent URL Enter the location of the DHCP snooping database. The location should be expressed like 
this: tftp://{domain name or IP address}/directory, if applicable/file name; for example, 
tftp://192.168.10.1/database.txt.

Timeout interval Enter how long (10-65535 seconds) the Switch tries to complete a specific update in the 
DHCP snooping database before it gives up.

Write delay 
interval

Enter how long (10-65535 seconds) the Switch waits to update the DHCP snooping 
database the first time the current bindings change after an update. Once the next 
update is scheduled, additional changes in current bindings are automatically included in 
the next update.



 Chapter 27 IP Source Guard

XGS4600 Series User’s Guide

286

27.6.1  DHCP Snooping Port Configure
Use this screen to specify whether ports are trusted or untrusted ports for DHCP snooping. 

Note: The Switch will drop all DHCP requests if you enable DHCP snooping and there are no 
trusted ports.

You can also specify the maximum number for DHCP packets that each port (trusted or untrusted) can 
receive each second. To open this screen, click Advanced Application > IP Source Guard > IPv4 Source 
Guard Setup > DHCP Snooping > Configure > Port.

Figure 218   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure> Port 
(Standalone mode) 

Renew DHCP 
Snooping URL

Enter the location of a DHCP snooping database, and click Renew if you want the Switch to 
load it. You can use this to load dynamic bindings from a different DHCP snooping 
database than the one specified in Agent URL.

When the Switch loads dynamic bindings from a DHCP snooping database, it does not 
discard the current dynamic bindings first. If there is a conflict, the Switch keeps the 
dynamic binding in volatile memory and updates the Binding collisions counter in the DHCP 
Snooping screen (Section 27.5 on page 282).

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.

Table 125   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure (continued)
LABEL DESCRIPTION
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Figure 219   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure> Port (Stacking 
mode) 

The following table describes the labels in this screen. 

Table 126   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure > Port 
LABEL DESCRIPTION
Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot number 

of the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number. * means all ports (on the same Switch).

Server Trusted state Select whether this port is a trusted port (Trusted) or an untrusted port (Untrusted).

Trusted ports are connected to DHCP servers or other switches, and the Switch discards 
DHCP packets from trusted ports only if the rate at which DHCP packets arrive is too high.

Untrusted ports are connected to subscribers, and the Switch discards DHCP packets from 
untrusted ports in the following situations:

• The packet is a DHCP server packet (for example, OFFER, ACK, or NACK).
• The source MAC address and source IP address in the packet do not match any of the 

current bindings.
• The packet is a RELEASE or DECLINE packet, and the source MAC address and source 

port do not match any of the current bindings.
• The rate at which DHCP packets arrive is too high.

Rate (pps) Specify the maximum number for DHCP packets (1-2048) that the Switch receives from 
each port each second. The Switch discards any additional DHCP packets. Enter 0 to 
disable this limit, which is recommended for trusted ports.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.



 Chapter 27 IP Source Guard

XGS4600 Series User’s Guide

288

27.6.2  DHCP Snooping VLAN Configure
Use this screen to enable DHCP snooping on each VLAN and to specify whether or not the Switch adds 
DHCP relay agent option 82 information (Chapter 51 on page 461) to DHCP requests that the Switch 
relays to a DHCP server for each VLAN. To open this screen, click Advanced Application > IP Source 
Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure > VLAN.

Figure 220   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure > VLAN

The following table describes the labels in this screen. 

Table 127   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure > VLAN 
LABEL DESCRIPTION
VLAN Search by VID Specify the VLANs you want to manage in the section below. Use a comma (,) to separate 

individual VLANs or a dash (-) to indicates a range of VLANs. For example, “3,4” or “3-9”.

Search Click this to display the specified range of VLANs in the section below.

VID This field displays the VLAN ID of each VLAN in the range specified above. If you configure 
the * VLAN, the settings are applied to all VLANs.

Enabled Select Yes to enable DHCP snooping on the VLAN. You still have to enable DHCP snooping 
on the Switch and specify trusted ports.

Note: The Switch will drop all DHCP requests if you enable DHCP snooping and 
there are no trusted ports.

Option 82 Profile Select a pre-defined DHCP option 82 profile that the Switch applies to all ports in the 
specified VLAN(s). The Switch adds the information (such as slot number, port number, VLAN 
ID and/or system name) specified in the profile to DHCP requests that it broadcasts to the 
DHCP VLAN, if specified, or VLAN. You can specify the DHCP VLAN in the DHCP Snooping 
Configure screen (see Section 27.6 on page 284).

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.

Change Pages Click Previous or Next to show the previous/next screen if all status information cannot be 
seen in one screen.
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27.6.3  DHCP Snooping VLAN Port Configure
Use this screen to apply a different DHCP option 82 profile to certain ports in a VLAN. To open this screen, 
click Advanced Application > IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure 
> VLAN > Port.

Figure 221   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure > VLAN > Port 

The following table describes the labels in this screen. 

Table 128   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure > VLAN > Port 
LABEL DESCRIPTION
VID Enter the ID number of the VLAN you want to configure here.

Port Enter the number of port(s) to which you want to apply the specified DHCP option 82 profile.

You can enter multiple ports separated by (no space) comma (,) or hyphen (-) for a range. 
For example, enter “3-5” for ports 3, 4, and 5. Enter “3,5,7” for ports 3, 5, and 7.

In stacking mode, the first number represents the slot and the second the port number. Enter 
1/1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 and port 28 for the Switch in slot 2, for 
example.

Option 82 Profile Select a pre-defined DHCP option 82 profile that the Switch applies to the specified port(s) in 
this VLAN. The Switch adds the information (such as slot number, port number, VLAN ID and/
or system name) specified in the profile to DHCP requests that it broadcasts to the DHCP 
VLAN, if specified, or VLAN. You can specify the DHCP VLAN in the DHCP Snooping Configure 
screen (see Section 27.6 on page 284).

Note: The profile you select here has priority over the one you select in the DHCP 
Snooping > Configure > VLAN screen.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it 
is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values above based on the last selected entry or, if not applicable, to 
clear the fields above.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change the 
settings. 

VID This field displays the VLAN to which the port(s) belongs.

Port This field displays the port(s) to which the Switch applies the settings. In stacking mode, the 
first number represents the slot and the second the port number.

Profile Name This field displays the DHCP option 82 profile that the Switch applies to the port(s).



 Chapter 27 IP Source Guard

XGS4600 Series User’s Guide

290

27.7  ARP Inspection Status
Use this screen to look at the current list of MAC address filters that were created because the Switch 
identified an unauthorized ARP packet. When the Switch identifies an unauthorized ARP packet, it 
automatically creates a MAC address filter to block traffic from the source MAC address and source 
VLAN ID of the unauthorized ARP packet. To open this screen, click Advanced Application > IP Source 
Guard > IPv4 Source Guard Setup > ARP Inspection.

Figure 222   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection Status

The following table describes the labels in this screen. 

Delete Select the entry(ies) that you want to remove in the Delete column, then click the Delete 
button to remove the selected entry(ies) from the table.

Cancel Click this to clear the Delete check boxes above.

Table 128   IP Source Guard > IPv4 Source Guard Setup > DHCP Snooping > Configure > VLAN > Port 
LABEL DESCRIPTION

Table 129   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection Status 
LABEL DESCRIPTION
Total number of 
filters

This field displays the current number of MAC address filters that were created because the 
Switch identified unauthorized ARP packets.

Index This field displays a sequential number for each MAC address filter.

MAC Address This field displays the source MAC address in the MAC address filter.

VID This field displays the source VLAN ID in the MAC address filter.

Port This field displays the source port of the discarded ARP packet. In stacking mode, the first 
field is the slot ID and the second field is the port number.

Expiry (sec) This field displays how long (in seconds) the MAC address filter remains in the Switch. You 
can also delete the record manually (Delete).

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click this to remove the selected entries.

Cancel Click this to clear the Delete check boxes above.

Change Pages Click Previous Page or Next Page to show the previous/next screen if all status information 
cannot be seen in one screen.
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27.7.1  ARP Inspection VLAN Status
Use this screen to look at various statistics about ARP packets in each VLAN. To open this screen, click 
Advanced Application > IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > VLAN Status.

Figure 223   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > VLAN Status

The following table describes the labels in this screen. 

27.7.2  ARP Inspection Log Status
Use this screen to look at log messages that were generated by ARP packets and that have not been 
sent to the syslog server yet. To open this screen, click Advanced Application > IP Source Guard > IPv4 
Source Guard Setup > ARP Inspection > Log Status.

Table 130   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > VLAN Status
LABEL DESCRIPTION
VLAN Search by VID Specify the VLANs you want to view in the section below. Use a comma (,) to separate 

individual VLANs or a dash (-) to indicates a range of VLANs. For example, “3,4” or “3-9”.

Search Click this to display the specified range of VLANs in the section below.

The Number of VLAN This is the number of VLANs that match the searching criteria and display in the list below.

This field displays only when you use the Search button to look for certain VLANs.

VID This field displays the VLAN ID of each VLAN in the range specified above.

Received This field displays the total number of ARP packets received from the VLAN since the Switch 
last restarted.

Request This field displays the total number of ARP Request packets received from the VLAN since 
the Switch last restarted.

Reply This field displays the total number of ARP Reply packets received from the VLAN since the 
Switch last restarted.

Forwarded This field displays the total number of ARP packets the Switch forwarded for the VLAN since 
the Switch last restarted.

Dropped This field displays the total number of ARP packets the Switch discarded for the VLAN since 
the Switch last restarted.

Change Pages Click Previous or Next to show the previous/next screen if all status information cannot be 
seen in one screen.
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Figure 224   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Log Status

The following table describes the labels in this screen. 

27.8  ARP Inspection Configure
Use this screen to enable ARP inspection on the Switch. You can also configure the length of time the 
Switch stores records of discarded ARP packets and global settings for the ARP inspection log. To open 

Table 131   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Log Status 
LABEL DESCRIPTION
Clearing log status table Click Apply to remove all the log messages that were generated by ARP packets and 

that have not been sent to the syslog server yet.

Total number of logs This field displays the number of log messages that were generated by ARP packets 
and that have not been sent to the syslog server yet. If one or more log messages are 
dropped due to unavailable buffer, there is an entry called overflow with the current 
number of dropped log messages.

Index This field displays a sequential number for each log message.

Port This field displays the source port of the ARP packet. In stacking mode, the first field is 
the slot ID and the second field is the port number.

VID This field displays the source VLAN ID of the ARP packet.

Sender Mac This field displays the source MAC address of the ARP packet.

Sender IP This field displays the source IP address of the ARP packet.

Num Pkts This field displays the number of ARP packets that were consolidated into this log 
message. The Switch consolidates identical log messages generated by ARP packets 
in the log consolidation interval into one log message. You can configure this interval in 
the ARP Inspection Configure screen. See Section 27.8 on page 292.

Reason This field displays the reason the log message was generated.

dhcp deny: An ARP packet was discarded because it violated a dynamic binding with 
the same MAC address and VLAN ID.

static deny: An ARP packet was discarded because it violated a static binding with the 
same MAC address and VLAN ID.

deny: An ARP packet was discarded because there were no bindings with the same 
MAC address and VLAN ID.

dhcp permit: An ARP packet was forwarded because it matched a dynamic binding.

static permit: An ARP packet was forwarded because it matched a static binding.

In the ARP Inspection VLAN Configure screen, you can configure the Switch to 
generate log messages when ARP packets are discarded or forwarded based on the 
VLAN ID of the ARP packet. See Section 27.8.2 on page 296.

Time This field displays when the log message was generated.
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this screen, click Advanced Application > IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > 
Configure.

Figure 225   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure

The following table describes the labels in this screen. 

Table 132   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure 
LABEL DESCRIPTION
Active Select this to enable ARP inspection on the Switch. You still have to enable ARP inspection 

on specific VLAN and specify trusted ports.

Filter Aging Time

Filter aging time This setting has no effect on existing MAC address filters.

Enter how long (1-2147483647 seconds) the MAC address filter remains in the Switch after 
the Switch identifies an unauthorized ARP packet. The Switch automatically deletes the 
MAC address filter afterwards. Type 0 if you want the MAC address filter to be permanent.

Log Profile

Log buffer size Enter the maximum number (1-1024) of log messages that were generated by ARP packets 
and have not been sent to the syslog server yet. Make sure this number is appropriate for 
the specified Syslog rate and Log interval.

If the number of log messages in the Switch exceeds this number, the Switch stops recording 
log messages and simply starts counting the number of entries that were dropped due to 
unavailable buffer. Click Clearing log status table in the ARP Inspection Log Status screen to 
clear the log and reset this counter. See Section 27.7.2 on page 291.

Syslog rate Type the maximum number of syslog messages the Switch can send to the syslog server in 
one batch. This number is expressed as a rate because the batch frequency is determined 
by the Log Interval. You must configure the syslog server (Chapter 58 on page 539) to use 
this. Enter 0 if you do not want the Switch to send log messages generated by ARP packets 
to the syslog server.

The relationship between Syslog rate and Log interval is illustrated in the following examples:

• 4 invalid ARP packets per second, Syslog rate is 5, Log interval is 1: the Switch sends 4 
syslog messages every second.

• 6 invalid ARP packets per second, Syslog rate is 5, Log interval is 2: the Switch sends 5 
syslog messages every 2 seconds.

Log interval Type how often (1-86400 seconds) the Switch sends a batch of syslog messages to the syslog 
server. Enter 0 if you want the Switch to send syslog messages immediately. See Syslog rate 
for an example of the relationship between Syslog rate and Log interval.
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27.8.1  ARP Inspection Port Configure
Use this screen to specify whether ports are trusted or untrusted ports for ARP inspection. You can also 
specify the maximum rate at which the Switch receives ARP packets on each untrusted port. To open 
this screen, click Advanced Application > IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > 
Configure > Port.

Figure 226   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure > Port (Standalone 
mode)

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.

Table 132   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure (continued)
LABEL DESCRIPTION
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Figure 227   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure > Port (Stacking 
mode)

The following table describes the labels in this screen. 

Table 133   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure > Port 
LABEL DESCRIPTION
Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 

number of the Switch in a stack.

Port This field displays the port number. In stacking mode, the first field is the slot ID and the 
second field is the port number. * means all ports (on the same Switch).

Trusted State Select whether this port is a trusted port (Trusted) or an untrusted port (Untrusted).

The Switch does not discard ARP packets on trusted ports for any reason.

The Switch discards ARP packets on untrusted ports in the following situations:

• The sender’s information in the ARP packet does not match any of the current 
bindings.

• The rate at which ARP packets arrive is too high. You can specify the maximum rate 
at which ARP packets can arrive on untrusted ports.

Limit Rate and Burst Interval settings have no effect on trusted ports.

Rate (pps) Specify the maximum rate (1-2048 packets per second) at which the Switch receives ARP 
packets from each port. The Switch discards any additional ARP packets. Enter 0 to 
disable this limit.

Burst interval (seconds) The burst interval is the length of time over which the rate of ARP packets is monitored for 
each port. For example, if the Rate is 15 pps and the burst interval is 1 second, then the 
Switch accepts a maximum of 15 ARP packets in every one-second interval. If the burst 
interval is 5 seconds, then the Switch accepts a maximum of 75 ARP packets in every five-
second interval.

Enter the length (1-15 seconds) of the burst interval.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel 
to save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.
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27.8.2  ARP Inspection VLAN Configure
Use this screen to enable ARP inspection on each VLAN and to specify when the Switch generates log 
messages for receiving ARP packets from each VLAN. To open this screen, click Advanced Application 
> IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure > VLAN.

Figure 228   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure > VLAN

The following table describes the labels in this screen. 

Table 134   IP Source Guard > IPv4 Source Guard Setup > ARP Inspection > Configure > VLAN 
LABEL DESCRIPTION
VLAN Search by 
VID

Specify the VLANs you want to manage in the section below. Use a comma (,) to separate 
individual VLANs or a dash (-) to indicates a range of VLANs. For example, “3,4” or “3-9”.

Search Click this to display the specified range of VLANs in the section below.

The Number of 
VLAN

This is the number of VLANs that match the searching criteria and display in the list below.

This field displays only when you use the Search button to look for certain VLANs.

VID This field displays the VLAN ID of each VLAN in the range specified above. If you configure the 
* VLAN, the settings are applied to all VLANs.

Enabled Select Yes to enable ARP inspection on the VLAN. Select No to disable ARP inspection on the 
VLAN.

Log Specify when the Switch generates log messages for receiving ARP packets from the VLAN.

None: The Switch does not generate any log messages when it receives an ARP packet from 
the VLAN.

Deny: The Switch generates log messages when it discards an ARP packet from the VLAN.

Permit: The Switch generates log messages when it forwards an ARP packet from the VLAN.

All: The Switch generates log messages every time it receives an ARP packet from the VLAN.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.

Change Pages Click Previous or Next to show the previous/next screen if all status information cannot be seen 
in one screen.
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27.9  IPv6 Source Guard Overview 
The purpose of IPv6 source guard is to distinguish between authorized and unauthorized users by  using 
a binding table that validates the source of IPv6 traffic. The binding table can be manually created or 
be learned through Dynamic Host Configuration Protocol version 6 snooping (DHCPv6 snooping). IPv6 
source guard can deny IPv6 traffic from an unknown source. The IPv6 source guard binding table 
includes:

• IPv6 address

• IPv6 prefix

• VLAN ID

• Port number

• MAC address 

Enable IPv6 source guard on a port for the Switch to check incoming IPv6 packets on that port. A 
packet is allowed when it matches any entry in the IPSG binding table. If a user tries to send IPv6 packets 
to the Switch that do not match an entry in the IPSG binding table, the Switch will drop these packets. 
The Switch forwards matching traffic normally. The IPv6 source guard related screens are available in 
standalone mode.

27.10  IPv6 Source Binding Status 
Use this screen to look at the current IPv6 dynamic and static bindings and to remove dynamic bindings 
based on IPv6 address and/or IPv6 prefix. Bindings are used to distinguish between authorized and 
unauthorized packets in the network. The Switch learns the bindings by snooping DHCP packets 
(dynamic bindings) and from information provided manually by administrators (static bindings). To open 
this screen, click Advanced Application > IP Source Guard > IPv6 Source Binding Status.

Figure 229   Advanced Application > IP Source Guard > IPv6 Source Binding Status 
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The following table describes the labels in this screen. 

27.11  IPv6 Static Binding Setup 
Use this screen to manually create an IPv6 source guard binding table entry and manage IPv6 static 
bindings. Static bindings are uniquely identified by the source IPv6 address / prefix. Each source IPv6 
address / prefix can only be in one static binding. If you try to create a static binding with the same 
source IPv6 address / prefix as an existing static binding, the new static binding replaces the original 
one. To open this screen, click Advanced Application > IP Source Guard > IPv6 Static Binding Setup.

Table 135   Advanced Application > IP Source Guard > IPv6 Source Binding Status 
LABEL DESCRIPTION
Clear Dynamic 
Source Binding

Specify how you want the Switch to remove dynamic IPv6 source binding entries when you 
click Flush.

• Select All to remove all of the dynamic entries from the IPv6 source binding table.
• Select IPv6 Address and enter an IPv6 address to remove the dynamic entries snooped 

with the specified IPv6 address.
• Select IPv6 Prefix and enter a Prefix address to remove the dynamic entries snooped with 

the specified Prefix address.

Flush Click this to remove dynamic IPv6 source binding entries according to your selections.

Cancel Click this to reset the values above based or if not applicable, to clear the fields above.

Index This field displays a sequential number for each binding.

Source Address This field displays the source IP address in the binding. If the entry is blank, this field will not be 
checked in the binding.

MAC Address This field displays the source MAC address in the binding. If the entry is blank, this field will not 
be checked in the binding.

VLAN This field displays the source VLAN ID in the binding. If the entry is blank, this field will not be 
checked in the binding.

Port This field displays the port number in the binding. If this field is blank, the binding applies to all 
ports.

Lease This field displays how many days, hours, minutes, and seconds the binding is valid; for 
example, 2d3h4m5s means the binding is still valid for 2 days, 3 hours, 4 minutes, and 5 
seconds. This field displays infinity if the binding is always valid (for example, a static binding).

Type This field displays how the Switch learned the binding.

S: This static binding was learned from information provided manually by an administrator.

DH: This dhcp-snooping binding was learned by snooping DHCP packets.
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Figure 230   Advanced Application > IP Source Guard > IPv6 Static Binding Setup (Standalone mode)

Figure 231   Advanced Application > IP Source Guard > IPv6 Static Binding Setup (Stacking mode)

The following table describes the labels in this screen. 

Table 136   Advanced Application > IP Source Guard > IPv6 Static Binding Setup 
LABEL DESCRIPTION
IPv6 Static Binding

Source Address Enter the IPv6 address or IPv6 prefix and prefix length in the binding.

MAC Address Enter the source MAC address in the binding. If this binding doesn’t check this field, select 
Any.

Note: You cannot choose Any for all three of MAC Address, VLAN and Port. You must fill in at 
least one.

VLAN Enter the source VLAN ID in the binding. If this binding doesn’t check this field, select Any.

Port Specify the port(s) in the binding. If this binding has one port, select the first radio button and 
enter the port number in the field to the right. In stacking mode, the first field is the slot ID and 
the second field is the port number. If this binding applies to all ports, select Any.

Add Click this to create the specified static binding or to update an existing one.



 Chapter 27 IP Source Guard

XGS4600 Series User’s Guide

300

27.12  IPv6 Source Guard Policy Setup 
Use this screen to have IPv6 source guard forward valid IPv6 addresses and/or IPv6 prefixes that are 
stored in the binding table and allow or block data traffic from all link-local addresses. To open this 
screen, click Advanced Application > IP Source Guard > IPv6 Source Guard Policy Setup.

• If you select Validate Address and not Validate Prefix, traffic for a binding entry that matches a IPv6 
address and VLAN ID, port number, and MAC address will be forwarded. If this binding entry is a IPv6 
prefix, the traffic will be denied.

• If you select Validate Prefix and not Validate Address, traffic for a binding entry that matches a IPv6 
prefix and VLAN ID, port number, and MAC address will be forwarded. If this binding entry is a IPv6 
address, the traffic will be denied.

• If you select both Validate Prefix and Validate Address then traffic matching either IPv6 address or 
prefix will be forwarded.

Figure 232   Advanced Application > IP Source Guard > IPv6 Source Guard Policy Setup 

Cancel Click this to reset the values above based  or if not applicable, to clear the fields above.

Clear Click this to clear the fields above.

Index This field displays a sequential number for each binding.

Source Address This field displays the IPv6 address or IPv6 prefix and prefix length in the binding.

MAC Address This field displays the source MAC address in the binding. If the entry is blank, this field will not 
be checked in the binding.

VLAN This field displays the source VLAN ID in the binding. If the entry is blank, this field will not be 
checked in the binding.

Port This field displays the port number in the binding. If this field is blank, the binding applies to all 
ports.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Select an entry checkbox and click Delete to remove the specified entry.

Cancel Click this to clear the Delete check boxes above.

Table 136   Advanced Application > IP Source Guard > IPv6 Static Binding Setup 
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

27.13  IPv6 Source Guard Port Setup 
Use this screen to apply configured IPv6 source guard policies to ports you specify. Use port * to apply a 
policy to all ports. To open this screen, click Advanced Application > IP Source Guard > IPv6 Source 
Guard Port Setup. 

Table 137   Advanced Application > IP Source Guard > IPv6 Source Guard Policy Setup 
LABEL DESCRIPTION
Name Enter a descriptive name for identification purposes for this IPv6 source guard policy.

Validate Address Select Validate Address to have IPv6 source guard forward valid addresses that are stored in 
the binding table. 

Validate Prefix Select Validate Prefix to have IPv6 source guard forward valid prefixes that are stored in the 
binding table. 

Link Local Select Permit to allow data traffic from all link-local addresses; otherwise leave the setting at 
Deny. A link-local address is an IPv6 unicast address that can be automatically configured on 
any interface using the link-local prefix FE80::/10 and the interface identifier in the modified 
EUI-64 format.

Add Click this to create the IPv6 source guard policy or to update an existing one.

Cancel Click this to reset the values above or if not applicable, to clear the fields above.

Clear Click this to clear the fields above.

Index This field displays a sequential number for each policy.

Name This field displays the descriptive name for identification purposes for this IPv6 source guard 
policy.

Validate Address This field displays the Validate Address status for this IPv6 source guard policy.

Validate Prefix This field displays the Validate Prefix status for this IPv6 source guard policy.

Link Local This field displays the Link Local traffic status for this IPv6 source guard policy. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Select an entry checkbox and click Delete to remove the specified entry.

Cancel Click this to clear the Delete check boxes above.
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Figure 233   Advanced Application > IP Source Guard > IPv6 Source Guard Port Setup (Standalone 
mode)

Figure 234   Advanced Application > IP Source Guard > IPv6 Source Guard Port Setup (Stacking mode)

The following table describes the labels in this screen. 

Table 138   Advanced Application > IP Source Guard > IPv6 Source Guard Port Setup 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. If you configure the * port, the settings are applied to all of 
the ports.

Policy Name Select an IPv6 source guard policy that the Switch will apply to this port.
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27.14  IPv6 Snooping Policy Setup 
Use this screen to dynamically create an IPv6 source guard binding table using a DHCPv6 snooping 
policy. A DHCPv6 snooping policy lets the Switch sniff DHCPv6 packets sent from a DHCPv6 server to a 
DHCPv6 client when it is assigning an IPv6 address. When a DHCPv6 client successfully gets a valid IPv6 
address, DHCPv6 snooping builds the binding table dynamically. To open this screen, click Advanced 
Application > IP Source Guard > IPv6 Snooping Policy Setup.

Note: If you do not select Protocol and Prefix Glean, then the Switch cannot perform DHCPv6 
snooping.

Figure 235   Advanced Application > IP Source Guard > IPv6 Snooping Policy Setup

The following table describes the labels in this screen. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.

Table 138   Advanced Application > IP Source Guard > IPv6 Source Guard Port Setup 
LABEL DESCRIPTION

Table 139   Advanced Application > IP Source Guard > IPv6 Snooping Policy Setup 
LABEL DESCRIPTION
Name Enter a descriptive name for identification purposes for this IPv6 snooping policy.

Protocol Select DHCP to let the Switch sniff DHCPv6 packets sent from a DHCPv6 server to a DHCPv6 
client.

Prefix Glean Select this to learn the IPv6 prefix and length from DHCPv6 sniffed packets.

Limit Address 
Count

This is the number of IPv6 addresses and prefixes learned using the IPv6 snooping policy. 

Note: The maximum limit address count is the maximum size of the IPv6 source 
guard binding table. At the time of writing, it is 50 for the GS2210 Switch series. 
See the product datasheet for the latest specifications.

Add Click this to create the IPv6 source guard policy or to update an existing one.

Cancel Click this to reset the values above or if not applicable, to clear the fields above.

Clear Click this to clear the fields above.
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27.15  IPv6 Snooping VLAN Setup 
Use this screen to enable a DHCPv6 snooping policy on a specific VLAN interface. To open this screen, 
click Advanced Application > IP Source Guard > IPv6 Snooping VLAN Setup.

Figure 236   Advanced Application > IP Source Guard > IPv6 Snooping VLAN Setup

The following table describes the labels in this screen. 

Index This field displays a sequential number for each IPv6 snooping policy.

Name This field displays the descriptive name for identification purposes for this IPv6 source guard 
policy.

Protocol This field displays the protocols learned from DHCPv6 sniffed packets.

Prefix Glean This field displays the IPv6 prefixes learned from DHCPv6 sniffed packets.

Limit Address 
Count 

This field displays the number of IPv6 addresses and prefixes learned using the IPv6 snooping 
policy. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Select an entry checkbox and click Delete to remove the specified entry.

Cancel Click this to clear the Delete check boxes above.

Table 139   Advanced Application > IP Source Guard > IPv6 Snooping Policy Setup 
LABEL DESCRIPTION

Table 140   Advanced Application > IP Source Guard > IPv6 Snooping VLAN Setup 
LABEL DESCRIPTION
Interface Select the VLAN interface to apply the selected DHCPv6 snooping policy.

Policy Select the IPv6 snooping policy to apply to this VLAN interface.

Add Click this to create the IPv6 source guard policy or to update an existing one.

Cancel Click this to reset the values above or if not applicable, to clear the fields above.

Clear Click this to clear the fields above.

Index This field displays a sequential number for each binding.

Interface This field displays the VLAN interface.

Policy This field displays the DHCPv6 snooping policy.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.
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27.16  IPv6 DHCP Trust Setup 
Use this screen to specify which ports are trusted for DHCPv6 snooping. To open this screen, click 
Advanced Application > IP Source Guard > IPv6 DHCP Trust Setup.

Note: DHCPv6 solicit packets are sent from a DHCPv6 client to a DHCPv6 server. Reply 
packets from a DHCPv6 server connected to an untrusted port are discarded.

Use port * to have all ports be Untrusted or Trusted.

Figure 237   Advanced Application > IP Source Guard > IPv6 DHCP Trust Setup (Standalone mode)

Delete Select an entry checkbox and click Delete to remove the specified entry.

Cancel Click this to clear the Delete check boxes above.

Table 140   Advanced Application > IP Source Guard > IPv6 Snooping VLAN Setup 
LABEL DESCRIPTION
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Figure 238   Advanced Application > IP Source Guard > IPv6 DHCP Trust Setup (Stacking mode)

The following table describes the labels in this screen. 

Table 141   Advanced Application > IP Source Guard > IPv6 DHCP Trust Setup 
LABEL DESCRIPTION
Trust Setting

Active Select this to specify whether ports are trusted or untrusted ports for DHCP snooping. If you do 
not select this then IPv6 DHCP Trust is not used and all ports are automatically trusted.

Port Setting

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. If you configure the * port, the settings are applied to all of 
the ports.

Trusted state Select whether this port is a trusted port (Trusted) or an untrusted port (Untrusted).

Trusted ports are connected to DHCPv6 servers or other switches. 

Untrusted ports are connected to subscribers, and the Switch discards DHCPv6 packets from 
untrusted ports in the following situations:

• The packet is a DHCPv6 server packet (for example, ADVERTISE, REPLY, or RELAY-REPLY).
• The source MAC address and source IP address in the packet do not match any of the 

current bindings.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.
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27.17  Technical Reference
This section provides technical background information on the topics discussed in this chapter.

27.17.1  DHCP Snooping Overview
Use DHCP snooping to filter unauthorized DHCP packets on the network and to build the binding table 
dynamically. This can prevent clients from getting IP addresses from unauthorized DHCP servers.

27.17.1.1  Trusted vs. Untrusted Ports
Every port is either a trusted port or an untrusted port for DHCP snooping. This setting is independent of 
the trusted/untrusted setting for ARP inspection. You can also specify the maximum number for DHCP 
packets that each port (trusted or untrusted) can receive each second.

Trusted ports are connected to DHCP servers or other switches. The Switch discards DHCP packets from 
trusted ports only if the rate at which DHCP packets arrive is too high. The Switch learns dynamic 
bindings from trusted ports.

Note: The Switch will drop all DHCP requests if you enable DHCP snooping and there are no 
trusted ports.

Untrusted ports are connected to subscribers. The Switch discards DHCP packets from untrusted ports in 
the following situations:

• The packet is a DHCP server packet (for example, OFFER, ACK, or NACK).

• The source MAC address and source IP address in the packet do not match any of the current 
bindings.

• The packet is a RELEASE or DECLINE packet, and the source MAC address and source port do not 
match any of the current bindings.

• The rate at which DHCP packets arrive is too high.

27.17.1.2  DHCP Snooping Database
The Switch stores the binding table in volatile memory. If the Switch restarts, it loads static bindings from 
permanent memory but loses the dynamic bindings, in which case the devices in the network have to 
send DHCP requests again. As a result, it is recommended you configure the DHCP snooping database.

The DHCP snooping database maintains the dynamic bindings for DHCP snooping and ARP inspection 
in a file on an external TFTP server. If you set up the DHCP snooping database, the Switch can reload the 
dynamic bindings from the DHCP snooping database after the Switch restarts.

You can configure the name and location of the file on the external TFTP server. The file has the following 
format:
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Figure 239   DHCP Snooping Database File Format

The <initial-checksum> helps distinguish between the bindings in the latest update and the bindings 
from previous updates. Each binding consists of 72 bytes, a space, and another checksum that is used 
to validate the binding when it is read. If the calculated checksum is not equal to the checksum in the 
file, that binding and all others after it are ignored.

27.17.1.3  DHCP Relay Option 82 Information
The Switch can add information to DHCP requests that it does not discard. This provides the DHCP server 
more information about the source of the requests. The Switch can add the following information:

• Slot ID (1 byte), port ID (1 byte), and source VLAN ID (2 bytes)

• System name (up to 32 bytes)

This information is stored in an Agent Information field in the option 82 field of the DHCP headers of client 
DHCP request frames. See Chapter 51 on page 461 for more information about DHCP relay option 82.

When the DHCP server responds, the Switch removes the information in the Agent Information field 
before forwarding the response to the original source.

You can configure this setting for each source VLAN. This setting is independent of the DHCP relay 
settings (Chapter 51 on page 461).

27.17.1.4  Configuring DHCP Snooping
Follow these steps to configure DHCP snooping on the Switch.

1 Enable DHCP snooping on the Switch.

2 Enable DHCP snooping on each VLAN, and configure DHCP relay option 82.

3 Configure trusted and untrusted ports, and specify the maximum number of DHCP packets that each 
port can receive per second.

4 Configure static bindings.

27.17.2  ARP Inspection Overview
Use ARP inspection to filter unauthorized ARP packets on the network. This can prevent many kinds of 
man-in-the-middle attacks, such as the one in the following example.

<initial-checksum>
TYPE DHCP-SNOOPING
VERSION 1
BEGIN
<binding-1> <checksum-1>
<binding-2> <checksum-1-2>
...
...
<binding-n> <checksum-1-2-..-n>
END
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Figure 240   Example: Man-in-the-middle Attack

In this example, computer B tries to establish a connection with computer A. Computer X is in the same 
broadcast domain as computer A and intercepts the ARP request for computer A. Then, computer X 
does the following things:

• It pretends to be computer A and responds to computer B.

• It pretends to be computer B and sends a message to computer A.

As a result, all the communication between computer A and computer B passes through computer X. 
Computer X can read and alter the information passed between them.

27.17.2.1  ARP Inspection and MAC Address Filters
When the Switch identifies an unauthorized ARP packet, it automatically creates a MAC address filter to 
block traffic from the source MAC address and source VLAN ID of the unauthorized ARP packet. You 
can configure how long the MAC address filter remains in the Switch.

These MAC address filters are different than regular MAC address filters (Chapter 12 on page 141).

• They are stored only in volatile memory.

• They do not use the same space in memory that regular MAC address filters use.

• They appear only in the ARP Inspection screens and commands, not in the MAC Address Filter screens 
and commands.

27.17.2.2  Trusted vs. Untrusted Ports
Every port is either a trusted port or an untrusted port for ARP inspection. This setting is independent of 
the trusted/untrusted setting for DHCP snooping. You can also specify the maximum rate at which the 
Switch receives ARP packets on untrusted ports.

The Switch does not discard ARP packets on trusted ports for any reason.

The Switch discards ARP packets on untrusted ports in the following situations:

• The sender’s information in the ARP packet does not match any of the current bindings.

• The rate at which ARP packets arrive is too high.

27.17.2.3  Syslog
The Switch can send syslog messages to the specified syslog server (Chapter 58 on page 539) when it 
forwards or discards ARP packets. The Switch can consolidate log messages and send log messages in 
batches to make this mechanism more efficient.
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27.17.2.4  Configuring ARP Inspection
Follow these steps to configure ARP inspection on the Switch.

1 Configure DHCP snooping. See Section 27.17.1.4 on page 308.

Note: It is recommended you enable DHCP snooping at least one day before you enable 
ARP inspection so that the Switch has enough time to build the binding table.

2 Enable ARP inspection on each VLAN.

3 Configure trusted and untrusted ports, and specify the maximum number of ARP packets that each port 
can receive per second.
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CHAPTER 28
Loop Guard

This chapter shows you how to configure the Switch to guard against loops on the edge of your network.

28.1  Loop Guard Overview 
Loop guard allows you to configure the Switch to shut down a port if it detects that packets sent out on 
that port loop back to the Switch. While you can use Spanning Tree Protocol (STP) to prevent loops in the 
core of your network. STP cannot prevent loops that occur on the edge of your network. 

Figure 241   Loop Guard vs STP

Loop guard is designed to handle loop problems on the edge of your network. This can occur when a 
port is connected to a Switch that is in a loop state. Loop state occurs as a result of human error. It 
happens when two ports on a switch are connected with the same cable. When a switch in loop state 
sends out broadcast messages the messages loop back to the switch and are re-broadcast again and 
again causing a broadcast storm. 

If a switch (not in loop state) connects to a switch in loop state, then it will be affected by the switch in 
loop state in the following way:

• It will receive broadcast messages sent out from the switch in loop state.

• It will receive its own broadcast messages that it sends out as they loop back. It will then re-broadcast 
those messages again.

The following figure shows port N on switch A connected to switch B. Switch B is in loop state. When 
broadcast or multicast packets leave port N and reach switch B, they are sent back to port N on A as 
they are rebroadcast from B. 
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Figure 242   Switch in Loop State

The loop guard feature checks to see if a loop guard enabled port is connected to a switch in loop 
state. This is accomplished by periodically sending a probe packet and seeing if the packet returns on 
the same port. If this is the case, the Switch will shut down the port connected to the switch in loop state.

The following figure shows a loop guard enabled port N on switch A sending a probe packet P to switch 
B. Since switch B is in loop state, the probe packet P returns to port N on A. The Switch then shuts down 
port N to ensure that the rest of the network is not affected by the switch in loop state. 

Figure 243   Loop Guard - Probe Packet

The Switch also shuts down port N if the probe packet returns to switch A on any other port. In other 
words loop guard also protects against standard network loops. The following figure illustrates three 
switches forming a loop. A sample path of the loop guard probe packet is also shown. In this example, 
the probe packet is sent from port N and returns on another port. As long as loop guard is enabled on 
port N. The Switch will shut down port N if it detects that the probe packet has returned to the Switch. 

Figure 244   Loop Guard - Network Loop

Note: After resolving the loop problem on your network you can re-activate the disabled port 
via the web configurator (see Section 8.5 on page 87) or via commands (see the 
Ethernet Switch CLI Reference Guide).

28.2  Loop Guard Setup 
Click Advanced Application > Loop Guard in the navigation panel to display the screen as shown. 

Note: The loop guard feature can not be enabled on the ports that have Spanning Tree 
Protocol (RSTP, MRSTP or MSTP) enabled.
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Figure 245   Advanced Application > Loop Guard (Standalone mode)

Figure 246   Advanced Application > Loop Guard (Stacking mode)
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The following table describes the labels in this screen. 

Table 142   Advanced Application > Loop Guard 
LABEL DESCRIPTION
Active Select this option to enable loop guard on the Switch.

The Switch generates syslog, internal log messages as well as SNMP traps when it shuts down a 
port via the loop guard feature. 

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to enable the loop guard feature on this port. The Switch sends broadcast 

and multicast probe packets from this port to check if the switch the port is connected to is in 
loop state. If the switch this port is connected to is in loop state the Switch will shut down this port. 

Clear this check box to disable the loop guard feature. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 29
VLAN Mapping

This chapter shows you how to configure VLAN mapping on the Switch.

29.1  VLAN Mapping Overview 
With VLAN mapping enabled, the Switch can map the VLAN ID and priority level of packets received 
from a private network to those used in the service provider’s network.

The Switch checks incoming traffic from the switch ports (non-management ports) against the VLAN 
mapping table first, the MAC learning table and then the VLAN table before forwarding them through 
the Gigabit uplink port. When VLAN mapping is enabled, the Switch discards the tagged packets that 
do not match an entry in the VLAN mapping table. If the incoming packets are untagged, the Switch 
adds a PVID based on the VLAN setting. 

Note: You can not enable VLAN mapping and VLAN stacking at the same time.

29.1.1  VLAN Mapping Example
In the following example figure, packets that carry VLAN ID 12 and are received on port 3 match a pre-
configured VLAN mapping rule. The Switch translates the VLAN ID from 12 into 123 before forwarding the 
packets. Any packets carrying a VLAN tag other than 12 (such as 10) and received on port 3 will be 
dropped.

Figure 247   VLAN mapping example 

29.2  Enabling VLAN Mapping
Click Advanced Application and then VLAN Mapping in the navigation panel to display the screen as 
shown. 
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Figure 248   VLAN Mapping (Standalone mode) 

Figure 249   VLAN Mapping (Stacking mode) 

The following table describes the labels in this screen. 

Table 143   VLAN Mapping 
LABEL DESCRIPTION
Active Select this option to enable VLAN mapping on the Switch.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.
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29.3  Configuring VLAN Mapping
Click the VLAN Mapping Configure link in the VLAN Mapping screen to display the screen as shown. Use 
this screen to enable and edit the VLAN mapping rule(s).

Figure 250   VLAN Mapping Configuration (Standalone mode) 

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis. 

Changes in this row are copied to all the ports as soon as you make them.

Active Select this check box to enable the VLAN mapping feature on this port. Clear this check box to 
disable the VLAN mapping feature. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 143   VLAN Mapping (continued)
LABEL DESCRIPTION
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Figure 251   VLAN Mapping Configuration (Stacking mode) 

The following table describes the labels in this screen. 

Table 144   VLAN Mapping Configuration 
LABEL DESCRIPTION
Active Check this box to activate this rule.

Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 

Port Type a port to be included in this rule. For stacking mode, the first field is the slot ID, the second 
field is the port number.

VID Enter a VLAN ID from 1 to 4094. This is the VLAN tag carried in the packets and will be translated 
into the VID you specified in the Translated VID field. 

Translated VID Enter a VLAN ID (from 1 to 4094) into which the customer VID carried in the packets will be 
translated. 

Priority Select a priority level (from 0 to 7). This is the priority level that replaces the customer priority 
level in the tagged packets or adds to the untagged packets.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Index This is the number of the VLAN mapping entry in the table. Click on an index number to change 
the settings.

Active This shows whether this entry is activated or not.

Name This is the descriptive name for this rule. 

Port This is the port number to which this rule is applied. In stacking mode, the first number represents 
the slot and the second the port number.

VID This is the customer VLAN ID in the incoming packets. 

Translated VID This is the VLAN ID that replaces the customer VLAN ID in the tagged packets.

Priority This is the priority level that replaces the customer priority level in the tagged packets.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the Delete check boxes.
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CHAPTER 30
Layer 2 Protocol Tunneling

This chapter shows you how to configure layer-2 protocol tunneling on the Switch.

30.1  Layer 2 Protocol Tunneling Overview 
Layer-2 protocol tunneling (L2PT) is used on the service provider's edge devices. L2PT allows edge 
switches (1 and 2 in the following figure) to tunnel layer-2 STP (Spanning Tree Protocol), CDP (Cisco 
Discovery Protocol) and VTP (VLAN Trunking Protocol) packets between customer switches (A, B and C 
in the following figure) connected through the service provider’s network. The edge switch 
encapsulates layer-2 protocol packets with a specific MAC address before sending them across the 
service provider’s network to other edge switches.

Figure 252   Layer-2 Protocol Tunneling Network Scenario 

In the following example, if you enable L2PT for STP, you can have switches A, B, C and D in the same 
spanning tree, even though switch A is not directly connected to switches B, C and D. Topology change 
information can be propagated throughout the service provider’s network.

To emulate a point-to-point topology between two customer switches at different sites, such as A and B, 
you can enable protocol tunneling on edge switches 1 and 2 for PAgP (Port Aggregation Protocol), 
LACP or UDLD (UniDirectional Link Detection).
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Figure 253   L2PT Network Example 

30.1.1  Layer-2 Protocol Tunneling Mode
Each port can have two layer-2 protocol tunneling modes, Access and Tunnel.

• The Access port is an ingress port on the service provider's edge device (1 or 2 in Figure 253 on page 
320) and connected to a customer switch (A or B). Incoming layer-2 protocol packets received on an 
access port are encapsulated and forwarded to the tunnel ports. 

• The Tunnel port is an egress port at the edge of the service provider's network and connected to 
another service provider’s switch. Incoming encapsulated layer-2 protocol packets received on a 
tunnel port are decapsulated and sent to an access port.

30.2  Configuring Layer 2 Protocol Tunneling 
Click Advanced Application > Layer 2 Protocol Tunneling in the navigation panel to display the screen 
as shown. 
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Figure 254   Advanced Application > Layer 2 Protocol Tunneling (Standalone mode) 

Figure 255   Advanced Application > Layer 2 Protocol Tunneling (Stacking mode) 
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The following table describes the labels in this screen. 

Table 145   Advanced Application > Layer 2 Protocol Tunneling 
LABEL DESCRIPTION
Active Select this to enable layer-2 protocol tunneling on the Switch.

Destination 
MAC Address

Specify an MAC address with which the Switch uses to encapsulate the layer-2 protocol packets 
by replacing the destination MAC address in the packets.

Note: The MAC address can be either a unicast MAC address or multicast MAC 
address. If you use a unicast MAC address, make sure the MAC address does 
not exist in the address table of a switch on the service provider’s network. 

Note: All the edge switches in the service provider’s network should be set to use the 
same MAC address for encapsulation.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
CDP Select this option to have the Switch tunnel CDP (Cisco Discovery Protocol) packets so that 

other Cisco devices can be discovered through the service provider’s network.

STP Select this option to have the Switch tunnel STP (Spanning Tree Protocol) packets so that STP can 
run properly across the service provider’s network and spanning trees can be set up based on 
bridge information from all (local and remote) networks.

VTP Select this option to have the Switch tunnel VTP (VLAN Trunking Protocol) packets so that all 
customer switches can use consistent VLAN configuration through the service provider’s 
network.

Point to Point The Switch supports PAgP (Port Aggregation Protocol), LACP (Link Aggregation Control Protocol) 
and UDLD (UniDirectional Link Detection) tunneling for a point-to-point topology.

Both PAgP and UDLD are Cisco’s proprietary data link layer protocols. PAgP is similar to LACP 
and used to set up a logical aggregation of Ethernet ports automatically. UDLD is to determine 
the link’s physical status and detect a unidirectional link.

PAGP Select this option to have the Switch send PAgP packets to a peer to automatically negotiate 
and build a logical port aggregation.

LACP Select this option to have the Switch send LACP packets to a peer to dynamically creates and 
manages trunk groups.

UDLD Select this option to have the Switch send UDLD packets to a peer’s port it connected to 
monitor the physical status of a link.

Mode Select Access to have the Switch encapsulate the incoming layer-2 protocol packets and 
forward them to the tunnel port(s). Select Access for ingress ports at the edge of the service 
provider's network. 

Note: You can enable L2PT services for STP, LACP, VTP, CDP, UDLD, and PAGP on the 
access port(s) only. 

Select Tunnel for egress ports at the edge of the service provider's network. The Switch 
decapsulates the encapsulated layer-2 protocol packets received on a tunnel port by 
changing the destination MAC address to the original one, and then forward them to an access 
port. If the service(s) is not enabled on an access port, the protocol packets are dropped.
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Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 145   Advanced Application > Layer 2 Protocol Tunneling (continued)
LABEL DESCRIPTION
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CHAPTER 31
sFlow

This chapter shows you how to configure sFlow to have the Switch monitor traffic in a network and send 
information to an sFlow collector for analysis.

31.1  sFlow Overview
sFlow (RFC 3176) is a standard technology for monitoring switched networks. An sFlow agent embedded 
on a switch or router gets sample data and packet statistics from traffic forwarded through its ports. The 
sFlow agent then creates sFlow data and sends it to an sFlow collector. The sFlow collector is a server 
that collects and analyzes sFlow datagram. An sFlow datagram includes packet header, input and 
output interface, sampling process parameters and forwarding information. 

sFlow minimizes impact on CPU load of the Switch as it analyzes sample data only. sFlow can 
continuously monitor network traffic and create reports for network performance analysis and 
troubleshooting. For example, you can use it to know which IP address or which type of traffic caused 
network congestion.

Figure 256   sFlow Application

31.2  sFlow Port Configuration
Click Advanced Application > sFlow in the navigation panel to display the screen as shown. 
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Figure 257   Advanced Application > sFlow (Standalone mode) 

Figure 258   Advanced Application > sFlow (Stacking mode) 
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The following table describes the labels in this screen. 

31.2.1  sFlow Collector Configuration
Click the Collector link in the sFlow screen to display the screen as shown. You can configure up to four 
sFlow collectors in this screen. You may want to configure more than one collector if the traffic load to 
be monitored is more than one collector can manage.

Table 146   Advanced Application > sFlow 
LABEL DESCRIPTION
Active Select this to enable the sFlow agent on the Switch.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this to allow the Switch to monitor traffic on this port and generate and send sFlow 

datagram to the specified collector. 

Sample-rate Enter a number (N) from 256 to 65535. The Switch captures every one out of N packets for this 
port and creates sFlow datagram.

poll-interval Specify a time interval (from 20 to 120 in seconds) the Switch waits before sending the sFlow 
datagram and packet counters for this port to the collector.

Collector 
Address 

Enter the IP address of the sFlow collector. 

Note: You must have the sFlow collector already configured in the sFlow > Collector 
screen. The sFlow collector does not need to be in the same subnet as the 
Switch, but it must be accessible from the Switch.

Note: Configure UDP port 6343 (the default) on a NAT router to allow port forwarding 
if the collector is behind a NAT router. Configure a firewall rule for UDP port 6343 
(the default) to allow incoming traffic if the collector is behind a firewall.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 259   Advanced Application > sFlow > Collector 

The following table describes the labels in this screen. 

Table 147   Advanced Application > sFlow > Collector 
LABEL DESCRIPTION
Collector 
Address

Enter the IP address of the sFlow collector.

UDP Port Enter a UDP port number the Switch uses to send sFlow datagram to the collector. If you change 
the port here, make sure you change it on the collector, too. The default port is 6343.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays the index number of this entry. Click on an index number to change the 
settings.

Collector 
Address

This field displays IP address of the sFlow collector.

UDP Port This field displays port number the Switch uses to send sFlow datagram to the collector.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 32
PPPoE

This chapter describes how the Switch gives a PPPoE termination server additional information that the 
server can use to identify and authenticate a PPPoE client.

32.1  PPPoE Intermediate Agent Overview 
A PPPoE Intermediate Agent (PPPoE IA) is deployed between a PPPoE server and PPPoE clients. It helps 
the PPPoE server identify and authenticate clients by adding subscriber line specific information to 
PPPoE discovery packets from clients on a per-port or per-port-per-VLAN basis before forwarding them 
to the PPPoE server. 

32.1.1  PPPoE Intermediate Agent Tag Format
If the PPPoE Intermediate Agent is enabled, the Switch adds a vendor-specific tag to PADI (PPPoE 
Active Discovery Initialization) and PADR (PPPoE Active Discovery Request) packets from PPPoE clients. 
This tag is defined in RFC 2516 and has the following format for this feature.

The Tag_Type is 0x0105 for vendor-specific tags, as defined in RFC 2516. The Tag_Len indicates the 
length of Value, i1 and i2. The Value is the 32-bit number 0x00000DE9, which stands for the “ADSL Forum” 
IANA entry. i1 and i2 are PPPoE intermediate agent sub-options, which contain additional information 
about the PPPoE client. 

32.1.2  Sub-Option Format
There are two types of sub-option: “Agent Circuit ID Sub-option” and “Agent Remote ID Sub-option”. 
They have the following formats. 

Table 148   PPPoE Intermediate Agent Vendor-specific Tag Format
Tag_Type

(0x0105)

Tag_Len Value i1 i2

Table 149   PPPoE IA Circuit ID Sub-option Format: User-defined String

SubOpt Length Value

0x01

(1 byte)

N

(1 byte)

String

(63 bytes)
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The 1 in the first field identifies this as an Agent Circuit ID sub-option and 2 identifies this as an Agent 
Remote ID sub-option. The next field specifies the length of the field. The Switch takes the Circuit ID string 
you manually configure for a VLAN on a port as the highest priority and the Circuit ID string for a port as 
the second priority. In addition, the Switch puts the PPPoE client’s MAC address into the Agent Remote 
ID Sub-option if you do not specify any user-defined string.

32.1.2.1  Flexible Circuit ID Syntax with Identifier String and Variables
If you do not configure a Circuit ID string for a VLAN on a specific port or for a specific port, the Switch 
adds the user-defined identifier string and variables into the Agent Circuit ID Sub-option. The variables 
can be the slot ID of the PPPoE client, the port number of the PPPoE client and/or the VLAN ID on the 
PPPoE packet. 

The identifier-string, slot ID, port number and VLAN ID are separated from each other by a pound key 
(#), semi-colon (;), period (.), comma (,), forward slash (/) or space. An Agent Circuit ID Sub-option 
example is “Switch/07/0123” and indicates the PPPoE packets come from a PPPoE client which is 
connected to the Switch’s port 7 and belong to VLAN 123.  

32.1.2.2  WT-101 Default Circuit ID Syntax
If you do not configure a Circuit ID string for a specific VLAN on a port or for a specific port, and disable 
the flexible Circuit ID syntax in the PPPoE > Intermediate Agent screen, the Switch automatically 
generates a Circuit ID string according to the default Circuit ID syntax which is defined in the DSL Forum 
Working Text (WT)-101. The default access node identifier is the host name of the PPPoE intermediate 
agent and the eth indicates “Ethernet”. 

32.1.3  Port State
Every port is either a trusted port or an untrusted port for the PPPoE intermediate agent. This setting is 
independent of the trusted/untrusted setting for DHCP snooping or ARP inspection. You can also specify 
the agent sub-options (circuit ID and remote ID) that the Switch adds to PADI and PADR packets from 
PPPoE clients.

Table 150   PPPoE IA Remote ID Sub-option Format

SubOpt Length Value

0x02

(1 byte)

N

(1 byte)

MAC Address or String

(63 bytes)

Table 151   PPPoE IA Circuit ID Sub-option Format: Using Identifier String and Variables

SubOpt Length Value

0x01

(1 byte)

N

(1 byte)

Identifier 
String

(53 byte)

delimiter

(1 byte)

Slot ID

(1 byte)

delimiter

(1 byte)

Port No

(2 byte)

delimiter

(1 byte)

VLAN ID

(4 bytes)

Table 152   PPPoE IA Circuit ID Sub-option Format: Defined in WT-101

SubOpt Length Value

0x01

(1 byte)

N

(1 byte)

Access 
Node 
Identifier 

(20 byte)

Space

(1 
byte)

eth

(3 
byte)

Space

(1 
byte)

Slot ID

(1 
byte)

/

(1 
byte)

Port No

(2 byte)

:

(1 
byte)

VLAN ID

(4 bytes)
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Trusted ports are connected to PPPoE servers. 

• If a PADO (PPPoE Active Discovery Offer), PADS (PPPoE Active Discovery Session-confirmation), or 
PADT (PPPoE Active Discovery Terminate) packet is sent from a PPPoE server and received on a 
trusted port, the Switch forwards it to all other ports.

• If a PADI or PADR packet is sent from a PPPoE client but received on a trusted port, the Switch 
forwards it to other trusted port(s).

Note: The Switch will drop all PPPoE discovery packets if you enable the PPPoE intermediate 
agent and there are no trusted ports.

Untrusted ports are connected to subscribers. 

• If a PADI, PADR, or PADT packet is sent from a PPPoE client and received on an untrusted port, the 
Switch adds a vendor-specific tag to the packet and then forwards it to the trusted port(s).

• The Switch discards PADO and PADS packets which are sent from a PPPoE server but received on an 
untrusted port.

32.2  The PPPoE Screen
Use this screen to configure the PPPoE Intermediate Agent on the Switch.

Click Advanced Application > PPPoE in the navigation panel to display the screen as shown. Click Click 
Here to go to the Intermediate Agent screen.

Figure 260   Advanced Application > PPPoE Intermediate Agent 

32.3  PPPoE Intermediate Agent 
Use this screen to configure the Switch to give a PPPoE termination server additional subscriber 
information that the server can use to identify and authenticate a PPPoE client.

Click Advanced Application > PPPoE > Intermediate Agent in the navigation panel to display the screen 
as shown. 



Chapter 32 PPPoE

XGS4600 Series User’s Guide

331

Figure 261   Advanced Application > PPPoE > Intermediate Agent 

The following table describes the labels in this screen. 

Table 153   Advanced Application > PPPoE > Intermediate Agent 
LABEL DESCRIPTION
Active Select this option to enable the PPPoE intermediate agent globally on the Switch.

access-node-
identifier

Enter up to 20 ASCII characters to identify the PPPoE intermediate agent. Hyphens (-) and 
spaces are also allowed. The default is the Switch’s host name. 

circuit-id Use this section to configure the Circuit ID field in the PADI and PADR packets. 

The Circuit ID you configure for a specific port or for a specific VLAN on a port has priority over 
this.

The Circuit ID you configure for a specific port (in the Advanced Application > PPPoE > 
Intermediate Agent > Port screen) or for a specific VLAN on a port (in the Advanced 
Application > PPPoE > Intermediate Agent > Port > VLAN screen) has priority over this. That 
means, if you also want to configure PPPoE IA Per-Port or Per-Port Per-VLAN setting, leave the 
fields here empty and configure circuit-id and remote-id in the Per-Port or Per-Port Per-VLAN 
screen.

Active Select this option to have the Switch add the user-defined identifier string and variables 
(specified in the option field) to PADI or PADR packets from PPPoE clients.

If you leave this option unselected and do not configure any Circuit ID string (using CLI 
commands) on the Switch, the Switch will use the string specified in the access-node-identifier 
field. 

identifier-string Specify a string that the Switch adds in the Agent Circuit ID sub-option. You can enter up to 53 
ASCII characters. Spaces are allowed.

option Select the variables that you want the Switch to generate and add in the Agent Circuit ID sub-
option. The variable options include sp, sv, pv and spv which indicate combinations of slot-
port, slot-VLAN, port-VLAN and slot-port-VLAN respectively. The Switch enters a zero into the 
PADI and PADR packets for the slot value.

delimiter Select a delimiter to separate the identifier-string, slot ID, port number and/or VLAN ID from 
each other. You can use a pound key (#), semi-colon (;), period (.), comma (,), forward slash (/
) or space.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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32.3.1  PPPoE IA Per-Port 
Use this screen to specify whether individual ports are trusted or untrusted ports and have the Switch 
add extra information to PPPoE discovery packets from PPPoE clients on a per-port basis.

Note: The Switch will drop all PPPoE packets if you enable the PPPoE Intermediate Agent on 
the Switch and there are no trusted ports.

Click the Port link in the Intermediate Agent screen to display the screen as shown. 

Figure 262   Advanced Application > PPPoE > Intermediate Agent > Port (Standalone mode) 

Figure 263   Advanced Application > PPPoE > Intermediate Agent > Port (Stacking mode)
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The following table describes the labels in this screen. 

32.3.2  PPPoE IA Per-Port Per-VLAN 
Use this screen to configure PPPoE IA settings that apply to a specific VLAN on a port.

Click the VLAN link in the Intermediate Agent > Port screen to display the screen as shown. 

Table 154   Advanced Application > PPPoE > Intermediate Agent > Port 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Server Trusted 
State 

Select whether this port is a trusted port (Trusted) or an untrusted port (Untrusted).

Trusted ports are uplink ports connected to PPPoE servers. 

• If a PADO (PPPoE Active Discovery Offer), PADS (PPPoE Active Discovery Session-
confirmation), or PADT (PPPoE Active Discovery Terminate) packet is sent from a PPPoE server 
and received on a trusted port, the Switch forwards it to all other ports.

• If a PADI or PADR packet is sent from a PPPoE client but received on a trusted port, the 
Switch forwards it to other trusted port(s).

Untrusted ports are downlink ports connected to subscribers. 

• If a PADI, PADR, or PADT packet is sent from a PPPoE client and received on an untrusted 
port, the Switch adds a vendor-specific tag to the packet and then forwards it to the trusted 
port(s).

• The Switch discards PADO and PADS packets which are sent from a PPPoE server but 
received on an untrusted port.

Circuit-id Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Circuit ID sub-
option for PPPoE discovery packets received on this port. Spaces are allowed.

The Circuit ID you configure for a specific VLAN on a port (in the Advanced Application > PPPoE 
> Intermediate Agent > Port > VLAN screen) has the highest priority.

Remote-id Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Remote ID sub-
option for PPPoE discovery packets received on this port. Spaces are allowed.

If you do not specify a string here or in the Remote-id field for a VLAN on a port, the Switch 
automatically uses the PPPoE client’s MAC address. 

The Remote ID you configure for a specific VLAN on a port (in the Advanced Application > 
PPPoE > Intermediate Agent > Port > VLAN screen) has the highest priority.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 264   Advanced Application > PPPoE > Intermediate Agent > Port > VLAN (Standalone mode) 

Figure 265   Advanced Application > PPPoE > Intermediate Agent > Port > VLAN (Stacking mode)

The following table describes the labels in this screen. 

Table 155   Advanced Application > PPPoE > Intermediate Agent > Port > VLAN 
LABEL DESCRIPTION
Show Port Enter a port number to show the PPPoE Intermediate Agent settings for the specified VLAN(s) on 

the port. For Stacking mode, the first field box is the Slot ID, the second field box is the port.

Show VLAN Use this section to specify the VLANs you want to configure in the section below.

Start VID Enter the lowest VLAN ID you want to configure in the section below.

End VID Enter the highest VLAN ID you want to configure in the section below.

Apply Click Apply to display the specified range of VLANs in the section below.

Port 
(Standalone 
mode)

This field displays the port number specified above.

Slot / Port 
(Stacking 
mode)

For Stacking mode, the first field box displays the Slot ID, the second field box displays the port 
number.

VID This field displays the VLAN ID of each VLAN in the range specified above. If you configure the * 
VLAN, the settings are applied to all VLANs.

* Use this row to make the setting the same for all VLANs. Use this row first and then make 
adjustments on a VLAN-by-VLAN basis. 

Note: Changes in this row are copied to all the VLANs as soon as you make them.
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32.3.3  PPPoE IA for VLAN 
Use this screen to set whether the PPPoE Intermediate Agent is enabled on a VLAN and whether the 
Switch appends the Circuit ID and/or Remote ID to PPPoE discovery packets from a specific VLAN.

Click the VLAN link in the Intermediate Agent screen to display the screen as shown. 

Figure 266   Advanced Application > PPPoE > Intermediate Agent > VLAN 

The following table describes the labels in this screen. 

Circuit-id Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Circuit ID sub-
option for this VLAN on the specified port. Spaces are allowed.

The Circuit ID you configure here has the highest priority.

Remote-id Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Remote ID sub-
option for this VLAN on the specified port. Spaces are allowed.

If you do not specify a string here or in the Remote-id field for a specific port, the Switch 
automatically uses the PPPoE client’s MAC address. 

The Remote ID you configure here has the highest priority.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 155   Advanced Application > PPPoE > Intermediate Agent > Port > VLAN (continued)
LABEL DESCRIPTION

Table 156   Advanced Application > PPPoE > Intermediate Agent > VLAN 
LABEL DESCRIPTION
Show VLAN Use this section to specify the VLANs you want to configure in the section below.

Start VID Enter the lowest VLAN ID you want to configure in the section below.

End VID Enter the highest VLAN ID you want to configure in the section below.

Apply Click Apply to display the specified range of VLANs in the section below.

VID This field displays the VLAN ID of each VLAN in the range specified above. If you configure the * 
VLAN, the settings are applied to all VLANs.

* Use this row to make the setting the same for all VLANs. Use this row first and then make 
adjustments on a VLAN-by-VLAN basis. 

Note: Changes in this row are copied to all the VLANs as soon as you make them.
Enabled Select this option to turn on the PPPoE Intermediate Agent on a VLAN.
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Circuit-id Select this option to make the Circuit ID settings for a specific VLAN take effect.

Remote-id Select this option to make the Remote ID settings for a specific VLAN take effect.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 156   Advanced Application > PPPoE > Intermediate Agent > VLAN (continued)
LABEL DESCRIPTION



XGS4600 Series User’s Guide

337

CHAPTER 33
Error Disable

33.1  Error Disable Overview 
This chapter shows you how to configure the rate limit for control packets on a port, and set the Switch 
to take an action (such as to shut down a port or stop sending packets) on a port when the Switch 
detects a pre-configured error. It also shows you how to configure the Switch to automatically undo the 
action after the error is gone.

33.1.1  CPU Protection Overview
Switches exchange protocol control packets in a network to get the latest networking information. If a 
switch receives large numbers of control packets, such as ARP, BPDU or IGMP packets, which are to be 
processed by the CPU, the CPU may become overloaded and be unable to handle regular tasks 
properly. 

The CPU protection feature allows you to limit the rate of ARP, BPDU and IGMP packets to be delivered 
to the CPU on a port. This enhances the CPU efficiency and protects against potential DoS attacks or 
errors from other network(s). You then can choose to drop control packets that exceed the specified 
rate limit or disable a port on which the packets are received.

33.1.2  Error-Disable Recovery Overview
Some features, such as loop guard or CPU protection, allow the Switch to shut down a port or discard 
specific packets on a port when an error is detected on the port. For example, if the Switch detects that 
packets sent out the port(s) loop back to the Switch, the Switch can shut down the port(s) 
automatically. After that, you need to enable the port(s) or allow the packets on a port manually via the 
web configurator or the commands. With error-disable recovery, you can set the disabled port(s) to 
become active or start receiving the packets again after the time interval you specify.

33.1.3  What You Can Do
• Use the Errdisable Status screen (Section 33.3 on page 338) to view whether the Switch detected that 

control packets exceeded the rate limit configured for a port or a port is disabled according to the 
feature requirements and what action you configure, and related information.

• Use the CPU Protection screen (Section 33.4 on page 340) to limit the maximum number of control 
packets (ARP, BPDU and/or IGMP) that the Switch can receive or transmit on a port.

• Use the Errdisable Detect screen (Section 33.5 on page 342) to have the Switch detect whether the 
control packets exceed the rate limit configured for a port and configure the action to take once the 
limit is exceeded.

• Use the Errdisable Recovery screen (Section 33.6 on page 343) to set the Switch to automatically 
undo an action after the error is gone.
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33.2  The Error Disable Screen
Use this screen to configure error disable related settings. Click Advanced Application > Errdisable in the 
navigation panel to open the following screen.

Figure 267    Advanced Application > Errdisable 

The following table describes the labels in this screen. 

33.3  Error-Disable Status 
Use this screen to view whether the Switch detected that control packets exceeded the rate limit 
configured for a port or a port is disabled according to the feature requirements and what action you 
configure, and related information. Click the Click here link next to Errdisable Status in the Advanced 
Application > Errdisable screen to display the screen as shown. 

Table 157   Advanced Application > Errdisable 
LABEL DESCRIPTION
Errdisable Status Click this link to view whether the Switch detected that control packets exceeded the rate 

limit configured for a port or a port is disabled according to the feature requirements and 
what action you configure, and related information.

CPU protection Click this link to limit the maximum number of control packets (ARP, BPDU and/or IGMP) 
that the Switch can receive or transmit on a port.

Errdisable Detect Click this link to have the Switch detect whether the control packets exceed the rate limit 
configured for a port and configure the action to take once the limit is exceeded.

Errdisable Recovery Click this link to set the Switch to automatically undo an action after the error is gone.
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Figure 268   Advanced Application > Errdisable > Errdisable Status (Standalone mode)  

Figure 269   Advanced Application > Errdisable > Errdisable Status (Stacking mode)  



 Chapter 33 Error Disable

XGS4600 Series User’s Guide

340

The following table describes the labels in this screen. 

33.4  CPU Protection Configuration 
Use this screen to limit the maximum number of control packets (ARP, BPDU and/or IGMP) that the 
Switch can receive or transmit on a port. Click the Click Here link next to CPU protection in the 
Advanced Application > Errdisable screen to display the screen as shown. 

Note: After you configure this screen, make sure you also enable error detection for the 
specific control packets in the Advanced Application > Errdisable > Errdisable Detect 
screen.

Table 158   Advanced Application > Errdisable > Errdisable Status 
LABEL DESCRIPTION
Inactive-reason 
mode reset

Port List Enter the number of the port(s) (separated by a comma) on which you want to reset inactive-
reason status. In stacking mode, the first number represents the slot and the second the port 
number. Enter 1/1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 and port 28 for the Switch in 
slot 2, for example.

Cause Select the cause of inactive-reason mode you want to reset here.

Reset Press to reset the specified port(s) to handle ARP, BPDU or IGMP packets instead of ignoring 
them, if the port(s) is in inactive-reason mode.

Errdisable Status

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number.

Cause This displays the type of the control packet received on the port or the feature enabled on the 
port and cause the Switch to take the specified action.

Active This field displays whether the control packets (ARP, BPDU, and/or IGMP), on the port is being 
detected or not. It also shows whether loop guard, anti-arp scanning, BPDU guard or ZULD is 
enabled on the port.

Mode This field shows the action that the Switch takes for the cause.

• inactive-port - The Switch disables the port.
• inactive-reason - The Switch drops all the specified control packets (such as BPDU) on the 

port.
• rate-limitation - The Switch drops the additional control packets the port(s) has to handle in 

every one second.

Rate This field displays how many control packets this port can receive or transmit per second. It can 
be adjusted in CPU Protection. 0 means no rate limit.

Status This field displays the errdisable status

• Forwarding: The Switch is forwarding packets. Rate-limitation mode is always in Forwarding 
status.

• Err-disable: The Switch disables the port on which the control packets are received 
(inactive-port) or drops specified control packets on the port (inactive-reason)

Recovery 
Time Left 
(secs)

This field displays the time (seconds) left before the port(s) becomes active of Errdisable 
Recovery.

Total 
Dropped

This field displays the total packet number dropped by this port where the packet rate exceeds 
the rate of mode rate-limitation.
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Figure 270   Advanced Application > Errdisable > CPU protection (Standalone mode) 

Figure 271   Advanced Application > Errdisable > CPU protection (Stacking mode) 

The following table describes the labels in this screen. 

Table 159   Advanced Application > Errdisable > CPU protection 
LABEL DESCRIPTION
Reason Select the type of control packet you want to configure here.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.
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33.5  Error-Disable Detect Configuration 
Use this screen to have the Switch detect whether the control packets exceed the rate limit configured 
for a port and configure the action to take once the limit is exceeded. Click the Click Here link next to 
Errdisable Detect link in the Advanced Application > Errdisable screen to display the screen as shown. 

Figure 272   Advanced Application > Errdisable > Errdisable Detect  

The following table describes the labels in this screen. 

Port (Standalone 
or stacking mode)

This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number. * means all ports (on the same Switch).

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments to each port if necessary. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Rate Limit (pkt/s) Enter a number from 0 to 256 to specify how many control packets this port can receive or 

transmit per second.

0 means no rate limit.

You can configure the action that the Switch takes when the limit is exceeded. See Section 
33.5 on page 342 for detailed information.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 159   Advanced Application > Errdisable > CPU protection (continued)
LABEL DESCRIPTION

Table 160   Advanced Application > Errdisable > Errdisable Detect 
LABEL DESCRIPTION
Cause This field displays the types of control packet that may cause CPU overload.

* Use this row to make the setting the same for all entries. Use this row first and then make 
adjustments to each entry if necessary. 

Note: Changes in this row are copied to all the entries as soon as you make them.
Active Select this option to have the Switch detect if the configured rate limit for a specific control 

packet is exceeded and take the action selected below.



Chapter 33 Error Disable

XGS4600 Series User’s Guide

343

33.6  Error-Disable Recovery Configuration 
Use this screen to configure the Switch to automatically undo an action after the error is gone. Click the 
Click Here link next to Errdisable Recovery in the Advanced Application > Errdisable screen to display 
the screen as shown. 

Figure 273   Advanced Application > Errdisable > Errdisable Recovery  

The following table describes the labels in this screen. 

Mode Select the action that the Switch takes when the number of control packets exceed the rate 
limit on a port, set in the Advanced Application > Errdisable > CPU protection screen.

• inactive-port - The Switch disables the port on which the control packets are received.
• inactive-reason - The Switch drops all the specified control packets (such as BPDU) on the 

port.
• rate-limitation - The Switch drops the additional control packets the port has to handle in 

every one second.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 160   Advanced Application > Errdisable > Errdisable Detect (continued)
LABEL DESCRIPTION

Table 161   Advanced Application > Errdisable > Errdisable Recovery 
LABEL DESCRIPTION
Active Select this option to turn on the error-disable recovery function on the Switch.

Reason This field displays the supported features that allow the Switch to shut down a port or discard 
packets on a port according to the feature requirements and what action you configure.

* Use this row to make the setting the same for all entries. Use this row first and then make 
adjustments to each entry if necessary. 

Note: Changes in this row are copied to all the entries as soon as you make them.
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Timer Status Select this option to allow the Switch to wait for the specified time interval to activate a port or 
allow specific packets on a port, after the error was gone. Deselect this option to turn off this 
rule.

Interval Enter the number of seconds (from 30 to 2592000) for the time interval.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 161   Advanced Application > Errdisable > Errdisable Recovery (continued)
LABEL DESCRIPTION
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CHAPTER 34
MAC Pinning

This chapter shows you how to configure MAC pinning on the Switch.

34.1  MAC Pinning Overview 
When the Switch obtains a connected device’s MAC address, it adds an entry in the MAC address 
forwarding table and uses the table to determine how to forward frames. In addition to the source MAC 
address of a received frame, the Switch also learns the VLAN to which the device belongs and the port 
on which the frame is received. If the Switch learns the same MAC address and same VLAN ID on 
another port, it updates the MAC address table immediately.

MAC pinning allows you to set a port or multiple ports to have priority over other ports in MAC address 
learning. That means when a MAC address (and VLAN ID) is learned on a MAC-pinning-enabled port, 
the MAC address will not be learned on any other port until the aging time for the dynamically learned 
MAC address in the table expires.

This helps enhance security. For example, when an attacker (A) sends packets to all connected clients 
by spoofing the source MAC address of a server (B) connected to one of the Switch’s ports, on which 
MAC pinning is enabled, the responses from clients will still be forwarded to the server according to the 
Switch’s MAC forwarding table.

34.2  MAC Pinning Configuration
Use this screen to enable MAC pinning on the Switch and on specific ports. Click Advanced Application 
> MAC Pinning in the navigation panel to open the following screen. 
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Figure 274   Advanced Application > MAC Pinning (Standalone mode) 

Figure 275   Advanced Application > MAC Pinning (Stacking mode) 

The following table describes the labels in this screen. 

Table 162   Advanced Application > MAC Pinning 
LABEL DESCRIPTION
Active Select this option to turn on the MAC pinning function on the Switch.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.
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Port This field displays the port number. In stacking mode, the first field is the slot ID and the second 
field is the port number. * means all ports (on the same Switch).

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments to each port if necessary. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to enable MAC pinning on this port. The port then has priority over other 

ports in MAC address learning.

Clear this check box to disable MAC pinning. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 162   Advanced Application > MAC Pinning (continued)
LABEL DESCRIPTION
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CHAPTER 35
Private VLAN

35.1  Private VLAN Overview 
Use private VLAN if you want you to block traffic between ports in the same VLAN. Community and 
Isolated VLANs are secondary private VLANs that must be associated with a Primary private VLAN.

• Primary: Ports in a Primary VLAN are promiscuous and they can communicate with all promiscuous 
ports in the same primary VLAN, and all ports in associated community and isolated VLANs. They 
cannot communicate with ports in different primary VLANs.

• Community: Ports in a Community VLAN can communicate with promiscuous ports in an associated 
Primary VLAN and other community ports in the same Community VLAN. They cannot communicate 
with ports in Isolated VLANs, non-associated Primary VLAN promiscuous ports nor community ports in 
different Community VLANs. 

• Isolated: Ports in an Isolated VLAN can communicate with promiscuous ports in an associated Primary 
VLAN only. They cannot communicate with other isolated ports in the same Isolated VLAN, non-
associated Primary VLAN promiscuous ports nor any community ports. 

Table 163   PVLAN Graphic Key 
LABEL DESCRIPTION
P-VLAN 100 Primary private VLAN

C-VLAN 101 Community private VLAN

I-VLAN 102 Isolated private VLAN 
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Tagged Private VLANs can span switches but trunking ports must be VLAN-trunking ports - see Advanced 
> VLAN > VLAN Port Setting. 

This is the communication process if primary VLAN P-VLAN 100 is associated with community VLAN C-
VLAN 101 and isolated VLAN I-VLAN 102.

• Promiscuous ports in P-VLAN 100 can communicate with all ports in P-VLAN 100 including community 
ports in C-VLAN 101 and isolated ports in I-VLAN 102.

• Community ports in C-VLAN 101 can communicate with promiscuous ports in P-VLAN 100 and other 
community ports in C-VLAN 101. They cannot communicate with isolated ports in I-VLAN 102.

• Isolated ports can communicate with promiscuous ports in P-VLAN 100. They cannot communicate 
with other isolated ports in I-VLAN 102 nor community ports in C-VLAN 101. 

Note: Isolation in VLAN > VLAN Port Setting (see Section 9.7.2 on page 120) has a higher 
priority than private VLAN settings, so promiscuous ports with Isolation in VLAN > VLAN 
Port Setting enabled will not be able to communicate with each other.

35.1.1  Configuration 
You must go to the Static VLAN screen first (see Section 9.7 on page 117) to create VLAN IDs for Primary, 
Isolated or Community VLANs. 

Click Advanced Application > Private VLAN to display the following screen.

Table 164   Spanning PVLAN Graphic Key 
LABEL DESCRIPTION
UP Uplink promiscuous port

TP VLAN-trunking ports

S1, S2 Switch 1, Switch 2

P-VLAN 100 Primary private VLAN with VLAN ID tag of 100

C-VLAN 101 Community private VLAN with VLAN ID tag of 101

I-VLAN 102 Isolated private VLAN with VLAN ID tag of 102
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Figure 276   Advanced Application > Private VLAN (Standalone mode) 

Figure 277   Advanced Application > Private VLAN (Stacking mode) 

The following table describes the labels in this screen. 

Table 165   Advanced Application > Private VLAN 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number. * means all ports (on the same Switch).
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Mode This is the type of VLAN mapped to this port.

• Normal: These are ports in a static VLAN. This is not a private VLAN.
• Promiscuous: Ports in a Primary VLAN are Promiscuous. They can communicate with all 

ports in the Primary VLAN and associated Community and Isolated VLANs. They cannot 
communicate with Promiscuous ports in different primary VLANs.

• Community: Ports in a Community VLAN can communicate with Promiscuous ports in an 
associated Primary VLAN and other community ports in the same Community VLAN. 
They cannot communicate with ports in an Isolated VLAN, non-associated Primary VLAN 
Promiscuous ports nor Community ports in different Community VLANs. 

• Isolated: Ports in an Isolated VLAN can communicate with Promiscuous ports in an 
associated Primary VLAN only. They cannot communicate with other Isolated ports in 
the same Isolated VLAN, non-associated Primary VLAN Promiscuous ports nor any 
Community ports.

Associated VLAN Enter the VLAN ID of a previously created VLAN here.

Note: The VLAN ID and Mode selected here must be the same as the VLAN ID and 
VLAN Type created in Advanced Application > VLAN > Static VLAN.

Tagged A VLAN ID tag identifies VLAN membership of a frame across switches.

Select this if the VLAN includes ports on multiple switches. The Switch forwards tagged 
frames through this port; it adds the PVID to untagged frames before sending them out.

Clear this if the VLAN includes ports on this Switch only. The Switch forwards untagged 
frames through this port; it removes the VLAN ID from tagged frames before sending them 
out.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 165   Advanced Application > Private VLAN (continued)
LABEL DESCRIPTION
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CHAPTER 36
Green Ethernet

This chapter shows you how to configure the Switch to reduce the power consumed by switch ports.

36.1  Green Ethernet Overview 
Green Ethernet reduces switch port power consumption in the following ways.

• IEEE 802.3az Energy Efficient Ethernet (EEE)

If EEE is enabled, both sides of a link support EEE and there is no traffic, the port enters Low Power Idle 
(LPI) mode. LPI mode turns off some functions of the physical layer (becomes quiet) to save power. 
Periodically the port transmits a REFRESH signal to allow the link partner to keep the link alive. When 
there is traffic to be sent, a WAKE signal is sent to the link partner to return the link to active mode.

• Auto Power Down

Auto Power Down turns off almost all functions of the port’s physical layer functions when the link is 
down, so the port only uses power to check for a link up pulse from the link partner. After the link up 
pulse is detected, the port wakes up from Auto Power Down and operates normally.

• Short Reach

Traditional Ethernet transmits all data with enough power to reach the maximum cable length. 
Shorter cables lose less power, so Short Reach saves power by adjusting the transmit power of each 
port according to the length of cable attached to that port.

36.2  Configuring Green Ethernet
Click Advanced Application > Green Ethernet in the navigation panel to display the screen as shown. 

Note: EEE, Auto Power Down and Short Reach are not supported on an uplink port.
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Figure 278   Advanced Application > Green Ethernet (Standalone mode)

Figure 279   Advanced Application > Green Ethernet (Stacking mode)

The following table describes the labels in this screen. 

Table 166   Advanced Application > Green Ethernet
LABEL DESCRIPTION
EEE Select this to activate Energy Efficient Ethernet globally.

Auto Power Down Select this to activate Auto Power Down globally.
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Short Reach Select this to activate Short Reach globally.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port This field displays the port number. In stacking mode, the first box field is the slot ID and the 
second field is the port number. * means all ports (on the same Switch).

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments to each port if necessary. 

Note: Changes in this row are copied to all the ports as soon as you make them.
EEE Select this to activate Energy Efficient Ethernet on this port.

Auto Power Down Select this to activate Auto Power Down on this port.

Short Reach Select this to activate Short Reach on this port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel 
to save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 166   Advanced Application > Green Ethernet
LABEL DESCRIPTION
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CHAPTER 37
Link Layer Discovery Protocol

(LLDP)

37.1  LLDP Overview
The LLDP (Link Layer Discovery Protocol) is a layer 2 protocol. It allows a network device to advertise its 
identity and capabilities on the local network. It also allows the device to maintain and store information 
from adjacent devices which are directly connected to the network device. This helps an administrator 
discover network changes and perform necessary network reconfiguration and management. The 
device information is encapsulated in the LLDPDUs (LLDP data units) in the form of TLV (Type, Length, 
Value). Device information carried in the received LLDPDUs is stored in the standard MIB.

The Switch supports these basic management TLVs. 

• End of LLDPDU (mandatory)

• Chassis ID (mandatory)

• Port ID (mandatory)

• Time to Live (mandatory)

• Port Description (optional)

• System Name (optional)

• System Description (optional)

• System Capabilities (optional)

• Management Address (optional)

The Switch also supports the IEEE 802.1 and IEEE 802.3 organizationally-specific TLVs.

IEEE 802.1 specific TLVs:

• Port VLAN ID TLV (optional)

• Port and Protocol VLAN ID TLV (optional)

IEEE 802.3 specific TLVs:

• MAC/PHY Configuration/Status TLV (optional)

• Power via MDI TLV (optional, for PoE models only)

• Link Aggregation TLV (optional)

• Maximum Frame Size TLV (optional)

The optional TLVs are inserted between the Time To Live TLV and the End of LLDPDU TLV.
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The next figure demonstrates that the network devices Switches and Routers (S and R) transmit and 
receive device information via LLDPDU and the network manager can query the information using 
Simple Network Management Protocol (SNMP).

Figure 280   LLDP Overview

37.2  LLDP-MED Overview
LLDP-MED (Link Layer Discovery Protocol for Media Endpoint Devices) is an extension to the standard 
LLDP developed by the Telecommunications Industry Association (TIA) TR-41.4 subcommittee which 
defines the enhanced discovery capabilities, such as VoIP applications, to enable network 
administrators manage their network topology application more efficiently. Unlike the traditional LLDP, 
which has some limitations when handling multiple application devices, the LLDP-MED offers display of 
accurate physical topology, interoperability of devices, and easy trouble shooting for misconfigured IP 
addresses. There are three classes of endpoint devices that the LLDP-MED supports:

Class I: IP Communications Controllers or other communication related servers

Class II: Voice Gateways, Conference Bridges or Media Servers

Class III: IP-Phones, PC-based Softphones, End user Communication Appliances supporting IP Media

The following figure shows that with the LLDP-MED, network connectivity devices (NCD) like Switches 
and Routers will transmit LLDP TLV to endpoint device (ED) like IP Phone first (1), to get its device type 
and capabilities information, then it will receive that information in LLDP-MED TLV back from endpoint 
devices (2), after that the network connectivity devices will transmit LLDP-MED TLV (3) to provision the 
endpoint device to such that the endpoint device’s network policy and location identification 
information is updated. Since LLDPDU updates status and configuration information periodically, 
network managers may check the result of provision via remote status. The remote status is updated by 
receiving LLDP-MED TLVs from endpoint devices.



Chapter 37 Link Layer Discovery Protocol (LLDP)

XGS4600 Series User’s Guide

357

Figure 281   LLDP-MED Overview  

37.3  LLDP Screens
Click Advanced Application > LLDP in the navigation panel to display the screen as shown next.

Figure 282   Advanced Application > LLDP

The following table describes the labels in this screen. 

Table 167   Advanced Application > LLDP 
LABEL DESCRIPTION
LLDP

LLDP Local 
Status 

Click here to show a screen with the Switch’s LLDP information.

LLDP Remote 
Status

Click here to show a screen with LLDP information from the neighboring devices.

LLDP 
Configuration 

Click here to show a screen to configure LLDP parameters. 
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37.4  LLDP Local Status 
This screen displays a summary of LLDP status on this Switch. Click Advanced Application > LLDP > LLDP 
Local Status to display the screen as shown next.

Figure 283   Advanced Application > LLDP > LLDP Local Status (Standalone mode)

LLDP-MED 

LLDP-MED 
Configuration  

Click here to show a screen to configure LLDP-MED (Link Layer Discovery Protocol for Media 
Endpoint Devices) parameters. 

LLDP-MED 
Network Policy

Click here to show a screen to configure LLDP-MED (Link Layer Discovery Protocol for Media 
Endpoint Devices) network policy parameters. 

LLDP-MED 
Location

Click here to show a screen to configure LLDP-MED (Link Layer Discovery Protocol for Media 
Endpoint Devices) location parameters. 

Table 167   Advanced Application > LLDP (continued)
LABEL DESCRIPTION
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Figure 284   Advanced Application > LLDP > LLDP Local Status (Stacking mode)

The following table describes the labels in this screen. 

Table 168   Advanced Application > LLDP > LLDP Local Status
LABEL DESCRIPTION
Basic TLV  

 Chassis ID TLV    
 

This displays the chassis ID of the local Switch, that is the Switch you’re configuring. The 
chassis ID is identified by the chassis ID subtype.

Chassis ID Subtype - this displays how the chassis of the Switch is identified.

Chassis ID - This displays the chassis ID of the local Switch. 

System Name 
TLV    

This shows the Host Name of the Switch.

 System 
Description TLV 

This shows the firmware version of the Switch. 

System 
Capabilities TLV 

This shows the System Capabilities enabled and supported on the local Switch.

• System Capabilities Supported - Bridge
• System Capabilities Enabled - Bridge
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37.4.1  LLDP Local Port Status Detail 
This screen displays detailed LLDP status for each port on this Switch. Click Advanced Application > LLDP 
> LLDP Local Status and then click a port number, for example 1 in the Local Port column to display the 
screen as shown next. 

Management 
Address TLV   

The Management Address TLV identifies an address associated with the local LLDP agent 
that may be used to reach higher layer entities to assist discovery by network management. 
The TLV may also include the system interface number and an object identifier (OID) that are 
associated with this management address.

This field displays the Management Address settings on the specified port(s). 

• Management Address Subtype - ipv4 / all-802 
• Interface Number Subtype - unknown
• Interface Number - 0 (not supported)
• Object Identifier - 0 (not supported)

LLDP Port 
Information 

This displays the local port information.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch in a stack.

Local Port This displays the number of the Switch port which receives the LLDPDU from the remote 
device. Click a port number to view the detailed LLDP status on this port at LLDP Local Port 
Status Detail screen. For Stacking mode, the first field box is the Slot ID, the second field box is 
the port.

Port ID Subtype This indicates how the port ID field is identified.

Port ID This is an alpha-numeric string that contains the specific identifier for the port from which this 
LLDPDU was transmitted.

Port Description This shows the port description that the Switch will advertise from this port.

Table 168   Advanced Application > LLDP > LLDP Local Status
LABEL DESCRIPTION



Chapter 37 Link Layer Discovery Protocol (LLDP)

XGS4600 Series User’s Guide

361

Figure 285   Advanced Application > LLDP > LLDP Local Status > LLDP Local Port Status Detail (Basic TLV)

Figure 286   Advanced Application > LLDP > LLDP Local Status > LLDP Local Port Status Detail (MED TLV)
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The following table describes the labels in this screen. 

Table 169   Advanced Application > LLDP > LLDP Local Status > LLDP Local Port Status Detail
LABEL DESCRIPTION
Basic TLV These are the Basic TLV flags

Port ID TLV The port ID TLV identifies the specific port that transmitted the LLDP frame. 

• Port ID Subtype: This shows how the port is identified.
• Port ID: This is the ID of the port. In stacking mode, the first number represents the slot and 

the second the port number.

Port Description 
TLV 

 This displays the local port description.

Dot1 TLV 

Port VLAN ID 
TLV

This displays the VLAN ID sent by the IEEE 802.1 Port VLAN ID TLV.

Port-Protocol 
VLAN ID TLV

This displays the IEEE 802.1 Port Protocol VLAN ID TLVs, which indicates whether the VLAN is 
enabled and supported.

Dot3 TLV  

MAC PHY 
Configuration & 
Status TLV

The MAC/PHY Configuration/Status TLV advertises the bit-rate and duplex capability of the 
sending 802.3 node. It also advertises the current duplex and bit-rating of the sending node. 
Lastly, it advertises whether these setting were the result of auto-negotiation during link 
initiation or manual override.

• AN Supported - Displays if the port supports or does not support auto-negotiation.
• AN Enabled - The current auto-negotiation status of the port. 
• AN Advertised Capability - The auto-negotiation capabilities of the port.
• Oper MAU Type - The current Medium Attachment Unit (MAU) type of the port.

Link 
Aggregation 
TLV

The Link Aggregation TLV indicates whether the link is capable of being aggregated, 
whether the link is currently in an aggregation, and if in an aggregation, the port 
identification of the aggregation.

• Aggregation Capability — The current aggregation capability of the port.

• Aggregation Status — The current aggregation status of the port.

• Aggregation Port ID — The aggregation ID of the current port.

Max Frame Size 
TLV

This displays the maximum supported frame size in octets. 

MED TLV LLDP Media Endpoint Discovery (MED) is an extension of LLDP that provides additional 
capabilities to support media endpoint devices. MED enables advertisement and discovery 
of network policies, device location discovery to allow creation of location databases, and 
information for troubleshooting.

Capabilities TLV This field displays which LLDP-MED TLV are capable to transmit on the Switch.

• Network Policy
• Location
• Extend Power via MDI PSE
• Extend Power via MDI PD
• Inventory Management

Device Type 
TLV

This is the LLDP-MED device class. The Zyxel Switch device type is:

• Network Connectivity
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37.5  LLDP Remote Status 
This screen displays a summary of LLDP status for each LLDP connection to a neighboring Switch. Click 
Advanced Application > LLDP > LLDP Remote Status to display the screen as shown next.

Figure 287   Advanced Application > LLDP > LLDP Remote Status (Standalone mode) 

Figure 288   Advanced Application > LLDP > LLDP Remote Status (Stacking mode) 

The following table describes the labels in this screen. 

Network Policy 
TLV

This displays a network policy for the specified application.

• Voice  
• Voice-Signaling  
• Guest-Voice  
• Guest-Voice-Signaling  
• Softphone-Voice  
• Video-Conferencing  
• Streaming-Video  
• Video-Signaling

Location 
Identification 
TLV

This shows the location information of a caller by its ELIN (Emergency Location Identifier 
Number) or the IETF Geopriv Civic Address based Location Configuration Information (Civic 
Address LCI).

• Coordinate-base LCI - latitude, longitude and altitude coordinates of the location 
Configuration Information (LCI)

• Civic LCI - IETF Geopriv Civic Address based Location Configuration Information
• ELIN - (Emergency Location Identifier Number)

Table 169   Advanced Application > LLDP > LLDP Local Status > LLDP Local Port Status Detail
LABEL DESCRIPTION

Table 170   Advanced Application > LLDP > LLDP Remote Status
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch in a stack.

Index The index number shows the number of remote devices that are connected to the Switch. 
Click on an index number to view the detailed LLDP status for this remote device in the LLDP 
Remote Port Status Detail screen.

Local Port This is the number of the Switch’s port that received LLDPDU from the remote device. In 
stacking mode, the first number represents the slot and the second the port number.

Chassis ID This displays the chassis ID of the remote device associated with the transmitting LLDP agent. 
The chassis ID is identified by the chassis ID subtype. For example, the MAC address of the 
remote device.

Port ID This is an alpha-numeric string that contains the specific identifier for the port from which this 
LLDPDU was transmitted. The port ID is identified by the port ID subtype.
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37.5.1  LLDP Remote Port Status Detail 
This screen displays detailed LLDP status of the remote device connected to the Switch. Click Advanced 
Application > LLDP > LLDP Remote Status and then click an index number, for example 1, in the Index 
column in the LLDP Remote Status screen to display the screen as shown next.

Figure 289   Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Basic 
TLV) 

Port Description This displays a description for the port from which this LLDPDU was transmitted.

System Name This displays the system name of the remote device.

Management 
Address

This displays the management address of the remote device. It could be the MAC address or 
IP address.  

Table 170   Advanced Application > LLDP > LLDP Remote Status
LABEL DESCRIPTION
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The following table describes the labels in Basic TLV part of the screen. 

Table 171   Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Basic 
TLV)
LABEL DESCRIPTION
Local Port This displays the number of the Switch’s port to which the remote device is connected.

Basic TLV  

Chassis ID TLV • Chassis ID Subtype - this displays how the chassis of the remote device is identified.
• Chassis ID - this displays the chassis ID of the remote device. The chassis ID is identified by 

the chassis ID subtype

Port ID TLV • Port ID Subtype - this displays how the port of the remote device is identified. 
• Port ID - this displays the port ID of the remote device. The port ID is identified by the port 

ID subtype.

Time To Live TLV This displays the time-to-live (TTL) multiplier of LLDP frames. The device information on the 
neighboring devices ages out and is discarded when its corresponding TTL expires. The TTL 
value is to multiply the TTL multiplier by the LLDP frames transmitting interval.

Port Description 
TLV 

This displays the remote port description.

System Name 
TLV

This displays the system name of the remote device.

System 
Description TLV

This displays the system description of the remote device.

System 
Capabilities TLV

This displays whether the system capabilities are enabled and supported on the remote 
device.

• System Capabilities Supported 
• System Capabilities Enabled

Management 
Address TLV

This displays the following management address parameters of the remote device.

• Management Address Subtype 
• Management Address 
• Interface Number Subtype 
• Interface Number 
• Object Identifier
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Figure 290   Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail> (Dot 
1 and Dot3 TLV) 

The following table describes the labels in the Dot1 and Dot3 parts of the screen. 

Table 172   Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Dot1 
and Dot3 TLV)
LABEL DESCRIPTION
Dot1 TLV 

Port VLAN ID 
TLV

This displays the VLAN ID of this port on the remote device. 
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Port-Protocol 
VLAN ID TLV

This displays the IEEE 802.1 Port Protocol VLAN ID TLV, which indicates whether the VLAN ID 
and whether it is enabled and supported on the port of remote Switch which sent the 
LLDPDU. 

• Port-Protocol VLAN ID
• Port-Protocol VLAN ID Supported
• Port-Protocol VLAN ID Enabled

Vlan Name TLV This shows the VLAN ID and name for remote device port.

• VLAN ID 
• VLAN Name

Protocol 
Identity TLV

The Protocol Identity TLV allows the Switch to advertise the particular protocols that are 
accessible through its port.

Dot3 TLV 

MAC PHY 
Configuration & 
Status TLV

The MAC/PHY Configuration/Status TLV advertises the bit-rate and duplex capability of the 
sending 802.3 node. It also advertises the current duplex and bit-rating of the sending node. 
Lastly, it advertises whether these setting were the result of auto-negotiation during link 
initiation or manual override.

• AN Supported - Displays if the port supports or does not support auto-negotiation.
• AN Enabled - The current auto-negotiation status of the port.  
• AN Advertised Capability - The auto-negotiation capabilities of the port.
• Oper MAU Type - The current Medium Attachment Unit (MAU) type of the port

Link 
Aggregation 
TLV

The Link Aggregation TLV indicates whether the link is capable of being aggregated, 
whether the link is currently in an aggregation, and if in an aggregation, the port 
identification of the aggregation.

• Aggregation Capability — The current aggregation capability of the port.

• Aggregation Status — The current aggregation status of the port.

• Aggregation Port ID — The aggregation ID of the current port.

Power Via MDI 
TLV

The Power Via MDI TLV allows network management to advertise and discover the MDI 
power support capabilities of the sending port on the remote device.

• Port Class 
• MDI Supported 
• MDI Enabled 
• Pair Controllable 
• PSE Power Pairs 
• Power Class 

Max Frame Size 
TLV

This displays the maximum supported frame size in octets.

Table 172   Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Dot1 
and Dot3 TLV)
LABEL DESCRIPTION
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Figure 291   Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (MED 
TLV) 
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The following table describes the labels in the MED TLV part of the screen. 

Table 173   Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (MED 
TLV) 
LABEL DESCRIPTION
MED TLV LLDP Media Endpoint Discovery (MED) is an extension of LLDP that provides additional 

capabilities to support media endpoint devices. MED enables advertisement and discovery 
of network policies, device location discovery to allow creation of location databases, and 
information for troubleshooting.

Capabilities TLV This displays the MED capabilities the remote port supports.

• Network Policy 
• Location 
• Extend Power via MDI PSE 
• Extend Power via MDI PD 
• Inventory Management

Device Type 
TLV

LLDP-MED endpoint device classes:

• Endpoint Class I
• Endpoint Class II
• Endpoint Class III
• Network Connectivity

Network Policy 
TLV

This displays a network policy for the specified application.

• Voice 
• Voice-Signaling 
• Guest-Voice 
• Guest-Voice-Signaling 
• Softphone-Voice 
• Video-Conferencing 
• Streaming-Video 
• Video-Signaling

Location 
Identification 
TLV

This shows the location information of a caller by its:

• Coordinate-base LCI - latitude and longitude coordinates of the Location Configuration 
Information (LCI)

• Civic LCI - IETF Geopriv Civic Address based Location Configuration Information
• ELIN - (Emergency Location Identifier Number)

Inventory TLV The majority of IP Phones lack support of management protocols such as SNMP, so LLDP-MED 
inventory TLVs are used to provide their inventory information to the Network Connectivity 
Devices such as the Switch. The Inventory TLV may contain the following information.

• Hardware Revision 
• Software Revision 
• Firmware Revision 
• Model Name 
• Manufacturer 
• Serial Number 
• Asset ID 

Extended 
Power via MDI 
TLV

Extended Power Via MDI Discovery enables detailed power information to be advertised by 
Media Endpoints, such as IP phones and Network Connectivity Devices such as the Switch.

• Power Type - whether it is currently operating from primary power or is on backup power 
(backup power may indicate to the Endpoint Device that it should move to a power 
conservation mode).

• Power Source - whether or not the Endpoint is currently operating from an external power 
source.

• Power Priority - the Endpoint Device’s power priority (which the Network Connectivity 
Device may use to prioritize which devices will remain in service during power shortages)

• Power Value - power requirement, in fractions of Watts, in current configuration
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37.6  LLDP Configuration 
Use this screen to configure global LLDP settings on the Switch. Click Advanced Application > LLDP > 
LLDP Configuration to display the screen as shown next.

Figure 292   Advanced Application > LLDP > LLDP Configuration (Standalone mode) 
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Figure 293   Advanced Application > LLDP > LLDP Configuration (Stacking mode) 

The following table describes the labels in this screen. 

Table 174   Advanced Application > LLDP > LLDP Configuration
LABEL DESCRIPTION
Active Select to enable LLDP on the Switch. It is enabled by default.

Transmit Interval Enter how many seconds the Switch waits before sending LLDP packets.

Transmit Hold Enter the time-to-live (TTL) multiplier of LLDP frames. The device information on the 
neighboring devices ages out and is discarded when its corresponding TTL expires. The TTL 
value is to multiply the TTL multiplier by the LLDP packets transmitting interval.

Transmit Delay Enter the delay (in seconds) between successive LLDPDU transmissions initiated by value or 
status changes in the Switch MIB.

Reinitialize Delay Enter the number of seconds for LLDP to wait before initializing on a port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch in a stack.

Port This displays the Switch’s port number. * means all ports (on the same Switch). In Stacking 
mode, the first number means Slot ID and the second is the port.
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37.6.1  LLDP Configuration Basic TLV Setting 
Use this screen to configure Basic TLV settings. Click Advanced Application > LLDP > LLDP Configuration > 
Basic TLV Setting to display the screen as shown next.

Figure 294   Advanced Application > LLDP > LLDP Configuration> Basic TLV Setting (Standalone mode)

Admin Status Select whether LLDP transmission and/or reception is allowed on this port.

• Disable - not allowed
• Tx-Only - transmit only
• Rx-Only - receive only
• Tx-Rx - transmit and receive

Notification Select whether LLDP notification is enabled on this port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 174   Advanced Application > LLDP > LLDP Configuration
LABEL DESCRIPTION
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Figure 295   Advanced Application > LLDP > LLDP Configuration> Basic TLV Setting (Stacking mode)

The following table describes the labels in this screen. 

37.6.2  LLDP Configuration Basic Org-specific TLV Setting 
Use this screen to configure organization-specific TLV settings. Click Advanced Application > LLDP > LLDP 
Configuration > Org-specific TLV Setting to display the screen as shown next.

Table 175   Advanced Application > LLDP > LLDP Configuration > Basic TLV Setting
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch in a stack.

Port This displays the Switch’s port number. * means all ports (on the same Switch). In Stacking 
mode, the first number means Slot ID and the second is the port.

Management 
Address

Select the check box(es) to enable or disable the sending of Management Address TLVs on 
the port(s).

Port Description Select the check box(es) to enable or disable the sending of Port Description TLVs on the 
port(s).

System Capabilities Select the check box(es) to enable or disable the sending of System Capabilities TLVs on the 
port(s).

System Description Select the check box(es) to enable or disable the sending of System Description TLVs on the 
port(s).

System Name Select the check box(es) to enable or disable the sending of System Name TLVs on the 
port(s).

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 296   Advanced Application > LLDP > LLDP Configuration> Org-specific TLV Setting (Standalone 
mode) 

Figure 297   Advanced Application > LLDP > LLDP Configuration> Org-specific TLV Setting (Stacking 
mode) 

The following table describes the labels in this screen. 

Table 176   Advanced Application > LLDP > LLDP Configuration > Org-specific TLV Setting
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch in a stack.

Port This displays the Switch’s port number. * means all ports (on the same Switch). In Stacking 
mode, the first number means Slot ID and the second is the port.

Dot1 TLV

Port-Protocol 
VLAN ID

Select the check box(es) to enable or disable the sending of IEEE 802.1 Port and Protocol 
VLAN ID TLVs on the port(s). 

Port VLAN ID Select the check box(es) to enable or disable the sending of IEEE 802.1 Port VLAN ID TLVs on 
the port(s). All check boxes in this column are enabled by default.
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37.7  LLDP-MED Configuration 
Click Advanced Application > LLDP > LLDP-MED Configuration to display the screen as shown next.

Dot3 TLV

Link 
Aggregation

Select the check box(es) to enable or disable the sending of IEEE 802.3 Link Aggregation TLVs 
on the port(s).

MAC/PHY Select the check box(es) to enable or disable the sending of IEEE 802.3 MAC/PHY 
Configuration/Status TLVs on the port(s). All check boxes in this column are enabled by 
default.

Max Frame Size Select the check box(es) to enable or disable the sending of IEEE 802.3 Max Frame Size TLVs 
on the port(s).

Power Via MDI Note: For PoE models only. 

The Power Via MDI TLV allows network management to advertise and discover the MDI 
power support capabilities of the sending port on the remote device.

• Port Class 
• MDI Supported 
• MDI Enabled 
• Pair Controlable 
• PSE Power Pairs 
• Power Class 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 176   Advanced Application > LLDP > LLDP Configuration > Org-specific TLV Setting
LABEL DESCRIPTION
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Figure 298   Advanced Application > LLDP > LLDP-MED Configuration (Standalone mode) 

Figure 299   Advanced Application > LLDP > LLDP-MED Configuration (Stacking mode) 

The following table describes the labels in this screen. 

Table 177   Advanced Application > LLDP > LLDP-MED Configuration
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number 
of the Switch in a stack.

Port This displays the Switch’s port number. Select * to configure all ports (in the same Switch) 
simultaneously. In Stacking mode, the first number means Slot ID and the second is the port.

Notification
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37.8  LLDP-MED Network Policy  
Click Advanced Application > LLDP > LLDP-MED Network Policy to display the screen as shown next.

Figure 300   Advanced Application > LLDP > LLDP-MED Network Policy (Standalone mode) 

Figure 301   Advanced Application > LLDP > LLDP-MED Network Policy (Stacking mode) 

Topology 
Change

Select to enable LLDP-MED topology change traps on this port.

MED TLV Setting 

Location Select to enable transmitting LLDP-MED location TLV.

Network Policy Select to enable transmitting LLDP-MED Network Policy TLV.

Apply Click Apply to save the changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 177   Advanced Application > LLDP > LLDP-MED Configuration
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

37.9  LLDP-MED Location  
Click Advanced Application > LLDP > LLDP-MED Location to display the screen as shown next.

Table 178   Advanced Application > LLDP > LLDP-MED Network Policy
LABEL DESCRIPTION
Port Enter the port number to set up the LLDP-MED network policy. For Stacking mode the first field 

box is the Slot ID, the second field box is the port.

Application Type Select the type of application used in the network policy.

• voice
• voice-signaling
• guest-voice
• guest-voice-signaling
• softphone-voice
• video-conferencing
• streaming-video
• video-signaling

Tag Select to tag or untag in the network policy.

• tagged
• untagged

VLAN Enter the VLAN ID number. It should be from 1 to 4094. For priority tagged frames, enter “0”.

DSCP Enter the DSCP value of the network policy. The value is defined from 0 through 63 with the 0 
representing use of the default DSCP value.

Priority Enter the priority value for the network policy.

Add Click Add after finish entering the network policy information. A summary table will list all the 
Switch you’ve added. 

Cancel Click Cancel to begin entering the information afresh.

Index This field displays the of index number of the network policy. Click an index number to edit 
the rule.

Port This field displays the port number of the network policy. In stacking mode, the first number 
represents the slot and the second the port number.

Application Type This field displays the application type of the network policy.

Tag This field displays the Tag Status of the network policy.

VLAN This field displays the VLANID of the network policy.

Priority This field displays the priority value of the network policy.

DSCP This field displays the DSCP value of the network policy.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Check the rules that you want to remove, then click the Delete button.

Cancel Click Cancel to clear the selected check boxes.
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Figure 302   Advanced Application > LLDP > LLDP-MED Location (Standalone mode) 
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Figure 303   Advanced Application > LLDP > LLDP-MED Location (Stacking mode) 

The following table describes the labels in this screen. 

Table 179   Advanced Application > LLDP > LLDP-MED Location
LABEL DESCRIPTION
Port Enter the port number you want to set up the location within the LLDP-MED network.For 

Stacking mode the first field box is the Slot ID, the second field box is the port.

Location 
Coordinates

The LLDP-MED uses geographical coordinates and Civic Address to set the location 
information of the remote device. Geographical based coordinates includes latitude, 
longitude, altitude and datum. Civic Address includes Country, State, County, City, Street 
and other related information.

Latitude Enter the latitude information. The value should be from 0º to 90º. 

• north
• south

Longitude Enter the longitude information. The value should be from 0º to 180º. 

• west
• east

Altitude Enter the altitude information. The value should be from -2097151 to 2097151 in meters or in 
floors.

• meters
• floor
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Datum Select the appropriate geodetic datum used by GPS.

• WGS84
• NAD83-NAVD88
• NAD83-MLLW

Civic Address Enter the Civic Address by providing information such as Country, State, County, City, Street, 
Number, ZIP code and other additional information. Enter at least two field in this 
configuration including the Country. The valid length of the Country field is 2 characters and 
all other fields are up to 32 characters.   

• Country
• State
• County
• City
• Division
• Neighbor 
• Street
• Leading-Street-Direction 
• Street-Suffix
• Trailing-Street-Suffix 
• House-Number
• House-Number-Suffix 
• Landmark
• Additional-Location 
• Name
• Zip-Code 
• Building
• Unit
• Floor
• Room-Number 
• Place-Type
• Postal-Community-Name 
• Post-Office-Box
• Additional-Code

ELIN Number Enter a numerical digit string, corresponding to the ELIN identifier which is used during 
emergency call setup to a traditional CAMA or ISDN trunk-based PSAP. The valid length is 
from 10 characters to 25 characters.

Add Click Add after finish entering the location information. 

Cancel Click Cancel to begin entering the location information afresh.

Index This lists the index number of the location configuration. Click an index number to view or edit 
the location.

Port This lists the port number of the location configuration. In stacking mode, the first number 
represents the slot and the second the port number.

Location 
Coordinates

This field displays the location configuration information based on geographical coordinates 
that includes longitude, latitude, altitude and datum.

Civic Address This field displays the Civic Address for the remote device using information such as Country, 
State, County, City, Street, Number, ZIP code and additional information.

ELIN Number This field shows the Emergency Location Identification Number (ELIN), which is used to 
identify endpoint devices when they issue emergency call services. The valid length is form 10 
characters to 25 characters.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Table 179   Advanced Application > LLDP > LLDP-MED Location
LABEL DESCRIPTION
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Delete Check the locations that you want to remove, then click the Delete button.

Cancel Click Cancel to clear the selected check boxes.

Table 179   Advanced Application > LLDP > LLDP-MED Location
LABEL DESCRIPTION
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CHAPTER 38
Anti-Arpscan

38.1  Anti-Arpscan Overview 
Address Resolution Protocol (ARP), RFC 826, is a protocol used to convert a network-layer IP address to a 
link-layer MAC address. ARP scan is used to scan the network of a certain interface for alive hosts. It 
shows the IP address and MAC addresses of all hosts found. Hackers could use ARP scan to find targets 
in your network. Anti-arpscan is used to detect unusual ARP scan activity and block suspicious hosts or 
ports. 

Unusual ARP scan activity is determined by port and host thresholds that you set. A port threshold is 
determined by the number of packets received per second on the port. If the received packet rate is 
over the threshold, then the port is put into an Err-Disable state. You can recover the normal state of the 
port manually if this happens and after you identify the cause of the problem.

A host threshold is determined by the number of ARP-request packets received per second. There is a 
global threshold rate for all hosts. If the rate of a host is over the threshold, then that host is blocked by 
using a MAC address filter. A blocked host is released automatically after the MAC aging time expires.

Note: A port-based threshold must be larger than the host-based threshold or the host-based 
threshold will not work.

38.1.1  What You Can Do
• Use the Anti-Arpscan Status screen (Section 38.2 on page 384) to see what ports are trusted and are 

forwarding traffic or are disabled.

• Use the Anti-Arpscan Host Status screen (Section 38.3 on page 385) to view blocked hosts and clear 
selected ones.

• Use the Anti-Arpscan Trust Host screen (Section 38.4 on page 386) to create or remove trusted hosts 
identified by IP address and subnet mask. Anti-arpscan is not performed on trusted hosts.

• Use this Anti-Arpscan Configure screen (Section 38.5 on page 386) to enable anti-arpscan, set port 
and host thresholds as well as configure ports to be trusted or untrusted. 

38.1.2  What You Need to Know
• You should set an uplink port as a trusted port before enabling Anti-arpscan so as to prevent the port 

from being shutdown due to receiving too many ARP messages.

• When a port is configured as a trusted port, Anti-arpscan is not performed on the port. Both host and 
port thresholds are ignored for trusted ports. If the received ARP packet rate on a port or the received 
ARP-requests from a host exceed the thresholds, the trusted port will not be closed. 

• If a port on the Switch is closed by Anti-arpscan, and you want to recover it, then do one of the 
following:

• Go to Basic Setting > Port Setup. Clear Active and click Apply. Then select Active and click Apply 
again.
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• Go to Application > Errdiable > Errdisable Recovery and set the interval for Anti-arpscan. After the 
interval expires, the closed port(s) will become active and start receiving packets again.

• Use the command port no inactive.

• Refer to the port logs to see when a port was closed.

38.2  Anti-Arpscan Status 
Use this screen to see what ports are trusted and are forwarding traffic or are disabled. To open this 
screen, click Advanced Application > Anti-Arpscan.

Figure 304   Advanced Application > Anti-Arpscan Status (Standalone mode)

Figure 305   Advanced Application > Anti-Arpscan Status (Stacking mode) 
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The following table describes the fields in the above screen. 

38.3  Anti-Arpscan Host Status 
Use this screen to view blocked hosts and unblock ones connected to certain ports. To open this screen, 
click Advanced Application > Anti-Arpscan > Host Status.

Figure 306   Advanced Application > Anti-Arpscan > Host Status

The following table describes the fields in the above screen. 

Table 180   Advanced Application > Anti-Arpscan Status
LABEL DESCRIPTION
Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 

number of the Switch in a stack.

Anti-Arpscan is.... This shows whether Anti-arpscan is enabled or disabled on the Switch.

Port This field displays the port number of the Switch.

Trusted This field displays whether the port is trusted or untrusted. Anti-arpscan is not performed on 
a trusted port. 

State This field displays whether the port can forward traffic normally (Forwarding) or is disabled 
(Err-Disable). 

Table 181   Advanced Application > Anti-Arpscan > Host Status
LABEL DESCRIPTION
Clear Filtered host: A filtered host is a blocked IP address.

Port List Type a port number or a series of port numbers separated by commas and spaces, and 
then click Clear to unblock all hosts connected to these ports.

Filtered host: This table lists information on blocked hosts. 

Index This displays the index number of an IP address (a host) that has been blocked. 

Host IP This displays the IP address of the blocked host.

MAC This displays the MAC address of the blocked host.

VLAN This displays the VLAN ID that shows which VLAN the blocked host is in.

Port This displays the port number to which the blocked host is connected.

State This shows Err-Disable if the ARP-request rate from this host is over the threshold. Forwarding 
hosts are not displayed.
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38.4  Anti-Arpscan Trust Host 
Use this screen to create or remove trusted hosts identified by IP address and subnet mask. Anti-arpscan 
is not performed on trusted hosts. To open this screen, click Advanced Application > Anti-Arpscan > Trust 
Host.

Figure 307   Advanced Application > Anti-Arpscan > Trust Host

The following table describes the fields in the above screen. 

38.5  Anti-Arpscan Configure 
Use this screen to enable Anti-Arpscan, set port and host thresholds as well as configure ports to be 
trusted or untrusted. To open this screen, click Advanced Application > Anti-Arpscan > Configure.

Table 182   Advanced Application > Anti-Arpscan > Trust Host
LABEL DESCRIPTION
Name Type a descriptive name of up to 32 printable ASCII characters to identify this host.

Host IP Type the IP address of the host.

Mask A trusted host may consist of a subnet of IP addresses. Type a subnet mask to create a 
single host or a subnet of hosts.

Add Click this to create the trusted host.

Cancel Click this to reset the values above based or, if not applicable, to clear the fields above.

Clear Click this to clear the fields above.

Index This field displays a sequential number for each trusted host.

Name This field displays the name of the trusted host.

Host IP This field displays the IP address of the trusted host.

Mask This field displays the subnet mask of the trusted host. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in 
the table heading row to select all entries.

Delete Select an entry check box and click Delete to remove the specified entry.

Cancel Click this to clear the check boxes above.
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Figure 308   Advanced Application > Anti-Arpscan > Configure (Standalone mode)

Figure 309   Advanced Application > Anti-Arpscan > Configure (Stacking mode)
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The following table describes the fields in the above screen. 

Table 183   Advanced Application > Anti-Arpscan > Configure
LABEL DESCRIPTION
Active Select this to enable Anti-arpscan on the Switch.

Port Threshold A port threshold is determined by the number of packets received per second on the port. 
If the received packet rate is over the threshold, then the port is put into an Err-Disable 
state. Type the maximum number of packets per second allowed on the port before it is 
blocked. 

Note: The allowed range is 2 to 255 packets received per second.
Host Threshold A host threshold is determined by the number of ARP-request packets received per 

second. This is the global threshold rate for all hosts. If the rate of a host is over the 
threshold, then that host is blocked by using a MAC address filter. A blocked host is 
released automatically after the MAC aging time expires.

Type the maximum number of ARP-request packets allowed by a host before it is blocked. 

Note: The allowed range is 2 to 100 ARP-request packets per second.

Note: The port-based threshold must be larger than the host-based threshold or 
the host-based threshold will not be applied.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port Use port * to have all ports be Untrusted or Trusted. Anti-arpscan is not performed on 
trusted hosts.

Trusted State Select Untrusted or Trusted for the associated port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.
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CHAPTER 39
BPDU Guard

39.1  BPDU Guard Overview 
A BPDU (Bridge Protocol Data Units) is a data frame that contains information about STP. STP-aware 
switches exchange BPDUs periodically. 

The BPDU guard feature allows you to prevent any new STP-aware switch from connecting to an existing 
network and causing STP topology changes in the network. If there is any BPDU detected on the port(s) 
on which BPDU guard is enabled, the Switch disables the port(s) automatically. You can then enable the 
port(s) manually in the Basic Setting > Port Setup screen (Section 8.5 on page 87) or use the Errdisable 
Recovery screen (see Section 33.6 on page 343) to have the port(s) become active after a certain time 
interval.

39.1.1  What You Can Do
• Use the BPDU Guard Status screen (Section 39.2 on page 389) to view the BPDU guard status.

• Use the BPDU Guard Configuration screen (Section 39.3 on page 391) to enable BPDU guard on the 
Switch.

39.2  BPDU Guard Status
Use this screen to view whether BPDU guard is enabled on the Switch and the port status. Click 
Advanced Application > BPDU Guard in the navigation panel. 
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Figure 310   Advanced Application > BPDU Guard Status (Standalone mode)

Figure 311   Advanced Application > BPDU Guard Status (Stacking mode)

The following table describes the fields in the above screen. 

Table 184   Advanced Application > BPDU Guard Status
LABEL DESCRIPTION
BPDU guard globally 
configuration

This field displays whether BPDU guard is activated on the Switch.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port This is the number of the port on the Switch.
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39.3  BPDU Guard Configuration
Use this screen to turn on the BPDU guard feature on the Switch and port(s).

In the BPDU Guard Status screen click Configuration to display the configuration screen as shown.

Figure 312   Advanced Application > BPDU Guard > BPDU Guard Configuration (Standalone mode)

Active This shows whether BPDU guard is activated on the port.

Status This shows whether the port is shut down (Err-disable) or able to transmit packets 
(Forwarding).

Table 184   Advanced Application > BPDU Guard Status
LABEL DESCRIPTION
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Figure 313   Advanced Application > BPDU Guard > BPDU Guard Configuration (Stacking mode)

The following table describes the fields in the above screen. 

Table 185   Advanced Application > BPDU Guard > BPDU Guard Configuration
LABEL DESCRIPTION
Active Select this option to enable BPDU guard on the Switch.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port This field displays the Switch’s port number

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to enable the BPDU guard feature on this port. The Switch shuts down 

this port if there is any BPDU received on the port. 

Clear this check box to disable the BPDU guard feature. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 40
OAM

40.1  OAM Overview 
Link layer Ethernet OAM (Operations, Administration and Maintenance) as described in IEEE 802.3ah is a 
link monitoring protocol. It utilizes OAM Protocol Data Units or OAM PDUs to transmit link status 
information between directly connected Ethernet devices. Both devices must support IEEE 802.3ah. 
Because link layer Ethernet OAM operates at layer two of the OSI (Open Systems Interconnection Basic 
Reference) model, neither IP or SNMP are necessary to monitor or troubleshoot network connection 
problems.

The Switch supports the following IEEE 802.3ah features:

• Discovery - this identifies the devices on each end of the Ethernet link and their OAM configuration.

• Remote Loopback - this can initiate a loopback test between Ethernet devices.

40.1.1  What You Can Do
• Use the OAM Status screen (Section 40.2 on page 393) to view the configuration of ports on which 

Ethernet OAM is enabled.

• Use the OAM Configuration screen (Section 40.3 on page 399) to enable Ethernet OAM on the Switch.

• Use the OAM Remote Loopback screen (Section 40.4 on page 401) to perform remote-loopback tests.

40.2  OAM Status
Use this screen to view the configuration of ports on which Ethernet OAM is enabled. Click Advanced 
Application > OAM in the navigation panel. 
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Figure 314   Advanced Application > OAM Status (Standalone mode) 

Figure 315   Advanced Application > OAM Status (Stacking mode) 

The following table describes the fields in the above screen. 

Table 186   Advanced Application > OAM Status
LABEL DESCRIPTION
Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 

number of the Switch in a stack.

Local

This section displays information about the ports on the Switch.
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40.2.1  OAM Details
Use this screen to view OAM configuration details and operational status of a specific port. Click a 
number in the Port column in the OAM Status screen to display the screen as shown next. 

Port This field displays the number of the port on the Switch. In stacking mode, the first box field 
is the slot ID and the second field is the port number. 

Mode This field displays the operational state of the port when OAM is enabled on the port.

Active - Allows the port to issue and respond to Ethernet OAM commands.

Passive - Allows the port to respond to Ethernet OAM commands.

Remote

This section displays information about the remote device.

Mac Address This field displays the MAC address of the remote device.

OUI This field displays the OUI (first three bytes of the MAC address) of the remote device.

Mode This field displays the operational state of the port when OAM is enabled on the port.

Active - Allows the port to issue and respond to Ethernet OAM commands.

Passive - Allows the port to respond to Ethernet OAM commands.

Config This field displays the capabilities of the Switch and remote device.

Table 186   Advanced Application > OAM Status
LABEL DESCRIPTION
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Figure 316   Advanced Application > OAM Status > OAM Details

The following table describes the fields in the above screen. 

Table 187   Advanced Application > OAM Status > OAM Details
LABEL DESCRIPTION
Discovery This section displays OAM configuration details and operational status of the port on the 

Switch and/or the remote device.

Local Client/Remote Client

OAM configurations
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Mode This field displays the OAM mode. The device in active mode (typically the service 
provider's device) controls the device in passive mode (typically the subscriber's device).

Active: The port initiates OAM discovery; sends information PDUs; and may send event 
notification PDUs, variable request/response PDUs, or loopback control PDUs.

Passive: The port waits for the remote device to initiate OAM discovery; sends information 
PDUs; may send event notification PDUs; and may respond to variable request PDUs or 
loopback control PDUs.

The Switch might not support some types of PDUs, as indicated in the fields below.

Unidirectional This field indicates whether or not the port can send information PDUs to transmit fault 
information when the receive path is non-operational.

Remote loopback This field indicates whether or not the port can use loopback control PDUs to put the 
remote device into loopback mode.

Link events This field indicates whether or not the port can interpret link events, such as link fault and 
dying gasp. Link events are sent in event notification PDUs and indicate when the number 
of errors in a given interval (time, number of frames, number of symbols, or number of 
errored frame seconds) exceeds a specified threshold. Organizations may create 
organization-specific link event TLVs as well.

Variable retrieval This field indicates whether or not the port can respond to requests for more information, 
such as requests for Ethernet counters and statistics, about link events.

Max. OAMPDU 
size

This field displays the maximum size of PDU for receipt and delivery.

Local Client/Remote Client

Operational Status

Link status This field indicates that the link between the Switch port and a connected IEEE 802.3ah-
enabled remote Ethernet device is up or down.

Info. revision This field displays the current version of local state and configuration. This two-octet value 
starts at zero and increments every time the local state or configuration changes.

Parser state This field indicates the current state of the parser.

Forward: The port is forwarding packets normally.

Loopback: The port is in loopback mode.

Discard: The port is discarding non-OAM PDUs because it is trying to or has put the remote 
device into loopback mode.

Table 187   Advanced Application > OAM Status > OAM Details
LABEL DESCRIPTION
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Discovery 
state

This field indicates the state in the OAM discovery process. OAM-enabled devices use this 
process to detect each other and to exchange information about their OAM 
configuration and capabilities. OAM discovery is a handshake protocol.

Fault: One of the devices is transmitting OAM PDUs with link fault information, or the 
interface is not operational.

Active Send Local: The port is in active mode and is trying to see if the remote device 
supports OAM.

Passive Wait: The port is in passive mode and is waiting for the remote device to begin 
OAM discovery.

Send Local Remote: This state occurs in the following circumstances.

• The port has discovered the remote device but has not accepted or rejected the 
connection yet.

• The port has discovered the remote device and rejected the connection.

Send Local Remote OK: The port has discovered the remote device and has accepted the 
connection. In addition, the remote device has not accepted or rejected the connection 
yet, or the remote device has rejected the connected.

Send Any: The port and the remote device have accepted the connection. This is the 
operating state for OAM links that are fully operational.

Remote Client

Operational Status

MAC address This field displays the MAC address of the IEEE 802.3ah-enabled remote Ethernet device 
that is connected to the Switch.

Vendor(oui) This field displays the Organizationally Unique Identifiers (OUI) representing the vendor of 
the IEEE 802.3ah-enabled remote Ethernet device that is connected to the Switch.

Statistics

This section displays the number of OAM packets transferred on the port of the Switch.

Information 
OAMPDU Tx

This field displays the number of OAM PDUs sent on the port.

Information 
OAMPDU Rx

This field displays the number of OAM PDUs received on the port.

Event Notification 
OAMPDU Tx

This field displays the number of unique or duplicate OAM event notification PDUs sent on 
the port.

Event Notification 
OAMPDU Rx

This field displays the number of unique or duplicate OAM event notification PDUs received 
on the port.

Loopback Control 
OAMPDU Tx

This field displays the number of loopback control OAM PDUs sent on the port.

Loopback Control 
OAMPDU Rx

This field displays the number of loopback control OAM PDUs received on the port.

Variable Request 
OAMPDU Tx

This field displays the number of OAM PDUs sent to request MIB objects on the remote 
device.

Variable Request 
OAMPDU Rx

This field displays the number of OAM PDUs received requesting MIB objects on the Switch.

Variable 
Response 
OAMPDU Tx

This field displays the number of OAM PDUs sent by the Switch in response to requests.

Variable 
Response 
OAMPDU Rx

This field displays the number of OAM PDUs sent by the remote device in response to 
requests.

Table 187   Advanced Application > OAM Status > OAM Details
LABEL DESCRIPTION
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40.3  OAM Configuration
Use this screen to turn on Ethernet OAM on the Switch and port(s) and configure the related settings.

In the OAM Status screen click Configuration to display the configuration screen as shown.

Figure 317   Advanced Application > OAM > OAM Configuration (Standalone mode) 

Unsupported 
OAMPDU Tx

This field displays the number of unsupported OAM PDUs sent on the port.

Unsupported 
OAMPDU Rx

This field displays the number of unsupported OAM PDUs received on the port.

Table 187   Advanced Application > OAM Status > OAM Details
LABEL DESCRIPTION
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Figure 318   Advanced Application > OAM > OAM Configuration (Stacking mode) 

The following table describes the fields in the above screen. 

Table 188   Advanced Application > OAM > OAM Configuration
LABEL DESCRIPTION
Active Select this option to enable Ethernet OAM on the Switch.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port This field displays the Switch’s port number. In stacking mode, the first box field is the slot ID 
and the second field is the port number. * means all ports (on the same Switch).

* Use this row to make the setting the same for all ports. Use this row first and then make 
adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.

Active Select this check box to enable Ethernet OAM on this port. 

Clear this check box to disable Ethernet OAM on the port. 

Mode Specify the OAM mode on the port.

Select Active to allow the port to issue and respond to Ethernet OAM commands.

Select Passive to allow the port to respond to Ethernet OAM commands.

Remote Loopback 
Supported

Select this check box to enable the remote loopback feature on the port. Otherwise, clear 
the check box to disable it.

Remote Loopback 
Ignore-Rx

Select this check box to set the Switch to process loopback commands received on the 
port. Otherwise, clear the check box to have the Switch ignore loopback commands 
received on the port.



Chapter 40 OAM

XGS4600 Series User’s Guide

401

40.4  OAM Remote Loopback
Use this screen to perform a remote-loopback test. In the OAM Status screen click Remote Loopback to 
display the screen as shown.

Figure 319   Advanced Application > OAM > OAM Remote Loopback

The following table describes the fields in the above screen. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 188   Advanced Application > OAM > OAM Configuration
LABEL DESCRIPTION

Table 189   Advanced Application > OAM > OAM Remote Loopback
LABEL DESCRIPTION
Remote Loopback 
Test

Port Enter the number of the port from which the Switch performs a remote-loopback test.

Number of 
Packet

Define the allowable packet number of the loopback test frames.

Packet Size Define the allowable packet size of the loopback test frames.

Test Click Test to begin the test.

Remote Loopback 
Mode

Port Enter the number of the port from which the Switch sends loopback control PDUs to initiate 
or terminate a remote-loopback test.

Start Click Start to initiate a remote-loopback test from the specified port by sending Enable 
Loopback Control PDUs to the remote device.

Stop Click Stop to terminate a remote-loopback test from the specified port by sending Disable 
Loopback Control PDUs to the remote device.
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CHAPTER 41
ZULD

41.1  ZULD Overview 
A unidirectional link is a connection where the link is up on both ends, but only one end can receive 
packets. This may happen if OAM was initially enabled but then disabled, there are misconfigured 
transmitting or receiving lines or the hardware is malfunctioning. Zyxel Unidirectional Link Detection 
(ZULD) is a layer-2 protocol that can detect and disable these physical one-way links before they cause 
loops or communication malfunction. 

In the figure below, S1 - A is a bidirectional link as both ends can send packets to each other. S1-B is 
unidirectional as B cannot send packets to S1 (although the S1-B link is up). Similarly, S2-S1 is 
unidirectional as S1 cannot send packets to S2 (although the S1-S2 link is up).

Figure 320   ZULD Overview

41.1.1  What You Can Do
• Use the ZULD Status screen (Section 41.2 on page 403) to see details on ZULD.

• Use the ZULD Configuration screen (Section 41.3 on page 405) to enable ZULD on a port, configure a 
mode and set the probe time.

41.1.2  What You Need to Know
• ZULD must be enabled on the Switch and the port(s) in order to detect unidirectional links by 

monitoring OAMPDUs.

• Ports advertise their unidirectional link detection capability using OAMPDUs, so all connected devices 
must support OAM as well as ZULD. You need to enable OAM on the Switch by going to Advanced 
Application > OAM > Configuration and selecting Active. OAM must be enabled on other connected 
devices too. If OAM is not enabled initially, ZULD will not work.

• If OAM is enabled initially and later disabled on one end of a link, the link will be unidirectional as that 
end cannot send OAMPDUs.
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• OAM discovery, the sending of OAMPDUs to other ports, is initiated by an active port. 

• When ZULD detects a unidirectional link, it sends a syslog and SNMP trap and may shut down the 
affected port (Aggressive Mode).

• If a port on the Switch is shut down by ZULD, and you want to recover it, then do one of the following:

• Go to Basic Setting > Port Setup. Clear Active and click Apply. Then select Active and click Apply 
again.

• Go to Application > Errdiable > Errdisable Recovery and set the interval for ZULD. After the interval 
expires, the closed port(s) will become active and start receiving packets again.

• Use the command port no inactive.

• Refer to the ZULD logs to see when a unidirectional link is detected and when it is recovered to a 
bidirectional link.

41.2  ZULD Status 
Use this screen to see details of unidirectional and bidirectional links discovered by ZULD. To open this 
screen, click Advanced Application > ZULD.

Figure 321   Advanced Application > ZULD Status (Standalone mode)
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Figure 322   Advanced Application > ZULD Status (Stacking mode)

The following table describes the fields in the above screen. 

Table 190   Advanced Application > ZULD Status
LABEL DESCRIPTION
ZULD is.... This shows whether ZULD is enabled or disabled on the Switch.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port This field displays the port number of the Switch.

Active This field displays whether ZULD is enabled on the port or not. ZULD must be enabled to 
detect an unidirectional link by monitoring OAMPDUs.

Mode This field indicates what ZULD will do when a unidirectional link is detected. In Normal 
mode, ZULD only sends a syslog and trap when it detects a unidirectional link. In 
Aggressive mode, ZULD shuts down the port (puts it into an ErrDisable state) as well as 
sends a syslog and trap when it detects a unidirectional link.

Probe Time Probe time is the length of time that ZULD waits before declaring that a link is unidirectional. 
When the probe time expires, and one port (either on the Switch or the connected 
device) still has not received an OAMPDU, then ZULD declares that the link is unidirectional.

Link State This field shows the following link states:

• Linkdown: This is an initialization state, where the port is not yet up.
• Probe: This indicates that ZULD is discovering the connected device on this link. 
• Bidirectional: Traffic sent by the Switch is received by the connected device on this link, 

and traffic from the connected device on this link is received by the Switch.
• Unidirectional: The state of the link between the port and its connected port cannot 

be determined either because no ZULD message was received, or one port is not 
capable of sending traffic.

• Shutdown: The port has been shut down because its link with the connected device is 
unidirectional and ZULD is in Aggressive mode.

Remote Operation This field displays whether ZULD is enabled or disabled on the connected device on this 
link. ZULD must be enabled on the connected device and on the port that’s connecting to 
the Switch.

Remote MAC Addr This is the MAC address of the port on the connected device to which the port of the 
Switch is connected.

Remote Port This is the port number of the port on the connected device to which the port of the Switch 
is connected.
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41.3  ZULD Configuration 
Use this screen to enable ZULD on a port, configure a mode and set the probe time. To open this screen, 
click Advanced Application > ZULD > Configuration.

Figure 323   Advanced Application > ZULD > Configuration (Standalone mode)
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Figure 324   Advanced Application > ZULD > Configuration (Stacking mode)

The following table describes the fields in the above screen. 

Table 191   Advanced Application > ZULD > Configuration
LABEL DESCRIPTION
Active Select this to enable ZULD on the Switch.

Slot (Stacking mode) This field appears only in stacking mode. Click the drop-down list to choose the slot 
number of the Switch in a stack.

Port Use port * to configure all ports to have the same settings. Alternatively, select individual 
ports for different settings.

Active Select this to enable ZULD on the port. ZULD must be enabled to detect an unidirectional 
link by monitoring OAMPDUs.

Mode Select Normal or Aggressive. In Normal mode, ZULD only sends a syslog and trap when it 
detects a unidirectional link. In Aggressive mode, ZULD shuts down the port (puts it into an 
ErrDisable state) as well as sends a syslog and trap when it detects a unidirectional link.

Probe Time Type the length of time that ZULD waits before declaring that a link is unidirectional. When 
the probe time expires, and one port (either on the Switch or the connected device) still 
has not received an OAMPDU, then ZULD declares that the link is unidirectional.

The allowed time range is from 5-65535 seconds.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.
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CHAPTER 42
NLB

42.1  NLB Overview
The Switch supports NLB (Network Load Balancing) traffic distribution. The Switch will copy and forward 
the incoming traffic to a cluster(s). Each server in a cluster tackles a separate copy of traffic. 

Figure 325   NLB Traffic Distribution 

The Switch only supports up to 2 clusters for NLB traffic distribution.

Note: NLB settings are configured on the servers.

See Section 42.1.2 on page 407 for more information about NLB.

42.1.1  What You Can Do
• Use the MAC Forwarding screen (Section 42.2 on page 408) to configure to which MAC addresses 

and ports the Switch should forward the incoming NLB traffic. 

• Use the IP Configuration screen (Section 42.3 on page 409) to map the IP address to the MAC address 
of a cluster for layer-3 forwarding.

42.1.2  What You Need to Know

NLB

Network Load Balancing (NLB) is a feature developed by Microsoft. NLB enhances the performance 
reliability for critical applications by sharing traffic with multiple servers in a cluster using TCP/IP protocol. 
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Each server of a cluster tackles a copy of a traffic. You can create a cluster by grouping up to 32 servers 
together. 

If a server in a cluster fails, traffic will be redistributed to the other operating servers. When the server is 
back in service, it will join the cluster automatically and share the traffic.

Unicast Mode

NLB replaces the real MAC addresses of the servers in a cluster with a unicast MAC address. Each server 
uses the same unicast MAC address, and a switch can’t map the unicast MAC address to a port. This 
forces a switch to flood traffic meant for the cluster to all ports of the switch to make sure the traffic is 
forwarded to the right destination.

The servers in a cluster can’t communicate with each other, because they use the same unicast MAC 
address.

Multicast Mode

NLB assigns a multicast MAC address to the servers in a cluster. Therefore, each server has two MAC 
addresses, the real MAC address and the multicast MAC address.

Create static ARP entries on a switch for the servers, so the switch will only forward traffic to the servers of 
the cluster.

The servers in a cluster can communicate with each other, because they keep their real MAC address 
and already have their own IP addresses.

42.2  MAC Forwarding
Use this screen to configure to which MAC addresses and ports the Switch should forward the incoming 
NLB traffic. 

Click Advanced Application > NLB in the navigation panel to display the screen as shown.

Note: The settings configured in the Advanced Application > NLB and Advanced Application > 
Static Multicast Forwarding screens cannot duplicate.

Figure 326   Advanced Application > NLB 
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The following table describes the labels in this screen.  

42.3  IP Configuration
Use this screen to map the IP address to the MAC address of a cluster for layer-3 forwarding. Use the 
MAC address added in the Advanced Application > NLB screen.

Click Advanced Application > NLB > IP configuration in the navigation panel to display the screen as 
shown.

Note: The settings configured in the Advanced Application > NLB > IP configuration and IP 
Application > ARP Setup > Static ARP screens cannot duplicate.

Table 192   Advanced Application > NLB
LABEL DESCRIPTION
MAC forwarding

Name Enter a descriptive name for identification purposes for this rule.

MAC Address Enter a multicast or unicast MAC address of a cluster. 

The last binary bit of the first octet pair in a multicast MAC address must be 1. For example, the 
first octet pair 00000001 is 01 and 00000011 is 03 in hexadecimal, so 01:00:5e:00:00:0A and 
03:00:5e:00:00:27 are valid multicast MAC addresses.

The last binary bit of the first octet pair in a unicast MAC address must be 0. For example, the 
first octet pair 00000000 is 00 and 00000010 is 02 in hexadecimal, so 00:00:5e:00:00:0A and 
02:00:5e:00:00:27 are valid unicast MAC addresses.

VID Enter the VLAN identification number. If you don’t have a specific target VLAN, enter 1.

The Switch will forward traffic to ports in this VLAN group.

Port Enter the port(s) to which you want the Switch to forward the incoming NLB traffic. 

You can enter multiple ports separated by (no space) comma (,) or hyphen for a range. For 
example, enter “3-5” for ports 3, 4, and 5. Enter “3,5,7” for ports 3, 5, and 7. 

In stacking mode, the first number represents the slot and the second the port number. Enter 1/
1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 and port 28 for the Switch in slot 2, for 
example.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays the index number of the rule.

Name This field displays the descriptive name of the rule.

MAC Address This field displays the multicast/unicast MAC address of this rule.

VID This field displays the VLAN group identification number.

Port This field displays the ports to which the Switch will forward the incoming NLB traffic.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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Figure 327   Advanced Application > NLB > IP configuration 

The following table describes the labels in this screen.  

Table 193   Advanced Application > NLB > IP configuration 
LABEL DESCRIPTION
IP Configuration

Name Enter a descriptive name for identification purposes for this rule.

IP Address Enter an IPv4 or IPv6 address for a cluster.

MAC Address Enter a multicast or unicast MAC address added in the Advanced Application > NLB screen. 

The last binary bit of the first octet pair in a multicast MAC address must be 1. For example, the 
first octet pair 00000001 is 01 and 00000011 is 03 in hexadecimal, so 01:00:5e:00:00:0A and 
03:00:5e:00:00:27 are valid multicast MAC addresses.

The last binary bit of the first octet pair in a unicast MAC address must be 0. For example, the 
first octet pair 00000000 is 00 and 00000010 is 02 in hexadecimal, so 00:00:5e:00:00:0A and 
02:00:5e:00:00:27 are valid unicast MAC addresses.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays the index number of the rule.

Name This field displays the descriptive name of the rule.

IP Address This field displays the IP address of the cluster.

MAC Address This field displays the multicast/unicast MAC address of this rule.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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CHAPTER 43
Wol Relay

43.1  Wol Relay Overview
Wake On LAN (WOL) is a feature to remotely turn on a device on the LAN network. A device is turned on 
by receiving a magic packet. To use this feature the remote hardware (for example the network 
adapter on a computer) must support Wake On LAN using the “Magic Packet” method.

A magic packet is a UDP broadcast packet. Broadcast packets are generally not routed. A magic 
packet can’t be routed. This prevents DDoS attacks, but also prohibits you from sending magic packets 
to other devices in different subnets. The Switch’s Wake On LAN relay feature allows you to send magic 
packets to devices across different subnets.

43.2  Wol Relay Screen
Use this screen to configure WoL relay settings on the Switch. Click Advanced Application > Wol Relay to 
open the following screen.

Figure 328   Advanced Application > Wol Relay 

The following table describes the labels in this screen. 

Table 194   Advanced Application > Wol Relay 
LABEL DESCRIPTION
Wol Relay

UDP Enter a UDP port number that magic packets are sent through.

The most common port for transmission is UDP port 9.

Source VLAN Enter the source VLAN ID where the magic packet originates from.

Destination VLAN Enter the destination VLAN ID where the magic packet will be sent to.
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Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays the index number of the rule.

UDP This field displays the UDP port of the rule.

Source VLAN This field displays the source VLAN ID of the rule.

Destination VLAN This field displays the destination VLAN ID of the rule.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 194   Advanced Application > Wol Relay (continued)
LABEL DESCRIPTION
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CHAPTER 44
Static Route

This chapter shows you how to configure static routes.

44.1  Static Routing Overview 
The Switch usually uses the default gateway to route outbound traffic from computers on the LAN to the 
Internet. To have the Switch send data to devices not reachable through the default gateway, use 
static routes.

For example, the next figure shows a computer (A) connected to the Switch. The Switch routes most 
traffic from A to the Internet through the Switch’s default gateway (R1). You create one static route to 
connect to services offered by your ISP behind router R2. You create another static route to 
communicate with a separate network behind a router R3 connected to the Switch.

Figure 329   Example of Static Routing Topology

44.2  Static Routing
Click IP Application > Static Routing in the navigation panel to display the screen as shown. Click the link 
next to IPv4 Static Route to open a screen where you can create IPv4 static routing rules. Click the link 
next to IPv6 Static Route to open a screen where you can create IPv6 static routing rules.
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Figure 330   IP Application > Static Routing 

44.3  Configuring IPv4 Static Route 
Click the link next to IPv4 Static Route in the IP Application > Static Routing screen to display the screen 
as shown. 

Figure 331   IP Application > Static Routing > IPv4 Static Route 

The following table describes the related labels you use to create a static route.  

Table 195   IP Application > Static Routing > IPv4 Static Route 
LABEL DESCRIPTION
Active This field allows you to activate/deactivate this static route.

Name Enter a descriptive name (up to 10 printable ASCII characters) for identification purposes. 

Destination IP 
Address

This parameter specifies the IP network address of the final destination. Routing is always based 
on network number. If you need to specify a route to a single host, use a subnet mask of 
255.255.255.255 in the subnet mask field to force the network number to be identical to the host 
ID.

IP Subnet Mask Enter the subnet mask for this destination.

Gateway IP 
Address

Enter the IP address of the gateway. The gateway is an immediate neighbor of your Switch that 
will forward the packet to the destination. The gateway must be a router on the same segment 
as your Switch.

Metric The metric represents the “cost” of transmission for routing purposes. IP routing uses hop count 
as the measurement of cost, with a minimum of 1 for directly connected networks. Enter a 
number that approximates the cost for this link. The number need not be precise, but it must be 
between 1 and 15. In practice, 2 or 3 is usually a good number.
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44.4  Configuring IPv6 Static Route 
Click the link next to IPv6 Static Route in the IP Application > Static Routing screen to display the screen 
as shown. 

Figure 332   IP Application > Static Routing > IPv6 Static Route 

Add Click Add to insert a new static route to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults. 

Index This field displays the index number of the route. Click a number to edit the static route entry. 

Active This field displays Yes when the static route is activated and NO when it is deactivated.

Name This field displays the descriptive name for this route. This is for identification purposes only.

Destination 
Address

This field displays the IP network address of the final destination. 

Subnet Mask This field displays the subnet mask for this destination.

Gateway 
Address

This field displays the IP address of the gateway. The gateway is the immediate neighbor of your 
Switch that will forward the packet to the destination. 

Metric This field displays the cost of transmission for routing purposes.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 195   IP Application > Static Routing > IPv4 Static Route (continued)
LABEL DESCRIPTION
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The following table describes the related labels you use to create a static route.  

Table 196   IP Application > Static Routing > IPv6 Static Route 
LABEL DESCRIPTION
Route 
Destination

Enter the IPv6 address of the final destination. 

Prefix Length Enter the prefix length number of up to 64 for this destination.

Next Hop Enter the IPv6 address of the next-hop router.

Interface Type Select the type of the IPv6 interface through which the IPv6 packets are forwarded.

The Switch supports only the VLAN interface type at the time of writing.

Interface ID Enter the ID number of the IPv6 interface through which the IPv6 packets are forwarded.

Add Click Add to insert a new static route to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Index This field displays the index number of the route. Click a number to edit the static route entry. 

Interface This field displays the descriptive name of the interface that is used to forward the packets to 
the destination.

Route 
Destination/Prefix 
Length

This field displays the IPv6 subnet prefix and prefix length of the final destination. 

Next Hop This field displays the IPv6 address of the gateway that helps forward the packet to the 
destination. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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CHAPTER 45
Policy Routing

This chapter shows you how to configure policy routing rules.

45.1  Policy Route Overview 
Traditionally, routing is based on the destination address only and the Switch takes the shortest path to 
forward a packet. Policy routing provides a mechanism to override the default routing behavior and 
alter the packet forwarding based on the policy defined by the network administrator. Policy-based 
routing is applied to incoming packets prior to the normal routing.

Individual routing policies are used as part of the overall policy routing process. A routing policy defines 
the action to take when a packet meets the criteria in a specified classifier. The action is taken only 
when all the criteria are met.  

45.1.1  Benefits
• Source-Based Routing – Network administrators can use policy-based routing to direct traffic from 

different users through different connections.

• Cost Savings – Policy routing allows organizations to distribute interactive traffic on high-bandwidth, 
high-cost paths while using low-cost paths for batch traffic.

• Load Sharing – Network administrators can use policy routing to distribute traffic among multiple 
paths.

45.2  Configuring Policy Routing Profile  
Click IP Application > Policy Routing in the navigation panel to display the screen as shown. Use this 
screen to configure a policy routing profile, which can consist of multiple policy routing rules.

Figure 333   IP Application > Policy Routing 
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The following table describes the labels in this screen.  

45.2.1  Policy Routing Rule Configuration 
You must first configure a layer-3 classifier in the Classifier screen (see Section 21.2 on page 213) and a 
policy routing profile in the Policy Routing screen (see Section 45.2 on page 417). 

Use this screen to configure a policy route to override the default (shortest path) routing behavior and 
forward packets based on the classifier and action you specify. A policy route rule defines the matching 
classifier and the action to take when a packet meets the criteria in the classifier. The action is taken 
only when all the criteria are met. Policy-based routing is applied to incoming packets on a per 
interface basis before normal routing. The Switch does not perform normal routing on packets that 
match any of the policy routes.

Click Rule Configuration in the IP Application > Policy Routing screen to display the screen as shown.

Table 197   IP Application > Policy Routing 
LABEL DESCRIPTION
Active This field allows you to activate/deactivate this policy routing profile and rules in the profile.

Profile Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 
Spaces are allowed.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to set the above fields back to the factory defaults. 

Index This field displays the index number of the policy routing profile. Click a number to edit the 
policy routing profile entry. 

Active This field displays Yes when the policy routing profile is activated and No when it is deactivated.

Profile Name This field displays the descriptive name for this profile. This is for identification purposes only.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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Figure 334   IP Application > Policy Routing > Rule Configuration 

The following table describes the labels in this screen. 

Table 198   IP Application > Policy Routing > Rule Configuration 
LABEL DESCRIPTION
Profile Name This field displays the policy routing profile(s) you configure in the IP Application > Policy Routing 

screen. 

Select a profile for which you want to configure a policy routing rule.

Sequence Enter the rule number from 1 to 64. The ordering of your rules is important as rules are applied in 
turn.

You can not specify a number already in use by another rule.

Statement Select Permit to forward traffic that matches this rule to the gateway specified in the rule.

Select Deny to disable the rule action and forward traffic that matches this rule according to 
the routing table on the Switch.

Classifier This field displays the available active classifiers you configure in the Classifier screen (see 
Chapter 21 on page 213), which are not used by any policy rule or policy routing rule.

Select a classifier to which this policy routing rule applies.

Action Enter the IP address of the gateway. The gateway is an immediate neighbor of your Switch that 
will forward the packet to the destination. 

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to set the above fields back to the factory defaults.

Active This field displays whether the policy route profile is enabled or not.

Profile Name This field displays the name of the policy route profile with which the rule is associated.



 Chapter 45 Policy Routing

XGS4600 Series User’s Guide

420

Seq This field displays the rule index number that you configure in the Sequence field. Click an index 
number to change the rule’s Statement. 

State This field displays permit when the rule action is activated and deny when is it deactivated.

Classifier This field displays the name of the classifier to which this policy applies.   

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry(ies) from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 198   IP Application > Policy Routing > Rule Configuration (continued)
LABEL DESCRIPTION
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CHAPTER 46
RIP

This chapter shows you how to configure RIP (Routing Information Protocol).

46.1  RIP Overview
RIP (Routing Information Protocol) allows a routing device to exchange routing information with other 
routers. The Direction field controls the sending and receiving of RIP packets. When set to:

• Both - the Switch will broadcast its routing table periodically and incorporate the RIP information that 
it receives.

• Incoming - the Switch will not send any RIP packets but will accept all RIP packets received.

• Outgoing - the Switch will send out RIP packets but will not accept any RIP packets received.

• None - the Switch will not send any RIP packets and will ignore any RIP packets received.

The Version field controls the format and the broadcasting method of the RIP packets that the Switch 
sends (it recognizes both formats when receiving). RIP-1 is universally supported; but RIP-2 carries more 
information. RIP-1 is probably adequate for most networks, unless you have an unusual network 
topology.

Both RIP-2B and RIP-2M send the routing data in RIP-2 format; the difference being that RIP-2B uses 
subnet broadcasting while RIP-2M uses multicasting.

The Switch also supports RIPng (RIP next generation) for IPv6. RIPv2 uses UDP port 520 and the multicast 
address 224.0.0.9, while RIPng uses UDP port 521 and the multicast address FF02::9.

46.1.1  Administrative Distance
When two or more than two different routing protocols, such as RIP and OSPF provide multiple routes to 
the same destination, the Switch can use the administrative distance of the route to determine which 
routing protocol to use and add the route to the routing table. 

The lower the administrative distance value is, the more preferable the routing protocol is. If two routes 
have the same administrative distance value, the Switch uses the route that has the lowest metric value. 
The following table lists the default administrative distance value of the route sources supported on the 
Switch. 

Table 199   Default Distance Value
ROUTE SOURCE ADMINISTRATIVE DISTANCE
Local 0

Static 1
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46.2  RIP Screen
Click IP Application > RIP in the navigation panel to display the screen as shown. Click the link next to 
IPv4 RIP to open a screen where you can enable RIP for IPv4 and configure the RIP version and direction 
for an IP interface. Click the link next to IPv6 RIP to open a screen where you can enable RIP for IPv6 
(RIPng) and configure the RIP timers and method of preventing routing loops for an IPv6 VLAN interface.

Figure 335   IP Application > RIP 

46.3  Configuring IPv4 RIP 
Click IP Application > RIP > IPv4 RIP in the navigation panel to display the screen as shown. You cannot 
manually configure a new entry. Each entry in the table is automatically created when you configure a 
new IP domain in the IP Setup screen (refer to Section 8.4 on page 82). 

Figure 336   IP Application > RIP > IPv4 RIP 

OSPF 110

RIP 120

Table 199   Default Distance Value
ROUTE SOURCE ADMINISTRATIVE DISTANCE
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The following table describes the labels in this screen. 

Table 200   IP Application > RIP > IPv4 RIP  
LABEL DESCRIPTION
Active Select this check box to enable IPv4 RIP on the Switch. 

Distance Enter a number from 10 to 255 to specify the administrative distance that is assigned to routes 
learned by RIP. 

The lower the administrative distance value is, the more preferable the routing protocol is. See 
Section 46.1.1 on page 421 for more information about administrative distance.

Note: You cannot set two routing protocols to have the same administrative distance.
Index This field displays the index number of an IP interface.  

* Settings in this row apply to all entries.

Use this row only if you want to make some settings the same for all entries. Use this row first to set the 
common settings and then make adjustments on a per entry basis. 

Note: Changes in this row are copied to all the entries as soon as you make them.
Network This field displays the IP interface configured on the Switch. 

Refer to the section on IP Setup for more information on configuring IP domains. 

Direction Select the RIP direction from the drop-down list box. Choices are Outgoing, Incoming, Both and 
None. 

Version Select the RIP version from the drop-down list box. Choices are RIP-1, RIP-2B and RIP-2M. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these changes if 
it is turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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46.4  Configuring IPv6 RIP 
Click IP Application > RIP > IPv6 RIP in the navigation panel to display the screen as shown. You cannot 
manually configure a new entry. Each entry in the table is automatically created when you configure a 
new IPv6 VLAN interface in the Interface Setup screen (refer to Section 8.6 on page 89). 

Figure 337   IP Application > RIP > IPv6 RIP 

The following table describes the labels in this screen. 

Table 201   IP Application > RIP > IPv6 RIP  
LABEL DESCRIPTION
Active Select this check box to enable IPv6 RIP on the Switch. 

Update Timer Set the duration of the Update Timer (in seconds) to specify how often the Switch broadcasts its 
routing table and incorporates routing table information sent from other routers. 

Timeout Timer Specify how long (in seconds) the Switch waits for route updates before a route is declared no 
longer valid. The metric of route will then be set to 16, which means the route is considered 
unreachable.

Timeout Timer should be greater than Update Timer.

Garbage 
Collection Timer

Specify how long (in seconds) the Switch waits before removing the invalid route from the 
routing table.

Distance Enter a number from 10 to 255 to specify the administrative distance that is assigned to routes 
learned by RIP. 

The lower the administrative distance value is, the more preferable the routing protocol is. See 
Section 46.1.1 on page 421 for more information about administrative distance.

Note: You cannot set two routing protocols to have the same administrative 
distance.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Index This field displays the index number of an IPv6 interface.
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* Settings in this row apply to all entries.

Use this row only if you want to make some settings the same for all entries. Use this row first to 
set the common settings and then make adjustments on a per entry basis. 

Note: Changes in this row are copied to all the entries as soon as you make them.
Interface This field displays the name of the IPv6 interface you created on the Switch.

Active Select the check box to enable the entry.

Method Specify the mechanism used by the interface to prevent routing loops.

• Select No-Horizon to not use any mechanism on this interface to prevent routing loops.
• Select Split-Horizon to prevent the interface from sending back the routing information 

received and learned from a neighbor. This also helps save bandwidth.
• Select Poison-Reverse to have the interface set the metric of routes learned from a 

neighbor to 16 and send the routing information back. The neighbor will then delete the 
routes from its routing table.

Metric The metric represents the “cost” of transmission for routing purposes. IP routing uses hop count 
as the measurement of cost, with a minimum of 1 for directly connected networks. Enter a 
number that approximates the cost for this link. The number need not be precise, but it must be 
between 1 and 15. In practice, 2 or 3 is usually a good number.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 201   IP Application > RIP > IPv6 RIP  (continued)
LABEL DESCRIPTION
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CHAPTER 47
OSPF

This chapter describes the OSPF (Open Shortest Path First) routing protocol and shows you how to 
configure OSPF. 

47.1  OSPF Overview 
OSPF (Open Shortest Path First) is a link-state protocol designed to distribute routing information within an 
autonomous system (AS). An autonomous system is a collection of networks using a common routing 
protocol to exchange routing information.

OSPF offers some advantages over traditional vector-space routing protocols (such as RIP). The 
following table summarizes some of the major differences between OSPF and RIP. 

The Switch uses OSPFv2 for IPv4, and also supports OSPFv3 to work with IPv6. OSPFv2 and OSPFv3 are 
quite similar. The OSPF mechanisms and algorithms are not changed but there are two new Link State 
Advertisements (LSA) types in OSPFv3. OSPFv2 uses plain text or MD5 authentication, while no 
authentication is required for OSPFv3 on the Switch. Their packet format is different, too.

47.1.1  OSPF Autonomous Systems and Areas
An OSPF autonomous system (AS) can be divided into logical areas. Each area represents a group of 
adjacent networks. All areas are connected to a backbone (also known as area 0). The backbone is 
the transit area to route packets between two areas. A stub area, at the edge of an AS is not a transit 
area since there is only one connection to the stub area. 

The following table describes the four classes of OSPF routers.

Table 202   OSPF vs. RIP  
OSPF RIP

Network Size Large Small (with up to 15 routers)

Metrics Bandwidth, hop count, throughput, round 
trip time and reliability.  

Hop count 

Convergence Fast Slow 

Table 203   OSPF: Router Types  
TYPE DESCRIPTION
Internal Router (IR) An Internal or intra-area router is a router in an area.

Area Border Router (ABR) An Area Border Router connects two or more areas.  

Backbone Router (BR) A backbone router has an interface to the backbone. 

AS Boundary Router An AS boundary router exchanges routing information with routers in other ASs. 
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The following figure depicts an OSPF network example. The backbone is area 0 with a backbone router. 
The internal routers are in area 1 and 2. The area border routers connect area 1 and 2 to the backbone. 

Figure 338   OSPF Network Example 

47.1.2  How OSPF Works
Layer-3 devices exchange routing information to build a synchronized link state database within the 
same AS or area. The link state database contains records of router IDs, their associated links and path 
costs. Each device can then use the link state database and Dijkstra algorithm to compute the least 
cost paths to network destinations. 

Layer-3 devices build a synchronized link state database by exchanging Hello messages to confirm 
which neighbor (layer-3) devices exist and then they exchange database descriptions (DDs) to create 
the link state database. The link state database is constantly updated through LSAs (Link State 
Advertisements). 

47.1.3  Interfaces and Virtual Links
An OSPF interface is a link between a layer-3 device and an OSPF network. An interface has state 
information, an IP address and subnet mask associated with it. When you configure an OSPF interface, 
you first set an interface to transmit OSPF traffic and add the interface to an area.

You can configure a virtual link to establish/maintain connectivity between a non-backbone area and 
the backbone. The virtual link must be configured on both layer-3 devices in the non-backbone area 
and the backbone.

47.1.4  OSPF and Router Elections
The OSPF protocol provides for automatic election of Designated Router (DR) and Backup Designated 
Router (BDR) on network segments. The DR and BDR keep track of link state updates in their area and 
make sure LSAs are sent to the rest of the network.

In most cases the default DR/BDR election is fine, but in some situations it must be controlled. In the 
following figure only router A has direct connectivity with all the other routers on the network segment. 
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Routers B and C do not have a direct connection with each other. Therefore they should not be allowed 
to become DR or BDR. Only router A should become the DR.

Figure 339   OSPF Router Election Example

You can assign a priority to an interface which determines whether this router will be elected to be a DR 
or BDR. The router with the highest priority becomes the DR, while a router with a priority of 0 does not 
participate in router elections. In Figure 339 on page 428 you can assign a priority of 0 to routers B and C, 
thereby ensuring they do not become DR or BDR and assign a priority of 1 to router A to make sure that 
it does become the DR. 

47.1.5  Configuring OSPF 
To configure OSPF on the Switch, do the following tasks:

1 Enable OSPF

2 Create OSPF areas

3 Create and associate interface(s) to an area

4 Create virtual links to maintain backbone connectivity.

47.2  OSPF Screen
Click IP Application > OSPF in the navigation panel to display the screen as shown. Click the link next to 
IPv4 OSPF to open screens where you can view IPv4 OSPF status and configure OSPF for IPv4. Click the 
link next to IPv6 OSPF to open screens where you can view IPv6 OSPF status and configure OSPF for IPv6 
(OSPF version 3).

Figure 340   IP Application > OSPF 
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47.3  IPv4 OSPF Status 
Use this screen to view current IPv4 OSPF status. Click IP Application > OSPF > IPv4 OSPF the navigation 
panel to display the screen as shown next. See Section 47.1 on page 426 for more information on OSPF.

Figure 341   IP Application > OSPF > IPv4 OSPF > OSPF Status 

The following table describes the labels in this screen. 

Table 204   IP Application > OSPF > IPv4 OSPF > OSPF Status  
LABEL DESCRIPTION
OSPF This field displays whether OSPF is activated (Running) or not (Down).

Interface The text box displays the OSPF status of the interface(s) on the Switch. 

Neighbor The text box displays the status of the neighboring router participating in the OSPF network. 

Link State 
Database 

The text box displays information in the link state database which contains data in the LSAs. 

Poll Interval(s) The text box displays how often (in seconds) this screen refreshes. You may change the refresh 
interval by typing a new number in the text box and then clicking Set Interval.

Stop Click Stop to end OSPF status polling.
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The following table describes some common output fields. 

Table 205   IP Application > IPv4 OSPF > OSPF Status: Common Output Fields  
FIELD DESCRIPTION
Interface

Internet Address This field displays the IP address and subnet bits of an IP routing domain. 

Area This field displays the area ID. 

Router ID This field displays the unique ID of the Switch. 

Transmit Delay This field displays the transmission delay in seconds.  

State This field displays the state of the Switch (backup or DR (designated router)). 

Priority This field displays the priority of the Switch. This number is used in the designated router 
election. 

Designated Router This field displays the router ID of the designated router. 

Backup Designated 
Router

This field displays the router ID of a backup designated router.

Time Intervals 
Configured

This field displays the time intervals (in seconds) configured. 

Neighbor Count This field displays the number of neighbor routers. 

Adjacent Neighbor 
Count

This field displays the number of neighbor router(s) that is adjacent to the Switch. 

Neighbor

Neighbor ID This field displays the router ID of the neighbor.

Pri This field displays the priority of the neighbor. This number is used in the designated router 
election.

State This field displays the state of the neighbor (backup or DR (designated router)).

Dead Time This field displays the dead time in seconds. 

Address This field displays the IP address of a neighbor. 

Interface This field displays the MAC address of a device. 

Link State Database

Link ID This field displays the ID of a router or subnet.  

ADV Router This field displays the IP address of the layer-3 device that sends the LSAs. 

Age This field displays the time (in seconds) since the last LSA was sent. 

Seq # This field displays the link sequence number of the LSA. 

Checksum This field displays the checksum value of the LSA. 

Link Count This field displays the number of links in the LSA. 
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47.4  IPv4 OSPF Configuration 
Use this screen to activate OSPF for IPv4 and set general settings. Click IP Application > OSPF > IPv4 OSPF 
> Configuration to display the IPv4 OSPF Configuration screen. See Section 47.1 on page 426 for more 
information on OSPF.

Figure 342   IP Application > IPv4 OSPF > Configuration 

The follow table describes the related labels in this screen. 

Table 206   IP Application > IPv4 OSPF > Configuration 
LABEL DESCRIPTION
Active OSPF for IPv4 is disabled by default. Select this option to enable it. 

Router ID Router ID uniquely identifies the Switch in an OSPF. Enter a unique ID (that uses the format of an 
IP address in dotted decimal notation) for the Switch. 

Distance Enter a number from 10 to 255 to specify the administrative distance that is assigned to routes 
learned by OSPF. 

The lower the administrative distance value is, the more preferable the routing protocol is. See 
Section 46.1.1 on page 421 for more information about administrative distance.

Note: You cannot set two routing protocols to have the same administrative 
distance.

Default-
information 
Originate 

Select Active to advertise a default route in your OSPF network if there is one in the routing table. 
When no matching route is found in the routing table, the default route will be used to forward 
traffic.
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47.5  Configure IPv4 OSPF Areas 
To ensure that the Switch receives only routing information from a trusted layer-3 devices, activate 
authentication. The OSPF supports three levels of authentication: 

• None – no authentication is used.

• Simple – authenticate link state updates using an 8 printable ASCII character password. 

• MD5 – authenticate link state updates using a 16 printable ASCII character password. 

Always Select the check box to have the Switch advertise a default route to neighboring OSPF routers 
even if the Switch doesn’t have one in its routing table.

Metric Enter a route cost (between 0 and 16777215) for the default route. 

Metric Type Select 1 to configure the default route as type 1, which has a default cost (metric) of 20 and 
adds up the cost toward the destination. Its external metrics are directly comparable to the 
internal OSPF cost. When selecting a path, the internal OSPF cost is added to the AB boundary 
router to the external metrics. 

Select 2 to configure the default route as type 2. The route has a default cost of 20 and the 
metric will never change along a traffic path. Its external metrics are not comparable to the 
OSPF cost. In this case, the external cost of the AB boundary router is used in path decision to a 
destination. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 206   IP Application > IPv4 OSPF > Configuration (continued)
LABEL DESCRIPTION
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 To configure an area, set the related fields in the IPv4 OSPF Configuration screen.

Figure 343   IP Application > OSPF > IPv4 OSPF > Configuration: Area Setup 

The following table describes the related labels in this screen.  

Table 207   IP Application > OSPF > IPv4 OSPF > Configuration: Area Setup 
LABEL DESCRIPTION
Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 

Area ID Enter a 32-bit ID (that uses the format of an IP address in dotted decimal notation) that uniquely 
identifies an area. 

A value of 0.0.0.0 indicates that this is a backbone (also known as Area 0). You can create only 
one backbone area on the Switch.

Authentication Select an authentication method (Simple or MD5) to activate authentication. Select None 
(default) to disable authentication. 

Usually interface(s) and virtual interface(s) should use the same authentication method as the 
associated area. If interface(s) and virtual interface(s) use different authentication methods 
than the associated area, the authentication methods are based on the interface(s) and virtual 
interface(s) settings.

Stub / NSSA Select this option to set the area as a stub area or a not-so-stubby area. 

If you enter 0.0.0.0 in the Area ID field, the settings in the stub area fields are ignored. 

No Summary Select this option to set the Switch to not send/receive LSAs.

Default 
route cost

Specify a cost (between 0 and 16777215) used to add a default route into a stub area for routes 
which are external to an OSPF domain. If you do not set a route cost, no default route is added. 
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47.5.1  View OSPF Area Information Table
The bottom of the IPv4 OSPF Configuration screen displays a summary table of all the OSPF areas you 
have configured. 

Figure 344   IP Application > OSPF > IPv4 OSPF > Configuration: Summary Table 

The following table describes the related labels in this screen. 

47.6  Configuring IPv4 OSPF Redistribution 
Use this screen to configure route redistribution and summary addresses. Route redistribution is used 
when other routers which use RIP routing protocol and/or static routes need to exchange routing 
information with the Switch using OSPF routing protocol. A summary address is used to cover more than 
one routing entries in order to reduce the routing table size.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to default settings. 

Table 207   IP Application > OSPF > IPv4 OSPF > Configuration: Area Setup (continued)
LABEL DESCRIPTION

Table 208   IP Application > OSPF > IPv4 OSPF > Configuration: Summary Table  
LABEL DESCRIPTION
Index This field displays the index number of an area.

Name This field displays the descriptive name of an area.

Area ID This field displays the area ID (that uses the format of an IP address in dotted decimal notation) 
that uniquely identifies an area. 

An area ID of 0.0.0.0 indicates the backbone. 

Authentication This field displays the authentication method used (None, Simple or MD5). 

Stub / NSSA This field displays the area defined (Stub, NSSA or None). 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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In the IPv4 OSPF Configuration screen, click Redistribute to display the OSPF Redistribution screen. 

Figure 345   IP Application > OSPF > IPv4 OSPF > Configuration > Redistribute

The following table describes the labels in this screen. 

Table 209   IP Application > OSPF > IPv4 OSPF > Configuration > Redistribute 
LABEL DESCRIPTION
Redistribute 
Route

Route redistribution allows your Switch to import and translate external routes learned through 
RIP routing protocol or configured manually (Static) into the OSPF network transparently. 

Active Select this option to activate route redistribution for routes learned through the selected 
protocol.

Type Select 1 for routing protocols (such as RIP) whose external metrics are directly comparable to 
the internal OSPF cost. When selecting a path, the internal OSPF cost is added to the AB 
boundary router to the external metrics. 

Select 2 for routing protocols whose external metrics are not comparable to the OSPF cost. In this 
case, the external cost of the AB boundary router is used in path decision to a destination. 

Metric Value Enter a route cost (between 0 and 16777215). The default metric value is 15.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Summary 
address

Enter a network IP address which can cover more than one network in order to reduce the 
routing table size. For example, you can use 192.168.8.0/22 instead of using 192.168.8.0/24, 
192.168.9.0/24, 192.168.10.0/24, and 192.168.11.0/24.

The third octet of these four network IP addresses is 00001000, 00001001, 00001010, 00001011 
respectively. The first 6 digits (000010) are the common part among these IP addresses. So 
192.168.8.0/22 can represent all of these networks.

Subnet mask Enter the subnet mask for this summary IP address which can cover multiple networks.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.
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47.7  Configuring IPv4 OSPF Interfaces 
To configure an OSPF interface, first create an IP routing domain in the IP Setup screen (see Section 8.4 
on page 82 for more information). Once you create an IP routing domain, an OSPF interface entry is 
automatically created. See Section 47.1 on page 426 for more information on OSPF.

In the IPv4 OSPF Configuration screen, click Interface to display the OSPF Interface screen. 

Figure 346   IP Application > OSPF > IPv4 OSPF > Configuration > Interface 

Cancel Click Cancel to begin configuring this screen afresh.

Index This field displays the index number of the summary address.

Summary 
address

This field displays the summary IP address.

Subnet mask This field displays the subnet mask for the summary IP address.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Check the rule(s) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the check boxes.

Table 209   IP Application > OSPF > IPv4 OSPF > Configuration > Redistribute (continued)
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

Table 210   IP Application > OSPF > IPv4 OSPF > Configuration > Interface 
LABEL DESCRIPTION
Network Select an IP interface.

Area ID Select the area ID (in an IP address format with dotted decimal notation) of an area to 
associate the interface to that area.

Authentication Note: OSPF Interface(s) must use the same authentication method within the same 
area.

Select an authentication method. The choices are Same-as-Area, None (default), Simple and 
MD5. 

To participate in an OSPF network, you must make the authentication method and/or 
password settings the same as the associated area. 

Select Same-as-Area to use the same authentication method within the area and set the 
related fields when necessary. 

Select None to disable authentication. This is the default setting.

Select Simple and set the Key field to authenticate OSPF packets transmitted through this 
interface using simple password authentication.

Select MD5 and set the Key ID and Key fields to authenticate OSPF packets transmitted 
through this interface using MD5 authentication. 

Key ID When you select MD5 in the Authentication field, specify the identification number of the 
authentication you want to use. 

Key When you select Simple in the Authentication field, enter a password eight-character long. 
Characters after the eighth character will be ignored. 

When you select MD5 in the Authentication field, enter a password 16-character long. 

Cost The interface cost is used for calculating the routing table. Enter a number between 1 and 
65535. The default interface cost is 15.

Priority The priority you assign to the interface is used in router elections to decide which router is going 
to be the Designated Router (DR) or the Backup Designated Router (BDR). You can assign a 
number between 0 and 255. A priority of 0 means that the router will not participate in router 
elections. 

Retransmit 
Interval

Specify how long (in seconds) the Switch should wait for an acknowledgment packet from the 
interface's neighbor device before retransmitting link-state advertisements (LSAs) on the 
interface. The valid range for retransmitting is between 1 and 65535. The default value is 5 
seconds.

Transmit Delay Set the estimated time (in seconds) that is required to transmit a link-state update packet on the 
interface. The valid range for transmitting delay is between 1 and 65535. The default value is 1 
second.

Hello Interval Specify how often (in seconds) the Switch sends hello packets on the interface to check if the 
interface's neighbor devices still exist. The valid range for hello interval is between 1 and 65535. 
The default value is 10 seconds.

Dead Interval Specify how long (in seconds) the Switch should wait for a hello packet from the interface's 
neighbor device before declaring that the neighbor device is not available. The valid range for 
dead interval is between 1 and 65535. The default value is 40 seconds.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults. 

Index This field displays the index number for an interface.
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47.8  IPv4 OSPF Virtual-Links   
Configure and view virtual link settings in this screen. See Section 47.1 on page 426 for more information 
on OSPF.

In the IPv4 OSPF Configuration screen, click Virtual-Link to display the screen as shown next. 

Figure 347   IP Application > OSPF > IPv4 OSPF > Configuration > Virtual-Link 

Network This field displays the IP interface information. 

Area ID This field displays the area ID (in an IP address format with dotted decimal notation) of an area 
to associate the interface to that area.

Authentication This field displays the authentication method used (Same-as-Area, None, Simple or MD5).

Key ID When the Authentication field displays MD5, this field displays the identification number of the 
key used.  

Cost This field displays the interface cost used for calculating the routing table.  

Priority This field displays the priority for this OSPF interface.  

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table. 

Cancel Click Cancel to begin configuring this screen afresh.

Table 210   IP Application > OSPF > IPv4 OSPF > Configuration > Interface (continued)
LABEL DESCRIPTION
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The following table describes the related labels in this screen. 

Table 211   IP Application > OSPF > IPv4 OSPF > Configuration > Virtual-Link 
LABEL DESCRIPTION
Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 

Area ID Select the area ID (in an IP address format with dotted decimal notation) of an area to 
associate the interface to that area.

Peer Router ID Enter the ID of a peer border router. 

Authentication Note: Virtual interface(s) must use the same authentication method within the 
same area.

Select an authentication method. The choices are Same-as-Area, None (default), Simple 
and MD5. 

To exchange OSPF packets with a peer border router, you must make the authentication 
method and/or password settings the same as the peer border router. 

Select Same-as-Area to use the same authentication method within the area and set the 
related fields when necessary. 

Select None to disable authentication. This is the default setting.

Select Simple to authenticate OSPF packets transmitted through this interface using a simple 
password.

Select MD5 to authenticate OSPF packets transmitted through this interface using MD5 
authentication. 

Key ID When you select MD5 in the Authentication field, specify the identification number of the 
authentication you want to use. 

Key When you select Simple in the Authentication field, enter a password eight-character long. 

When you select MD5 in the Authentication field, enter a password 16-character long. 

Retransmit 
Interval

Specify how long (in seconds) the Switch should wait for an acknowledgment packet from the 
interface's neighbor device before retransmitting link-state advertisements (LSAs) on the 
interface. The valid range for retransmitting is between 1 and 65535. The default value is 5 
seconds.

Transmit Delay Set the estimated time (in seconds) that is required to transmit a link-state update packet on 
the interface. The valid range for transmitting delay is between 1 and 65535. The default value 
is 1 second.

Hello Interval Specify how often (in seconds) the Switch sends hello packets on the interface to check if the 
interface's neighbor devices still exist. The valid range for hello interval is between 1 and 65535. 
The default value is 10 seconds.

Dead Interval Specify how long (in seconds) the Switch should wait for a hello packet from the interface's 
neighbor device before declaring that the neighbor device is not available. The valid range for 
dead interval is between 1 and 65535. The default value is 40 seconds.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults. 

Index This field displays an index number of an entry. 

Name This field displays a descriptive name of a virtual link.

Peer Router ID This field displays the ID (that uses the format of an IP address in dotted decimal notation) of a 
peer border router. 

Authentication This field displays the authentication method used (Same-as-Area, None, Simple or MD5).
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47.9  IPv6 OSPF Status 
Use this screen to view current IPv6 OSPF status. Click IP Application > OSPF > IPv6 OSPF in the navigation 
panel to display the screen as shown next. See Section 47.1 on page 426 for more information on OSPF.

Figure 348   IP Application > OSPF > IPv6 OSPF > OSPF Status 

Key ID When the Authentication field displays MD5, this field displays the identification number of the 
key used.  

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the Delete check boxes.

Table 211   IP Application > OSPF > IPv4 OSPF > Configuration > Virtual-Link (continued)
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

The following table describes some common output fields. 

Table 212   IP Application > OSPF > IPv6 OSPF > OSPF Status  
LABEL DESCRIPTION
OSPF This field displays whether OSPF is activated (Running) or not (Down).

Interface The text box displays the OSPF status of the interface(s) on the Switch. 

Neighbor The text box displays the status of the neighboring router participating in the OSPF network. 

Link State 
Database 

The text box displays information in the link state database which contains data in the LSAs. 

Poll Interval(s) The text box displays how often (in seconds) this screen refreshes. You may change the refresh 
interval by typing a new number in the text box and then clicking Set Interval.

Stop Click Stop to end OSPF status polling.

Table 213   IP Application > IPv6 OSPF > OSPF Status: Common Output Fields  
FIELD DESCRIPTION
Interface

Interface ID This field displays the ID number of the IPv6 interface.

Internet Address This field displays the IPv6 link-local/global addresses and prefix length for the IPv6 interface. 

Neighbor

Neighbor ID This field displays the router ID of the neighbor.

Pri This field displays the priority of the neighbor. This number is used in the designated router 
election.

Dead Time This field displays the dead time in seconds the Switch waits for a hello packet from the 
interface's neighbor device before declaring that the neighbor device is not available. The 
default value is 40 seconds. 

State/IfState This field displays the state of the neighbor (Init, ExStart, Exchange or Full) and whether the 
neighbor interface is acting as a DR (designated router), BDR (backup designated router) or 
DRother.

Duration This field displays how long a relationship between the neighbor and the Switch IPv6 
interface has been established to exchange routing information.

I/F [State] This field displays the name of the Switch IPv6 interface and whether it is a (DR (designated 
router), BDR (backup designated router) or DRother).

Link State Database

Type This field displays the type of the LSA.

• Type 1: Router LSA
• Type 2: Network LSA
• Type 3: Inter-Area Prefix LSA
• Type 4: Inter-Area Router LSA
• Type 5: AS-External LSA
• Type 6: Group Membership LSA
• Type 7: NSSA LSA
• Type 8: Link LSA
• Type 9: Intra-area Prefix LSA

LSId This field displays the link state ID to identify what is advertised by the LSA.

Adv Router This field displays the router ID of the layer-3 device that sends the LSAs. 

Age This field displays the time (in seconds) since the last LSA was sent. 

Seq Num This field displays the link sequence number of the LSA. 

Checksum This field displays the checksum value of the LSA. 
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47.10  IPv6 OSPF Configuration 
Use this screen to activate OSPF for IPv6 and set general settings. Click IP Application > OSPF > IPv6 OSPF 
> Configuration to display the IPv6 OSPF Configuration screen. See Section 47.1 on page 426 for more 
information on OSPF.

Figure 349   IP Application > IPv6 OSPF > Configuration 

The follow table describes the related labels in this screen. 

Link Count This field displays the number of links in the LSA. 

Payload This field displays the router ID for LSA type 1 or 2, the next-hop router address for LSA type 8, 
and the IPv6 prefix of the route entry for other LSA types.

Table 213   IP Application > IPv6 OSPF > OSPF Status: Common Output Fields  (continued)
FIELD DESCRIPTION

Table 214   IP Application > IPv6 OSPF > Configuration 
LABEL DESCRIPTION
Active OSPF for IPv6 is disabled by default. Select this option to enable it. 

Router ID Router ID uniquely identifies the Switch in an OSPF. Enter a unique ID (that uses the format of an 
IP address in dotted decimal notation) for the Switch. 

Distance Enter a number from 10 to 255 to specify the administrative distance that is assigned to routes 
learned by OSPF. 

The lower the administrative distance value is, the more preferable the routing protocol is. See 
Section 46.1.1 on page 421 for more information about administrative distance.

Note: You cannot set two routing protocols to have the same administrative 
distance.
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47.11  IPv6 OSPF Redistribution 
Use this screen to configure route redistribution. Route redistribution is used when other routers which use 
RIP routing protocol and/or static routes need to exchange routing information with the Switch using 
OSPF routing protocol. 

In the IPv6 OSPF Configuration screen, click Redistribute to display the OSPF Redistribution screen. 

Figure 350   IP Application > OSPF > IPv6 OSPF > Configuration > Redistribute

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Area ID Enter a 32-bit ID (that uses the format of an IPv4 address in dotted decimal notation) that 
uniquely identifies an area. 

A value of 0.0.0.0 indicates that this is a backbone (also known as Area 0). You can create only 
one backbone area on the Switch.

Stub / NSSA Select this option to set the area as a stub area or a not-so-stubby area. 

If you enter 0.0.0.0 in the Area ID field, the settings in the stub area fields are ignored. 

No Summary Select this option to set the Switch to not send/receive LSAs.

Default 
route cost

Specify a cost (between 0 and 16777215) used to add a default route into a stub area for routes 
which are external to an OSPF domain. If you do not set a route cost, no default route is added. 

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to default settings. 

Index This field displays the index number of an area.

Area ID This field displays the area ID (that uses the format of an IP address in dotted decimal notation) 
that uniquely identifies an area. 

An area ID of 0.0.0.0 indicates the backbone. 

Stub / NSSA This field displays the area defined (Stub, NSSA or None). 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 214   IP Application > IPv6 OSPF > Configuration (continued)
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

47.12  IPv6 OSPF Interfaces 
To configure an OSPF interface, first create an IPv6 VLAN interface in the Interface Setup screen and 
enable the VLAN interface in the IPv6 Interface Setup screen (see Section 8.6 on page 89 and Section 
8.7.4 on page 95 for more information). Once you create and enable an IPv6 VLAN interface, an OSPF 
interface entry is automatically created. See Section 47.1 on page 426 for more information on OSPF.

In the IPv6 OSPF Configuration screen, click Interface to display the OSPF Interface screen. 

Figure 351   IP Application > OSPF > IPv6 OSPF > Configuration > Interface 

Table 215   IP Application > OSPF > IPv6 OSPF > Configuration > Redistribute 
LABEL DESCRIPTION
Redistribute 
Route

Route redistribution allows your Switch to import and translate external routes learned through 
RIP routing protocol or configured manually (Static) into the OSPF network transparently. 

Active Select this option to activate route redistribution for routes learned through the selected 
protocol.

Type Select 1 for routing protocols (such as RIP) whose external metrics are directly comparable to 
the internal OSPF cost. When selecting a path, the internal OSPF cost is added to the AB 
boundary router to the external metrics. 

Select 2 for routing protocols whose external metrics are not comparable to the OSPF cost. In this 
case, the external cost of the AB boundary router is used in path decision to a destination. 

Metric Value Enter a route cost (between 0 and 16777215). The default metric value is 15.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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The following table describes the labels in this screen. 

47.13  IPv6 OSPF Virtual-Links   
Configure and view virtual link settings in this screen. See Section 47.1 on page 426 for more information 
on OSPF.

Table 216   IP Application > OSPF > IPv6 OSPF > Configuration > Interface 
LABEL DESCRIPTION
Interface Select an IPv6 VLAN interface.

Area ID Select the area ID (in an IP address format with dotted decimal notation) of an area to 
associate the interface to that area.

Cost The interface cost is used for calculating the routing table. Enter a number between 1 and 
65535. The default interface cost is 15.

Priority The priority you assign to the interface is used in router elections to decide which router is going 
to be the Designated Router (DR) or the Backup Designated Router (BDR). You can assign a 
number between 0 and 255. A priority of 0 means that the router will not participate in router 
elections. 

Retransmit 
Interval

Specify how long (in seconds) the Switch should wait for an acknowledgment packet from the 
interface's neighbor device before retransmitting link-state advertisements (LSAs) on the 
interface. The valid range for retransmitting is between 1 and 65535. The default value is 5 
seconds.

Transmit Delay Set the estimated time (in seconds) that is required to transmit a link-state update packet on the 
interface. The valid range for transmitting delay is between 1 and 65535. The default value is 1 
second.

Hello Interval Specify how often (in seconds) the Switch sends hello packets on the interface to check if the 
interface's neighbor devices still exist. The valid range for hello interval is between 1 and 65535. 
The default value is 10 seconds.

Dead Interval Specify how long (in seconds) the Switch should wait for a hello packet from the interface's 
neighbor device before declaring that the neighbor device is not available. The valid range for 
dead interval is between 1 and 65535. The default value is 40 seconds.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults. 

Index This field displays the index number for an interface.

Interface This field displays the name of the IPv6 VLAN interface. 

Area ID This field displays the area ID (in an IP address format with dotted decimal notation) of an area 
to associate the interface to that area.

Cost This field displays the interface cost used for calculating the routing table.  

Priority This field displays the priority for this OSPF interface.  

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table. 

Cancel Click Cancel to begin configuring this screen afresh.
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In the IPv4 OSPF Configuration screen, click Virtual-Link to display the screen as shown next. 

Figure 352   IP Application > OSPF > IPv6 OSPF > Configuration > Virtual-Link 

The following table describes the related labels in this screen. 

Table 217   IP Application > OSPF > IPv6 OSPF > Configuration > Virtual-Link 
LABEL DESCRIPTION
Area ID Select the area ID (in an IP address format with dotted decimal notation) of an area to 

associate the interface to that area.

Peer Router ID Enter the ID of a peer border router. 

Retransmit 
Interval

Specify how long (in seconds) the Switch should wait for an acknowledgment packet from the 
interface's neighbor device before retransmitting link-state advertisements (LSAs) on the 
interface. The valid range for retransmitting is between 1 and 65535. The default value is 5 
seconds.

Transmit Delay Set the estimated time (in seconds) that is required to transmit a link-state update packet on 
the interface. The valid range for transmitting delay is between 1 and 65535. The default value 
is 1 second.

Hello Interval Specify how often (in seconds) the Switch sends hello packets on the interface to check if the 
interface's neighbor devices still exist. The valid range for hello interval is between 1 and 65535. 
The default value is 10 seconds.

Dead Interval Specify how long (in seconds) the Switch should wait for a hello packet from the interface's 
neighbor device before declaring that the neighbor device is not available. The valid range for 
dead interval is between 1 and 65535. The default value is 40 seconds.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults. 

Index This field displays an index number of an entry. 

Area ID This field displays the area ID (in an IP address format with dotted decimal notation) of an area 
to associate the interface to that area.

Peer Router ID This field displays the ID (that uses the format of an IP address in dotted decimal notation) of a 
peer border router. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.
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Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the Delete check boxes.

Table 217   IP Application > OSPF > IPv6 OSPF > Configuration > Virtual-Link (continued)
LABEL DESCRIPTION
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CHAPTER 48
IGMP

This chapter shows you how to configure the Switch as a multicast router. See also Section 25.3.1 on 
page 242 for information on IGMP snooping.

48.1  IGMP Overview
IP multicast is an IETF standard for distributing data to multiple recipients. The following figure shows a 
multicast session and the relationship between a multicast server, multicast routers and multicast hosts. A 
multicast server transmits multicast packets and multicast routers forward multicast packets to multicast 
hosts.   

Figure 353   IP Multicast 

A host can decide to join or leave a multicast group at any time. A host can also be a member of more 
than one multicast group. Multicast groups are identified by IP addresses in the Class D range (224.0.0.0 
to 239.255.255.255). A multicast server sends packets addressed to a particular multicast group 
(multicast IP address).

IGMP (Internet Group Management Protocol) is used by multicast hosts to indicate their multicast group 
membership to multicast routers. Multicast routers can also use IGMP to periodically check if multicast 
hosts still want to receive transmission from a multicast server. In other words, multicast routers check if 
any hosts on their network are still members of a specific multicast group. 
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The Switch supports IGMP version 1 (IGMP-v1), version 2 (IGMP-v2) and IGMP version 3 (IGMP-v3). Refer 
to RFC 1112, RFC 2236 and RFC 3376 for information on IGMP versions 1, 2 and 3 respectively. At start up, 
the Switch queries all directly connected networks to gather group membership. After that, the Switch 
periodically updates this information. 

48.1.1  How IGMP Works
This section describes how IGMP works and the changes it has gone through from version 1 to version 3. 
IGMP version 1 defines how a multicast router checks to see if any multicast hosts are part of a multicast 
group. It checks for group membership by sending out an IGMP Query packet. Hosts that are members 
of a multicast group reply with an IGMP Report packet. This is also referred to as a join group request. The 
multicast router then keeps a list of all networks that have members of this multicast group and forwards 
multicast traffic to that network.   

Figure 354   IGMP Version 1 Example 

The main difference in IGMP version 2 is that it provides a mechanism for a multicast group member to 
notify a multicast router that it is leaving a multicast group. The multicast router then sends a group-
specific IGMP query to check if there are any members remaining in that group. If the multicast router 
does not receive an IGMP report from any members, it stops sending multicast traffic to that group. This 
change helps shorten the leave convergence time, in other words, the amount of time that a multicast 
router believes that there are group members on a particular network. This in turn helps reduce the 
amount of multicast traffic going through the multicast router. 

Figure 355   IGMP Version 2 Example 

IGMP version 3 allows a multicast host to join a multicast group and specify from which source (multicast 
server) it wants to receive multicast packets. Alternatively, a multicast host can specify from which 
multicast servers it does not want to receive multicast packets. In the following figure multicast server X 
(IP address 10.1.1.1) and multicast server Z (IP address 13.2.2.2) both send multicast traffic to the same 
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multicast group identified by the multicast IP address 225.1.1.1. In IGMP version 3 multicast host A can 
join multicast group 225.1.1.1 and specify that it only wants to receive multicast packets from server X. 

Figure 356   IGMP Version 3 Example 

48.2  Port-based IGMP
The Switch sends IGMP Query packets to all ports. The Switch then listens for IGMP Report packets, and it 
records which port the messages came from. It then delivers multicast traffic to only those ports from 
which it received a request to join a multicast group. 

48.3  Configuring IGMP 
Click IP Application > IGMP in the navigation panel to display the screen as shown next. Each entry in 
the table is automatically created when you configure a new IP domain in the IP Setup screen (refer to 
Section 8.4 on page 82).

Figure 357   IP Application > IGMP 



Chapter 48 IGMP

XGS4600 Series User’s Guide

451

The following table describes the labels in this screen. 

Table 218   IP Application > IGMP  
LABEL DESCRIPTION
Active Select this check box to enable IGMP on the Switch. 

Note: You cannot enable both IGMP snooping and IGMP at the same time. Refer to 
Section 25.3.2 on page 245 for more information on IGMP snooping. 

Unknown 
Multicast 
Frame

Specify the action to perform when the Switch receives an unknown multicast frame. Unknown 
multicast frames are addressed to multicast groups for which the Switch has not recorded any 
group members. Select Drop to discard the frame(s). Select Flooding to send the frame(s) to all 
ports. 

Index This field displays an index number of an entry. 

Network This field displays the IP domain configured on the Switch. 

Refer to Section 8.4 on page 82 for more information on configuring IP domains. 

Version Select an IGMP version from the drop-down list box. The choices are IGMP-v1, IGMP-v2, IGMP-v3 
and None. 

Generally, if you want to enable IGMP on the Switch, you should choose IGMP-v3 as it is 
compatible with older versions. Choose an earlier version of IGMP (IGMP-v2 or IGMP-v1) if the 
multicast hosts on your network can not recognize IGMP version 3 or version 2 Query messages.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 49
DVMRP

This chapter introduces DVMRP and tells you how to configure it.

49.1  DVMRP Overview
DVMRP (Distance Vector Multicast Routing Protocol) is a protocol used for routing multicast data within 
an autonomous system (AS). This DVMRP implementation is based on draft-ietf-idmr-dvmrp-v3-10. 
DVMRP provides multicast forwarding capability to a layer-3 switch that runs both the IPv4 protocol (with 
IP Multicast support) and the IGMP protocol. The DVMRP metric is a hop count of 32.

IGMP is a protocol used for joining or leaving a multicast group. You must have IGMP enabled when you 
enable DVMRP; otherwise you see the screen as in Figure 360 on page 454.

49.2  How DVMRP Works
DVMRP uses the Reverse Path Multicasting (RPM) algorithm to generate an IP Multicast delivery tree. 
Multicast packets are forwarded along these multicast tree branches. DVMRP dynamically learns host 
membership information using Internet Group Management Protocol (IGMP). The trees are updated 
dynamically to track the membership of individual groups.

1 Initially an advertisement multicast packet is broadcast (“B” in the following figure). 

2 DVMRP-enabled Layer-3 devices that do not have any hosts in their networks that belong to this 
multicast group send back a prune message (“P”).

3 If hosts later join the multicast group, a graft message (“G”) to undo the prune is sent to the parent.

4 The final multicast (“M”) after pruning and grafting is shown in the next figure.

Figure 358   How DVMRP Works 
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49.2.1  DVMRP Terminology 
DVMRP probes are used to discover other DVMRP Neighbors on a network. 

DVMRP reports are used to exchange DVMRP source routing information. These packets are used to 
build the DVMRP multicast routing table that is used to build source trees and also perform Reverse Path 
Forwarding (RPF) checks on incoming multicast packets. RPF checks prevent duplicate packets being 
filtered when loops exist in the network topology. 

DVMRP prunes trim the multicast delivery tree(s). DVMRP grafts attach a branch back onto the multicast 
delivery tree.

49.3  Configuring DVMRP  
Configure DVMRP on the Switch when you wish it to act as a multicast router (“mrouter”). Click IP 
Application > DVMRP in the navigation panel to display the screen as shown. 

Figure 359   IP Application > DVMRP 

The following table describes the labels in this screen. 

Table 219   IP Application > DVMRP  
LABEL DESCRIPTION
Active Select Active to enable DVMRP on the Switch. You should do this if you want the Switch to act as a 

multicast router. 

Threshold Threshold is the maximum time to live (TTL) value. TTL is used to limit the scope of multicasting. You 
should reduce this value if you do not wish to flood Layer-3 devices many hops away with multicast 
traffic. This applies only to multicast traffic this Switch sends out.

Index Index is the DVMRP configuration for the IP routing domain defined under Network. The maximum 
number of DVMRP configurations allowed is the maximum number of IP routing domains allowed on 
the Switch. See Section 8.4 on page 82 for more information on IP routing domains.

Network This is the IP routing domain IP address and subnet mask you set up in IP Setup.

VID DVMRP cannot be enabled on the same VLAN group across different IP routing domains, that is, you 
cannot have duplicate VIDs for different DVMRP configurations (see Figure 362 on page 454).

Active Select Active to enable DVMRP on this IP routing domain.



 Chapter 49 DVMRP

XGS4600 Series User’s Guide

454

49.3.1  DVMRP Configuration Error Messages 
You must have IGMP enabled when you enable DVMRP; otherwise you see the screen as in the next 
figure.

Figure 360   DVMRP: IGMP Not Set Error 

When you disable IGMP, but DVMRP is still active you also see another warning screen.

Figure 361   DVMRP: Unable to Disable IGMP Error 

Each IP routing domain DVMRP configuration must be in a different VLAN group; otherwise you see the 
following screen.

Figure 362   DVMRP: Duplicate VID Error Message 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these changes if 
it is turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 219   IP Application > DVMRP  (continued)
LABEL DESCRIPTION
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49.4  Default DVMRP Timer Values 
The following are some default DVMRP timer values. 

Table 220   DVMRP: Default Timer Values  
DVMRP FIELD DEFAULT VALUE
Probe interval  10 sec

Report interval  35 sec

Route expiration time  140 sec

Prune lifetime  Variable (less than two hours)

Prune retransmission time  3 sec with exponential back off

Graft retransmission time  5 sec with exponential back off
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CHAPTER 50
Differentiated Services

This chapter shows you how to configure Differentiated Services (DiffServ) on the Switch.

50.1  DiffServ Overview 
Quality of Service (QoS) is used to prioritize source-to-destination traffic flows. All packets in the flow are 
given the same priority. You can use CoS (class of service) to give different priorities to different packet 
types.

DiffServ is a class of service (CoS) model that marks packets so that they receive specific per-hop 
treatment at DiffServ-compliant network devices along the route based on the application types and 
traffic flow. Packets are marked with DiffServ Code Points (DSCPs) indicating the level of service desired. 
This allows the intermediary DiffServ-compliant network devices to handle the packets differently 
depending on the code points without the need to negotiate paths or remember state information for 
every flow. In addition, applications do not have to request a particular service or give advanced 
notice of where the traffic is going. 

50.1.1  DSCP and Per-Hop Behavior 
DiffServ defines a new DS (Differentiated Services) field to replace the Type of Service (ToS) field in the IP 
header. The DS field contains a 6-bit DSCP field which can define up to 64 service levels and the 
remaining 2 bits are defined as currently unused (CU). The following figure illustrates the DS field. 

Figure 363   DiffServ: Differentiated Service Field 

DSCP is backward compatible with the three precedence bits in the ToS octet so that non-DiffServ 
compliant, ToS-enabled network device will not conflict with the DSCP mapping. 

The DSCP value determines the PHB (Per-Hop Behavior), that each packet gets as it is forwarded across 
the DiffServ network. Based on the marking rule different kinds of traffic can be marked for different 
priorities of forwarding. Resources can then be allocated according to the DSCP values and the 
configured policies. 

50.1.2  DiffServ Network Example 
The following figure depicts a DiffServ network consisting of a group of directly connected DiffServ-
compliant network devices. The boundary node (A in Figure 364) in a DiffServ network classifies (marks 
with a DSCP value) the incoming packets into different traffic flows (Platinum, Gold, Silver, Bronze) 
based on the configured marking rules. A network administrator can then apply various traffic policies to 
the traffic flows. For example, one traffic policy would be to give higher drop precedence to one traffic 

DSCP (6 bits) CU (2 bits)
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flow over others. In our example packets in the Bronze traffic flow are more likely to be dropped when 
congestion occurs than the packets in the Platinum traffic flow as they move across the DiffServ 
network.

Figure 364   DiffServ Network 

50.2  Activating DiffServ  
Activate DiffServ to apply marking rules or IEEE 802.1p priority mapping on the selected port(s). 

Click IP Application > DiffServ in the navigation panel to display the screen as shown.
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Figure 365   IP Application > DiffServ (Standalone mode) 

Figure 366   IP Application > DiffServ (Stacking mode)
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The following table describes the labels in this screen. 

50.3  DSCP-to-IEEE 802.1p Priority Settings    
You can configure the DSCP to IEEE 802.1p mapping to allow the Switch to prioritize all traffic based on 
the incoming DSCP value according to the DiffServ to IEEE 802.1p mapping table. 

The following table shows the default DSCP-to-IEEE802.1p mapping.

50.3.1  Configuring DSCP Settings 
To change the DSCP-IEEE 802.1p mapping, click the DSCP Setting link in the DiffServ screen to display the 
screen as shown next. 

Table 221   IP Application > DiffServ 
LABEL DESCRIPTION
Active Select this option to enable DiffServ on the Switch.

Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the index number of a port on the Switch. In stacking mode, the first number 
represents the slot and the second the port number. * means all ports (on the same Switch).

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select Active to enable DiffServ on the port. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 222   Default DSCP-IEEE 802.1p Mapping
DSCP VALUE 0 – 7 8 – 15 16 – 23 24 – 31 32 – 39 40 – 47 48 – 55 56 – 63

IEEE 802.1p 0 1 2 3 4 5 6 7
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Figure 367   IP Application > DiffServ > DSCP Setting 

The following table describes the labels in this screen. 

Table 223   IP Application > DiffServ > DSCP Setting 
LABEL DESCRIPTION
0 … 63 This is the DSCP classification identification number. 

To set the IEEE 802.1p priority mapping, select the priority level from the drop-down list box. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 51
DHCP

This chapter shows you how to configure the DHCP feature. 

51.1  DHCP Overview 
DHCP (Dynamic Host Configuration Protocol RFC 2131 and RFC 2132) allows individual computers to 
obtain TCP/IP configuration at start-up from a server. You can configure the Switch as a DHCP server or 
a DHCP relay agent. When configured as a server, the Switch provides the TCP/IP configuration for the 
clients. If you configure the Switch as a relay agent, then the Switch forwards DHCP requests to DHCP 
server on your network. If you don’t configure the Switch as a DHCP server or relay agent then you must 
have a DHCP server in the broadcast domain of the client computers or else the client computers must 
be configured manually.

The Dynamic Host Configuration Protocol for IPv6 (DHCPv6, RFC 3315) is a server-client protocol that 
allows a DHCP server to assign and pass IPv6 network addresses, prefixes and other configuration 
information to DHCP clients. DHCPv6 servers and clients exchange DHCP messages using UDP. Each 
DHCP client and server has a unique DHCP Unique IDentifier (DUID), which is used for identification when 
they are exchanging DHCPv6 messages. The DUID is generated from the MAC address, time, vendor 
assigned ID and/or the vendor's private enterprise number registered with the IANA. It should not 
change over time even after you reboot the device.

51.1.1  DHCP Modes 
The Switch can be configured as a DHCP server or DHCP relay agent. 

• If you configure the Switch as a DHCP server, it will maintain the pool of IP addresses along with 
subnet masks/prefixes, DNS server and default gateway information and distribute them to your LAN 
computers. 

• If there is already a DHCP server on your network, then you can configure the Switch as a DHCP relay 
agent. When the Switch receives a request from a computer on your network, it contacts the DHCP 
server for the necessary IP information, and then relays the assigned information back to the 
computer. 

51.1.2  DHCPv4 Configuration Options
The DHCPv4 configuration on the Switch is divided into Global and VLAN screens. The screen you should 
use for configuration depends on the DHCP services you want to offer the DHCP clients on your network. 
Choose the configuration screen based on the following criteria:

• Global - The Switch forwards all DHCPv4 requests to the same DHCP server.

• VLAN - The Switch is configured on a VLAN by VLAN basis. The Switch can be configured as a DHCP 
server for one VLAN and at the same time the Switch can be configured to relay DHCPv4 requests for 
clients in another VLAN.
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51.2  DHCP Configuration
Click IP Application > DHCP in the navigation panel to display the screen as shown. Click the link next to 
DHCPv4 to open screens where you can enable and configure DHCPv4 server/relay settings and create 
option 82 profiles. Click the link next to DHCPv6 to open screens where you can configure DHCPv6 
settings.

Figure 368   IP Application > DHCP 

51.3  DHCPv4 Status 
Click IP Application > DHCP > DHCPv4 in the navigation panel. The DHCP Status screen displays. 

Figure 369   IP Application > DHCP > DHCPv4 

The following table describes the labels in this screen. 

Table 224   IP Application > DHCP > DHCPv4
LABEL DESCRIPTION
Server Status This section displays configuration settings related to the Switch’s DHCP server mode. 

Index This is the index number. Click an index number to change the settings.

VID This field displays the VLAN ID for which the Switch is a DHCP server.

Server Status This field displays the starting DHCP client IP address. 

IP Pool Size This field displays the number of IP addresses that can be assigned to clients. 

Relay Status This section displays configuration settings related to the Switch’s DHCP relay mode. 

Relay Mode This field displays:

• None - if the Switch is not configured as a DHCP relay agent.
• Global - if the Switch is configured as a DHCP relay agent only.
• VLAN - followed by a VLAN ID or multiple VLAN IDs if it is configured as a relay agent for 

specific VLAN(s).
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51.3.1  DHCPv4 Server Status Detail 
Click IP Application > DHCP > DHCPv4 in the navigation panel and then click an existing index number 
of a DHCP server configuration to view the screen as shown. Use this screen to view details regarding 
DHCP server settings configured on the Switch.

Figure 370   IP Application > DHCP > DHCPv4 > Server Status Detail 

The following table describes the labels in this screen. 

VID This field displays the ID number of the VLAN for which the Switch acts as a DHCP relay 
agent.

Current Source 
Address

This field displays the source IP address of the DHCP requests that the Switch forwards to a 
DHCP server. 

Table 224   IP Application > DHCP > DHCPv4
LABEL DESCRIPTION

Table 225   IP Application > DHCP > DHCPv4 > Server Status Detail
LABEL DESCRIPTION
Start IP Address This field displays the starting IP address of the IP address pool configured for this DHCP server 

instance.

End IP Address This field displays the last IP address of the IP address pool configured for this DHCP server 
instance.

Subnet Mask This field displays the subnet mask value sent to clients from this DHCP server instance. 

Default Gateway This field displays the default gateway value sent to clients from this DHCP server instance.

Primary DNS Server This field displays the primary DNS server value sent to clients from this DHCP server instance.

Secondary DNS 
Server

This field displays the secondary DNS server value sent to clients from this DHCP server 
instance.

Lease Time This field displays the amount of time that the IP address is valid.

Address Leases This section displays information about the IP addresses this DHCP server issued to clients.

Index This field displays a sequential number for each DHCP request handled by the Switch.

IP Address This is the IP address issued to a DHCP client.

Timer This field displays the time remaining before the DHCP client has to renew its IP address.

Hardware Address This field displays the MAC address of the DHCP client.

It may also display SELF OCCUPIED ADDRESS if the IP address cannot be used for DHCP 
because it is already assigned to the Switch itself.

Hostname This field displays the system name of the client. 
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51.4  DHCPv4 Relay 
Configure DHCP relay on the Switch if the DHCP clients and the DHCP server are not in the same 
broadcast domain. During the initial IP address leasing, the Switch helps to relay network information 
(such as the IP address and subnet mask) between a DHCP client and a DHCP server. Once the DHCP 
client obtains an IP address and can connect to the network, network information renewal is done 
between the DHCP client and the DHCP server without the help of the Switch.

The Switch can be configured as a global DHCP relay. This means that the Switch forwards all DHCP 
requests from all domains to the same DHCP server. You can also configure the Switch to relay DHCP 
information based on the VLAN membership of the DHCP clients.

51.4.1  DHCPv4 Relay Agent Information 
The Switch can add information about the source of client DHCP requests that it relays to a DHCP server 
by adding Relay Agent Information. This helps provide authentication about the source of the requests. 
The DHCP server can then provide an IP address based on this information. Please refer to RFC 3046 for 
more details. 

The DHCP Relay Agent Information feature adds an Agent Information field (also known as the Option 
82 field) to DHCP requests. The Option 82 field is in the DHCP headers of client DHCP request frames that 
the Switch relays to a DHCP server.

51.4.1.1  DHCPv4 Relay Agent Information Format
A DHCP Relay Agent Information option has the following format. 

i1, i2 and iN are DHCP relay agent sub-options, which contain additional information about the DHCP 
client. You need to define at least one sub-option.

51.4.1.2  Sub-Option Format
There are two types of sub-option: “Agent Circuit ID Sub-option” and “Agent Remote ID Sub-option”. 
They have the following formats. 

Table 226   DHCP Relay Agent Information Option Format
Code

(82)

Length

(N)

i1 i2

  ...

iN

Table 227   DHCP Relay Agent Circuit ID Sub-option Format

SubOpt Code Length Value

1

(1 byte)

N

(1 byte)

Slot ID, Port ID, VLAN ID, System Name or String

Table 228   DHCP Relay Agent Remote ID Sub-option Format

SubOpt Code Length Value

2

(1 byte)

N

(1 byte)

MAC Address or String
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The 1 in the first field identifies this as an Agent Circuit ID sub-option and 2 identifies this as an Agent 
Remote ID sub-option. The next field specifies the length of the field. 

51.4.2  DHCPv4 Option 82 Profile
Use this screen to create DHCPv4 option 82 profiles. Click IP Application > DHCP > DHCPv4 in the 
navigation panel and click the Option 82 Profile link to display the screen as shown. 

Figure 371   IP Application > DHCP > DHCPv4 > Option 82 Profile 

The following table describes the labels in this screen. 

Table 229   IP Application > DHCP > DHCPv4 > Option 82 Profile 
LABEL DESCRIPTION
Name Enter a descriptive name for the profile for identification purposes. You can use up to 32 ASCII 

characters. Spaces are allowed.

Circuit-ID Use this section to configure the Circuit ID sub-option to include information that is specific to the 
relay agent (the Switch).

Enable Select this option to have the Switch add the Circuit ID sub-option to client DHCP requests that it 
relays to a DHCP server.

slot-port Select this option to have the Switch add the number of port that the DHCP client is connected 
to.

vlan Select this option to have the Switch add the ID of VLAN which the port belongs to.

hostname This is the system name you configure in the Basic Setting > General Setup screen. 

Select this option for the Switch to add the system name to the client DHCP requests that it relays 
to a DHCP server.

string Enter a string of up to 64 ASCII characters that the Switch adds into the client DHCP requests. 
Spaces are allowed.

Remote-ID Use this section to configure the Remote ID sub-option to include information that identifies  the 
relay agent (the Switch).

Enable Select this option to have the Switch append the Remote ID sub-option to the option 82 field of 
DHCP requests.
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51.4.3  Configuring DHCPv4 Global Relay
Use this screen to configure global DHCPv4 relay. Click IP Application > DHCP > DHCPv4 in the 
navigation panel and click the Global link to display the screen as shown.

Figure 372   IP Application > DHCP > DHCPv4 > Global 

The following table describes the labels in this screen. 

mac Select this option to have the Switch add its MAC address to the client DHCP requests that it 
relays to a DHCP server.

string Enter a string of up to 64 ASCII characters for the remote ID information in this field. Spaces are 
allowed.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values. 

Profile Name This field displays the descriptive name of the profile. Click the name to change the settings.  

Circuit-ID

Enable This field displays whether the Circuit ID sub-option is added to client DHCP requests.

Field This field displays the information that is included in the Circuit ID sub-option.

Remote-ID

Enable This field displays whether the Remote ID sub-option is added to client DHCP requests.

Field This field displays the information that is included in the Remote ID sub-option.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Check the entry(ies) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).

Table 229   IP Application > DHCP > DHCPv4 > Option 82 Profile (continued)
LABEL DESCRIPTION

Table 230   IP Application > DHCP > DHCPv4 > Global 
LABEL DESCRIPTION
Active Select this check box to enable DHCPv4 relay.

Remote DHCP 
Server 1 .. 3

Enter the IP address of a DHCPv4 server in dotted decimal notation.   

Option 82 
Profile 

Select a pre-defined DHCPv4 option 82 profile that the Switch applies to all ports. The Switch 
adds the Circuit ID sub-option and/or Remote ID sub-option specified in the profile to DHCP 
requests that it relays to a DHCP server.
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51.4.4  DHCPv4 Global Relay Port Configure 
Use this screen to apply a different DHCP option 82 profile to certain ports on the Switch. To open this 
screen, click IP Application > DHCP > DHCPv4 > Global > Port.

Figure 373   IP Application > DHCP > DHCPv4 > Global > Port

The following table describes the labels in this screen. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Table 230   IP Application > DHCP > DHCPv4 > Global (continued)
LABEL DESCRIPTION

Table 231   IP Application > DHCP > DHCPv4 > Global > Port 
LABEL DESCRIPTION
Port Enter the number of port(s) to which you want to apply the specified DHCP option 82 profile.

You can enter multiple ports separated by (no space) comma (,) or hyphen (-) for a range. 
For example, enter “3-5” for ports 3, 4, and 5. Enter “3,5,7” for ports 3, 5, and 7.

In stacking mode, the first number represents the slot and the second the port number. Enter 
1/1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 and port 28 for the Switch in slot 2, for 
example.

Option 82 Profile Select a pre-defined DHCP option 82 profile that the Switch applies to the specified port(s). 
The Switch adds the Circuit ID sub-option and/or Remote ID sub-option specified in the 
profile to DHCP requests that it relays to a DHCP server.

Note: The profile you select here has priority over the one you select in the DHCP > 
DHCPv4 > Global screen.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it 
is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values above based on the last selected entry or, if not applicable, to 
clear the fields above.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change the 
settings. 
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51.4.5  Global DHCP Relay Configuration Example
The follow figure shows a network example where the Switch is used to relay DHCP requests for the 
VLAN1 and VLAN2 domains. There is only one DHCP server that services the DHCP clients in both 
domains. 

Figure 374   Global DHCP Relay Network Example 

Configure the DHCP Relay screen as shown. Make sure you select a DHCP option 82 profile (default1 in 
this example) to set the Switch to send additional information (such as the VLAN ID) together with the 
DHCP requests to the DHCP server. This allows the DHCP server to assign the appropriate IP address 
according to the VLAN ID. 

Figure 375   DHCP Relay Configuration Example 

Port This field displays the port(s) to which the Switch applies the settings. In stacking mode, the 
first number represents the slot and the second the port number.

Profile Name This field displays the DHCP option 82 profile that the Switch applies to the port(s).

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Select the entry(ies) that you want to remove, then click the Delete button to remove the 
selected entry(ies) from the table.

Cancel Click this to clear the check boxes above.

Table 231   IP Application > DHCP > DHCPv4 > Global > Port (continued)
LABEL DESCRIPTION

example
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51.5  Configuring DHCP VLAN Settings   
Use this screen to configure your DHCP settings based on the VLAN domain of the DHCP clients. Click IP 
Application > DHCP > DHCPv4 in the navigation panel, then click the VLAN link In the DHCP Status screen 
that displays. 

Note: You must set up a management IP address for each VLAN that you want to configure 
DHCP settings for on the Switch. See Section 8.4 on page 82 for information on how to 
do this.

Figure 376   IP Application > DHCP > DHCPv4 > VLAN 

The following table describes the labels in this screen. 

Table 232   IP Application > DHCP > DHCPv4 > VLAN 
LABEL DESCRIPTION
VID Enter the ID number of the VLAN to which these DHCP settings apply. 

DHCP Status Select whether the Switch should function as a DHCP Server or Relay for the specified VID. If 
you select Server then fields related to DHCP relay configuration are grayed out and vice 
versa.

Server Use this section if you want to configure the Switch to function as a DHCP server for this VLAN.



 Chapter 51 DHCP

XGS4600 Series User’s Guide

470

51.5.1  DHCPv4 VLAN Port Configure 
Use this screen to apply a different DHCP option 82 profile to certain ports in a VLAN. To open this screen, 
click IP Application > DHCP > DHCPv4 > VLAN > Port.

Client IP Pool 
Starting 
Address

Specify the first of the contiguous addresses in the IP address pool.

Size of Client 
IP Pool

Specify the size, or count of the IP address pool. The Switch can issue from 1 to 253 IP addresses 
to DHCP clients.

IP Subnet 
Mask

Enter the subnet mask for the client IP pool. 

Default 
Gateway

Enter the IP address of the default gateway device. 

Primary/ 
Secondary 
DNS Server

Enter the IP addresses of the DNS servers. The DNS servers are passed to the DHCP clients along 
with the IP address and the subnet mask. 

Lease Time Select Infinite to have the binding always valid. Select the second radio button to set up the 
binding’s valid days, hours and minutes. 

Relay Use this section if you want to configure the Switch to function as a DHCP relay for this VLAN.

Remote 
DHCP Server 
1 .. 3

Enter the IP address of a DHCP server in dotted decimal notation.   

Source 
Address

Enter the source IP address that the Switch adds to DHCP requests from clients on this VLAN 
before forwarding them. If you leave this field set to 0.0.0.0, the Switch automatically sets the 
source IP address of the DHCP requests to the IP address of the interface on which the packet is 
received.

The source IP address helps DHCP clients obtain an appropriate IP address when you configure 
multiple routing domains on a VLAN.

Option 82 Profile Select a pre-defined DHCP option 82 profile that the Switch applies to all ports in this VLAN. The 
Switch adds the Circuit ID sub-option and/or Remote ID sub-option specified in the profile to 
DHCP requests that it relays to a DHCP server.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

VID This field displays the ID number of the VLAN group to which this DHCP settings apply. 

Type This field displays Server or Relay for the DHCP mode. 

DHCP Status For DHCP server configuration, this field displays the starting IP address and the size of the IP 
address pool. 

For DHCP relay configuration, this field displays the first remote DHCP server IP address.

Source Address This field displays the source IP address you configured for DHCP requests from clients on this 
VLAN.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Select the configuration entries you want to remove and click Delete to remove them.

Cancel Click Cancel to clear the check boxes. 

Table 232   IP Application > DHCP > DHCPv4 > VLAN (continued)
LABEL DESCRIPTION
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Figure 377   IP Application > DHCP > DHCPv4 > VLAN > Port

The following table describes the labels in this screen. 

Table 233   IP Application > DHCP > DHCPv4 > VLAN > Port 
LABEL DESCRIPTION
VID Enter the ID number of the VLAN you want to configure here.

Port Enter the number of port(s) to which you want to apply the specified DHCP option 82 profile.

You can enter multiple ports separated by (no space) comma (,) or hyphen (-) for a range. 
For example, enter “3-5” for ports 3, 4, and 5. Enter “3,5,7” for ports 3, 5, and 7.

In stacking mode, the first number represents the slot and the second the port number. Enter 
1/1-1/24,2/28 for ports 1 to 24 for the Switch in slot 1 and port 28 for the Switch in slot 2, for 
example.

Option 82 Profile Select a pre-defined DHCP option 82 profile that the Switch applies to the specified port(s) in 
this VLAN. The Switch adds the Circuit ID sub-option and/or Remote ID sub-option specified in 
the profile to DHCP requests that it relays to a DHCP server.

Note: The profile you select here has priority over the one you select in the DHCP > 
DHCPv4 > VLAN screen.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it 
is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values above based on the last selected entry or, if not applicable, to 
clear the fields above.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change the 
settings. 

VID This field displays the VLAN to which the port(s) belongs.

Port This field displays the port(s) to which the Switch applies the settings.

Profile Name This field displays the DHCP option 82 profile that the Switch applies to the port(s) in this VLAN.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Select the configuration entries you want to remove and click Delete to remove them.

Cancel Click Cancel to clear the check boxes. 
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51.5.2  Example: DHCP Relay for Two VLANs
The following example displays two VLANs (VIDs 1 and 2) for a campus network. Two DHCP servers are 
installed to serve each VLAN. The system is set up to forward DHCP requests from the dormitory rooms 
(VLAN 1) to the DHCP server with an IP address of 192.168.1.100. Requests from the academic buildings 
(VLAN 2) are sent to the other DHCP server with an IP address of 172.16.10.100. 

Figure 378   DHCP Relay for Two VLANs 

For the example network, configure the VLAN Setting screen as shown. 

Figure 379   DHCP Relay for Two VLANs Configuration Example 

VLAN 1

VLAN 2
 

example
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51.6  DHCPv6 Status 
Click IP Application > DHCP > DHCPv6 in the navigation panel to see information on the DHCPv6 server. 
The DHCPv6 Status screen displays. 

Figure 380   IP Application > DHCP > DHCPv6

The following table describes the labels in this screen. 

51.7  DHCPv6 Information
Use this screen to configure DHCPv6 and DNS server settings on the Switch. Click IP Application > DHCP > 
DHCPv6 > Information in the navigation panel to display the screen as shown. 

Table 234   IP Application > DHCP > DHCPv6
LABEL DESCRIPTION
Server Status This section displays configuration settings related to the Switch’s DHCP server mode. 

Index This is the index number of a DHCPv6 server information.

VID This field displays the VLAN ID to which the DHCP server belongs.

DHCP Server A DHCPv6 server can assign and pass IPv6 network addresses, prefixes and other 
configuration information to DHCP clients. 

Information This field displays Yes when the entry supports display of the refresh time and DNS server; it 
shows No when it does not. 

Prefix 
Delegation

This field displays Yes when the entry supports the prefix delegation; it shows No when it does 
not. The prefix delegation is used by an IPv6 device to generate its IP address. 

DHCP Relay A DHCPv6 relay agent is on the same network as the DHCPv6 clients and helps forward 
messages between the DHCPv6 server (that’s in another network) and the DHCPv6 clients. 

This field displays Yes when the Switch supports DHCPv6 Relay and No when it does not. Yes 
means the Switch forwards all DHCP requests to the same DHCP server. No means the Switch 
does not forward DHCP requests to a DHCP server.
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Figure 381   IP Application > DHCP > DHCPv6 > Information 

The following table describes the labels in this screen. 

Table 235   IP Application > DHCP > DHCPv6 > Information 
LABEL DESCRIPTION
Active Select this check box to enable the entry.

VID Enter the ID number of the VLAN to which the DHCPv6 server belongs here.

Refresh Time Enter the number of seconds a DHCPv6 client should wait before refreshing information retrieved 
from a DHCPv6 server. The allowed range is 600 to 4294967295 seconds.

DNS Server Specify the IPv6 address of the DNS server for the DHCP clients to use here.  

An 128-bit IPv6 address is written as eight 16-bit hexadecimal blocks separated by colons (:). This 
is an example IPv6 address ‘2001:0db8:1a2b:0015:0000:0000:1a2f:0000’. 

IPv6 addresses can be abbreviated in two ways:

• Leading zeros in a block can be omitted. So ‘2001:0db8:1a2b:0015:0000:0000:1a2f:0000’ 
can be written as ‘2001:db8:1a2b:15:0:0:1a2f:0’. 

• Any number of consecutive blocks of zeros can be replaced by a double colon. A double 
colon can only appear once in an IPv6 address. So 
‘2001:0db8:0000:0000:1a2f:0000:0000:0015’ can be written as 
‘2001:0db8::1a2f:0000:0000:0015’, ‘2001:0db8:0000:0000:1a2f::0015’, ‘2001:db8::1a2f:0:0:15’ 
or ‘2001:db8:0:0:1a2f::15’.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values. 

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change its 
settings. 

Active This field displays whether the entry is activated or not.

VID This field displays the ID number of the VLAN to which the DHCPv6 server belongs.  

Refresh Time This field displays the number of seconds a DHCPv6 client should wait before refreshing 
information retrieved from a DHCPv6 server. It displays disable if Refresh Time is not configured.

DNS Server This field displays the IPv6 address of the DNS server that the DHCP clients will use. It displays 
disable when it is not configured.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 
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51.8  DHCPv6 Prefix Delegation
Prefix delegation enables an IPv6 device to use the received IPv6 prefix (for example, ‘2001:db2::/48’) to 
generate its IP address. The Switch passes the IPv6 prefix information to its connected hosts (according 
to VLAN) so that they can generate their IPv6 addresses.

Use this screen to configure DHCPv6 client and IPv6 prefix settings for a specific VLAN on the Switch. 
Click IP Application > DHCP > DHCPv6 > Prefix Delegation in the navigation panel to display the screen 
as shown. 

Figure 382   IP Application > DHCP > DHCPv6 > Prefix Delegation 

The following table describes the labels in this screen. 

Delete Check the entry(ies) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).

Table 235   IP Application > DHCP > DHCPv6 > Information (continued)
LABEL DESCRIPTION

Table 236   IP Application > DHCP > DHCPv6 > Prefix Delegation 
LABEL DESCRIPTION
Client DUID Each DHCP client and server has a unique DHCP Unique IDentifier (DUID), which is used for 

identification when they are exchanging DHCPv6 messages. The DUID is generated from the 
MAC address, time, vendor assigned ID and/or the vendor's private enterprise number registered 
with the IANA. Type the client DUID for the devices connected to the Switch in this field.

Client Name Type a name to identify the DHCPv6 client in this field.

VID Type the ID number of the VLAN to which the DHCPv6 client belongs here.

Prefix Address IPv6 uses an address prefix to represent the network address. An IPv6 prefix length specifies how 
many most significant bits (start from the left) in the address compose the network address. The 
prefix length is written as “/x” where x is a number. For example, ‘2001:db8:1a2b:15::1a2f:0/32’ is 
a prefix address with prefix length.

/32 means that the first 32 bits (‘2001:db8’) from the left is the network prefix.

Type the prefix address in this field. For example, type ‘2001:db8:1a2b:15::1a2f:0’

Prefix Length Type the prefix length in this field. For example, type 32.
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51.9  DHCPv6 Relay
A DHCPv6 relay agent is on the same network as the DHCPv6 clients and helps forward messages 
between the DHCPv6 server (that’s in another network) and the DHCPv6 clients. 

The DHCPv6 relay agent can add the remote identification (remote-ID) option and the interface-ID 
option to the Relay-Forward DHCPv6 messages. The remote-ID option carries a user-defined string, such 
as the system name. The interface-ID option provides slot number, port information and the VLAN ID to 
the DHCPv6 server. The remote-ID option (if any) is stripped from the Relay-Reply messages before the 
relay agent sends the packets to the clients. The DHCPv6 server copies the interface-ID option from the 
Relay-Forward message into the Relay-Reply message and sends it to the relay agent. The interface-ID 
should not change even after the relay agent restarts.

Use this screen to configure DHCPv6 relay settings for a specific VLAN on the Switch. Click IP Application 
> DHCP > DHCPv6 > DHCPv6 Relay in the navigation panel to display the screen as shown. 

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values. 

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change its 
settings. 

Client DUID This field displays the client DHCP Unique IDentifier (DUID) which uniquely identifies the client.

Client Name This field displays a name to identify the DHCPv6 client.

VID This field displays the ID number of the VLAN to which the DHCPv6 client belongs. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Check the entry(ies) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).

Table 236   IP Application > DHCP > DHCPv6 > Prefix Delegation (continued)
LABEL DESCRIPTION
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Figure 383   IP Application > DHCP > DHCPv6 > DHCPv6 Relay

The following table describes the labels in this screen. 

Table 237   IP Application > DHCP > DHCPv6> DHCPv6 Relay 
LABEL DESCRIPTION
VID Enter the ID number of the VLAN to which the DHCPv6 server that will assign IP information 

belongs here.

Helper Address Enter the IPv6 address of the DHCPv6 server that will assign IP information here.

An 128-bit IPv6 address is written as eight 16-bit hexadecimal blocks separated by colons (:). This 
is an example IPv6 address ‘2001:0db8:1a2b:0015:0000:0000:1a2f:0000’. 

IPv6 addresses can be abbreviated in two ways:

• Leading zeros in a block can be omitted. So ‘2001:0db8:1a2b:0015:0000:0000:1a2f:0000’ can 
be written as ‘2001:db8:1a2b:15:0:0:1a2f:0’. 

• Any number of consecutive blocks of zeros can be replaced by a double colon. A double 
colon can only appear once in an IPv6 address. So 
‘2001:0db8:0000:0000:1a2f:0000:0000:0015’ can be written as 
‘2001:0db8::1a2f:0000:0000:0015’, ‘2001:0db8:0000:0000:1a2f::0015’, ‘2001:db8::1a2f:0:0:15’ 
or ‘2001:db8:0:0:1a2f::15’.

Options

Interface ID Select this option to have the Switch add the interface-ID option in the DHCPv6 requests from 
the clients in the specified VLAN before the Switch forwards them to a DHCPv6 server.

Remote ID Enter a string of up to 64 printable characters to be carried in the remote-ID option. The Switch 
adds the remote-ID option in the DHCPv6 requests from the clients in the specified VLAN before 
the Switch forwards them to a DHCPv6 server.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your changes 
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values. 

Clear Click Clear to reset the fields to the factory defaults.

VID This field displays the VLAN ID number. Click the VLAN ID to change the settings.  

Helper Address This field displays the IPv6 address of the remote DHCPv6 server for this VLAN.

Interface ID This field displays whether the interface-ID option is added to DHCPv6 requests from clients in this 
VLAN.

Remote ID This field displays whether the remote-ID option is added to DHCPv6 requests from clients in this 
VLAN.
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Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Check the entry(ies) that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected checkbox(es).

Table 237   IP Application > DHCP > DHCPv6> DHCPv6 Relay (continued)
LABEL DESCRIPTION
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CHAPTER 52
VRRP

This chapter shows you how to configure and monitor the Virtual Router Redundancy Protocol (VRRP) on 
the Switch. 

52.1  VRRP Overview 
Each host on a network is configured to send packets to a statically configured default gateway (this 
Switch). The default gateway can become a single point of failure. Virtual Router Redundancy Protocol 
(VRRP), defined in RFC 2338, allows you to create redundant backup gateways to ensure that the 
default gateway of a host is always available. 

In VRRP, a virtual router (VR) represents a number of physical layer-3 devices. An IP address is associated 
with the virtual router. A layer-3 device having the same IP address is the preferred master router while 
the other Layer-3 devices are the backup routers. The master router forwards traffic for the virtual router. 
When the master router becomes unavailable, a backup router assumes the role of the master router 
until the master router comes back up and takes over. 

The following figure shows a VRRP network example with the switches (A and B) implementing one 
virtual router VR1 to ensure the link between the host X and the uplink gateway G. Host X is configured 
to use VR1 (192.168.1.20) as the default gateway. If switch A has a higher priority, it is the master router. 
Switch B, having a lower priority, is the backup router. 

Figure 384   : Example 1 

If switch A (the master router) is unavailable, switch B takes over. Traffic is then processed by switch B.  
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52.2  VRRP Status
Click IP Application > VRRP in the navigation panel to display the VRRP Status screen as shown next. 

Figure 385   IP Application > VRRP Status 

The following table describes the labels in this screen. 

52.3  VRRP Configuration 
The following sections describe the different parts of the VRRP Configuration screen.

52.3.1  IP Interface Setup 
Before configuring VRRP, first create an IP interface (or routing domain) in the IP Setup screen (see the 
Section 8.4 on page 82 for more information). 

Table 238   IP Application > VRRP Status 
LABEL DESCRIPTION
Index This field displays the index number of a rule. 

Network This field displays the IP address and the subnet mask bits of an IP routing domain that is 
associated to a virtual router. 

VRID This field displays the ID number of the virtual router. 

VR Status This field displays the status of the virtual router. 

This field is Master indicating that this Switch functions as the master router. 

This field is Backup indicating that this Switch functions as a backup router.

This field displays Init when this Switch is initiating the VRRP protocol or when the Uplink Status 
field displays Dead. 

Uplink Status This field displays the status of the link between this Switch and the uplink gateway. 

This field is Alive indicating that the link between this Switch and the uplink gateway is up. 
Otherwise, this field is Dead. 

This field displays Probe when this Switch is check for the link state. 

Poll Interval(s) The text box displays how often (in seconds) this screen refreshes. You may change the refresh 
interval by typing a new number in the text box and then clicking Set Interval.

Stop Click Stop to halt system statistic polling.
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Click IP Application, VRRP and click the Configuration link to display the VRRP Configuration screen as 
shown next. 

Note: You can only configure VRRP on interfaces with unique VLAN IDs.

Note: Routing domains with the same VLAN ID are not displayed in the table indicated. 

Figure 386   IP Application > VRRP Configuration: IP Interface 

The following table describes the labels in this screen. 

Table 239   IP Application > VRRP Configuration: IP Interface 
LABEL DESCRIPTION
Index This field displays the index number of an entry.

Network This field displays the IP address and number of subnet mask bit of an IP domain. 

Authentication Select None to disable authentication. This is the default setting. 

Select Simple to use a simple password to authenticate VRRP packet exchanges on this 
interface.

Key When you select Simple in the Authentication field, enter a password key (up to eight printable 
ASCII character long) in this field. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to discard all changes made in this table. 
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52.3.2  VRRP Parameters 
This section describes the VRRP parameters. 

52.3.2.1  Advertisement Interval 
The master router sends out Hello messages to let the other backup routers know that it is still up and 
running. The time interval between sending the Hello messages is the advertisement interval. By default, 
a Hello message is sent out every second.

If the backup routers do not receive a Hello message from the master router after this interval expires, it 
is assumed that the master router is down. Then the backup router with the highest priority becomes the 
master router.  

Note: All routers participating in the virtual router must use the same advertisement interval. 

52.3.2.2  Priority 
Configure the priority level (1 to 254) to set which backup router to take over in case the master router 
goes down. The backup router with the highest priority will take over. The priority of the VRRP router that 
owns the IP address(es) associated with the virtual router is 255. 

52.3.2.3  Preempt Mode 
If the master router is unavailable, a backup router assumes the role of the master router. However, 
when another backup router with a higher priority joins the network, it will preempt the lower priority 
backup router that is the master. Disable preempt mode to prevent this from happening.  

By default, a layer 3 device with the same IP address as the virtual router will become the master router 
regardless of the preempt mode. 

52.3.3  Configuring VRRP Parameters
After you set up an IP interface, configure the VRRP parameters in the VRRP Configuration screen. 

Figure 387   IP Application > VRRP Configuration: VRRP Parameters 
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The following table describes the labels in this screen. 

52.3.4  Viewing VRRP Summary
View the VRRP configuration summary at the bottom of the screen. 

Figure 388   IP Application > VRRP Configuration: Summary 

The following table describes the labels in this screen. 

Table 240   IP Application > VRRP Configuration: VRRP Parameters 
LABEL DESCRIPTION
Active Select this option to enable this VRRP entry. 

Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 

Network Select an IP domain to which this VRRP entry applies. 

Virtual Router ID Select a virtual router number (1 to 7) for which this VRRP entry is created. 

You can configure up to seven virtual routers for one network.

Advertisement Interval Specify the number of seconds between Hello message transmissions. The default is 1. 

Preempt Mode Select this option to activate preempt mode. 

Priority Enter a number (between 1 and 254) to set the priority level. The bigger the number, the 
higher the priority.  

This field is 100 by default.

Uplink Gateway Enter the IP address of the uplink gateway in dotted decimal notation. 

The Switch checks the link to the uplink gateway. 

Response Ping Select this option to have the Switch respond to a ping that is sent to the virtual IP address.

Primary Virtual IP Enter the IP address of the primary virtual router in dotted decimal notation. 

Secondary Virtual IP This field is optional. Enter the IP address of a secondary virtual router in dotted decimal 
notation. This field is ignored when you enter 0.0.0.0.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if 
it is turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to discard all changes made in this table.

Clear Click Clear to set the above fields back to the factory defaults. 

Table 241   IP Application > VRRP Configuration: Summary 
LABEL DESCRIPTION
Index This field displays the index number of an entry. Click an index number to change the settings. 

Active This field shows whether a VRRP entry is enabled (Yes) or disabled (No). 

Name This field displays a descriptive name of an entry. 

Network This field displays the IP address and subnet mask of an interface. 

VRID This field displays the ID number of a virtual router. 

Primary VIP This field displays the IP address of the primary virtual router.
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52.4  VRRP Configuration Examples 
The following sections show two VRRP configuration examples on the Switch. 

52.4.1  One Subnet Network Example 
The figure below shows a simple VRRP network with only one virtual router VR1 (VRID =1) and two 
switches. The network is connected to the WAN via an uplink gateway G (172.16.1.100). The host 
computer X is set to use VR1 as the default gateway.  

Figure 389   VRRP Configuration Example: One Virtual Router Network 

You want to set switch A as the master router. Configure the VRRP parameters in the VRRP Configuration 
screens on the switches as shown in the figures below.

Uplink Gateway This field displays the IP address of the uplink gateway.

Priority This field displays the priority level (1 to 255) of the entry. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

Table 241   IP Application > VRRP Configuration: Summary (continued)
LABEL DESCRIPTION
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Figure 390   VRRP Example 1: VRRP Parameter Settings on Switch A 

Figure 391   VRRP Example 1: VRRP Parameter Settings on Switch B 

After configuring and saving the VRRP configuration, the VRRP Status screens for both switches are 
shown next. 

Figure 392   VRRP Example 1: VRRP Status on Switch A 

Figure 393   VRRP Example 1: VRRP Status on Switch B 

52.4.2  Two Subnets Example 
The following figure depicts an example in which two switches share the network traffic. Hosts in the two 
network groups use different default gateways. Each switch is configured to backup a virtual router 
using VRRP.

example

example

example

example
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You wish to configure switch A as the master router for virtual router VR1 and as a backup for virtual 
router VR2. On the other hand, switch B is the master for VR2 and a backup for VR1. 

Figure 394   VRRP Configuration Example: Two Virtual Router Network 

You need to configure the VRRP Configuration screen for virtual router VR2 on each switch, while 
keeping the VRRP configuration in example 1 for virtual router VR1 (refer to Section 52.4.2 on page 485). 
Configure the VRRP parameters on the switches as shown in the figures below. 

Figure 395   VRRP Example 2: VRRP Parameter Settings for VR2 on Switch A 

Figure 396   VRRP Example 2: VRRP Parameter Settings for VR2 on Switch B 

example

example
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After configuring and saving the VRRP configuration, the VRRP Status screens for both switches are 
shown next.

Figure 397   VRRP Example 2: VRRP Status on Switch A

Figure 398   VRRP Example 2: VRRP Status on Switch B

example

example
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CHAPTER 53
Router Setup

53.1  Router Setup Overview 
The Switch learns the next-hop(s) using ARP and determines routing path(s) for a destination. The Switch 
supports Equal-Cost MultiPath (ECMP) to forward packets destined to the same device (A for example) 
through different routing paths (1, 2 and 3) of equal path cost. This allows you to balance or share traffic 
loads between multiple routing paths when the Switch is connected to more than one next-hop. ECMP 
works with static routes or a routing protocol, such as OSPF. With ECMP, packets are routed through the 
paths of equal cost according to the hash algorithm output. 

53.2  Configuring Router Setup 
Click IP Application > Router Setup in the navigation panel to display the screen as shown next. 

Figure 399   IP Application > Router Setup  
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The following table describes the labels in this screen. 

Table 242   IP Application > Router Setup 
LABEL DESCRIPTION
Active Select this option to enable Equal-Cost MultiPath (ECMP) routing on the Switch.

Criteria Select the criteria the Switch uses to determine the routing path for a packet.

Select src-ip to have the Switch use a hash algorithm to convert a packet’s source IP address 
into a hash value which acts as an index to a route path. 

Select src-dst-ip to have the Switch use a hash algorithm to convert a packet’s source and 
destination IP addresses into a hash value which acts as an index to a route path.

Aging Time Specify the time interval (from 0 to 86400 in increments of 10) in seconds at which the Switch 
sends an ARP request to update a resolved next-hop’s MAC address.

Discover Time Specify the time interval (from 0 to 86400 in increments of 10) in seconds at which the Switch 
sends an ARP request to update an unresolved next-hop’s MAC address.

Maximum Paths Set the maximum number of paths for one ECMP (Equal-Cost MultiPath) route. The maximum 
number varies by Switch. A smaller number of maximum-paths means more ECMP routes are 
allowed and a larger number of maximum-paths means fewer ECMP routes are allowed. 

The number of paths for a static route for ECMP cannot be bigger than the maximum-paths 
value configured here. 

Throughput may be influenced while configuring ECMP maximum-paths.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 54
ARP Setup

54.1  ARP Overview 
Address Resolution Protocol (ARP) is a protocol for mapping an Internet Protocol address (IP address) to 
a physical machine address, also known as a Media Access Control or MAC address, on the local area 
network. 

An IP (version 4) address is 32 bits long. In an Ethernet LAN, MAC addresses are 48 bits long. The ARP 
table maintains an association between each MAC address and its corresponding IP address. 

54.1.1  How ARP Works
When an incoming packet destined for a host device on a local area network arrives at the Switch, the 
Switch looks in the ARP Table and if it finds the address, it sends it to the device.

If no entry is found for the IP address, ARP broadcasts the request to all the devices on the LAN. The 
Switch fills in its own MAC and IP address in the sender address fields, and puts the known IP address of 
the target in the target IP address field. In addition, the Switch puts all ones in the target MAC field 
(FF.FF.FF.FF.FF.FF is the Ethernet broadcast address). The replying device (which is either the IP address of 
the device being sought or the router that knows the way) replaces the broadcast address with the 
target's MAC address, swaps the sender and target pairs, and unicasts the answer directly back to the 
requesting machine. ARP updates the ARP Table for future reference and then sends the packet to the 
MAC address that replied. 

54.1.2  ARP Learning Mode
The Switch supports three ARP learning modes: ARP-Reply, Gratuitous-ARP, and ARP-Request.

54.1.2.1  ARP-Reply
The Switch in ARP-Reply learning mode updates the ARP table only with the ARP replies to the ARP 
requests sent by the Switch. This can help prevent ARP spoofing.

In the following example, the Switch does not have IP address and MAC address mapping information 
for hosts A and B in its ARP table, and host A wants to ping host B. Host A sends an ARP request to the 
Switch and then sends an ICMP request after getting the ARP reply from the Switch. The Switch finds no 
matched entry for host B in the ARP table and broadcasts the ARP request to all the devices on the LAN. 
When the Switch receives the ARP reply from host B, it updates its ARP table and also forwards host A’s 
ICMP request to host B. After the Switch gets the ICMP reply from host B, it sends out an ARP request to 
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get host A’s MAC address and updates the ARP table with host A’s ARP reply. The Switch then can 
forward host B’s ICMP reply to host A.

54.1.2.2  Gratuitous-ARP
A gratuitous ARP is an ARP request in which both the source and destination IP address fields are set to 
the IP address of the device that sends this request and the destination MAC address field is set to the 
broadcast address. There will be no reply to a gratuitous ARP request. 

A device may send a gratuitous ARP packet to detect IP collisions. If a device restarts or its MAC address 
is changed, it can also use gratuitous ARP to inform other devices in the same network to update their 
ARP table with the new mapping information.

In Gratuitous-ARP learning mode, the Switch updates its ARP table with either an ARP reply or a 
gratuitous ARP request.

54.1.2.3  ARP-Request
When the Switch is in ARP-Request learning mode, it updates the ARP table with both ARP replies, 
gratuitous ARP requests and ARP requests.
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Therefore in the following example, the Switch can learn host A’s MAC address from the ARP request 
sent by host A. The Switch then forwards host B’s ICMP reply to host A right after getting host B’s MAC 
address and ICMP reply. 

54.2  ARP Setup
Click IP Application > ARP Setup in the navigation panel to display the screen as shown. Click the link 
next to ARP Learning to open a screen where you can set the ARP learning mode for each port. Click 
the link next to Static ARP to open a screen where you can create static ARP entries on the Switch.

Figure 400   IP Application > ARP Setup 

54.2.1  ARP Learning 
Use this screen to configure each port’s ARP learning mode. Click the link next to ARP Learning in the IP 
Application > ARP Setup screen to display the screen as shown next. 
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Figure 401   IP Application > ARP Setup > ARP Learning (Standalone mode)

Figure 402   IP Application > ARP Setup > ARP Learning (Stacking mode) 
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The following table describes the labels in this screen. 

54.2.2  Static ARP
Use this screen to create static ARP entries that will display in the Management > ARP Table screen and 
will not age out. Click the link next to Static ARP in the IP Application > ARP Setup screen to display the 
screen as shown. 

Figure 403   IP Application > ARP Setup > Static ARP (Standalone mode)

Table 243   IP Application > ARP Setup > ARP Learning 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This field displays the port number. In stacking mode, the first number represents the slot and the 
second the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
ARP Learning 
Mode

Select the ARP learning mode the Switch uses on the port.

Select ARP-Reply to have the Switch update the ARP table only with the ARP replies to the ARP 
requests sent by the Switch.

Select Gratuitous-ARP to have the Switch update its ARP table with either an ARP reply or a 
gratuitous ARP request.

Select ARP-Request to have the Switch update the ARP table with both ARP replies, gratuitous 
ARP requests and ARP requests.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 404   IP Application > ARP Setup > Static ARP (Stacking mode)

The following table describes the related labels in this screen.  

Table 244   IP Application > ARP Setup > Static ARP 
LABEL DESCRIPTION
Active Select this check box to activate your rule. You may temporarily deactivate a rule without 

deleting it by clearing this check box.

Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes. 

IP Address Enter the IP address of a device connected to a Switch port with the corresponding MAC 
address below.

MAC Address Enter the MAC address of the device with the corresponding IP address above.

VID Enter the ID number of VLAN to which the device belongs.

Port Enter the number of port to which the device connects. In stacking mode, the first number 
represents the slot and the second the port number. 

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults. 

Index This field displays the index number of an entry. Click an index number to change the settings. 

Active This field displays Yes when the entry is activated and NO when it is deactivated.

Name This field displays the descriptive name for this entry. This is for identification purposes only.

IP Address This is the IP address of a device connected to a Switch port with the corresponding MAC 
address below.

MAC Address This is the MAC address of the device with the corresponding IP address above.

VID This field displays the VLAN to which the device belongs.

Port This field displays the port to which the device connects. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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CHAPTER 55
Maintenance

This chapter explains how to configure the maintenance screens that let you maintain the firmware and 
configuration files.

55.1  The Maintenance Screen
Use this screen to manage firmware and your configuration files. Click Management > Maintenance in 
the navigation panel to open the following screen.

Figure 405    Management > Maintenance (Standalone mode)
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Figure 406    Management > Maintenance (Stacking mode)

The following table describes the labels in this screen. 

Table 245   Management > Maintenance 
LABEL DESCRIPTION
Current This field displays which configuration (Configuration 1 or Configuration 2) is currently operating on 

the Switch.

Firmware 
Upgrade

Click Click Here to go to the Firmware Upgrade screen.

Restore 
Configuration

Click Click Here to go to the Restore Configuration screen.

Backup 
Configuration

Click Click Here to go to the Backup Configuration screen.

Auto 
Configuration

Click Click Here to go to the Auto Configuration screen.

Erase Running-
Configuration

Click Click Here to reset the current configuration of the Switch. Note that this will not reset the 
configuration to the factory default settings.

Save 
Configuration

Click Config 1 to save the current configuration settings to Configuration 1 on the Switch. 

Click Config 2 to save the current configuration settings to Configuration 2 on the Switch. 

Click Custom Default to save the current configuration settings to a custom default file on the 
Switch.

Reboot System Click Config 1 to reboot the system and load Configuration 1 on the Switch. 

Click Config 2 to reboot the system and load Configuration 2 on the Switch. 

Click Stacking Default to reboot the system and load stacking configurations on the Switch.

Click Factory Default to reboot the system and load the factory default configuration on the 
Switch.

Click Custom Default to reboot the system and load a saved Custom Default configuration file on 
the Switch. This will save the custom default configuration settings to both Configuration 1 and 
Configuration 2. If a Custom Default configuration file was not saved, clicking Custom Default 
loads the factory default configuration on the Switch.

Note: Make sure to click the Save button in any screen to save your settings to the 
current configuration on the Switch.
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55.2  Erase Running-Configuration   
Follow the steps below to clear current configuration on the Switch. Note that this will NOT reset the 
Switch back to its factory defaults. For example, if your Switch is set to stacking mode and you click 
erase running-configuration, after the Switch restarts, it will remain in stacking mode. If you want to 
change the Switch to its factory default mode, click the Factory Default button in Reboot System. See 
(Section 55.4.1 on page 499).

1 In the Maintenance screen, click the Click Here button next to Erase Running-Configuration to clear all 
Switch configuration information you configured on the Switch. 

2  Click OK to reset all Switch configurations.

Figure 407   Erase Running-Configuration: Confirmation

3 In the web configurator, click the Save button in the top of the screen to make the changes take effect. 
If you want to access the Switch web configurator again, you may need to change the IP address of 
your computer to be in the same subnet as that of the default Switch IP address (192.168.1.1 or DHCP-
assigned IP).

55.3  Save Configuration
Click Config 1 to save the current configuration settings permanently to configuration one on the 
Switch.

Click Config 2 to save the current configuration settings permanently to configuration two on the Switch.

Click Custom Default to save the current configuration settings permanently to a custom default file on 
the Switch. If configuration changes cause the Switch to behave abnormally, click Custom Default (next 
to Reboot System) to have the Switch automatically reboot and restore the saved Custom Default 
configuration file.

Alternatively, click Save on the top right-hand corner in any screen to save the configuration changes 
to the current configuration. 

Tech-Support Click Click Here to see the Tech-Support screen. You can set CPU and memory thresholds for log 
reports and download related log reports for issue analysis. Log reports include CPU history and 
utilization, crash and memory.

Certificates Click Click Here to go to the Certificates screen.

Table 245   Management > Maintenance (continued)
LABEL DESCRIPTION
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55.4  Reboot System
Reboot System allows you to restart the Switch without physically turning the power off. It also allows you 
to load configuration one (Config 1), configuration two (Config 2), stacking default, a Custom Default or 
Factory Default when you reboot. Follow the steps below to reboot the Switch.

1 In the Maintenance screen, click a configuration button to reboot and load that configuration file. The 
following screen displays.

Figure 408   Reboot System: Confirmation 

2 Click OK again and then wait for the Switch to restart. This takes up to two minutes. This does not affect 
the Switch’s configuration.

Click Config 1 and follow steps 1 to 2 to reboot and load configuration one on the Switch.

Click Config 2 and follow steps 1 to 2 to reboot and load configuration two on the Switch.

Click Factory Default and follow steps 1 to 2 to reboot and load default configuration settings on the 
Switch.

Click Custom Default and follow steps 1 to 2 to reboot and load Custom Default configuration settings on 
the Switch. This will save the custom default configuration settings to both Configuration 1 and 
Configuration 2. 

55.4.1  Load Stacking Default 
Follow the steps below to reset the Switch back to the stacking defaults. The master Switch login 
information will not be reset.

1 Click the Stacking Default button to clear all Switch configuration information you configured and return 
to the stacking defaults. 

2 Click OK to continue or Cancel to abort.

Figure 409   Load Stacking Default: Start 

3 If you want to access the Switch web configurator again, you may need to change the IP address of 
your computer to be in the same subnet as that of the default Switch IP address (192.168.1.1).
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55.4.2  Factory Default 
Follow the steps below to reset the Switch back to the factory defaults. 

1 Click the Factory Default button. 

2 Click OK to continue or Cancel to abort.

Figure 410   Load Factory Default: Start 

If you want to access the Switch web configurator again, you may need to change the IP address of 
your computer to be in the same subnet as that of the default Switch IP address (192.168.1.1 or DHCP-
assigned IP).

55.4.3  Custom Default 
Follow the steps below to reset the Switch back to the Custom Default configurations file you created. 
This will save the custom default configuration settings to both Configuration 1 and Configuration 2. 

1 Click the Custom Default button. 

2 Click OK to continue or Cancel to abort.

Note: If you did not save a Custom Default file in the web configurator or CLI using copy 
running-config custom-default, then the factory default file is restored after you 
press click Custom Default (next to Reboot System) on the Switch. You will then have to 
make all your configurations again on the Switch.

Figure 411   Load Custom Default: Start 

55.5  Firmware Upgrade
Make sure you have downloaded (and unzipped) the correct model firmware and version to your 
computer before uploading to the device. 

Be sure to upload the correct model firmware as uploading the wrong 
model firmware may damage your device. 
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The Switch supports dual firmware images, Firmware 1 and Firmware 2. Use this screen to specify which 
image is updated when firmware is uploaded using the web configurator and to specify which image is 
loaded when the Switch starts up.

Click Management > Maintenance > Firmware Upgrade to view the screen as shown next. 

Figure 412   Management > Maintenance > Firmware Upgrade (Standalone mode) 
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Figure 413    Management > Maintenance > Firmware Upgrade (Stacking mode) 

The top of firmware upgrade screen shows which firmware version is currently running on the Switch. 
Type the path and file name of the firmware file you wish to upload to the Switch in the File Path text box 
or click Browse to locate it. Firmware upgrades are only applied after a reboot. Click Upgrade to load 
the new firmware. Select the Config Boot Image drop-down list box if you want to reboot the Switch and 
click Apply to apply the new firmware immediately. Click Upgrade to load the new firmware. 

After the firmware upgrade process is complete, see the System Info screen to verify your current 
firmware version number. 

Table 246   Management > Maintenance> Firmware Upgrade 
LABEL DESCRIPTION
Slot (Stacking 
mode)

This is the slot index number.

Name This is the name of the Switch that you’re configuring.

Status (Stacking 
mode)

This field displays the current stacking status on the Switch. 

Version The Switch has two firmware sets, Firmware 1 and Firmware 2, residing in flash.

• Running shows the version number (and model code) and MM/DD/YYYY creation date of 
the firmware currently in use on the Switch (Firmware 1 or Firmware 2). The firmware 
information is also displayed at System Information in Basic Settings.

• Firmware 1 shows its version number (and model code) and MM/DD/YYYY creation date.
• Firmware 2 shows its version number (and model code) and MM/DD/YYYY creation date.
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55.6  Restore Configuration File
Restore a previously saved configuration from your computer to the Switch using the Restore 
Configuration screen.

Figure 414   Management > Maintenance > Restore Configuration 

Click the Choose File button to upload the path and file name of the configuration file you wish to 
restore in the File Path text box. After you have specified the file, click Restore. "config" is the name of the 
configuration file on the Switch, so your backup configuration file is automatically renamed when you 
restore using this screen.

55.7  Backup Configuration File
Backing up your Switch configurations allows you to create various “snapshots” of your device from 
which you may restore at a later date.

Back up your current Switch configuration to a computer using the Backup Configuration screen.

Current Boot 
Image

This displays which firmware is currently in use on the Switch (Firmware 1 or Firmware 2).

Config Boot 
Image

Select which firmware (Firmware 1 or Firmware 2) should load after rebooting. Click Apply and 
reboot the Switch to see changes including in the Current Boot Image field.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

(Stacking mode) Click the drop-down list to choose the slot number of the Switch in a stack to upgrade the 
firmware on this slot. Or select All to upgrade the firmware for all slots. 

Firmware Choose to upload the new firmware to (Firmware) 1 or (Firmware) 2.

Choose File Click this and locate the path and file name of the firmware file you wish to upload to the 
Switch. 

Upgrade Click Upgrade to load the new firmware. Firmware upgrades are only applied after a reboot. 
To reboot, go to Management > Maintenance > Reboot System. You may also click Config 1, 
Config 2, or Factory Default (Config 1, Config 2 and Factory Default are the configuration files 
you want the Switch to use when it restarts). 

Table 246   Management > Maintenance> Firmware Upgrade (continued)
LABEL DESCRIPTION
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Figure 415   Management > Maintenance > Backup Configuration 

Follow the steps below to back up the current Switch configuration to your computer in this screen. 

1 Select which Switch configuration file you want to download to your computer.

2 Click Backup.

3 If the current configuration file is open and/or downloaded to your computer automatically, you can 
click File > Save As to save the file to a specific place. 

If a dialog box pops up asking whether you want to open or save the file, click Save or Save File to 
download it to the default downloads folder on your computer. If a Save As screen displays after you 
click Save or Save File, Choose a location to save the file on your computer from the Save in drop-down 
list box and type a descriptive name for it in the File name list box. Click Save to save the configuration 
file to your computer.

55.8  Auto Configuration
The Switch can download a pre-saved auto configuration file automatically when you reboot the 
Switch using the DHCP or HTTPS mode. This will overwrite the running configuration stored in the Switch’s 
RAM instead of the startup configuration stored in the Switch’s flash memory.

Figure 416   Management > Maintenance > Auto Configuration
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The following table describes the labels in this screen. 

55.9  Tech-Support 
The Tech-Support feature is a log enhancement tool that logs useful information such as CPU utilization 
history, memory and Mbuf (Memory Buffer) log and crash reports for issue analysis by customer support 
should you have difficulty with your Switch. The Tech Support menu eases your effort in obtaining reports 
and it is also available in CLI command by typing “Show tech-support” command.

Click Menu > Management > Maintenance > Tech-Support to see the following screen.

Table 247   Management > Maintenance > Auto Configuration
LABEL DESCRIPTION
Mode This field shows which mode (DHCP or HTTPS) was used the last time the Switch rebooted 

and auto configuration was executed.

It shows None if auto configuration was not enabled.

State This field shows whether auto configuration was executed successfully the last time the 
Switch rebooted.

None - Auto configuration was disabled and not executed.

Success - An auto configuration file was downloaded successfully to the Switch.

Un-success - An auto configuration file was not downloaded to the Switch.

Filename This field displays the name of the auto configuration file that was downloaded the last 
time the Switch rebooted.

It shows None if auto configuration was not enabled or not executed successfully.

Active Select the checkbox to enable auto configuration.

Mode Select DHCP to have the Switch use the TFTP server IP address and auto configuration file 
name assigned by a DHCP server to download a pre-saved configuration file when the 
Switch reboots.

Note: The Switch should act as a DHCP client to send a DHCP request with DHCP 
option 60 so that it can get the TFTP server address and configuration file 
name from the DHCP server. See Section 6.4 on page 61 for more 
information about how to use auto configuration.

Select HTTPS to have the Switch use the URL you specified in the HTTPS URL field to access a 
web server and download the auto configuration file using HTTPS.

DHCP VLAN ID Enter the VLAN ID of the DHCP server that assigns the TFTP server IP address and auto 
configuration file name to the Switch.

HTTPS URL Type the URL that can be used to access and download the auto configuration file from a 
web server using HTTPS. For example, https://webserverIPaddress/configfilename.cfg.

Note: You must fill in this field if you select HTTPS in the Mode field. Otherwise, auto 
configuration won’t work.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 417   Management > Maintenance > Tech-Support

You may need WordPad or similar software to see the log report correctly. The table below describes 
the fields in the above screen. 

Table 248   Management > Maintenance > Tech-Support 
LABEL DESCRIPTION
CPU Type a number ranging from 50 to 100 in the CPU threshold box, and type another number 

ranging from 5 to 60 in the seconds box then click Apply. 

For example, 80 for CPU threshold and 5 for seconds means a log will be created when CPU 
utilization reaches over 80% and lasts for 5 seconds. 

The log report holds 7 days of CPU log data and is stored in volatile memory (RAM). The data 
is lost if the Switch is turned off or in event of power outage. After 7 days, the logs wrap 
around and new ones replace the earliest ones.

The higher the CPU threshold number, the fewer logs will be created, and the less data 
technical support will have to analyze and vice versa. 

Mbuf Type a number ranging from 50 to 100 in the Mbuf (Memory Buffer) threshold box. The Mbuf 
log report is stored in flash (permanent) memory.

For example, Mbuf 50 means a log will be created when the Mbuf utilization is over 50%.

The higher the Mbuf threshold number, the fewer logs will be created, and the less data 
technical support will have to analyze and vice versa. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

All Click Download to see all the log report and system status. This log report is stored in flash 
memory. If the All log report is too large, you can download the log reports separately 
below.

Crash Click Download to see the crash log report. The log will include information of the last crash 
and is stored in flash memory.

CPU history Click Download to see the CPU history log report. The 7-days log is stored in RAM and you will 
need to save it, otherwise it will be lost in event of Switch shutdown or power outage.

Memory Section Click Download to see the memory section log report. This log report is stored in flash 
memory.
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55.10  Certificates
The Switch can use HTTPS certificates that are verified by a third party to create secure HTTPS 
connections between your computer and the Switch. This way, you may securely access the Switch 
using the web configurator. See Section 56.8 on page 527 for more information about HTTPS.

Certificates are based on public-private key pairs. A certificate contains the certificate owner’s identity 
and public key. Certificates provide a way to exchange public keys for use in authentication.

Click Management > Maintenance > Certificates to open the following screen. Use this screen to import 
the VMG's CA-signed certificates.

Figure 418   Management > Maintenance > Certificates

The following table describes the labels in this screen. 

Mbuf Click Download to see the Mbuf log report. The log includes Mbuf over threshold 
information. This log report is stored in flash memory.

ROM Click Download to see the Read Only Memory (ROM) log report. This report is stored in flash 
memory.

L3 Click Download to see the layer-3 Switch log report. The log only applies to the layer-3 
Switch models. This report is stored in flash memory.

Table 248   Management > Maintenance > Tech-Support (continued)
LABEL DESCRIPTION

Table 249   Management > Maintenance > Certificates
LABEL DESCRIPTION
File Path Click Choose File to find the certificate file you want to upload.

Password This field only applies when you import a binary PKCS#12 format file. Type the file’s 
password that was created when the PKCS #12 file was exported. The private key should 
not exceed 32 ASCII characters (not including spaces).

Import Click this button to save the certificate that you have enrolled from a certification authority 
from your computer to the Switch.

Service This field displays the service type that this certificate is for.
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55.10.1  HTTPS Certificates
Use this screen to view the HTTPS certificate details. Click a hyperlink in the Service column in the 
Management > Maintenance > Certificates screen to open the following screen. 

Subject This field displays identifying information about the certificate’s owner, such as CN 
(Common Name), OU (Organizational Unit or department), O (Organization or company) 
and C (Country). It is recommended that each certificate have unique subject 
information.

Issuer This field displays identifying information about the certificate’s issuing certification 
authority, such as a common name, organizational unit or department, organization or 
company and country.

Valid From This field displays the date that the certificate becomes applicable. 

Valid To This field displays the date that the certificate expires.

Select an entry’s check box to select a specific entry.

Delete Click this button to delete the certificate (or certification request). You cannot delete a 
certificate that one or more features is configured to use.

Table 249   Management > Maintenance > Certificates
LABEL DESCRIPTION
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Figure 419   Management > Maintenance > Certificates > HTTPS

55.11  FTP Command Line
This section shows some examples of uploading to or downloading files from the Switch using FTP 
commands. First, understand the filename conventions.

55.11.1  Filename Conventions 
The configuration file (also known as the romfile or ROM) contains the factory default settings in the 
screens such as password, Switch setup, IP Setup, and so on. Once you have customized the Switch’s 
settings, they can be saved back to your computer under a filename of your choosing.
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ZyNOS (Zyxel Network Operating System, sometimes referred to as the “ras” file) is the system firmware 
and has a “bin” filename extension. 

You can store up to two images, or firmware files of the same device model, on the Switch. Only one 
image is used at a time.

• Run the boot image <1|2> command to specify which image is updated when firmware is loaded 
using the web configurator and to specify which image is loaded when the Switch starts up.

• You can also use FTP commands to upload firmware to any image.

The Switch supports dual firmware images, ras-0 and ras-1. You can switch from one to the other by 
using the boot image <index> command, where <index> is 1 (ras-0) or 2 (ras-1). See the CLI 
Reference Guide for more information about using commands. The system does not reboot after it 
switches from one image to the other.

55.11.1.1  Example FTP Commands
ftp> put firmware.bin ras-0

This is a sample FTP session showing the transfer of the computer file "firmware.bin" to the Switch.

ftp> get config config.cfg

This is a sample FTP session saving the current configuration to a file called “config.cfg” on your 
computer.

If your (T)FTP client does not allow you to have a destination filename different than the source, you will 
need to rename them as the Switch only recognizes “config”, “ras-0”, and “ras-1”. Be sure you keep 
unaltered copies of both files for later use.

Be sure to upload the correct model firmware as uploading the wrong 
model firmware may damage your device.

55.11.2  FTP Command Line Procedure  

1 Launch the FTP client on your computer.

2 Enter open, followed by a space and the IP address of your Switch. 

3 Press [ENTER] when prompted for a username (the default is “admin”).

4 Enter your password as requested (the default is “1234”).

Table 250   Filename Conventions 

FILE TYPE INTERNAL 
NAME

EXTERNAL 
NAME DESCRIPTION

Configuration File config .cfg This is the configuration (config) filename on the Switch. 
Uploading the config file replaces the specified 
configuration file system, including your Switch 
configurations, system-related data (including the default 
password), the error log and the trace log.

Firmware ras-0

ras-1

*.bin This is the generic name for the ZyNOS firmware on the 
Switch. ras-0 is image 1; ras-1 is image 2.
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5 Enter bin to set transfer mode to binary.

6 Use put to transfer files from the computer to the Switch, for example, put firmware.bin ras-0 
transfers the firmware on your computer (firmware.bin) to the Switch and renames it to “ras-0”. Similarly, 
put config.cfg config transfers the configuration file on your computer (config.cfg) to the Switch 
and renames it to “config”. Likewise get config config.cfg transfers the configuration file on the 
Switch to your computer and renames it to “config.cfg”. See Table 250 on page 510 for more 
information on filename conventions.

7 Enter quit to exit the ftp prompt.

55.11.3  GUI-based FTP Clients
The following table describes some of the commands that you may see in GUI-based FTP clients.

55.11.4  FTP Restrictions 
FTP will not work when:

• FTP service is disabled in the Service Access Control screen.

• The IP address(es) in the Remote Management screen does not match the client IP address. If it does 
not match, the Switch will disconnect the FTP session immediately. 

Table 251   General Commands for GUI-based FTP Clients 
COMMAND DESCRIPTION
Host Address Enter the address of the host server.

Login Type Anonymous. 

This is when a user I.D. and password is automatically supplied to the server for 
anonymous access. Anonymous logins will work only if your ISP or service administrator 
has enabled this option.

Normal.  

The server requires a unique User ID and Password to login.

Transfer Type Transfer files in either ASCII (plain text format) or in binary mode. Configuration and 
firmware files should be transferred in binary mode.

Initial Remote Directory Specify the default remote directory (path).

Initial Local Directory Specify the default local directory (path).
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CHAPTER 56
Access Control

This chapter describes how to control access to the Switch.

56.1  Access Control Overview    
A console port and FTP are allowed one session each, Telnet and SSH share nine sessions, up to five Web 
sessions (five different usernames and passwords) and/or limitless SNMP access control sessions are 
allowed. 

A console port access control session and Telnet access control session cannot coexist when multi-login 
is disabled. See the Ethernet Switch CLI Reference Guide for more information on disabling multi-login.

56.1.1  What You Can Do
• Use the Access Control screen (Section 56.2 on page 512) to display the main screen.

• Use the SNMP screen (Section 56.3.4 on page 518) to configure your SNMP settings.

• Use the Trap Group screen (Section 56.3.5 on page 520) to specify the types of SNMP traps that should 
be sent to each SNMP manager.

• Use the User Information screen (Section 56.3.7 on page 522) to create SNMP users for authentication 
with managers using SNMP v3 and associate them to SNMP groups.

• Use the Logins screens (Section 56.4 on page 524) to assign which users can access the Switch via 
web configurator at any one time.

• Use the Service Access Control screen (Section 56.10 on page 532) to decide what services you may 
use to access the Switch.

• Use the Remote Management screen (Section 56.11 on page 533) to specify a group of one or more 
“trusted computers” from which an administrator may use a service to manage the Switch.

56.2  The Access Control Main Screen
Use this screen to display the main screen. Click Management > Access Control in the navigation panel 
to display the main screen as shown. 

Table 252   Access Control Overview 
Console Port SSH Telnet FTP Web SNMP

One session Share up to nine 
sessions

One session Up to five accounts No limit
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Figure 420   Management > Access Control 

The following table describes the labels in this screen. 

56.3  About SNMP  
Simple Network Management Protocol (SNMP) is an application layer protocol used to manage and 
monitor TCP/IP-based devices. SNMP is used to exchange management information between the 
network management system (NMS) and a network element (NE). A manager station can manage and 
monitor the Switch through the network via SNMP version 1 (SNMPv1), SNMP version 2c or SNMP version 
3. The next figure illustrates an SNMP management operation. SNMP is only available if TCP/IP is 
configured.

Figure 421   SNMP Management Model  

An SNMP managed network consists of two main components: agents and a manager. 

An agent is a management software module that resides in a managed Switch (the Switch). An agent 
translates the local management information from the managed Switch into a form compatible with 
SNMP. The manager is the console through which network administrators perform network management 
functions. It executes applications that control and monitor managed devices. 

Table 253   Management > Access Control 
LABEL DESCRIPTION
SNMP Click this link to configure your SNMP settings.

Logins Click this link to assign which users can access the Switch via web configurator at any one 
time.

Service Access 
Control

Click this link to decide what services you may use to access the Switch.

Remote 
Management

Click this link to specify a group of one or more “trusted computers” from which an 
administrator may use a service to manage the Switch.
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The managed devices contain object variables/managed objects that define each piece of 
information to be collected about a Switch. Examples of variables include number of packets received, 
node port status and so on. A Management Information Base (MIB) is a collection of managed objects. 
SNMP allows a manager and agents to communicate for the purpose of accessing these objects.

SNMP itself is a simple request/response protocol based on the manager/agent model. The manager 
issues a request and the agent returns responses using the following protocol operations: 

56.3.1  SNMP v3 and Security
SNMP v3 enhances security for SNMP management. SNMP managers can be required to authenticate 
with agents before conducting SNMP management sessions.

Security can be further enhanced by encrypting the SNMP messages sent from the managers. 
Encryption protects the contents of the SNMP messages. When the contents of the SNMP messages are 
encrypted, only the intended recipients can read them. 

56.3.2  Supported MIBs  
MIBs let administrators collect statistics and monitor status and performance.

The Switch supports the following MIBs:

• SNMP MIB II (RFC 1213)

• RFC 1157 SNMP v1

• RFC 1493 Bridge MIBs

• RFC 1643 Ethernet MIBs

• RFC 1155 SMI

• RFC 2674 SNMPv2, SNMPv2c

• RFC 1757 RMON

• SNMPv2, SNMPv2c or later version, compliant with RFC 2011 SNMPv2 MIB for IP, RFC 2012 SNMPv2 MIB 
for TCP, RFC 2013 SNMPv2 MIB for UDP

56.3.3  SNMP Traps 

The Switch sends traps to an SNMP manager when an event occurs. The following tables outline the 
SNMP traps by category.

Table 254   SNMP Commands
COMMAND DESCRIPTION
Get Allows the manager to retrieve an object variable from the agent.

GetNext Allows the manager to retrieve the next object variable from a table or list within an agent. In 
SNMPv1, when a manager wants to retrieve all elements of a table from an agent, it initiates a 
Get operation, followed by a series of GetNext operations. 

Set  Allows the manager to set values for object variables within an agent. 

Trap  Used by the agent to inform the manager of some events.
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An OID (Object ID) that begins with “1.3.6.1.4.1.890.1.15” is defined in private MIBs. Otherwise, it is a 
standard MIB OID. 

Table 255   SNMP System Traps 

OPTION OBJECT LABEL OBJECT ID DESCRIPTION
coldstart coldStart 1.3.6.1.6.3.1.1.5.1 This trap is sent when the Switch is turned 

on.

warmstart warmStart 1.3.6.1.6.3.1.1.5.2 This trap is sent when the Switch restarts.

fanspeed zyHwMonitorFanSpeedOutOfR
ange

1.3.6.1.4.1.890.1.15.3.26.2.1 This trap is sent when the fan speed goes 
above or below the normal operating 
range.

temperature zyHwMonitorTemperatureOutO
fRange

1.3.6.1.4.1.890.1.15.3.26.2.2 This trap is sent when the temperature goes 
above or below the normal operating 
range.

voltage zyHwMonitorPowerSupplyVolta
geOutOfRange

1.3.6.1.4.1.890.1.15.3.26.2.3 This trap is sent when the voltage goes 
above or below the normal operating 
range.

reset zySysMgmtUncontrolledSystem
Reset

1.3.6.1.4.1.890.1.15.3.49.2.1 This trap is sent when the Switch 
automatically resets.

zySysMgmtControlledSystemRe
set

1.3.6.1.4.1.890.1.15.3.49.2.2 This trap is sent when the Switch resets by 
an administrator through a management 
interface.

zySysMgmtBootImageInconsist
ence

1.3.6.1.4.1.890.1.15.3.49.2.3 This trap is sent when the index number of 
image which is loaded when the Switch 
starts up is different from what is specified 
via the CLI.

RebootEvent 1.3.6.1.4.1.890.1.5.1.1.2 This trap is sent when the Switch reboots by 
an administrator through a management 
interface.

timesync zyDateTimeTrapTimeServerNot
Reachable

1.3.6.1.4.1.890.1.15.3.82.3.1 This trap is sent when the Switch’s date and 
time is not manually entered or the 
specified time server is not reachable.

intrusionlock zyPortIntrusionLock 1.3.6.1.4.1.890.1.15.3.61.3.2 This trap is sent when intrusion lock occurs 
on a port.

loopguard zyLoopGuardLoopDetect 1.3.6.1.4.1.890.1.15.3.45.2.1 This trap is sent when loopguard shuts down 
a port.

errdisable zyErrdisableDetect 1.3.6.1.4.1.890.1.15.3.24.4.1 This trap is sent when an error is detected 
on a port, such as a loop occurs or the rate 
limit for specific control packets is 
exceeded.

zyErrdisableRecovery 1.3.6.1.4.1.890.1.15.3.24.4.2 This trap is sent when the Switch ceases the 
action taken on a port, such as shutting 
down the port or discarding packets on the 
port, after the specified recovery interval.

loginrecord zyAccessControlLoginRecord 1.3.6.1.4.1.890.1.15.3.9.4.1 This trap is sent when users log in.

zyAccessControlLogoutRecord 1.3.6.1.4.1.890.1.15.3.9.4.2 This trap is sent when users log out.

zyAccessControlLoginFail 1.3.6.1.4.1.890.1.15.3.9.4.3 This trap is sent when users fail in login.
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Table 256   SNMP Stacking Traps
OPTION OBJECT LABEL OBJECT ID DESCRIPTION

Channel zyStackingChannelUp 1.3.6.1.4.1.890.1.15.3.97.4.1 stacking channel up

zyStackingChannelDown 1.3.6.1.4.1.890.1.15.3.97.4.2 stacking channel down

Slot zyStackingSlotAttach 1.3.6.1.4.1.890.1.15.3.97.4.3 stacking slot attached success

zyStackingSlotDetach 1.3.6.1.4.1.890.1.15.3.97.4.4 stacking slot detached

Master zyStackingNewMaster 1.3.6.1.4.1.890.1.15.3.97.4.5 backup takeover as master

Upgrade 
Firmware

zyStackingUpgradeFirmwareFail 1.3.6.1.4.1.890.1.15.3.97.4.6 Upgrade Firmware fail with correspond slot ID.

Backup zyStackingNewBackup 1.3.6.1.4.1.890.1.15.3.97.4.7 New Backup with correspond slot ID.

zyStackingBackupTakeover 1.3.6.1.4.1.890.1.15.3.97.4.8 Replaced master with correspond slot ID.

Master zyStackingNewMasterFromTakeo
ver

1.3.6.1.4.1.890.1.15.3.97.4.9 New master from taking over with correspond slot 
ID.

Fail zyStackingSyncConfFail 1.3.6.1.4.1.890.1.15.3.97.4.10 Sync. configuration fail with correspond slot ID.

zyStackingSysRestoreConfFail 1.3.6.1.4.1.890.1.15.3.97.4.11 Stacking backup takeover restore configuration 
fail.

zyStackingSlotInitFail 1.3.6.1.4.1.890.1.15.3.97.4.12 Stacking Slot init fail.

Change zyStackingSlotChangeIndex 1.3.6.1.4.1.890.1.15.3.97.4.13 Stacking change slot index.

zyStackingPriorityChange 1.3.6.1.4.1.890.1.15.3.97.4.14 Staking priority change.

zyStackingTopologyChange 1.3.6.1.4.1.890.1.15.3.97.4.15 Staking topology change.

Table 257   SNMP Interface Traps 

OPTION OBJECT LABEL OBJECT ID DESCRIPTION
linkup linkUp 1.3.6.1.6.3.1.1.5.4 This trap is sent when the Ethernet link 

is up.

linkdown linkDown 1.3.6.1.6.3.1.1.5.3 This trap is sent when the Ethernet link 
is down.

autonegotiation zyPortAutonegotiationFailed 1.3.6.1.4.1.890.1.15.3.61.3.1 This trap is sent when an Ethernet 
interface fails to auto-negotiate with 
the peer Ethernet interface.

lldp lldpRemTablesChange 1.0.8802.1.1.2.0.0.1 The trap is sent when entries in the 
remote database have any updates.

Link Layer Discovery Protocol (LLDP), 
defined as IEEE 802.1ab, enables LAN 
devices that support LLDP to 
exchange their configured settings. 
This helps eliminate configuration 
mismatch issues.
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transceiver-ddm zyTransceiverDdmiTemperatureO
utOfRange

1.3.6.1.4.1.890.1.15.3.84.3.1 This trap is sent when the transceiver 
temperature is above or below the 
normal operating range.

zyTransceiverDdmiTxPowerOutOfR
ange

1.3.6.1.4.1.890.1.15.3.84.3.2 This trap is sent when the transmitted 
optical power is above or below the 
normal operating range.

zyTransceiverDdmiRxPowerOutOf
Range

1.3.6.1.4.1.890.1.15.3.84.3.3 This trap is sent when the received 
optical power is above or below the 
normal operating range.

zyTransceiverDdmiVoltageOutOfR
ange

1.3.6.1.4.1.890.1.15.3.84.3.4 This trap is sent when the transceiver 
supply voltage is above or below the 
normal operating range.

zyTransceiverDdmiTxBiasOutOfRa
nge

1.3.6.1.4.1.890.1.15.3.84.3.5 This trap is sent when the transmitter 
laser bias current is above or below 
the normal operating range.

storm-control zyPortStormControlTrap 1.3.6.1.4.1.890.1.15.3.78.2.1 This trap is sent when storm control is 
detected on a specific port. A packet 
filter action has been applied on the 
interface.

zuld zyZuldUnidirectionalDetected 1.3.6.1.4.1.890.1.15.3.110.3.1 This trap is sent when a unidirectional 
link is detected.

zyZuldBidirectionalRecovered 1.3.6.1.4.1.890.1.15.3.110.3.2 This trap is sent when the port which is 
shut down by ZULD becomes active 
again.

Table 257   SNMP Interface Traps (continued)

OPTION OBJECT LABEL OBJECT ID DESCRIPTION

Table 258   AAA Traps 

OPTION OBJECT LABEL OBJECT ID DESCRIPTION
authentication authenticationFailure 1.3.6.1.6.3.1.1.5.5 This trap is sent when authentication 

fails due to incorrect user name and/or 
password.

zyAaaAuthenticationFailure 1.3.6.1.4.1.890.1.15.3.8.3.1 This trap is sent when authentication 
fails due to incorrect user name and/or 
password.

zyRadiusServerAuthenticationSer
verNotReachable

1.3.6.1.4.1.890.1.15.3.71.2.1 This trap is sent when there is no 
response message from the RADIUS 
authentication server.

zyTacacsServerAuthenticationSer
verUnreachable

1.3.6.1.4.1.890.1.15.3.83.2.1 This trap is sent when there is no 
response message from the TACACS+  
authentication server.

authorization zyAaaAuthorizationFailure 1.3.6.1.4.1.890.1.15.3.8.3.2 This trap is sent when management 
connection authorization failed.

accounting zyRadiusServerAccountingServer
NotReachable 

1.3.6.1.4.1.890.1.15.3.71.2.2 This trap is sent when there is no 
response message from the RADIUS 
accounting server.

zyTacacsServerAccountingServer
Unreachable

1.3.6.1.4.1.890.1.15.3.83.2.2 This trap is sent when there is no 
response message from the TACACS+ 
accounting server.
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56.3.4  Configuring SNMP    
From the Access Control screen, display the SNMP screen. You can click Access Control to go back to 
the Access Control screen. 

Table 259   SNMP IP Traps 

OPTION OBJECT LABEL OBJECT ID DESCRIPTION
ping pingProbeFailed 1.3.6.1.2.1.80.0.1 This trap is sent when a single ping probe fails.

pingTestFailed 1.3.6.1.2.1.80.0.2 This trap is sent when a ping test (consisting of a 
series of ping probes) fails.

pingTestCompleted 1.3.6.1.2.1.80.0.3 This trap is sent when a ping test is completed.

traceroute traceRouteTestFailed 1.3.6.1.2.1.81.0.2 This trap is sent when a traceroute test fails.

traceRouteTestCompleted 1.3.6.1.2.1.81.0.3 This trap is sent when a traceroute test is 
completed.

Table 260   SNMP Switch Traps 

OPTION OBJECT LABEL OBJECT ID DESCRIPTION
stp STPNewRoot 1.3.6.1.2.1.17.0.1 This trap is sent when the STP root switch 

changes.

zyMrstpNewRoot 1.3.6.1.4.1.890.1.15.3.52.3.1 This trap is sent when the MRSTP root switch 
changes.

zyMstpNewRoot 1.3.6.1.4.1.890.1.15.3.53.3.1 This trap is sent when the MSTP root switch 
changes.

STPTopologyChange 1.3.6.1.2.1.17.0.2 This trap is sent when the STP topology 
changes.

zyMrstpTopologyChange 1.3.6.1.4.1.890.1.15.3.52.3.2 This trap is sent when the MRSTP topology 
changes.

zyMstpTopologyChange 1.3.6.1.4.1.890.1.15.3.53.3.2 This trap is sent when the MSTP root switch 
changes.

mactable zyMacForwardingTableFull 1.3.6.1.4.1.890.1.15.3.48.2.1 This trap is sent when more than 99% of the 
MAC table is used.

rmon RmonRisingAlarm 1.3.6.1.2.1.16.0.1 This trap is sent when a variable goes over 
the RMON "rising" threshold.

RmonFallingAlarm 1.3.6.1.2.1.16.0.2 This trap is sent when the variable falls below 
the RMON "falling" threshold.

classifier zyAclV2ClassifierLogNotification 1.3.6.1.4.1.890.1.15.3.105.4.1 This trap is sent when the Switch detects 
classifier log information.

rip zyRipExceedMaxDynamicRoute 1.3.6.1.4.1.890.1.15.3.74.2.1 This trap is sent when the maximum allowed 
number of dynamic routes learned through 
RIP has been exceeded.

ospf zyOspfExceedMaxDynamicRoute
Path

1.3.6.1.4.1.890.1.15.3.57.3.1 This trap is sent when the maximum allowed 
number of dynamic routes learned through 
OSPF has been exceeded.



Chapter 56 Access Control

XGS4600 Series User’s Guide

519

Figure 422   Management > Access Control > SNMP 

The following table describes the labels in this screen. 

Table 261   Management > Access Control > SNMP 
LABEL DESCRIPTION
General Setting Use this section to specify the SNMP version and community (password) values.

Version Select the SNMP version for the Switch. The SNMP version on the Switch must match the version 
on the SNMP manager. Choose SNMP version 2c (v2c), SNMP version 3 (v3) or both (v3v2c). 

Note: SNMP version 2c is backwards compatible with SNMP version 1.
Get Community Enter the Get Community string, which is the password for the incoming Get- and GetNext- 

requests from the management station.

The Get Community string is only used by SNMP managers using SNMP version 2c or lower.

Set Community Enter the Set Community string, which is the password for the incoming Set- requests from the 
management station. 

The Set Community string is only used by SNMP managers using SNMP version 2c or lower.

Trap Community Enter the Trap Community string, which is the password sent with each trap to the SNMP 
manager.

The Trap Community string is only used by SNMP managers using SNMP version 2c or lower.

Trap Destination Use this section to configure where to send SNMP traps from the Switch.

Version Specify the version of the SNMP trap messages. 

IP Enter the IP addresses of up to four managers to send your SNMP traps to.

Port Enter the port number upon which the manager listens for SNMP traps.

Username Enter the username to be sent to the SNMP manager along with the SNMP v3 trap.

Note: This username must match an existing account on the Switch (configured in 
the Management > Access Control > SNMP > User screen). 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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56.3.5  Configuring SNMP Trap Group   
From the SNMP screen, click Trap Group to view the screen as shown. Use the Trap Group screen to 
specify the types of SNMP traps that should be sent to each SNMP manager.

Figure 423   Management > Access Control > SNMP > Trap Group 

The following table describes the labels in this screen. 

56.3.6  Enabling/Disabling Sending of SNMP Traps on a Port  
From the SNMP > Trap Group screen, click Port to view the screen as shown. Use this screen to set 
whether a trap received on the port(s) would be sent to the SNMP manager.

Table 262   Management > Access Control > SNMP > Trap Group 
LABEL DESCRIPTION
Trap Destination IP Select one of your configured trap destination IP addresses. These are the IP addresses of the 

SNMP managers. You must first configure a trap destination IP address in the SNMP Setting 
screen. 

Use the rest of the screen to select which traps the Switch sends to that SNMP manager. 

Type Select the categories of SNMP traps that the Switch is to send to the SNMP manager. 

Options Select the individual SNMP traps that the Switch is to send to the SNMP station. See Section 
56.3.3 on page 514 for individual trap descriptions.

The traps are grouped by category. Selecting a category automatically selects all of the 
category’s traps. Clear the check boxes for individual traps that you do not want the Switch 
to send to the SNMP station. Clearing a category’s check box automatically clears all of the 
category’s trap check boxes (the Switch only sends traps from selected categories).

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 424   Management > Access Control > SNMP > Trap Group > Port (Standalone mode) 

Figure 425   Management > Access Control > SNMP > Trap Group > Port (Stacking mode) 
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The following table describes the labels in this screen. 

56.3.7  Configuring SNMP User   
From the SNMP screen, click User to view the screen as shown. Use the User screen to create SNMP users 
for authentication with managers using SNMP v3 and associate them to SNMP groups. An SNMP user is 
an SNMP manager.

Figure 426   Management > Access Control > SNMP > User 

Table 263   Management > Access Control > SNMP > Trap Group > Port 
LABEL DESCRIPTION
Option Select the trap type you want to configure here.

Slot Select the slot number that represents the Switch in a stack.

Port This field displays a port number. In stacking mode, the first number represents the slot and the 
second the port number.

* (Standalone 
mode)

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set 
the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
1/* (Stacking 
mode)

Settings in this row apply to all ports for the Switch represented by the slot ID (in stacking 
mode).

Use this row only if you want to make some of the settings the same for all ports. Use this row first 
to set the common settings and then make adjustments on a port-by-port basis. 

Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to enable the sending of SNMP traps on this port. The Switch sends the 

related traps received on this port to the SNMP manager. 

Clear this check box to disable the sending of SNMP traps on this port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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The following table describes the labels in this screen. 

Table 264   Management > Access Control > SNMP > User 
LABEL DESCRIPTION
User Information Note: Use the username and password of the login accounts you specify in this 

screen to create accounts on the SNMP v3 manager.

Username Specify the username of a login account on the Switch.

Security Level Select whether you want to implement authentication and/or encryption for SNMP 
communication from this user. Choose:

• noauth -to use the username as the password string to send to the SNMP manager. This is 
equivalent to the Get, Set and Trap Community in SNMP v2c. This is the lowest security 
level.

• auth - to implement an authentication algorithm for SNMP messages sent by this user.
• priv - to implement authentication and encryption for SNMP messages sent by this user. 

This is the highest security level.

Note: The settings on the SNMP manager must be set at the same security level or 
higher than the security level settings on the Switch. 

Authentication Select an authentication algorithm. MD5 (Message Digest 5) and SHA (Secure Hash 
Algorithm) are hash algorithms used to authenticate SNMP data. SHA authentication is 
generally considered stronger than MD5, but is slower. 

Password Enter the password of up to 32 ASCII characters for SNMP user authentication. 

Privacy Specify the encryption method for SNMP communication from this user. You can choose one 
of the following:

• DES - Data Encryption Standard is a widely used (but breakable) method of data 
encryption. It applies a 56-bit key to each 64-bit block of data.

• AES - Advanced Encryption Standard is another method for data encryption that also 
uses a secret key. AES applies a 128-bit key to 128-bit blocks of data.

Password Enter the password of up to 32 ASCII characters for encrypting SNMP packets. 

Group SNMP v3 adopts the concept of View-based Access Control Model (VACM) group. SNMP 
managers in one group are assigned common access rights to MIBs. Specify in which SNMP 
group this user is. 

admin - Members of this group can perform all types of system configuration, including the 
management of administrator accounts.

readwrite - Members of this group have read and write rights, meaning that the user can 
create and edit the MIBs on the Switch, except the user account and AAA configuration.

readonly - Members of this group have read rights only, meaning the user can collect 
information from the Switch.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is 
turned off or loses power, so use the Save link on the top navigation panel to save your 
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to reset the fields to the factory defaults.

Index This is a read-only number identifying a login account on the Switch. Click on an index 
number to view more details and edit an existing account.

Username This field displays the username of a login account on the Switch.

Security Level This field displays whether you want to implement authentication and/or encryption for SNMP 
communication with this user. 

Authentication This field displays the authentication algorithm used for SNMP communication with this user. 

Privacy This field displays the encryption method used for SNMP communication with this user. 
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56.4  Setting Up Login Accounts  
Up to five people (one administrator and four non-administrators) may access the Switch via web 
configurator at any one time. 

• An administrator is someone who can both view and configure Switch changes. The username for the 
Administrator is always admin. The default administrator password is 1234.

Note: It is highly recommended that you change the default administrator password (1234).

• A non-administrator (username is something other than admin) is someone who can view but not 
configure Switch settings. 

Click Management > Access Control > Logins to view the screen as shown. 

Figure 427   Management > Access Control > Logins 

Group This field displays the SNMP group to which this user belongs.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to begin configuring this screen afresh.

Table 264   Management > Access Control > SNMP > User (continued)
LABEL DESCRIPTION
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The following table describes the labels in this screen. 

56.5  SSH Overview
Unlike Telnet or FTP, which transmit data in clear text, SSH (Secure Shell) is a secure communication 
protocol that combines authentication and data encryption to provide secure encrypted 
communication between two hosts over an unsecured network.

Figure 428   SSH Communication Example

Table 265   Management > Access Control > Logins 
LABEL DESCRIPTION
Administrator

This is the default administrator account with the “admin” user name. You cannot change the default administrator 
user name. Only the administrator has read/write access.

Old Password Type the existing system password (1234 is the default password when shipped).

New Password Enter your new system password. 

Retype to confirm Retype your new system password for confirmation

Edit Logins

You may configure passwords for up to four users. These users have read-only access. You can give users higher 
privileges via the CLI. For more information on assigning privileges see the Ethernet Switch CLI Reference Guide.

User Name Set a user name (up to 32 ASCII characters long). 

Password Enter your new system password. 

Retype to confirm Retype your new system password for confirmation

Privilege Type the privilege level for this user. At the time of writing, users may have a privilege level 
of 0, 3, 13, or 14 representing different configuration rights as shown below.

• 0 - Display basic system information.
• 3 - Display configuration or status.
• 13 - Configure features except for login accounts, SNMP user accounts, the 

authentication method sequence and authorization settings, multiple logins, 
administrator and enable passwords, and configuration information display.

• 14 - Configure login accounts, SNMP user accounts, the authentication method 
sequence and authorization settings, multiple logins, and administrator and enable 
passwords, and display configuration information.

Users can run command lines if the session’s privilege level is greater than or equal to the 
command’s privilege level. The session privilege initially comes from the privilege of the 
login account. For example, if the user has a privilege of 5, he/she can run commands that 
requires privilege level of 5 or less but not more.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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56.6  How SSH works
The following table summarizes how a secure connection is established between two remote hosts. 

Figure 429   How SSH Works

1 Host Identification

The SSH client sends a connection request to the SSH server. The server identifies itself with a host key. The 
client encrypts a randomly generated session key with the host key and server key and sends the result 
back to the server. 

The client automatically saves any new server public keys. In subsequent connections, the server public 
key is checked against the saved version on the client computer.

2 Encryption Method

Once the identification is verified, both the client and server must agree on the type of encryption 
method to use.

3 Authentication and Data Transmission

After the identification is verified and data encryption activated, a secure tunnel is established between 
the client and the server. The client then sends its authentication information (user name and password) 
to the server to log in to the server.
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56.7  SSH Implementation on the Switch
Your Switch supports SSH version 2 using RSA authentication and three encryption methods (DES, 3DES 
and Blowfish). The SSH server is implemented on the Switch for remote management and file transfer on 
port 22. Only one SSH connection is allowed at a time.

56.7.1  Requirements for Using SSH
You must install an SSH client program on a client computer (Windows or Linux operating system) that is 
used to connect to the Switch over SSH.

56.8  Introduction to HTTPS
HTTPS (HyperText Transfer Protocol over Secure Socket Layer, or HTTP over SSL) is a web protocol that 
encrypts and decrypts web pages. Secure Socket Layer (SSL) is an application-level protocol that 
enables secure transactions of data by ensuring confidentiality (an unauthorized party cannot read the 
transferred data), authentication (one party can identify the other party) and data integrity (you know if 
data has been changed). 

It relies upon certificates, public keys, and private keys.

HTTPS on the Switch is used so that you may securely access the Switch using the web configurator. The 
SSL protocol specifies that the SSL server (the Switch) must always authenticate itself to the SSL client (the 
computer which requests the HTTPS connection with the Switch), whereas the SSL client only should 
authenticate itself when the SSL server requires it to do so. Authenticating client certificates is optional 
and if selected means the SSL-client must send the Switch a certificate. You must apply for a certificate 
for the browser from a Certificate Authority (CA) that is a trusted CA on the Switch.

Please refer to the following figure. 

1 HTTPS connection requests from an SSL-aware web browser go to port 443 (by default) on the Switch’s 
WS (web server).

2 HTTP connection requests from a web browser go to port 80 (by default) on the Switch’s WS (web 
server). 

Figure 430   HTTPS Implementation
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Note: If you disable HTTP in the Service Access Control screen, then the Switch blocks all HTTP 
connection attempts.

56.9  HTTPS Example
If you haven’t changed the default HTTPS port on the Switch, then in your browser enter “https://Switch 
IP Address/” as the web site address where “Switch IP Address” is the IP address or domain name of the 
Switch you wish to access.

56.9.1  Internet Explorer Warning Messages

56.9.1.1  Internet Explorer 6
When you attempt to access the Switch HTTPS server, a Windows dialog box pops up asking if you trust 
the server certificate. 

You see the following Security Alert screen in Internet Explorer. Select Yes to proceed to the web 
configurator login screen; if you select No, then web configurator access is blocked.

Figure 431   Security Alert Dialog Box (Internet Explorer 6)

56.9.1.2  Internet Explorer 7 or later version 
When you attempt to access the Switch HTTPS server, a screen with the message "There is a problem 
with this website's security certificate." may display. If that is the case, click Continue to this website (not 
recommended) to proceed to the web configurator login screen.



Chapter 56 Access Control

XGS4600 Series User’s Guide

529

Figure 432   Security Certificate Warning (Internet Explorer 11) 

After you log in, you will see the red address bar with the message Certificate Error. Click on Certificate 
Error next to the address bar and click View certificates. 

Figure 433   Certificate Error (Internet Explorer 11) 

Click Install Certificate... and follow the on-screen instructions to install the certificate in your browser.

example
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Figure 434   Certificate (Internet Explorer 11) 

56.9.2  Mozilla Firefox Warning Messages
When you attempt to access the Switch HTTPS server, a This Connection is Untrusted or Your connection 
is not secure screen may display. If that is the case, click I Understand the Risks or Advanced and then 
the Add Exception... button.  

Figure 435   Security Alert (Mozilla Firefox 53.0) 
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Confirm the HTTPS server URL matches. Click Confirm Security Exception to proceed to the web 
configurator login screen.

Figure 436   Security Alert (Mozilla Firefox 53.0) 

56.9.3  Google Chrome Warning Messages
When you attempt to access the Switch HTTPS server, a Your connection is not private screen may 
display. If that is the case, click Advanced and then Proceed to x.x.x.x (unsafe) to proceed to the web 
configurator login screen. 

example
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Figure 437   Security Alert (Google Chrome 58.0.3029.110) 

56.9.4  The Main Screen
After you accept the certificate and enter the login username and password, the Switch main screen 
appears. The lock displayed in the bottom right of the browser status bar or next to the website address 
denotes a secure connection.

Figure 438   Example: Lock Denoting a Secure Connection

56.10  Service Access Control   
Service Access Control allows you to decide what services you may use to access the Switch. You may 
also change the default service port and configure “trusted computer(s)” for each service in the 
Remote Management screen (discussed later). Click Access Control to go back to the main Access 
Control screen. 
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Figure 439   Management > Access Control > Service Access Control 

The following table describes the fields in this screen. 

56.11  Remote Management   
From the Access Control screen, display the Remote Management screen as shown next. 

You can specify a group of one or more “trusted computers” from which an administrator may use a 
service to manage the Switch. Click Access Control to return to the Access Control screen. 

Table 266   Management > Access Control > Service Access Control 
LABEL DESCRIPTION
Services Services you may use to access the Switch are listed here.

Active Select this option for the corresponding services that you want to allow to access the Switch.

Service Port For Telnet, SSH, FTP, HTTP or HTTPS services, you may change the default service port by typing the 
new port number in the Service Port field. If you change the default port number then you will 
have to let people (who wish to use the service) know the new port number for that service. 

Timeout Type how many minutes (from 1 to 255) a management session can be left idle before the session 
times out. After it times out you have to log in with your password again. Very long idle timeouts 
may have security risks. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Figure 440   Management > Access Control > Remote Management 

The following table describes the labels in this screen. 

Table 267   Management > Access Control > Remote Management 
LABEL DESCRIPTION
Entry This is the client set index number. A “client set” is a group of one or more “trusted computers” 

from which an administrator may use a service to manage the Switch.

Active Select this check box to activate this secured client set. Clear the check box if you wish to 
temporarily disable the set without deleting it. 

Start Address

End Address

Configure the IP address range of trusted computers from which you can manage this Switch.

The Switch checks if the client IP address of a computer requesting a service or protocol 
matches the range set here. The Switch immediately disconnects the session if it does not 
match.

Telnet/FTP/HTTP/
ICMP/SNMP/
SSH/HTTPS

Select services that may be used for managing the Switch from the specified trusted 
computers.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 57
Diagnostic

This chapter explains the Diagnostic screen. You can use this screen to help you identify problems.

57.1  Diagnostic 
Click Management > Diagnostic in the navigation panel to open this screen. Use this screen to check 
system logs, ping IP addresses or perform port tests. 

Figure 441   Management > Diagnostic (Standalone mode)
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Figure 442   Management > Diagnostic (Stacking mode)

The following table describes the labels in this screen. 

Table 268   Management > Diagnostic 
LABEL DESCRIPTION
Ping Test  

IPv4 Select this option if you want to ping an IPv4 address, and select which traffic flow (in-band 
or out-of-band) the Switch is to send ping frames.

If you select in-band, the Switch sends the frames to all ports except the management port 
(labeled MGMT).

If you select out-of-band, the Switch sends the frames to the management port (labeled 
MGMT).

Otherwise, select - to send ping requests to all VLANs on the Switch.

IPv6 Select this option if you want to ping an IPv6 address. You can also select vlan and specify 
the ID number of the VLAN to which the Switch is to send ping requests. Otherwise, select - to 
send ping requests to all VLANs on the Switch.

IP Address/Host 
Name

Type the IP address or host name of a device that you want to ping in order to test a 
connection.

Click Ping to have the Switch ping the IP address.
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Source IP 
Address

Type the source IP address that you want to ping in order to test a connection.

Click Ping to have the Switch ping the IP address.

Count Enter the number of ICMP Echo Request (ping) messages the Switch continuously sends.

Trace Route Test

IPv4 Select this option if you want to trace the route packets take to a device with an IPv4 
address, and select in-band or out-of-band on which the Switch traces the path. Otherwise, 
select - to trace the path on any VLAN.

IPv6 Select this option if you want to trace the route packets take to a device with an IPv6 
address.

IP Address/Host 
Name

Enter the IP address or host name of a device to which you want to perform a traceroute.

Click Trace Route to have the Switch perform the traceroute function. This determines the 
path a packet takes to the specified device.

TTL Enter the Time To Live (TTL) value for the ICMP Echo Request packets. This is to set the 
maximum number of the hops (routers) a packet can travel through. Each router along the 
path will decrement the TTL value by one and forward the packets. When the TTL value 
becomes zero and the destination is not found, the router drops the packets and informs the 
sender.

Wait Time Specify how many seconds the Switch waits for a response to a probe before running 
another traceroute.

Queries Specify how many times the Switch performs the traceroute function.

Ethernet Port Test  Click the drop-down list to choose the slot number of the Switch in a stack. Enter a port 
number and click Port Test to perform an internal loopback test. 

Cable Diagnostics Click the drop-down list to choose the slot number of the Switch in a stack. Enter an Ethernet 
port number and click Diagnose to perform a physical wire-pair test of the Ethernet 
connections on the specified port(s). The following fields display when you diagnose a port.

This field is available only on the Switch that has one or more copper Ethernet ports (except 
the MGMT port).

Port This is the number of the physical Ethernet port on the Switch.

Channel An Ethernet cable usually has four pairs of wires. A 10BASE-T or 100BASE-TX port only use and 
test two pairs, while a 1000BASE-T port requires all four pairs.

This displays the descriptive name of the wire-pair in the cable.

Pair status Ok: The physical connection between the wire-pair is okay.

Open: There is no physical connection (an open circuit detected) between the wire-pair.

Short: There is an short circuit detected between the wire-pair.

Unknown: The Switch failed to run cable diagnostics on the cable connected this port.

Unsupported: The port is a fiber port or it is not active.

Cable length 
(m)

This displays the total length of the Ethernet cable that is connected to the port when the 
Pair status is Ok and the Switch chipset supports this feature.

This shows N/A if the Pair status is Open or Short. Check the Distance to fault.

This shows Unsupported if the Switch chipset does not support to show the cable 

length.

Table 268   Management > Diagnostic (continued)
LABEL DESCRIPTION
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Distance to 
fault (m)

This displays the distance between the port and the location where the cable is open or 
shorted.

This shows N/A if the Pair status is Ok.

This shows Unsupported if the Switch chipset does not support to show the distance.

Locator LED Enter a time interval (in minutes) and click Blink to show the actual location of the Switch 
between several devices in a rack. 

The default time interval is 30 minutes.

Click Stop to have the Switch terminate the blinking locator LED.

Table 268   Management > Diagnostic (continued)
LABEL DESCRIPTION
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CHAPTER 58
System Log

58.1  Overview
A log message stores the information for viewing.

58.2  System Log
Click Management > System Log in the navigation panel to open this screen. Use this screen to check 
current system logs.

Note: When a log reaches the maximum number of log messages, new log messages 
automatically overwrite existing log messages, starting with the oldest existing log 
message first.

Figure 443   Management > System Log 

The summary table shows the time the log message was recorded and the reason the log message was 
generated. Click Refresh to update this screen. Click Clear to clear the whole log, regardless of what is 
currently displayed on the screen. Click Download to save the log to your computer.
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CHAPTER 59
Syslog Setup

This chapter explains the syslog screens.

59.1  Syslog Overview 
The syslog protocol allows devices to send event notification messages across an IP network to syslog 
servers that collect the event messages. A syslog-enabled device can generate a syslog message and 
send it to a syslog server.

Syslog is defined in RFC 3164. The RFC defines the packet format, content and system log related 
information of syslog messages. Each syslog message has a facility and severity level. The syslog facility 
identifies a file in the syslog server. Refer to the documentation of your syslog program for details. The 
following table describes the syslog severity levels. 

59.2  Syslog Setup 
Click Management > Syslog in the navigation panel to display this screen. The syslog feature sends logs 
to an external syslog server. Use this screen to configure the device’s system logging settings and 
configure a list of external syslog servers.

Table 269   Syslog Severity Levels
CODE SEVERITY
0 Emergency: The system is unusable.

1 Alert: Action must be taken immediately.

2 Critical: The system condition is critical.

3 Error: There is an error condition on the system.

4 Warning: There is a warning condition on the system.

5 Notice: There is a normal but significant condition on the system.

6 Informational: The syslog contains an informational message.

7 Debug: The message is intended for debug-level purposes.
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Figure 444   Management > Syslog Setup

The following table describes the labels in this screen. 

Table 270   Management > Syslog Setup
LABEL DESCRIPTION
Syslog Select Active to turn on syslog (system logging) and then configure the syslog setting. 

Logging Type This column displays the names of the categories of logs that the device can generate.

Active Select this option to set the device to generate logs for the corresponding category.

Facility The log facility allows you to send logs to different files in the syslog server. Refer to the 
documentation of your syslog program for more details.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Syslog Server 

Setup

Active Select this check box to have the device send logs to this syslog server. Clear the check box 
if you want to create a syslog server entry but not have the device send logs to it (you can 
edit the entry later).

Server Address Enter the IPv4 or IPv6 address of the syslog server.
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UDP Port The default syslog server port is 514. If your syslog server uses a different port, configure the 
one it uses here.

Log Level Select the severity level(s) of the logs that you want the device to send to this syslog server. 
The lower the number, the more critical the logs are.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to return the fields to the factory defaults.

Index This is the index number of a syslog server entry. Click this number to edit the entry.

Active This field displays Yes if the device is to send logs to the syslog server. No displays if the device 
is not to send logs to the syslog server.

IP Address This field displays the IP address of the syslog server.

UDP Port This field displays the UDP port used by the syslog server.

Log Level This field displays the severity level of the logs that the device is to send to this syslog server.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries. 

Delete Click Delete to remove the selected entry(ies).

Cancel Click Cancel to begin configuring this screen afresh.

Table 270   Management > Syslog Setup
LABEL DESCRIPTION
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CHAPTER 60
Cluster Management

This chapter introduces cluster management.

60.1  Clustering Management Overview 
Cluster Management allows you to manage switches through one Switch, called the cluster manager. 
The switches must be directly connected and be in the same VLAN group so as to be able to 
communicate with one another.   

In the following example, switch A in the basement is the cluster manager and the other switches on the 
upper floors of the building are cluster members. 

Figure 445   Clustering Application Example 

Table 271   Zyxel Clustering Management Specifications
Maximum number of cluster members 24

Cluster Member Models Cluster member models must be compatible with Zyxel cluster 
management implementation.

Cluster Manager  The cluster manager is the Switch through which you manage the cluster 
member switches.

Cluster Members  Cluster members are the switches being managed by the cluster 
manager switch.
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60.2  Cluster Management Status   
Click Management > Cluster Management in the navigation panel to display the following screen.

Note: A cluster can only have one manager.

Figure 446   Management > Cluster Management 

The following table describes the labels in this screen. 

60.2.1  Cluster Member Switch Management 
Go to the Clustering Management Status screen of the cluster manager switch and then select an Index 
hyperlink from the list of members to go to that cluster member switch's web configurator home page. 
This cluster member web configurator home page and the home page that you'd see if you accessed it 
directly are different.

Table 272   Management > Cluster Management 
LABEL DESCRIPTION
Status This field displays the role of this Switch within the cluster.

Manager

Member (you see this if you access this screen in the cluster member switch directly and not via 
the cluster manager)

None (neither a manager nor a member of a cluster)

Manager This field displays the cluster manager switch’s hardware MAC address.

The Number of 
Member 

This field displays the number of switches that make up this cluster. The following fields describe 
the cluster member switches.

Index You can manage cluster member switches via the cluster manager switch. Each number in the 
Index column is a hyperlink leading to the cluster member switch’s web configurator (see Figure 
447 on page 545). 

MacAddr This is the cluster member switch’s hardware MAC address.

Name This is the cluster member switch’s System Name.

Model This field displays the model name. 

Status This field displays:

Online (the cluster member switch is accessible)

Error (for example, the cluster member switch password was changed or the switch was set as 
the manager and so left the member list, etc.)

Offline (the switch is disconnected - Offline shows approximately 1.5 minutes after the link 
between cluster member and manager goes down)
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Figure 447   Cluster Management: Cluster Member Web Configurator Screen 

60.2.1.1  Uploading Firmware to a Cluster Member Switch   
You can use FTP to upload firmware to a cluster member switch through the cluster manager switch as 
shown in the following example.

Figure 448   Example: Uploading Firmware to a Cluster Member Switch 

example

example

C:\>ftp 192.168.1.1
Connected to 192.168.1.1.
220 Switch FTP version 1.0 ready at Thu Jan  1 00:58:46 1970
User (192.168.0.1:(none)): admin
331 Enter PASS command
Password:
230 Logged in
ftp> ls
200 Port command okay
150 Opening data connection for LIST
--w--w--w-   1 owner    group       6173152 Jul 01 12:00 ras-0
--w--w--w-   1 owner    group       6173152 Jul 01 12:00 ras-1
-rw-rw-rw-   1 owner    group      33554432 Jul 01 12:00 config
--w--w--w-   1 owner    group             0 Jul 01 12:00 ras-00-a0-c5-01-23-46
-rw-rw-rw-   1 owner    group             0 Jul 01 12:00 config-00-a0-c5-01-23-46
226 File sent OK
ftp: 297 bytes received in 0.00Seconds 297000.00Kbytes/sec.
ftp> bin
200 Type I OK
ftp> put 410AAGB0.bin ras-00-a0-c5-01-23-46
200 Port command okay
150 Opening data connection for STOR ras-00-a0-c5-01-23-46
226 File received OK
ftp: 262144 bytes sent in 0.63Seconds 415.44Kbytes/sec.
ftp>
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The following table explains some of the FTP parameters. 

60.3  Clustering Management Configuration  
Use this screen to configure clustering management. Click Configuration from the Cluster Management 
screen to display the next screen.

Figure 449   Management > Clustering Management > Configuration 

Table 273   FTP Upload to Cluster Member Example 
FTP PARAMETER DESCRIPTION
User Enter “admin”. 

Password The web configurator password default is 1234.

ls Enter this command to list the name of cluster member switch’s firmware and 
configuration file.

410AAGB0.bin This is the name of the firmware file you want to upload to the cluster member 
switch.

ras-00-a0-c5-01-23-46 This is the cluster member switch’s firmware name as seen in the cluster 
manager switch.

config-00-a0-c5-01-23-46 This is the cluster member switch’s configuration file name as seen in the cluster 
manager switch.
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The following table describes the labels in this screen. 

Table 274   Management > Clustering Management > Configuration 
LABEL DESCRIPTION
Clustering Manager

Active Select Active to have this Switch become the cluster manager switch. A cluster can only 
have one manager. Other (directly connected) switches that are set to be cluster 
managers will not be visible in the Clustering Candidates list. If a switch that was previously a 
cluster member is later set to become a cluster manager, then its Status is displayed as Error 
in the Cluster Management Status screen appears in the member summary list below.

Name Type a name to identify the Clustering Manager. You may use up to 32 printable characters 
(spaces are allowed).

VID  This is the VLAN ID and is only applicable if the Switch is set to 802.1Q VLAN. All switches must 
be directly connected and in the same VLAN group to belong to the same cluster. Switches 
that are not in the same VLAN group are not visible in the Clustering Candidates list. This field 
is ignored if the Clustering Manager is using Port-based VLAN.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clustering 
Candidate 

The following fields relate to the switches that are potential cluster members.

List A list of suitable candidates found by auto-discovery is shown here. The switches must be 
directly connected. Directly connected switches that are set to be cluster managers will not 
be visible in the Clustering Candidate list. Switches that are not in the same management 
VLAN group will not be visible in the Clustering Candidate list.

Password Each cluster member’s password is its web configurator password. Select a member in the 
Clustering Candidate list and then enter its web configurator password. If that switch 
administrator changes the web configurator password afterwards, then it cannot be 
managed from the Cluster Manager. Its Status is displayed as Error in the Cluster 
Management Status screen.

If multiple devices have the same password then hold [SHIFT] and click those switches to 
select them. Then enter their common web configurator password.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to 
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Refresh Click Refresh to perform auto-discovery again to list potential cluster members.

The next summary table shows the information for the clustering members configured. 

Index This is the index number of a cluster member switch.

MacAddr This is the cluster member switch’s hardware MAC address.

Name This is the cluster member switch’s System Name.

Model This is the cluster member switch’s model name. 

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the 
table heading row to select all entries.

Remove Click the Remove button to remove the selected cluster member switch(es) from the 
cluster.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 61
MAC Table

This chapter introduces the MAC Table screen.

61.1  MAC Table Overview 
The MAC Table screen (a MAC table is also known as a filtering database) shows how frames are 
forwarded or filtered across the Switch’s ports. When a device (which may belong to a VLAN group) 
sends a packet which is forwarded to a port on the Switch, the MAC address of the device is shown on 
the Switch’s MAC Table. It also shows whether the MAC address is dynamic (learned by the Switch) or 
static (manually entered in the Static MAC Forwarding screen).

The Switch uses the MAC Table to determine how to forward frames. See the following figure.

1 The Switch examines a received frame and learns the port from which this source MAC address came.

2 The Switch checks to see if the frame's destination MAC address matches a source MAC address 
already learned in the MAC Table. 

• If the Switch has already learned the port for this MAC address, then it forwards the frame to that port.

• If the Switch has not already learned the port for this MAC address, then the frame is flooded to all 
ports. Too much port flooding leads to network congestion then the Switch sends an ARP to request 
the MAC address. The Switch then learns the port that replies with the MAC address.

• If the Switch has already learned the port for this MAC address, but the destination port is the same as 
the port it came in on, then it filters the frame.

Figure 450   MAC Table Flowchart 



Chapter 61 MAC Table

XGS4600 Series User’s Guide

549

61.2  Viewing the MAC Table
Click Management > MAC Table in the navigation panel to display the following screen. Use this screen 
to search specific MAC addresses. You can also directly add dynamic MAC address(es) into the static 
MAC forwarding table or MAC filtering table from the MAC table using this screen.

Figure 451   Management > MAC Table 

The following table describes the labels in this screen. 

Table 275   Management > MAC Table 
LABEL DESCRIPTION
Condition Select All to display all MAC addresses in the MAC table.

Select Static to only display static MAC address(es) in this screen.

Select MAC and enter a valid MAC address (six hexadecimal character pairs) to display the 
MAC address information in this screen.

Select VID and type a VLAN identification number to display all MAC addresses in the VLAN.

Select Port and type the number of a port to display all MAC addresses learned from the port.

Select Trunk and type the ID of a trunk group to display all MAC addresses learned from the 
port(s) in the trunk group.

Sort by Select this to display and arrange the data according to MAC address (MAC), VLAN group 
(VID) or port number (Port). The information is then displayed in the summary table below.
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Transfer Type Select Dynamic to MAC forwarding and click Transfer to add the relative dynamic MAC 
address(es) you select the criteria here into the static MAC forwarding table (see Section 10.2 
on page 134). The type of the MAC address(es) will be changed to “static”.

Select Dynamic to MAC filtering and click Transfer to add the relative dynamic MAC 
address(es) you make the search here into the static MAC filtering table (see Section 12.1 on 
page 141). The MAC address(es) will be removed from the MAC table and all traffic sent from 
the MAC address(es) will be blocked by the Switch.

Search Click this to search data in the MAC table according to your input criteria.

Transfer Click this to perform the MAC address transferring you selected in the Transfer Type field.

Cancel Click this to begin configuring the search criteria afresh.

Index This is the incoming frame index number.

MAC Address This is the MAC address of the device from which this incoming frame came.

VID This is the VLAN group to which this frame belongs.

Port This is the port from which the above MAC address was learned. In stacking mode, the first 
number represents the slot and the second the port number.

Type This shows whether the MAC address is dynamic (learned by the Switch) or static (manually 
entered in the Static MAC Forwarding screen).

Table 275   Management > MAC Table (continued)
LABEL DESCRIPTION
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CHAPTER 62
IP Table

This chapter introduces the IP table.

62.1  IP Table Overview 
The IP Table screen shows how packets are forwarded or filtered across the Switch’s ports. When a 
device (which may belong to a VLAN group) sends a packet which is forwarded to a port on the Switch, 
the IP address of the device is shown on the Switch’s IP Table. The IP Table also shows whether the IP 
address is dynamic (learned by the Switch) or static (belonging to the Switch).

The Switch uses the IP Table to determine how to forward packets. See the following figure.

1 The Switch examines a received packet and learns the port from which this source IP address came.

2 The Switch checks to see if the packet's destination IP address matches a source IP address already 
learned in the IP Table. 

• If the Switch has already learned the port for this IP address, then it forwards the packet to that 
port.

• If the Switch has not already learned the port for this IP address, then the packet is flooded to all 
ports. Too much port flooding leads to network congestion then the Switch sends an ARP to request 
the MAC address. The Switch then learns the port that replies with the MAC address.

• If the Switch has already learned the port for this IP address, but the destination port is the same as 
the port it came in on, then it filters the packet.

Figure 452   IP Table Flowchart 
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62.2  Viewing the IP Table
Click Management > IP Table in the navigation panel to display the following screen.

Figure 453   Management > IP Table 

The following table describes the labels in this screen. 

Table 276   Management > IP Table 
LABEL DESCRIPTION
Sort by Click one of the following buttons to display and arrange the data according to that button type. 

The information is then displayed in the summary table below.

IP Click this button to display and arrange the data according to IP address.

VID Click this button to display and arrange the data according to VLAN group.

Port Click this button to display and arrange the data according to port number.

Index This field displays the index number. 

IP Address This is the IP address of the device from which the incoming packets came.

VID This is the VLAN group to which the packet belongs.

Port This is the port from which the above IP address was learned. This field displays CPU to indicate the 
IP address belongs to the Switch. In stacking mode, the first number represents the slot and the 
second the port number.

Type This shows whether the IP address is dynamic (learned by the Switch) or static (belonging to the 
Switch).
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CHAPTER 63
ARP Table

This chapter introduces ARP Table.

63.1  ARP Table Overview 
Address Resolution Protocol (ARP) is a protocol for mapping an Internet Protocol address (IP address) to 
a physical machine address, also known as a Media Access Control or MAC address, on the local area 
network. 

An IP (version 4) address is 32 bits long. In an Ethernet LAN, MAC addresses are 48 bits long. The ARP 
Table maintains an association between each MAC address and its corresponding IP address. 

63.1.1  How ARP Works
When an incoming packet destined for a host device on a local area network arrives at the Switch, the 
Switch's ARP program looks in the ARP Table and if it finds the address, it sends it to the device.

If no entry is found for the IP address, ARP broadcasts the request to all the devices on the LAN. The 
Switch fills in its own MAC and IP address in the sender address fields, and puts the known IP address of 
the target in the target IP address field. In addition, the Switch puts all ones in the target MAC field 
(FF.FF.FF.FF.FF.FF is the Ethernet broadcast address). The replying device (which is either the IP address of 
the device being sought or the router that knows the way) replaces the broadcast address with the 
target's MAC address, swaps the sender and target pairs, and unicasts the answer directly back to the 
requesting machine. ARP updates the ARP Table for future reference and then sends the packet to the 
MAC address that replied. 

63.2  The ARP Table Screen  
Click Management > ARP Table in the navigation panel to open the following screen. Use the ARP table 
to view IP-to-MAC address mapping(s) and remove specific dynamic ARP entries.
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Figure 454   Management > ARP Table 

The following table describes the labels in this screen. 

Table 277   Management > ARP Table 
LABEL DESCRIPTION
Condition Specify how you want the Switch to remove ARP entries when you click Flush.

Select All to remove all of the dynamic entries from the ARP table.

Select IP Address and enter an IP address to remove the dynamic entries learned with the 
specified IP address.

Select Port and enter a port number to remove the dynamic entries learned on the specified 
port.

Flush Click Flush to remove the ARP entries according to the condition you specified.

Cancel Click Cancel to return the fields to the factory defaults.

Index This is the ARP table entry number.

IP Address This is the IP address of a device connected to a Switch port with the corresponding MAC 
address below.

MAC Address This is the MAC address of the device with the corresponding IP address above.

VID This field displays the VLAN to which the device belongs.

Port This field displays the port to which the device connects. CPU means this IP address is the Switch’s 
management IP address. In stacking mode, the first number represents the slot and the second 
the port number.

Age(s) This field displays how long (in seconds) an entry can still remain in the ARP table before it ages 
out and needs to be relearned. This shows 0 for a static entry.

Type This shows whether the IP address is dynamic (learned by the Switch) or static (manually 
configured in the Basic Setting > IP Setup or IP Application > ARP Setup > Static ARP screen).
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CHAPTER 64
Routing Table

This chapter introduces the routing table. 

64.1  Overview
The routing table contains the route information to the network(s) that the Switch can reach. 

64.2  Routing Table
Click Management > Routing in the navigation panel to display the screen as shown. Click the link next 
to IPv4 Routing Table to open a screen where you can view IPv4 routing table information. Click the link 
next to IPv6 Routing Table to open a screen where you can view IPv6 routing table information.

Figure 455   Management > Routing Table 

64.3  Viewing the IPv4 Routing Table 
Use this screen to view IPv4 routing table information. Click Management > Routing Table > IPv4 Routing 
Table in the navigation panel to display the screen as shown. 

Figure 456   Management > Routing Table > IPv4 Routing Table  
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The following table describes the labels in this screen. 

64.4  Viewing the IPv6 Routing Table 
Use this screen to view IPv6 routing table information. Click Management > Routing Table > IPv6 Routing 
Table in the navigation panel to display the screen as shown. 

Figure 457   Management > Routing Table > IPv6 Routing Table  

The following table describes the labels in this screen. 

Table 278   Management > Routing Table > IPv4 Routing Table 
LABEL DESCRIPTION
Index This field displays the index number. 

Destination This field displays the destination IP routing domain.  

Gateway This field displays the IP address of the gateway device. 

Interface This field displays the IP address of the Interface.

Metric This field displays the cost of the route. 

Type This field displays the method used to learn the route.

STATIC - added as a static entry. 

LOCAL - added as a local interface entry.

RIP - added as a RIP entry.

OSPF - added as an OSPF entry.

LOOPBACK - added as a loopback interface entry. 

Uptime This field displays how long the route has been running since the Switch learned the route and 
added an entry in the routing table. 

Table 279   Management > Routing Table > IPv6 Routing Table 
LABEL DESCRIPTION
Index This field displays the index number. 

Route 
Destination / 
Prefix Length

This field displays the IPv6 subnet prefix and prefix length of the final destination.

Next Hop This field displays the IPv6 address of the gateway that helps forward the packet to the 
destination. 

Interface This field displays the descriptive name of the IPv6 interface that is used to forward the packets to 
the destination.
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Metric This field displays the cost of the route. 

Type This field displays the method used to learn the route.

Static - added as a static entry. 

Connect - added as a local interface entry.

RIP - added as a RIP entry.

OSPF - added as an OSPF entry.

Table 279   Management > Routing Table > IPv6 Routing Table (continued)
LABEL DESCRIPTION
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CHAPTER 65
Path MTU Table

This chapter introduces the IPv6 Path MTU table. 

65.1  Path MTU Overview 
The largest size (in bytes) of a packet that can be transferred over a data link is called the maximum 
transmission unit (MTU). The Switch uses Path MTU Discovery to discover Path MTU (PMTU), that is, the 
minimum link MTU of all the links in a path to the destination. If the Switch receives an ICMPv6 Packet Too 
Big error message after sending a packet, it fragments the next packet according to the suggested MTU 
in the error message.

65.2  Viewing the Path MTU Table
Use this screen to view IPv6 path MTU information on the Switch. Click Management > Path MTU Table in 
the navigation panel to display the screen as shown. 

Figure 458   Management > Path MTU Table  

The following table describes the labels in this screen. 

Table 280   Management > Path MTU Table 
LABEL DESCRIPTION
Path MTU 
aging time

This field displays how long an entry remains in the Path MTU table before it ages out and needs to 
be relearned.

Index This field displays the index number of each entry in the table. 

Destination 
Address

This field displays the destination IPv6 address of each path/entry.  

MTU This field displays the maximum transmission unit of the links in the path.

Expire This field displays how long (in minutes) an entry can still remain in the Path MTU table before it 
ages out and needs to be relearned.
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CHAPTER 66
Configure Clone

This chapter shows you how you can copy the settings of one port onto other ports.

66.1  Configure Clone 
Cloning allows you to copy the basic and advanced settings from a source port to a destination port or 
ports. Click Management > Configure Clone to open the following screen. 
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Figure 459   Management > Configure Clone (Standalone) 
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Figure 460   Management > Configure Clone (Stacking) 
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The following table describes the labels in this screen. 

Table 281   Management > Configure Clone 
LABEL DESCRIPTION
Source/
Destination

In stacking mode, a port is defined by a slot ID representing the Switch in the stack and a port 
number.

Select the source port and slot (in stacking mode) under the Source label. This port’s attributes 
are copied.

Enter the destination port or ports under the Destination label. These are the ports which are 
going to have the same attributes as the source port. You can enter individual ports separated 
by a comma or a range of ports by using a hyphen. For example, 2, 4, 6 indicates that ports 2, 4 
and 6 are the destination ports. 2-6 indicates that ports 2 through 6 are the destination ports.

In stacking mode, you can select multiple destination slots.

Basic Setting Select which port settings (configured in the Basic Setting menus) should be copied to the 
destination port(s). 

Advanced 
Application

Select which port settings (configured in the Advanced Application menus) should be copied to 
the destination ports. 

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these 
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save 
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.



XGS4600 Series User’s Guide

563

CHAPTER 67
IPv6 Neighbor Table

This chapter introduces the IPv6 neighbor table. 

67.1  IPv6 Neighbor Table Overview 
An IPv6 host is required to have a neighbor table. If there is an address to be resolved or verified, the 
Switch sends out a neighbor solicitation message. When the Switch receives a neighbor advertisement 
in response, it stores the neighbor’s link-layer address in the neighbor table. You can also manually 
create a static IPv6 neighbor entry using the Basic Setting > IPv6 > IPv6 Configuration > IPv6 Neighbor 
Setup screen.

When the Switch needs to send a packet, it first consults other table to determine the next hop. Once 
the next hop IPv6 address is known, the Switch looks into the neighbor table to get the link-layer address 
and sends the packet when the neighbor is reachable. If the Switch cannot find an entry in the 
neighbor table or the state for the neighbor is not reachable, it starts the address resolution process. This 
helps reduce the number of IPv6 solicitation and advertisement messages.

67.2  Viewing the IPv6 Neighbor Table
Use this screen to view IPv6 neighbor information on the Switch. Click Management > IPv6 Neighbor 
Table in the navigation panel to display the screen as shown. 

Figure 461   Management > IPv6 Neighbor Table  

The following table describes the labels in this screen. 

Table 282   Management > IPv6 Neighbor Table 
LABEL DESCRIPTION
Sort by Select this to display and arrange the data according to IPv6 address (Address), MAC address 

(MAC) or IPv6 interface (Interface). The information is then displayed in the summary table below.

Index This field displays the index number of each entry in the table. 

Address This field displays the IPv6 address of the Switch or a neighboring device.

MAC This field displays the MAC address of the IPv6 interface on which the IPv6 address is configure or 
the MAC address of the neighboring device.
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Status This field displays whether the neighbor IPv6 interface is reachable. In IPv6, “reachable” means an 
IPv6 packet can be correctly forwarded to a neighbor node (host or router) and the neighbor 
can successfully receive and handle the packet. The available options in this field are:

• reachable (R): The interface of the neighboring device is reachable. (The Switch has received 
a response to the initial request.)

• stale (S): The last reachable time has expired and the Switch is waiting for a response to 
another initial request. The field displays this also when the Switch receives an unrequested 
response from the neighbor’s interface.

• delay (D): The neighboring interface is no longer known to be reachable, and traffic has been 
sent to the neighbor recently. The Switch delays sending request packets for a short to give 
upper-layer protocols a chance to determine reachability.

• probe (P): The Switch is sending request packets and waiting for the neighbor’s response.
• invalid (IV): The neighbor address is with an invalid IPv6 address.
• unknown (?): The status of the neighboring interface can not be determined for some reason.
• incomplete (I): Address resolution is in progress and the link-layer address of the neighbor has 

not yet been determined. The interface of the neighboring device did not give a complete 
response.

Type This field displays the type of an address mapping to a neighbor interface. The available options in 
this field are:

• other (O): none of the following type.
• local (L): A Switch interface is using the address.
• dynamic (D): The IP address to MAC address can be successfully resolved using IPv6 Neighbor 

Discovery protocol. Is it similar as IPv4 ARP (Address Resolution protocol).
• static (S): The interface address is statically configured.

Interface This field displays the ID number of the IPv6 interface on which the IPv6 address is created or 
through which the neighboring device can be reached.

Table 282   Management > IPv6 Neighbor Table (continued)
LABEL DESCRIPTION
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CHAPTER 68
Port Status

This chapter introduces the port status screens.

68.1  Status  
Use this screen to view system status and click a number in the Slot column to display each port 
statistical summary on the stacked Switch. This screen displays only when the Switch is in stacking mode 
and you click the Port Status quick link from the Status screen.

Figure 462   Status > Port Status: Status (Stacking mode) 

The following table describes the labels in this screen. 

68.2  Port Status  
This screen displays a port statistical summary with links to each port showing statistical details. To view 
the port statistics, click Management > Port Status to see the following screen. Alternatively, click Status 
from any web configurator screen, the Port Status link in the Quick Links section of the Status screen and 
then a Switch’s slot number to display the Port Status screen as shown next. 

Table 283   Status > Port Status: Status (Stacking mode)
LABEL DESCRIPTION
System Up Time This field displays how long the stacked Switch has been running since it last restarted or was 

turned on.

Slot This field displays the slot ID of the stacked Switch. You can click the ID number to go to the Port 
Status screen.

Name This field displays the model name of the stacked Switch.
Status This field displays whether the stacked Switch is active or inactive in a stack system.

Up Time This field displays the time that the active Switch in a stack has been running.
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Figure 463   Management > Port Status (Standalone mode) 

Figure 464   Management > Port Status (Stacking mode) 
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The following table describes the labels in this screen. 

68.2.1  Port Details   
Click a number in the Port column in the Port Status screen to display individual port statistics. Use this 
screen to check status and detailed performance data about an individual port on the Switch.

Table 284   Port Status
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This identifies the Ethernet port. In stacking mode, the first number represents the slot and the 
second the port number. Click a port number to display the Port Details screen (refer to Figure 
465 on page 568).

Name This is the name you assigned to this port in the Basic Setting > Port Setup screen.

Link This field displays the speed (such as 100M for 100 Mbps, 1G for 1000 Mbps or 1 Gbps, or 10G for 
10 Gbps) and the duplex (F for full duplex). It also shows the cable type (Copper or Fiber) for the 
combo ports. This field displays Down if the port is not connected to any device.

State If STP (Spanning Tree Protocol) is enabled, this field displays the STP state of the port. (See Section 
13.1.3 on page 144 for more information).

If STP is disabled, this field displays FORWARDING if the link is up, otherwise, it displays STOP. 

LACP This fields displays whether LACP (Link Aggregation Control Protocol) has been enabled on the 
port.

TxPkts This field shows the number of transmitted frames on this port.

RxPkts This field shows the number of received frames on this port.

Errors This field shows the number of received errors on this port.

Tx KB/s This field shows the transmission speed of data sent on this port in kilobytes per second.

Rx KB/s This field shows the transmission speed of data received on this port in kilobytes per second.

Up Time This field shows the total amount of time in hours, minutes and seconds the port has been up.

Clear Counter Select Port, type a port number and then click Clear Counter to erase the recorded statistical 
information for that port, or select Any to clear statistics for all ports.
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Figure 465   Port Status: Port Details  

The following table describes the labels in this screen. 

Table 285   Port Status: Port Details 
LABEL DESCRIPTION
Port Info

Port NO. This field displays the port number you are viewing. In stacking mode, the first number represents 
the slot and the second the port number.

Name This field displays the name of the port.

Link This field displays the speed (such as 100M for 100Mbps, 1G for 1000 Mbps or 1 Gbps, or 10G for 
10 Gbps) and the duplex (F for full duplex). It also shows the cable type (Copper or Fiber) for the 
combo ports. This field displays Down if the port is not connected to any device.

State If STP (Spanning Tree Protocol) is enabled, this field displays the STP state of the port (see Section 
13.1.3 on page 144 for more information). 

If STP is disabled, this field displays FORWARDING if the link is up, otherwise, it displays STOP.

LACP This field shows if LACP is enabled on this port or not. 

TxPkts This field shows the number of transmitted frames on this port

RxPkts This field shows the number of received frames on this port
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Errors This field shows the number of received errors on this port.

Tx KBs/s This field shows the transmission speed of data sent on this port in kilobytes per second.

Rx KBs/s This field shows the transmission speed of data received on this port in kilobytes per second.

Up Time This field shows the total amount of time the connection has been up.

Tx Packet

The following fields display detailed information about packets transmitted.

Unicast This field shows the number of good unicast packets transmitted.

Multicast This field shows the number of good multicast packets transmitted.

Broadcast This field shows the number of good broadcast packets transmitted.

Pause This field shows the number of 802.3x Pause packets transmitted.

Tagged This field shows the number of packets with VLAN tags transmitted.

Rx Packet 

The following fields display detailed information about packets received.

Unicast This field shows the number of good unicast packets received.

Multicast This field shows the number of good multicast packets received.

Broadcast This field shows the number of good broadcast packets received.

Pause This field shows the number of 802.3x Pause packets received.

Control This field shows the number of control packets received (including those with CRC error) but it 
does not include the 802.3x Pause packets.

TX Collision

The following fields display information on collisions while transmitting.

Single This is a count of successfully transmitted packets for which transmission is inhibited by exactly 
one collision.

Multiple This is a count of successfully transmitted packets for which transmission was inhibited by more 
than one collision.

Excessive This is a count of packets for which transmission failed due to excessive collisions. Excessive 
collision is defined as the number of maximum collisions before the retransmission count is reset.

Late This is the number of times a late collision is detected, that is, after 512 bits of the packets have 
already been transmitted.

Error Packet The following fields display detailed information about packets received that were in error.

RX CRC This field shows the number of packets received with CRC (Cyclic Redundant Check) error(s).

Length This field shows the number of packets received with a length that was out of range.

Runt This field shows the number of packets received that were too short (shorter than 64 octets), 
including the ones with CRC errors. 

Distribution

64 This field shows the number of packets (including bad packets) received that were 64 octets in 
length.

65 to 127 This field shows the number of packets (including bad packets) received that were between 65 
and 127 octets in length.

128 to 255 This field shows the number of packets (including bad packets) received that were between 128 
and 255 octets in length.

256 to 511 This field shows the number of packets (including bad packets) received that were between 256 
and 511 octets in length.

Table 285   Port Status: Port Details (continued)
LABEL DESCRIPTION
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68.2.2  DDMI
Use this screen to view the Digital Diagnostics Monitoring Interface (DDMI) status of the Switch’s SFP 
transceivers. Click Management > Port Status > DDMI to see the following screen.

Figure 466   Management > Port Status > DDMI 

The following table describes the labels in this screen. 

68.2.3  DDMI Details
Use this screen to view the real-time SFP (Small Form Factor Pluggable) transceiver information and 
operating parameters on the SFP port. The parameters include, for example, transmitting and receiving 
power, and module temperature.

Click a number in the Port column in the DDMI screen to view current transceivers’ status. 

512 to 1023 This field shows the number of packets (including bad packets) received that were between 512 
and 1023 octets in length.

1024 to 1518 This field shows the number of packets (including bad packets) received that were between 
1024 and 1518 octets in length.

Giant This field shows the number of packets (including bad packets) received that were between 
1519 octets and the maximum frame size.

The maximum frame size varies depending on your Switch model. 

Table 285   Port Status: Port Details (continued)
LABEL DESCRIPTION

Table 286   Management > Port Status > DDMI
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This identifies the SFP port. In stacking mode, the first number represents the slot and the second 
the port number. 

Vendor This displays the vendor name of the optical transceiver.

Part Number This displays the part number of the optical transceiver.

Serial Number This displays the serial number of the optical transceiver.

Revision This displays the revision number of the optical transceiver.

Date Code This displays the date when the optical transceiver was manufactured.

Transceiver This displays whether the connection to the optical network is up or down.
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Figure 467   DDMI Details 

The following table describes the labels in this screen. 

Table 287   DDMI Details  
LABEL DESCRIPTION
Transceiver Information

Port No This identifies the SFP port. 

Connector 
Type

This displays the connector type of the optical transceiver.

Vendor This displays the vendor name of the optical transceiver.

Part Number This displays the part number of the optical transceiver.

Serial Number This displays the serial number of the optical transceiver.

Revision This displays the revision number of the optical transceiver.

Date Code This displays the date when the optical transceiver was manufactured.

Transceiver This displays whether the connection to the optical network is up or down.

DDMI Information

Type This displays the DDMI parameter.

Current This displays the current status for each monitored DDMI parameter.

High Alarm 
Threshold

This displays the high value alarm threshold for each monitored DDMI parameter. An alarm signal 
is reported to the Switch if the monitored DDMI parameter reaches this value.

High Warn 
Threshold

This displays the high value warning threshold for each monitored DDMI parameter. A warning 
signal is reported to the Switch if the monitored DDMI parameter reaches this value.

Low Warn 
Threshold

This displays the low value warning threshold for each monitored DDMI parameter. A warning 
signal is reported to the Switch if the monitored DDMI parameter reaches this value.

Low Alarm 
Threshold

This displays the low value alarm threshold for each monitored DDMI parameter. An alarm signal is 
reported to the Switch if the monitored DDMI parameter reaches this value.
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68.2.4  Port Utilization  
This screen displays the percentage of actual transmitted or received frames on a port as a percentage 
of the Link speed. To view port utilization, click Management > Port Status > Port Utilization to see the 
following screen. Alternatively, click Status from any web configurator screen and then the Port Status 
link in the Quick Links section of the Status screen to display the Port Status screen and then click the 
Utilization link tab. 

Figure 468   Management > Port Status > Utilization (Standalone mode) 
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Figure 469   Management > Port Status > Utilization (Stacking mode) 

The following table describes the labels in this screen. 

Table 288   Management > Port Status > Utilization
LABEL DESCRIPTION
Slot (Stacking 
mode)

This field appears only in stacking mode. Click the drop-down list to choose the slot number of 
the Switch in a stack.

Port This identifies the Ethernet port. In stacking mode, the first number represents the slot and the 
second the port number. 

Link This field displays the speed (such as 100M for 100 Mbps, 1000M for 1000 Mbps, or 10G for 10 
Gbps) and the duplex (F for full duplex). This field displays Down if the port is not connected to 
any device.

Tx kB/s This field shows the transmission speed of data sent on this port in kilobytes per second.

Tx Utilization% This field shows the percentage of actual transmitted frames on this port as a percentage of the 
Link speed.

Rx KB/s This field shows the transmission speed of data received on this port in kilobytes per second.

Rx Utilization% This field shows the percentage of actual received frames on this port as a percentage of the 
Link speed.



XGS4600 Series User’s Guide

574

CHAPTER 69
Service Register

69.1  Service Register Overview
myZyxel is Zyxel’s online services center where you can register your Switch and manage subscription 
services available for your Switch.

At the time of writing, you can enable the Advance Routing service license for the Switch, which allows 
you to use advanced L3 routing features, such as RIPng and OSPFv3 for IPv6. Without the service license, 
you can still configure the L3 routing features, but they will not work.

69.2  Service Register Screen
Click Management > Service Register to display the screen as shown. Use this screen to display the status 
of your service registration. Go to myZyxel to activate or extend the subscription. 

Figure 470   Management > Service Register 

The following table describes the labels in this screen. 

Table 289   Management > Service Register  
LABEL DESCRIPTION
Service This lists the name of the service that is available on the Switch.

Status This field displays whether the service license is enabled at myZyxel (Licensed) or not (Not 
Licensed). 

Type This field displays whether you applied for a trial application (Trial) or registered a service 
(Standard) at myZyxel. It displays N/A if the service license is not enabled.

Expiration This field displays the amount of time remaining before your trial license expires.

Note: You can enable a standard license at myZyxel if the trial license expires.
Update Click this button to renew service license information (such as the registration status and expiration 

day).

Note: It is recommended you use this button after you register for a new service.
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CHAPTER 70
Troubleshooting

This chapter offers some suggestions to solve problems you might encounter. The potential problems are 
divided into the following categories.

• Power, Hardware Connections, and LEDs

• Switch Access and Login

• Switch Configuration

70.1  Power, Hardware Connections, and LEDs

The Switch does not turn on. None of the LEDs turn on.

1 Make sure the Switch is turned on.

2 Make sure you are using the power adaptor or cord included with the Switch.

3 Make sure the power adaptor or cord is connected to the Switch and plugged in to an appropriate 
power source. Make sure the power source is turned on.

4 Turn the Switch off and on.

5 Disconnect and re-connect the power adaptor or cord to the Switch (in AC models or if the AC power 
supply is connected in AC/DC models).

6 If the problem continues, contact the vendor.

One of the LEDs does not behave as expected.

1 Make sure you understand the normal behavior of the LED. See Section 3.3 on page 37.

2 Check the hardware connections. See Section 3.1 on page 31.

3 Inspect your cables for damage. Contact the vendor to replace any damaged cables.

4 Turn the Switch off and on.

5 Disconnect and re-connect the power adaptor or cord to the Switch (in AC models or if the AC power 
supply is connected in AC/DC models).
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6 If the problem continues, contact the vendor.

70.2  Switch Access and Login

I forgot the IP address for the Switch.

1 The default in-band IP address in standalone mode is http://DHCP-assigned IP (when connecting to a 
DHCP server) or 192.168.1.1.
The default in-band IP address in stacking mode is 192.168.1.1.

2 Use the console port to log in to the Switch.

3 Use the MGMT port to log in to the Switch, the default IP address of the MGMT port is 192.168.0.1.

4 If this does not work, you have to reset the device to its factory defaults. See Section 4.6 on page 48.

I forgot the username and/or password.

1 The default username is admin and the default password is 1234.

2 If this does not work, you have to reset the device to its factory defaults. See Section 4.6 on page 48.

I cannot see or access the Login screen in the web configurator.

1 Make sure you are using the correct IP address.

• The default in-band IP address in standalone mode is http://DHCP-assigned IP (when connecting 
to a DHCP server) or 192.168.1.1.
The default in-band IP address in stacking mode is 192.168.1.1.

• If you changed the IP address, use the new IP address.

• If you changed the IP address and have forgotten it, see the troubleshooting suggestions for I 
forgot the IP address for the Switch.

2 Check the hardware connections, and make sure the LEDs are behaving as expected. See Section 3.3 
on page 37.

3 Make sure your Internet browser does not block pop-up windows and has JavaScripts and Java 
enabled.

4 Make sure your computer is in the same subnet as the Switch. (If you know that there are routers 
between your computer and the Switch, skip this step.)
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5 Reset the device to its factory defaults, and try to access the Switch with the default IP address. See 
Section 4.6 on page 48.

6 If the problem continues, contact the vendor, or try one of the advanced suggestions.

Advanced Suggestions

• Try to access the Switch using another service, such as Telnet. If you can access the Switch, check the 
remote management settings to find out why the Switch does not respond to HTTP.

I can see the Login screen, but I cannot log in to the Switch.

1 Make sure you have entered the user name and password correctly. The default user name is admin, 
and the default password is 1234. These fields are case-sensitive, so make sure [Caps Lock] is not on.

2 You may have exceeded the maximum number of concurrent Telnet sessions. Close other Telnet 
session(s) or try connecting again later. 

Check that you have enabled logins for HTTP or Telnet. If you have configured a secured client IP 
address, your computer’s IP address must match it. Refer to the chapter on access control for details.

3 Disconnect and re-connect the cord to the Switch.

4 If this does not work, you have to reset the device to its factory defaults. See Section 4.6 on page 48.

Pop-up Windows, JavaScripts and Java Permissions 

In order to use the web configurator you need to allow:

• Web browser pop-up windows from your device.

• JavaScripts (enabled by default).

• Java permissions (enabled by default).

There is unauthorized access to my Switch via telnet, HTTP and SSH.

To avoid unauthorized access, configure the secured client setting in the Management > Access 
Control > Remote Management screen for telnet, HTTP and SSH (see Section 56.11 on page 533). 
Computers not belonging to the secured client set cannot get permission to access the Switch.
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70.3  Switch Configuration

I lost my configuration settings after I restart the Switch.

Make sure you save your configuration into the Switch’s 
nonvolatile memory each time you make changes. Click 
Save at the top right corner of the web configurator to save 
the configuration permanently. See also Section 55.3 on page 498 for more information about how to 
save your configuration.
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APPENDIX A
Customer Support

In the event of problems that cannot be solved by using this manual, you should contact your vendor. If 
you cannot contact your vendor, then contact a Zyxel office for the region in which you bought the 
device. 

See http://www.zyxel.com/homepage.shtml and also 
http://www.zyxel.com/about_zyxel/zyxel_worldwide.shtml for the latest information.

Please have the following information ready when you contact an office.

Required Information
• Product model and serial number.

• Warranty Information.

• Date that you received your device.

• Brief description of the problem and the steps you took to solve it.

Corporate Headquarters (Worldwide)

Taiwan
• Zyxel Communications Corporation

• http://www.zyxel.com

Asia

China
• Zyxel Communications (Shanghai) Corp.

Zyxel Communications (Beijing) Corp.

Zyxel Communications (Tianjin) Corp.

• http://www.zyxel.cn

India
• Zyxel Technology India Pvt Ltd

• http://www.zyxel.in

Kazakhstan
• Zyxel Kazakhstan

• http://www.zyxel.kz
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Korea
• Zyxel Korea Corp.

• http://www.zyxel.kr

Malaysia
• Zyxel Malaysia Sdn Bhd.

• http://www.zyxel.com.my

Pakistan
• Zyxel Pakistan (Pvt.) Ltd.

• http://www.zyxel.com.pk

Philippines
• Zyxel Philippines

• http://www.zyxel.com.ph

Singapore
• Zyxel Singapore Pte Ltd.

• http://www.zyxel.com.sg

Taiwan
• Zyxel Communications Corporation

• http://www.zyxel.com/tw/zh/

Thailand
• Zyxel Thailand Co., Ltd 

• http://www.zyxel.co.th

Vietnam
• Zyxel Communications Corporation-Vietnam Office

• http://www.zyxel.com/vn/vi

Europe

Austria
• Zyxel Deutschland GmbH 

• http://www.zyxel.de

Belarus
• Zyxel BY 

• http://www.zyxel.by
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Belgium
• Zyxel Communications B.V.  

• http://www.zyxel.com/be/nl/

• http://www.zyxel.com/be/fr/ 

Bulgaria
• Zyxel България

• http://www.zyxel.com/bg/bg/ 

Czech Republic
• Zyxel Communications Czech s.r.o 

• http://www.zyxel.cz

Denmark
• Zyxel Communications A/S

• http://www.zyxel.dk

Estonia
• Zyxel Estonia

• http://www.zyxel.com/ee/et/

Finland
• Zyxel Communications

• http://www.zyxel.fi

France
• Zyxel France

• http://www.zyxel.fr

Germany
• Zyxel Deutschland GmbH 

• http://www.zyxel.de

Hungary
• Zyxel Hungary & SEE 

• http://www.zyxel.hu

Italy
• Zyxel Communications Italy 

• http://www.zyxel.it/
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Latvia
• Zyxel Latvia

• http://www.zyxel.com/lv/lv/homepage.shtml

Lithuania
• Zyxel Lithuania

• http://www.zyxel.com/lt/lt/homepage.shtml

Netherlands
• Zyxel Benelux

• http://www.zyxel.nl

Norway
• Zyxel Communications

• http://www.zyxel.no

Poland
• Zyxel Communications Poland

• http://www.zyxel.pl

Romania
• Zyxel Romania

• http://www.zyxel.com/ro/ro

Russia
• Zyxel Russia 

• http://www.zyxel.ru

Slovakia
• Zyxel Communications Czech s.r.o. organizacna zlozka

• http://www.zyxel.sk

Spain
• Zyxel Communications ES Ltd

• http://www.zyxel.es

Sweden
• Zyxel Communications 

• http://www.zyxel.se

Switzerland
• Studerus AG
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• http://www.zyxel.ch/

Turkey
• Zyxel Turkey A.S.

• http://www.zyxel.com.tr

UK
• Zyxel Communications UK Ltd.

• http://www.zyxel.co.uk

Ukraine
• Zyxel Ukraine

• http://www.ua.zyxel.com

Latin America

Argentina
• Zyxel Communication Corporation

• http://www.zyxel.com/ec/es/

Brazil
• Zyxel Communications Brasil Ltda.

• https://www.zyxel.com/br/pt/

Ecuador
• Zyxel Communication Corporation

• http://www.zyxel.com/ec/es/

Middle East

Israel
• Zyxel Communication Corporation

• http://il.zyxel.com/homepage.shtml

Middle East
• Zyxel Communication Corporation

• http://www.zyxel.com/me/en/
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North America

USA
• Zyxel Communications, Inc. - North America Headquarters

• http://www.zyxel.com/us/en/

Oceania

Australia
• Zyxel Communications Corporation

• http://www.zyxel.com/au/en/

Africa

South Africa
• Nology (Pty) Ltd.

• http://www.zyxel.co.za
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APPENDIX B
Common Services

The following table lists some commonly-used services and their associated protocols and port numbers. 
For a comprehensive list of port numbers, ICMP type/code numbers and services, visit the IANA (Internet 
Assigned Number Authority) web site. 

• Name: This is a short, descriptive name for the service. You can use this one or create a different one, 
if you like.

• Protocol: This is the type of IP protocol used by the service. If this is TCP/UDP, then the service uses the 
same port number with TCP and UDP. If this is User-Defined, the Port(s) is the IP protocol number, not 
the port number.

• Port(s): This value depends on the Protocol. Please refer to RFC 1700 for further information about port 
numbers.

• If the Protocol is TCP, UDP, or TCP/UDP, this is the IP port number.

• If the Protocol is USER, this is the IP protocol number.

• Description: This is a brief explanation of the applications that use this service or the situations in which 
this service is used.

Table 290   Commonly Used Services 

NAME PROTOCOL PORT(S) DESCRIPTION
AH (IPSEC_TUNNEL) User-Defined 51 The IPSEC AH (Authentication Header) tunneling 

protocol uses this service.

AIM/New-ICQ TCP 5190 AOL’s Internet Messenger service. It is also used as a 
listening port by ICQ.

AUTH TCP 113 Authentication protocol used by some servers.

BGP TCP 179 Border Gateway Protocol.

BOOTP_CLIENT UDP 68 DHCP Client.

BOOTP_SERVER UDP 67 DHCP Server.

CU-SEEME TCP

UDP

7648

24032

A popular videoconferencing solution from White 
Pines Software.

DNS TCP/UDP 53 Domain Name Server, a service that matches web 
names (for example www.zyxel.com) to IP numbers.

ESP (IPSEC_TUNNEL) User-Defined 50 The IPSEC ESP (Encapsulation Security Protocol) 
tunneling protocol uses this service.

FINGER TCP 79 Finger is a UNIX or Internet related command that can 
be used to find out if a user is logged on.

FTP TCP

TCP

20

21

File Transfer Program, a program to enable fast transfer 
of files, including large files that may not be possible by 
e-mail.

H.323 TCP 1720 NetMeeting uses this protocol.

HTTP TCP 80 Hyper Text Transfer Protocol - a client/server protocol 
for the world wide web.

HTTPS TCP 443 HTTPS is a secured http session often used in e-
commerce.
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ICMP User-Defined 1 Internet Control Message Protocol is often used for 
diagnostic or routing purposes.

ICQ UDP 4000 This is a popular Internet chat program.

IGMP (MULTICAST) User-Defined 2 Internet Group Multicast Protocol is used when 
sending packets to a specific group of hosts.

IKE UDP 500 The Internet Key Exchange algorithm is used for key 
distribution and management.

IRC TCP/UDP 6667 This is another popular Internet chat program.

MSN Messenger TCP 1863 Microsoft Networks’ messenger service uses this 
protocol. 

NEW-ICQ TCP 5190 An Internet chat program.

NEWS TCP 144 A protocol for news groups.

NFS UDP 2049 Network File System - NFS is a client/server distributed 
file service that provides transparent file sharing for 
network environments.

NNTP TCP 119 Network News Transport Protocol is the delivery 
mechanism for the USENET newsgroup service.

PING User-Defined 1 Packet INternet Groper is a protocol that sends out 
ICMP echo requests to test whether or not a remote 
host is reachable.

POP3 TCP 110 Post Office Protocol version 3 lets a client computer 
get e-mail from a POP3 server through a temporary 
connection (TCP/IP or other).

PPTP TCP 1723 Point-to-Point Tunneling Protocol enables secure 
transfer of data over public networks. This is the control 
channel.

PPTP_TUNNEL (GRE) User-Defined 47 PPTP (Point-to-Point Tunneling Protocol) enables 
secure transfer of data over public networks. This is the 
data channel.

RCMD TCP 512 Remote Command Service.

REAL_AUDIO TCP 7070 A streaming audio service that enables real time 
sound over the web.

REXEC TCP 514 Remote Execution Daemon.

RLOGIN TCP 513 Remote Login.

RTELNET TCP 107 Remote Telnet.

RTSP TCP/UDP 554 The Real Time Streaming (media control) Protocol 
(RTSP) is a remote control for multimedia on the 
Internet. 

SFTP TCP 115 Simple File Transfer Protocol.

SMTP TCP 25 Simple Mail Transfer Protocol is the message-exchange 
standard for the Internet. SMTP enables you to move 
messages from one e-mail server to another.

SNMP TCP/UDP 161 Simple Network Management Program.

SNMP-TRAPS TCP/UDP 162 Traps for use with the SNMP (RFC:1215).

SQL-NET TCP 1521 Structured Query Language is an interface to access 
data on many different types of database systems, 
including mainframes, midrange systems, UNIX systems 
and network servers.

Table 290   Commonly Used Services (continued)

NAME PROTOCOL PORT(S) DESCRIPTION



Appendix B Common Services

XGS4600 Series User’s Guide

587

SSH TCP/UDP 22 Secure Shell Remote Login Program.

STRM WORKS UDP 1558 Stream Works Protocol.

SYSLOG UDP 514 Syslog allows you to send system logs to a UNIX server.

TACACS UDP 49 Login Host Protocol used for (Terminal Access 
Controller Access Control System).

TELNET TCP 23 Telnet is the login and terminal emulation protocol 
common on the Internet and in UNIX environments. It 
operates over TCP/IP networks. Its primary function is to 
allow users to log into remote host systems.

TFTP UDP 69 Trivial File Transfer Protocol is an Internet file transfer 
protocol similar to FTP, but uses the UDP (User 
Datagram Protocol) rather than TCP (Transmission 
Control Protocol).

VDOLIVE TCP 7000 Another videoconferencing solution.

Table 290   Commonly Used Services (continued)

NAME PROTOCOL PORT(S) DESCRIPTION
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APPENDIX C
IPv6

Overview

IPv6 (Internet Protocol version 6), is designed to enhance IP address size and features. The increase in 
IPv6 address size to 128 bits (from the 32-bit IPv4 address) allows up to 3.4 x 1038 IP addresses. 

IPv6 Addressing

The 128-bit IPv6 address is written as eight 16-bit hexadecimal blocks separated by colons (:). This is an 
example IPv6 address 2001:0db8:1a2b:0015:0000:0000:1a2f:0000. 

IPv6 addresses can be abbreviated in two ways:

• Leading zeros in a block can be omitted. So 2001:0db8:1a2b:0015:0000:0000:1a2f:0000 can be 
written as 2001:db8:1a2b:15:0:0:1a2f:0. 

• Any number of consecutive blocks of zeros can be replaced by a double colon. A double colon can 
only appear once in an IPv6 address. So 2001:0db8:0000:0000:1a2f:0000:0000:0015 can be 
written as 2001:0db8::1a2f:0000:0000:0015, 2001:0db8:0000:0000:1a2f::0015, 
2001:db8::1a2f:0:0:15 or 2001:db8:0:0:1a2f::15.

Prefix and Prefix Length

Similar to an IPv4 subnet mask, IPv6 uses an address prefix to represent the network address. An IPv6 
prefix length specifies how many most significant bits (start from the left) in the address compose the 
network address. The prefix length is written as “/x” where x is a number. For example, 

2001:db8:1a2b:15::1a2f:0/32

means that the first 32 bits (2001:db8) is the subnet prefix. 

Link-local Address

A link-local address uniquely identifies a device on the local network (the LAN). It is similar to a “private IP 
address” in IPv4. You can have the same link-local address on multiple interfaces on a device. A link-
local unicast address has a predefined prefix of fe80::/10. The link-local unicast address format is as 
follows.

Table 291   Link-local Unicast Address Format

Global Address

A global address uniquely identifies a device on the Internet. It is similar to a “public IP address” in IPv4. A 
global unicast address starts with a 2 or 3. 

1111 1110 10 0 Interface ID

10 bits 54 bits 64 bits
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Unspecified Address

An unspecified address (0:0:0:0:0:0:0:0 or ::) is used as the source address when a device does not have 
its own address. It is similar to “0.0.0.0” in IPv4.

Loopback Address

A loopback address (0:0:0:0:0:0:0:1 or ::1) allows a host to send packets to itself. It is similar to “127.0.0.1” 
in IPv4.

Multicast Address

In IPv6, multicast addresses provide the same functionality as IPv4 broadcast addresses. Broadcasting is 
not supported in IPv6. A multicast address allows a host to send packets to all hosts in a multicast group. 

Multicast scope allows you to determine the size of the multicast group. A multicast address has a 
predefined prefix of ff00::/8. The following table describes some of the predefined multicast addresses. 

The following table describes the multicast addresses which are reserved and can not be assigned to a 
multicast group. 

Table 292   Predefined Multicast Address 
MULTICAST ADDRESS DESCRIPTION
FF01:0:0:0:0:0:0:1 All hosts on a local node. 

FF01:0:0:0:0:0:0:2 All routers on a local node.

FF02:0:0:0:0:0:0:1 All hosts on a local connected link.

FF02:0:0:0:0:0:0:2 All routers on a local connected link.

FF05:0:0:0:0:0:0:2 All routers on a local site. 

FF05:0:0:0:0:0:1:3 All DHCP severs on a local site. 

Table 293   Reserved Multicast Address 
MULTICAST ADDRESS
FF00:0:0:0:0:0:0:0

FF01:0:0:0:0:0:0:0

FF02:0:0:0:0:0:0:0

FF03:0:0:0:0:0:0:0

FF04:0:0:0:0:0:0:0

FF05:0:0:0:0:0:0:0

FF06:0:0:0:0:0:0:0

FF07:0:0:0:0:0:0:0

FF08:0:0:0:0:0:0:0

FF09:0:0:0:0:0:0:0

FF0A:0:0:0:0:0:0:0

FF0B:0:0:0:0:0:0:0

FF0C:0:0:0:0:0:0:0

FF0D:0:0:0:0:0:0:0

FF0E:0:0:0:0:0:0:0

FF0F:0:0:0:0:0:0:0
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Subnet Masking

Both an IPv6 address and IPv6 subnet mask compose of 128-bit binary digits, which are divided into 
eight 16-bit blocks and written in hexadecimal notation. Hexadecimal uses four bits for each character 
(1 ~ 10, A ~ F). Each block’s 16 bits are then represented by four hexadecimal characters. For example, 
FFFF:FFFF:FFFF:FFFF:FC00:0000:0000:0000.

Interface ID

In IPv6, an interface ID is a 64-bit identifier. It identifies a physical interface (for example, an Ethernet 
port) or a virtual interface (for example, the management IP address for a VLAN). One interface should 
have a unique interface ID.

EUI-64

The EUI-64 (Extended Unique Identifier) defined by the IEEE (Institute of Electrical and Electronics 
Engineers) is an interface ID format designed to adapt with IPv6. It is derived from the 48-bit (6-byte) 
Ethernet MAC address as shown next. EUI-64 inserts the hex digits fffe between the third and fourth bytes 
of the MAC address and complements the seventh bit of the first byte of the MAC address. See the 
following example. 

Stateless Autoconfiguration

With stateless autoconfiguration in IPv6, addresses can be uniquely and automatically generated. 
Unlike DHCPv6 (Dynamic Host Configuration Protocol version six) which is used in IPv6 stateful 
autoconfiguration, the owner and status of addresses don’t need to be maintained by a DHCP server. 
Every IPv6 device is able to generate its own and unique IP address automatically when IPv6 is initiated 
on its interface. It combines the prefix and the interface ID (generated from its own Ethernet MAC 
address, see Interface ID and EUI-64) to form a complete IPv6 address.

When IPv6 is enabled on a device, its interface automatically generates a link-local address (beginning 
with fe80).

When the interface is connected to a network with a router and the Switch is set to automatically obtain 
an IPv6 network prefix from the router for the interface, it generates 1another address which combines 
its interface ID and global and subnet information advertised from the router. This is a routable global IP 
address.

DHCPv6

The Dynamic Host Configuration Protocol for IPv6 (DHCPv6, RFC 3315) is a server-client protocol that 
allows a DHCP server to assign and pass IPv6 network addresses, prefixes and other configuration 
information to DHCP clients. DHCPv6 servers and clients exchange DHCP messages using UDP.

Table 294   
                MAC 00 : 13 : 49 : 12 : 34 : 56

Table 295   
     EUI-64 02 : 13 : 49 : FF : FE : 12 : 34 : 56

1. In IPv6, all network interfaces can be associated with several addresses. 



Appendix C IPv6

XGS4600 Series User’s Guide

591

Each DHCP client and server has a unique DHCP Unique IDentifier (DUID), which is used for identification 
when they are exchanging DHCPv6 messages. The DUID is generated from the MAC address, time, 
vendor assigned ID and/or the vendor's private enterprise number registered with the IANA. It should not 
change over time even after you reboot the device.

Identity Association

An Identity Association (IA) is a collection of addresses assigned to a DHCP client, through which the 
server and client can manage a set of related IP addresses. Each IA must be associated with exactly 
one interface. The DHCP client uses the IA assigned to an interface to obtain configuration from a DHCP 
server for that interface. Each IA consists of a unique IAID and associated IP information.
The IA type is the type of address in the IA. Each IA holds one type of address. IA_NA means an identity 
association for non-temporary addresses and IA_TA is an identity association for temporary addresses. 
An IA_NA option contains the T1 and T2 fields, but an IA_TA option does not. The DHCPv6 server uses T1 
and T2 to control the time at which the client contacts with the server to extend the lifetimes on any 
addresses in the IA_NA before the lifetimes expire. After T1, the client sends the server (S1) (from which 
the addresses in the IA_NA were obtained) a Renew message. If the time T2 is reached and the server 
does not respond, the client sends a Rebind message to any available server (S2). For an IA_TA, the 
client may send a Renew or Rebind message at the client's discretion.  

DHCP Relay Agent

A DHCP relay agent is on the same network as the DHCP clients and helps forward messages between 
the DHCP server and clients. When a client cannot use its link-local address and a well-known multicast 
address to locate a DHCP server on its network, it then needs a DHCP relay agent to send a message to 
a DHCP server that is not attached to the same network.

The DHCP relay agent can add the remote identification (remote-ID) option and the interface-ID option 
to the Relay-Forward DHCPv6 messages. The remote-ID option carries a user-defined string, such as the 
system name. The interface-ID option provides slot number, port information and the VLAN ID to the 
DHCPv6 server. The remote-ID option (if any) is stripped from the Relay-Reply messages before the relay 
agent sends the packets to the clients. The DHCP server copies the interface-ID option from the Relay-
Forward message into the Relay-Reply message and sends it to the relay agent. The interface-ID should 
not change even after the relay agent restarts.

Prefix Delegation

Prefix delegation enables an IPv6 router to use the IPv6 prefix (network address) received from the ISP (or 
a connected uplink router) for its LAN. The Switch uses the received IPv6 prefix (for example, 2001:db2::/
48) to generate its LAN IP address. Through sending Router Advertisements (RAs) regularly by multicast, 
the Switch passes the IPv6 prefix information to its LAN hosts. The hosts then can use the prefix to 
generate their IPv6 addresses.

T1
T2

Renew Rebind

Rebind

to S1
Renew
to S1

Renew
to S1
Renew
to S1

Renew
to S1
Renew
to S1

to S2

to S2
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ICMPv6

Internet Control Message Protocol for IPv6 (ICMPv6 or ICMP for IPv6) is defined in RFC 4443.  ICMPv6 has 
a preceding Next Header value of 58, which is different from the value used to identify ICMP for IPv4. 
ICMPv6 is an integral part of IPv6. IPv6 nodes use ICMPv6 to report errors encountered in packet 
processing and perform other diagnostic functions, such as "ping".

Neighbor Discovery Protocol (NDP)

The Neighbor Discovery Protocol (NDP) is a protocol used to discover other IPv6 devices and track 
neighbor’s reachability in a network. An IPv6 device uses the following ICMPv6 messages types: 

• Neighbor solicitation: A request from a host to determine a neighbor’s link-layer address (MAC 
address) and detect if the neighbor is still reachable. A neighbor being “reachable” means it 
responds to a neighbor solicitation message (from the host) with a neighbor advertisement message. 

• Neighbor advertisement: A response from a node to announce its link-layer address.

• Router solicitation: A request from a host to locate a router that can act as the default router and 
forward packets.

• Router advertisement: A response to a router solicitation or a periodical multicast advertisement from 
a router to advertise its presence and other parameters.

IPv6 Cache

An IPv6 host is required to have a neighbor cache, destination cache, prefix list and default router list. 
The Switch maintains and updates its IPv6 caches constantly using the information from response 
messages. In IPv6, the Switch configures a link-local address automatically, and then sends a neighbor 
solicitation message to check if the address is unique. If there is an address to be resolved or verified, the 
Switch also sends out a neighbor solicitation message. When the Switch receives a neighbor 
advertisement in response, it stores the neighbor’s link-layer address in the neighbor cache. When the 
Switch uses a router solicitation message to query for a router and receives a router advertisement 
message, it adds the router’s information to the neighbor cache, prefix list and destination cache. The 
Switch creates an entry in the default router list cache if the router can be used as a default router.

When the Switch needs to send a packet, it first consults the destination cache to determine the next 
hop. If there is no matching entry in the destination cache, the Switch uses the prefix list to determine 
whether the destination address is on-link and can be reached directly without passing through a router. 
If the address is onlink, the address is considered as the next hop. Otherwise, the Switch determines the 
next-hop from the default router list or routing table. Once the next hop IP address is known, the Switch 
looks into the neighbor cache to get the link-layer address and sends the packet when the neighbor is 
reachable. If the Switch cannot find an entry in the neighbor cache or the state for the neighbor is not 
reachable, it starts the address resolution process. This helps reduce the number of IPv6 solicitation and 
advertisement messages.

Multicast Listener Discovery

The Multicast Listener Discovery (MLD) protocol (defined in RFC 2710) is derived from IPv4's Internet 
Group Management Protocol version 2 (IGMPv2). MLD uses ICMPv6 message types, rather than IGMP 
message types. MLDv1 is equivalent to IGMPv2 and MLDv2 is equivalent to IGMPv3.

MLD allows an IPv6 switch or router to discover the presence of MLD listeners who wish to receive 
multicast packets and the IP addresses of multicast groups the hosts want to join on its network.  
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MLD snooping and MLD proxy are analogous to IGMP snooping and IGMP proxy in IPv4. 

MLD filtering controls which multicast groups a port can join.

MLD Messages

A multicast router or switch periodically sends general queries to MLD hosts to update the multicast 
forwarding table. When an MLD host wants to join a multicast group, it sends an MLD Report message 
for that address.

An MLD Done message is equivalent to an IGMP Leave message. When an MLD host wants to leave a 
multicast group, it can send a Done message to the router or switch. The router or switch then sends a 
group-specific query to the port on which the Done message is received to determine if other devices 
connected to this port should remain in the group.

Example - Enabling IPv6 on Windows XP/2003/Vista

By default, Windows XP and Windows 2003 support IPv6. This example shows you how to use the ipv6 
install command on Windows XP/2003 to enable IPv6. This also displays how to use the ipconfig 
command to see auto-generated IP addresses.

IPv6 is installed and enabled by default in Windows Vista. Use the ipconfig command to check your 
automatic configured IPv6 address as well. You should see at least one IPv6 address available for the 
interface on your computer.

Example - Enabling DHCPv6 on Windows XP

Windows XP does not support DHCPv6. If your network uses DHCPv6 for IP address assignment, you have 
to additionally install a DHCPv6 client software on your Windows XP. (Note: If you use static IP addresses 
or Router Advertisement for IPv6 address assignment in your network, ignore this section.)

This example uses Dibbler as the DHCPv6 client. To enable DHCPv6 client on your computer:

1 Install Dibbler and select the DHCPv6 client option on your computer.

C:\>ipv6 install
Installing...
Succeeded.

C:\>ipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

        Connection-specific DNS Suffix  . : 
        IP Address. . . . . . . . . . . . : 10.1.1.46
        Subnet Mask . . . . . . . . . . . : 255.255.255.0
        IP Address. . . . . . . . . . . . : fe80::2d0:59ff:feb8:103c%4
        Default Gateway . . . . . . . . . : 10.1.1.254



 Appendix C IPv6

XGS4600 Series User’s Guide

594

2 After the installation is complete, select Start > All Programs > Dibbler-DHCPv6 > Client Install as service.

3 Select Start > Control Panel > Administrative Tools > Services.

4 Double click Dibbler - a DHCPv6 client.

5 Click Start and then OK.

6 Now your computer can obtain an IPv6 address from a DHCPv6 server.

Example - Enabling IPv6 on Windows 7

Windows 7 supports IPv6 by default. DHCPv6 is also enabled when you enable IPv6 on a Windows 7 
computer.

To enable IPv6 in Windows 7:

1 Select Control Panel > Network and Sharing Center > Local Area Connection.
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2 Select the Internet Protocol Version 6 (TCP/IPv6) checkbox to enable it.

3 Click OK to save the change.

4 Click Close to exit the Local Area Connection Status screen.

5 Select Start > All Programs > Accessories > Command Prompt.

6 Use the ipconfig command to check your dynamic IPv6 address. This example shows a global address 
(2001:b021:2d::1000) obtained from a DHCP server.

C:\>ipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

   Connection-specific DNS Suffix  . : 
   IPv6 Address. . . . . . . . . . . : 2001:b021:2d::1000
   Link-local IPv6 Address . . . . . : fe80::25d8:dcab:c80a:5189%11
   IPv4 Address. . . . . . . . . . . : 172.16.100.61
   Subnet Mask . . . . . . . . . . . : 255.255.255.0
   Default Gateway . . . . . . . . . : fe80::213:49ff:feaa:7125%11
                                       172.16.100.254



XGS4600 Series User’s Guide

596

APPENDIX D
Legal Information

Copyright
Copyright © 2018 by Zyxel Communications Corporation.
The contents of this publication may not be reproduced in any part or as a whole, transcribed, stored in a retrieval system, translated into any 
language, or transmitted in any form or by any means, electronic, mechanical, magnetic, optical, chemical, photocopying, manual, or 
otherwise, without the prior written permission of Zyxel Communications Corporation.
Published by Zyxel Communications Corporation. All rights reserved.

Disclaimer
Zyxel does not assume any liability arising out of the application or use of any products, or software described herein. Neither does it convey any 
license under its patent rights nor the patent rights of others. Zyxel further reserves the right to make changes in any products described herein 
without notice. This publication is subject to change without notice.

Regulatory Notice and Statement
United States of America

The following information applies if you use the product within USA area.

Federal Communications Commission (FCC) EMC Statement
• This device complies with Part 15 of FCC rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference that may cause undesired operations.
• Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the 

equipment.
• This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These 

limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to 
cause harmful interference in which case the user will be required to correct the interference at his own expense.

Canada
The following information applies if you use the product within Canada area.

Innovation, Science and Economic Development Canada ICES Statement
CAN ICES-3 (A)/NMB-3(A) 

European Union

The following information applies if you use the product within the European Union.

CE EMC Statement 
WARNING: This equipment is compliant with Class A of EN55032. In a residential environment this equipment may cause radio interference. 
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List of National Codes

Notices 
CLASS 1 LASER PRODUCT 
APPAREIL À LASER DE CLASS 1 
PRODUCT COMPLIES WITH 21 CFR 1040.10 AND 1040.11
PRODUIT CONFORME SELON 21 CFR 1040.10 ET 1040.11

Safety Warnings
• Do NOT use this product near water, for example, in a wet basement or near a swimming pool.
• Do NOT expose your device to dampness, dust or corrosive liquids.
• Do NOT store things on the device.
• Do not obstruct the device ventilation slots as insufficient airflow may harm your device. For example, do not place the device in an 

enclosed space such as a box or on a very soft surface such as a bed or sofa.
• Do NOT install, use, or service this device during a thunderstorm. There is a remote risk of electric shock from lightning.
• Connect ONLY suitable accessories to the device.
• Do NOT open the device or unit. Opening or removing covers can expose you to dangerous high voltage points or other risks. 
• ONLY qualified service personnel should service or disassemble this device. Please contact your vendor for further information.
• Make sure to connect the cables to the correct ports.
• Place connecting cables carefully so that no one will step on them or stumble over them.
• Always disconnect all cables from this device before servicing or disassembling.
• Use ONLY an appropriate power adaptor or cord for your device. Connect it to the right supply voltage (for example, 110V AC in North 

America or 230V AC in Europe).
• DO NOT remove the plug and connect it to a power outlet by itself; always attach the plug to the power adaptor first before connecting it to 

a power outlet.
• Do NOT allow anything to rest on the power adaptor or cord and do NOT place the product where anyone can walk on the power adaptor 

or cord.
• Do NOT use the device if the power adaptor or cord is damaged as it might cause electrocution.
• If the power adaptor or cord is damaged, remove it from the device and the power source.
• Do NOT attempt to repair the power adaptor or cord. Contact your local vendor to order a new one.
• DO NOT use the device outside, and make sure all the connections are indoors. There is a remote risk of electric shock from lightning.
• CAUTION: RISK OF EXPLOSION IF BATTERY (on the motherboard) IS REPLACED BY AN INCORRECT TYPE. DISPOSE OF USED BATTERIES 

ACCORDING TO THE INSTRUCTIONS. Dispose them at the applicable collection point for the recycling of electrical and electronic equipment. 
For detailed information about recycling of this product, please contact your local city office, your household waste disposal service or the 
store where you purchased the product.

• Use ONLY power wires of the appropriate wire gauge for your device. Connect it to a power supply of the correct voltage.
• Fuse Warning! Replace a fuse only with a fuse of the same type and rating.
• The POE (Power over Ethernet) devices that supply or receive power and their connected Ethernet cables must all be completely indoors.
• This equipment must be grounded by qualified service personnel. Never defeat the ground conductor or operate the equipment in the 

absence of a suitably installed ground conductor. Contact the appropriate electrical inspection authority or an electrician if you are 
uncertain that suitable grounding is available.

• When connecting or disconnecting power to hot-pluggable power supplies, if offered with your system, observe the following guidelines:
- Install the power supply before connecting the power cable to the power supply.
- Unplug the power cable before removing the power supply.
- If the system has multiple sources of power, disconnect power from the system by unplugging all power cables from the power supply. 

COUNTRY ISO 3166 2 LETTER CODE COUNTRY ISO 3166 2 LETTER CODE

Austria AT Liechtenstein LI

Belgium BE Lithuania LT

Bulgaria BG Luxembourg LU

Croatia HR Malta MT

Cyprus CY Netherlands NL

Czech Republic CR Norway NO

Denmark DK Poland PL

Estonia EE Portugal PT

Finland FI Romania RO

France FR Serbia RS

Germany DE Slovakia SK

Greece GR Slovenia SI

Hungary HU Spain ES

Iceland IS Sweden SE

Ireland IE Switzerland CH

Italy IT Turkey TR

Latvia LV United Kingdom GB
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• The following warning statements apply, where the disconnect device is not incorporated in the equipment or where the plug on the power 
supply cord is intended to serve as the disconnect device, 
- For PERMANENTLY CONNECTED EQUIPMENT, a readily accessible disconnect device shall be incorporated external to the equipment;
- For PLUGGABLE EQUIPMENT, the socket-outlet shall be installed near the equipment and shall be easily accessible.

Important Safety Instructions

1 Warning! Energy Hazard. Remove all metal jewelry, watches, and so on from your hands and wrists 
before serving this device.

2 Caution! The RJ-45 jacks are not used for telephone line connection.

3 Hazardous Moving Parts. Keep body parts away from fan blades.

4 Hot Surface. Do not touch.

1 Avertissement: Risque de choc électrique. Retirer tout bijoux en métal et votre montre de vos mains et 
poignets avant de manipuler cet appareil.

2 Attention: Les câbles RJ-45 ne doivent pas être utilisés pour les connections téléphoniques.

3 Mobilité des pièces détachées. S'assurer que les pièces détachées ne sont pas en contact avec 
les pales du ventilateur.

4 Surface brûlante. Ne pas toucher.

Environment Statement

European Union - Disposal and Recycling Information
The symbol below means that according to local regulations your product and/or its battery shall be disposed of separately from domestic 
waste. If this product is end of life, take it to a recycling station designated by local authorities. At the time of disposal, the separate collection of 
your product and/or its battery will help save natural resources and ensure that the environment is sustainable development.  

Die folgende Symbol bedeutet, dass Ihr Produkt und/oder seine Batterie gemäß den örtlichen Bestimmungen getrennt vom Hausmüll entsorgt 
werden muss. Wenden Sie sich an eine Recyclingstation, wenn dieses Produkt das Ende seiner Lebensdauer erreicht hat. Zum Zeitpunkt der 
Entsorgung wird die getrennte Sammlung von Produkt und/oder seiner Batterie dazu beitragen, natürliche Ressourcen zu sparen und die Umwelt 
und die menschliche Gesundheit zu schützen.

El símbolo de abajo indica que según las regulaciones locales, su producto y/o su batería deberán depositarse como basura separada de la 
doméstica. Cuando este producto alcance el final de su vida útil, llévelo a un punto limpio. Cuando llegue el momento de desechar el 
producto, la recogida por separado éste y/o su batería ayudará a salvar los recursos naturales y a proteger la salud humana y 
medioambiental.

Le symbole ci-dessous signifie que selon les réglementations locales votre produit et/ou sa batterie doivent être éliminés séparément des ordures 
ménagères. Lorsque ce produit atteint sa fin de vie, amenez-le à un centre de recyclage. Au moment de la mise au rebut, la collecte séparée 
de votre produit et/ou de sa batterie aidera à économiser les ressources naturelles et protéger l'environnement et la santé humaine.

Il simbolo sotto significa che secondo i regolamenti locali il vostro prodotto e/o batteria deve essere smaltito separatamente dai rifiuti domestici. 
Quando questo prodotto raggiunge la fine della vita di servizio portarlo a una stazione di riciclaggio. Al momento dello smaltimento, la raccolta 
separata del vostro prodotto e/o della sua batteria aiuta a risparmiare risorse naturali e a proteggere l'ambiente e la salute umana.

Symbolen innebär att enligt lokal lagstiftning ska produkten och/eller dess batteri kastas separat från hushållsavfallet. När den här produkten når 
slutet av sin livslängd ska du ta den till en återvinningsstation. Vid tiden för kasseringen bidrar du till en bättre miljö och mänsklig hälsa genom att 
göra dig av med den på ett återvinningsställe.
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About the Symbols
Various symbols are used in this product to ensure correct usage, to prevent danger to the user and others, and to prevent property damage. 
The meaning of these symbols are described below. It is important that you read these descriptions thoroughly and fully understand the 
contents.
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Explanation of the Symbols

Viewing Certifications
Go to http://www.zyxel.com to view this product’s documentation and certifications.

Zyxel Limited Warranty
Zyxel warrants to the original end user (purchaser) that this product is free from any defects in material or workmanship for a specific period (the 
Warranty Period) from the date of purchase. The Warranty Period varies by region. Check with your vendor and/or the authorized Zyxel local 
distributor for details about the Warranty Period of this product. During the warranty period, and upon proof of purchase, should the product 
have indications of failure due to faulty workmanship and/or materials, Zyxel will, at its discretion, repair or replace the defective products or 
components without charge for either parts or labor, and to whatever extent it shall deem necessary to restore the product  or components to 
proper operating condition. Any replacement will consist of a new or re-manufactured functionally equivalent product of equal or higher value, 
and will be solely at the discretion of Zyxel. This warranty shall not apply if the product has been modified, misused, tampered with, damaged by 
an act of God, or subjected to abnormal working conditions.

Note
Repair or replacement, as provided under this warranty, is the exclusive remedy of the purchaser. This warranty is in lieu of all other warranties, 
express or implied, including any implied warranty of merchantability or fitness for a particular use or purpose. Zyxel shall in no event be held 
liable for indirect or consequential damages of any kind to the purchaser.
To obtain the services of this warranty, contact your vendor. You may also refer to the warranty policy for the region in which you bought the 
device at http://www.zyxel.com/web/support_warranty_info.php.

Registration
Register your product online to receive e-mail notices of firmware upgrades and information at www.zyxel.com for global products, or at 
www.us.zyxel.com for North American products.

Trademarks
ZyNOS (Zyxel Network Operating System) and ZON (Zyxel One Network) are registered trademarks of Zyxel Communications, Inc. Other 
trademarks mentioned in this publication are used for identification purposes only and may be properties of their respective owners.

Open Source Licenses 
This product contains in part some free software distributed under GPL license terms and/or GPL like licenses. Open source licenses are provided 
with the firmware package. You can download the latest firmware at www.zyxel.com. To obtain the source code covered under those Licenses, 
please contact support@zyxel.com.tw to get it. 

SYMBOL EXPLANATION

Alternating current (AC):

AC is an electric current in which the flow of electric charge periodically reverses direction.

Direct current (DC):

DC if the unidirectional flow or movement of electric charge carriers.

Earth; ground:

A wiring terminal intended for connection of a Protective Earthing Conductor.

Class II equipment:

The method of protection against electric shock in the case of class II equipment is either double insulation 
or reinforced insulation.  
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Index

Numbers

802.1P priority   89
802.3az   352

A

access control
limitations   512
login account   524
remote management   533
service port   532
SNMP   513

accounting
setup   268

address learning, MAC   123, 125
Address Resolution Protocol (ARP)   490, 553, 559, 562
administrator password   41, 525
age   161
aggregator ID   188, 191
aging time   81
anti-arpscan   383

blocked hosts   385
host threshold   386
status   384
trusted hosts   386

applications
bridging   23
IEEE 802.1Q VLAN   25
switched workgroup   24

Area Border Router (ABR)   426
area ID

and OSPF   433, 443
ARP

how it works   490, 553
table   553

ARP (Address Resolution Protocol)   490, 553
ARP inspection   276, 308

and MAC filter   309
configuring   310

syslog messages   309
trusted ports   309

ARP scan   383
AS Boundary Router   426
authentication   433

and OSPF   432
and RADIUS   264
setup   268

authorization
privilege levels   271
setup   268

automatic VLAN registration   113
Autonomous System

and OSPF   426
Autonomous System (AS)   426, 452

B

back up, configuration file   503
Backbone Router (BR)   426
backbone, routing   426
Backup Designated Router(BDR), and OSPF   427
basic settings   74
basic setup tutorial   54
BDR (Backup Designated Router)   427
binding   276
binding table   276

building   276
BPDU   389
BPDU (Bridge Protocol Data Units)   389
BPDU guard   389

and Errdisable Recovery   389
port status   389

BPDUs (Bridge Protocol Data Units)   144
Bridge Protocol Data Units   389
Bridge Protocol Data Units (BPDUs)   144
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C

CDP   322
certifications

notices   597
viewing   600

CFI (Canonical Format Indicator)   112
changing the password   46
Cisco Discovery Protocol, see CDP
CIST   147
CIST (Common and Internal Spanning Tree)   145
Class of Service (CoS)   456
classifier   213, 217

and QoS   213
editing   218, 219
example   220
overview   213
setup   213, 217, 218, 219
viewing   218, 219

cloning a port See port cloning
cluster management   543

and switch passwords   547
cluster manager   543, 547
cluster member   543, 547
cluster member firmware upgrade   545
network example   543
setup   546
specification   543
status   544
switch models   543
VID   547
web configurator   544

cluster manager   543
cluster member   543
command interface   27
Common and Internal Spanning Tree (CIST)   145
Common and Internal Spanning Tree, See CIST   147
configuration   415

change running config   499
configuration file   48

backup   503
restore   48, 503
saving   498

configuration, saving   47
console port

settings   34

contact information   579
copying port settings, See port cloning
copyright   596
CPU management port   130
CPU protection

configuration   340
overview   337

current date   79
current time   79
customer support   579

D

Database Description (DD)   427
daylight saving time   79
default gateway   470
default IP address   34
Designated Router(DR), and OSPF   427
DHCP   461

client IP pool   470
configuration options   461
modes   461
relay agent   461
relay example   472
server   461
setup   469

DHCP (Dynamic Host Configuration Protocol)   461
DHCP relay option 82   308
DHCP snooping   54, 276, 307

configuring   308
DHCP relay option 82   308
trusted ports   307
untrusted ports   307

DHCP snooping database   307
DHCP Unique IDentifier   475, 476
DHCPv6

DHCP Unique IDentifier   475, 476
diagnostics   535

Ethernet port test   537
ping   536

Differentiated Service (DiffServ)   456
DiffServ   456

activate   457
DS field   456
DSCP   456
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DSCP-to-IEEE802.1p mapping   459
network example   456
PHB   456

disclaimer   596
double-tagged frames   231
DR (Designated Router)   427
DS (Differentiated Services)   456
DSCP

DSCP-to-IEEE802.1p mapping   459
service level   456
what it does   456

DSCP (DiffServ Code Point)   456
DUID   475, 476
DVMRP

Autonomous System   452
default timer setting   455
error message   454
graft   453
how it works   452
implementation   452
probe   453
prune   453
report   453
setup   453
terminology   453
threshold   453

DVMRP (Distance Vector Multicast Routing 
Protocol)   452

dynamic link aggregation   186

E

EEE   352
egress port   133
Energy Efficient Ethernet   352
error disable detect   338, 342
error disable recovery

configuration   343
overview   337

Ethernet broadcast address   490, 553
Ethernet OAM   393
Ethernet port test   537
Ethernet ports

default settings   32
example

summary address   435
exchange RIP and OSPF information   434, 443
external authentication server   264

F

fan speed   76, 77
FCC interference statement   596
file transfer using FTP

command example   510
filename convention, configuration

configuration
file names   509

filtering   141
rules   141

filtering database, MAC table   548
firmware   75

upgrade   500, 545
flow control   89

back pressure   89
IEEE802.3x   89

forwarding
delay   161

frames
tagged   122
untagged   122

front panel   31
FTP   27, 509

file transfer procedure   510
restrictions over WAN   511

G

GARP   113
GARP (Generic Attribute Registration Protocol)   113
GARP terminology   113
GARP timer   113
general setup   78
getting help   49
GMT (Greenwich Mean Time)   79
Green Ethernet   352
GVRP   113, 122

and port assignment   122



  Index

XGS4600 Series User’s Guide

604

GVRP (GARP VLAN Registration Protocol)   113

H

hardware installation   28
mounting   29

hardware monitor   75, 76, 77
hardware overview   31
hello time   160
hops   161
HTTPS   527

certificates   527
implementation   527
public keys, private keys   527

HTTPS example   528

I

IEEE 802.1p, priority   81
IEEE 802.1x

activate   198, 203, 267
reauthentication   200

IEEE 802.1x, port authentication   196
IGMP   452

how it works   449
overview   448
port based   450
setup   450
version   239
version 3   449
versions supported   449

IGMP (Internet Group Management Protocol)   239, 
448

IGMP filtering   239
profile   247
profiles   243, 249, 250, 252, 254

IGMP leave timeout
fast   245
mormal   244

IGMP snooping   240
MVR   256

IGMP throttling   245
ingress port   133
initial setup   50

Installation
Rack-mounting   29

installation
freestanding   28
precautions   29

interface   429, 441
and OSPF   436, 444

interface, and OSPF   427
Internal Router (IR)   426
Internet Protocol version 6, see IPv6
introduction   23
IP

interface   82, 83, 84, 480
routing domain   82
setup   82

IP address   83, 84
IP multicast example   448
IP source guard   276

ARP inspection   276, 308
DHCP snooping   276, 307
static bindings   276

IP subnet mask   83, 84
IP table   551

how it works   551
IPv4 static route

configuration   414
IPv6   26, 588

addressing   588
EUI-64   590
global address   588
interface ID   590
link-local address   588
Neighbor Discovery Protocol   26, 588
ping   26, 588
prefix   588
prefix length   588
stateless autoconfiguration   590
unspecified address   589

IPv6 OSPF
general settings   442

IPv6 static route
configuration   415
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L

L2PT   319
access port   320
CDP   319
configuration   320
encapsulation   319
LACP   319
MAC address   319
mode   320
overview   319
PAgP   319
point to point   319
STP   319
tunnel port   320
UDLD   319
VTP   319

LACP   186, 322
system priority   193
timeout   194

Layer 2 protocol tunneling, see L2PT
LEDs   37
limit MAC address learning   209
Link Aggregate Control Protocol (LACP)   186
link aggregation   186

dynamic   186
ID information   187
setup   188, 191
traffic distribution algorithm   188
traffic distribution type   191

Link Layer Discovery Protocol (LLDP )   355, 356
link state database   427, 429, 441
LLDP (Link Layer Discovery Protocol)   355
LLDP-MED (Link Layer Discovery Protocol for Media 

Endpoint Devices)   356
local port mirroring   174
lockout   47
login   39

password   46
login account

Administrator   524
non-administrator   524

login accounts   524
configuring via web configurator   524
multiple   524
number of   524

login password   525

loop guard   311
how it works   312
port shut down   312
probe packet   312

loop guard, vs STP   311
LSA (Link State Advertisement)   427

M

MAC (Media Access Control)   75
MAC address   75, 490, 553

maximum number per port   209
MAC address learning   81, 123, 125, 134, 209

specify limit   209
MAC authentication   197

aging time   205
MAC filter

and ARP inspection   309
MAC freeze   208
MAC table   548

how it works   548
viewing   549

MAC-based VLAN   129
maintenance   496

configuration backup   503
current configuration   497
firmware   500
main screen   497
restoring configuration   503

Management Information Base (MIB)   514
management port   34, 133

default IP address   34
managing the device

good habits   27
using FTP. See FTP.
using SNMP. See SNMP.
using Telnet. See command interface.
using the command interface. See command 

interface.
using the web configurator. See web configurator.

man-in-the-middle attacks   308
max

age   161
hops   161

maximum transmission unit   558
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Memory Buffer   505
metric   435, 444
MGMT port   34
MIB

and SNMP   514
supported MIBs   514

MIB (Management Information Base)   514
mini GBIC ports   32

connection speed   33
connector type   32
transceiver installation   33
transceiver removal   33

mirroring ports   174
monitor port   176, 178
mounting brackets   29
MSA (MultiSource Agreement)   32
MST Instance, See MSTI   146
MST region   146
MSTI   146

MST ID   146
MSTI (Multiple Spanning Tree Instance)   145
MSTP   143, 145

bridge ID   165, 166
configuration   159, 162
configuration digest   166
forwarding delay   161
Hello Time   165
hello time   160
Max Age   165
max age   161
max hops   161
MST region   146
network example   145
path cost   162
port priority   162
revision level   161

MSTP (Multiple Spanning Tree Protocol)   143
MTU   558
MTU (Multi-Tenant Unit)   80
multicast   239

802.1 priority   243, 249, 250, 252, 254
and IGMP   239
IGMP throttling   245
IP addresses   239
overview   239
setup   242, 243, 248, 249, 250, 251, 252, 254

multicast delivery tree   453

multicast group   247
multicast VLAN   260
Multiple Spanning Tree Instance, See MSTI   145
Multiple Spanning Tree Protocol   144
Multiple Spanning Tree Protocol, See MSTP.   143
Multiple STP   144
Multiple STP, see MSTP   145
MVR   256

configuration   257
group configuration   260
network example   256

MVR (Multicast VLAN Registration)   256

N

network management system (NMS)   513
NTP (RFC-1305)   79

O

OAM   393
details   395
discovery   393
port configuration   393
remote loopback   393
remote-loopback   401

Operations, Administration and Maintenance   393
OSPF   426

advantages   426
area   426, 432
Area 0   426
area ID   433, 443
authentication   432, 433
autonomous system   426
backbone   426
configuration steps   428
general settings   431
how it works   427
interface   427, 429, 436, 441, 444
link state database   427, 429, 441
network example   427
priority   427
redistribute route   435, 444
router elections   427
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router ID   431, 442
router types   426
status   429, 440
stub area   426, 433, 443
virtual link   427
virtual links   438, 445
vs RIP   426

OSPF (Open Shortest Path First)   426
OSPF redistribution   434, 443

P

PAGP   322
password   46

administrator   41, 525
Path MTU   558
Path MTU Discovery   558
PHB (Per-Hop Behavior)   456
ping, test connection   536
policy   223, 411, 419

and classifier   223, 411, 419
and DiffServ   222
configuration   223, 411, 419
example   225
overview   222
rules   222

policy routing
benefits   417
cost savings   417
load sharing   417
overview   417

policy-based routing   417
Port Aggregation Protocol, see PAgP
port authentication   196

and RADIUS   265
IEEE802.1x   198, 203, 267
MAC authentication   197

port based IGMP   450
port based VLAN type   81
port cloning   559, 562

advanced settings   559, 562
basic settings   559, 562

port details   567
port isolation   133
port mirroring   174, 178

direction   178, 182
egress   178, 182
ingress   178, 182

port redundancy   186
port security   206, 211

address learning   209
limit MAC address learning   209
MAC address learning   206, 211
overview   206, 211
setup   206, 211, 312, 320

port setup   87
port status   565

port details   567
port utilization   572
port VLAN trunking   114
port-based VLAN   130

all connected   133
port isolation   133
settings wizard   133

ports
“standby”   186
diagnostics   538
mirroring   174
speed/duplex   89

power
voltage   76, 77

power module
disconnecting   36

power status   76, 77
PPPoE IA

trusted ports   330
untrusted ports   330

priority level   81
priority, and OSPF   428
priority, queue assignment   81
product registration   600
protocol based VLAN   125

and IEEE 802.1Q tagging   125
example   127
hexadecimal notation for protocols   124, 126
isolate traffic   125
priority   124, 126

PVID   112, 122
PVID (Priority Frame)   112
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Q

QoS
and classifier   213

queue weight   227
queuing   227

SPQ   227
WFQ   227
WRR   227

queuing method   227, 229

R

RADIUS   264
advantages   265
and authentication   264
Network example   264
server   265
settings   265
setup   265

Rapid Spanning Tree Protocol, See RSTP.   143
reboot

load configuration   499
reboot system   499
redistribute route   435, 444
reducing routing table size   434, 443
reflector port   174
registration

product   600
remote management   533

service   534
trusted computers   534

remote port mirroring   174, 178
resetting   48, 498, 499, 500

to custom default settings   500
to factory default settings   498, 499, 500

restoring configuration   48, 503
Reverse Path Forwarding (RPF)   453
Reverse Path Multicasting (RPM)   452
RFC 3164   540
RIP   435, 444

configuration   422, 424
direction   421
overview   421
version   421

vs OSPF   426
RIP (Routing Information Protocol)   421
RMirror   174

monitor port   179
reflector port   179
source   179

RMirror, see also remote port mirroring   178
Round Robin Scheduling   227
route cost   435, 444
router ID   431, 442
routing domain   82, 480
routing table   555
RSTP   143
rubber feet   28

S

save configuration   47, 498
Secure Shell See SSH
service access control   532

service port   533
sFlow   324

collector   326
configuration   324
datagram   324
overview   324
poll interval   326
sample rate   326
UDP port   327

sFlow agent   324
sFlow collector   324
Simple Network Management Protocol, see SNMP
SNMP   27, 513

agent   513
and MIB   514
authentication   523
communities   41, 519
management model   513
manager   513
MIB   514
network components   513
object variables   514
protocol operations   514
security   523
setup   518
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traps   520
users   522
version 3 and security   514
versions supported   513

SNMP traps   514
supported   515, 516, 518

source-based routing   417
Spanning Tree Protocol, See STP.   143
SPQ (Strict Priority Queuing)   227
SSH

encryption methods   527
how it works   526
implementation   527

SSH (Secure Shell)   525
SSL (Secure Socket Layer)   527
standby ports   186
static bindings   276
static MAC address   134
static MAC forwarding   123, 125, 134
static multicast address   137
static multicast forwarding   137
static route

overview   413
static routes   415
static trunking example   194
Static VLAN   118
static VLAN

control   120
tagging   120

status
LED   37
port   565
power   76, 77
STP   152, 157, 164
VLAN   115
VRRP   480

STP   143, 322
bridge ID   152, 158
bridge priority   150, 155
configuration   149, 154, 159
designated bridge   144
forwarding delay   151, 156
Hello BPDU   144
Hello Time   150, 152, 155, 158
how it works   144
Max Age   151, 153, 156, 158
path cost   143, 151, 156

port priority   151, 156
port state   144
root port   144
status   152, 157, 164
terminology   143
vs loop guard   311

stub area   426, 433, 443
stub area, See also OSPF   433, 443
subnet based VLANs   122

and DHCP VLAN   124
and priority   123
configuration   123

summary address   434, 435, 443
switch lockout   47
switch reset   48
switch setup   80
syslog   309, 540

protocol   540
settings   540
setup   540
severity levels   540

system information   74
system reboot   499

T

TACACS+   264
setup   267

TACACS+ (Terminal Access Controller Access-Control 
System Plus)   264

tagged VLAN   112
Tech-Support   505
temperature indicator   75, 76, 77
time

current   79
time zone   79

Time (RFC-868)   79
time server   79
time service protocol   79

format   79
Time To Live (TTL)   453
trademarks   600
transceiver

installation   33
removal   33
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translating RIP into OSPF   435, 444
traps

destination   519
trunk group   186
trunking   186

example   194
trusted ports

ARP inspection   309
DHCP snooping   307
PPPoE IA   330

Tunnel Protocol Attribute, and RADIUS   272
tutorials   54

DHCP snooping   54
Type of Service (ToS)   456

U

UDLD   322
UniDirectional Link Detection, see UDLD
untrusted ports

ARP inspection   309
DHCP snooping   307
PPPoE IA   330

user profiles   264
utilization

port   572

V

Vendor Specific Attribute See VSA
ventilation holes   28
VID   86, 112, 115, 116, 233

number of possible VIDs   112
priority frame   112

VID (VLAN Identifier)   112
virtual links   438, 445
virtual links, and OSPF   427
Virtual Router

status   480
Virtual Router (VR)   479
Virtual Router Redundancy Protocol (VRRP)   479
VLAN   80, 112

acceptable frame type   122

automatic registration   113
ID   112
ingress filtering   122
introduction   80
port number   116
port settings   120
port-based VLAN   130
port-based, all connected   133
port-based, isolation   133
port-based, wizard   133
static VLAN   118
status   115, 116
tagged   112
trunking   114, 122
type   81, 114

VLAN (Virtual Local Area Network)   80
VLAN mapping   315

activating   315
configuration   317
example   315
priority level   315
tagged   315
traffic flow   315
untagged   315
VLAN ID   315

VLAN number   83, 84, 86
VLAN stacking   231, 233

configuration   233
example   231
frame format   233
port roles   232, 235
port-based Q-in-Q   235
priority   233
selective Q-in-Q   237

VLAN Trunking Protocol, see VTP
VLAN, protocol based, See protocol based VLAN
VLAN, subnet based, See subnet based VLANs   122
VRID (Virtual Router ID)   480
VRRP   479

advertisement interval   482
authentication   481
backup router   479
configuration example   484
Hello message   482
how it works   479
interface setup   480
master router   479
network example   479, 484



  Index

XGS4600 Series User’s Guide

611

parameters   482
preempt mode   482, 483
priority   482, 483
status   480
uplink gateway   483
uplink status   480
Virtual Router   479
Virtual Router ID   483
VRID   480

VSA   271
VTP   322

W

warranty   600
note   600

web configurator   27, 39
getting help   49
layout   41
login   39
logout   49
navigation panel   43

weight, queuing   227
Weighted Round Robin Scheduling (WRR)   227
WFQ (Weighted Fair Queuing)   227
WRR (Weighted Round Robin Scheduling   227

Z

ZON Neighbor Management   72
ZON Utility   68
ZULD   402

example   402
probe time   405
status   403

ZULD (Zyxel Unidirectional Link Detection)   402
ZyNOS (Zyxel Network Operating System)   510
Zyxel Unidirectional Link Detection   402
Zyxel Unidirectional Link Detection (ZULD)   402


	XGS4600 Series
	Contents Overview
	Table of Contents

	User’s Guide
	Getting to Know Your Switch
	1.1 Introduction
	1.1.1 Bridging Example
	1.1.2 High Performance Switching Example
	1.1.3 Gigabit Ethernet to the Desktop
	1.1.4 IEEE 802.1Q VLAN Application Example
	1.1.5 IPv6 Support
	1.1.6 Stacking Mode

	1.2 Ways to Manage the Switch
	1.3 Good Habits for Managing the Switch

	Hardware Installation and Connection
	2.1 Freestanding Installation
	2.2 Mounting the Switch on a Rack
	2.2.1 Rack-mounted Installation Requirements
	2.2.2 Attaching the Mounting Brackets to the Switch
	2.2.3 Mounting the Switch on a Rack


	Hardware Overview
	3.1 Front Panel Connections
	3.1.1 Ethernet Ports
	3.1.2 SFP/SFP+ Slots
	3.1.3 Dual Personality Interfaces
	3.1.4 Management Port
	3.1.5 Console Port

	3.2 Rear Panel
	3.2.1 Grounding
	3.2.2 AC Power Connection (AC Models Only)
	3.2.3 DC Power Connection (DC Models Only)

	3.3 LEDs

	The Web Configurator
	4.1 Introduction
	4.2 System Login
	4.3 The Web Configurator Layout
	4.3.1 Change Your Password

	4.4 Saving Your Configuration
	4.5 Switch Lockout
	4.6 Resetting the Switch
	4.6.1 Reload the Configuration File

	4.7 Logging Out of the Web Configurator
	4.8 Help

	Initial Setup Example
	5.1 Overview
	5.1.1 Creating a VLAN
	5.1.2 Setting Port VID
	5.1.3 Configuring Switch Management IP Address


	Tutorials
	6.1 Overview
	6.2 How to Use DHCPv4 Snooping on the Switch
	6.3 How to Use DHCPv4 Relay on the Switch
	6.3.1 DHCP Relay Tutorial Introduction
	6.3.2 Creating a VLAN
	6.3.3 Configuring DHCPv4 Relay
	6.3.4 Troubleshooting

	6.4 How to Use Auto Configuration via a DHCP Server on the Switch


	Technical Reference
	Status and ZON Utility
	7.1 Overview
	7.2 Status
	7.3 Zyxel One Network (ZON) Utility
	7.3.1 Requirements
	7.3.2 Run the ZON Utility

	7.4 ZON Neighbor Management Screen

	Basic Setting
	8.1 System Information
	8.1.1 System Information Stacking Hardware Monitor

	8.2 General Setup
	8.3 Switch Setup
	8.3.1 Introduction to VLANs

	8.4 IP Setup
	8.4.1 IP Interfaces
	8.4.2 IP Status Details
	8.4.3 IP Configuration

	8.5 Port Setup
	8.6 Interface Setup
	8.7 IPv6
	8.7.1 IPv6 Interface Status
	8.7.2 IPv6 Configuration
	8.7.3 IPv6 Global Setup
	8.7.4 IPv6 Interface Setup
	8.7.5 IPv6 Link-Local Address Setup
	8.7.6 IPv6 Global Address Setup
	8.7.7 IPv6 Neighbor Discovery Setup
	8.7.8 IPv6 Router Discovery Setup
	8.7.9 IPv6 Prefix Setup
	8.7.10 IPv6 Neighbor Setup
	8.7.11 DHCPv6 Client Setup

	8.8 Loopback Interface
	8.8.1 IPv4 Loopback Interface

	8.9 Stacking
	8.9.1 Stacking Status
	8.9.2 Stacking Slot
	8.9.3 Stacking Configuration

	8.10 DNS

	VLAN
	9.1 Introduction to IEEE 802.1Q Tagged VLANs
	9.1.1 Forwarding Tagged and Untagged Frames

	9.2 Automatic VLAN Registration
	9.2.1 GARP
	9.2.2 GVRP

	9.3 Port VLAN Trunking
	9.4 Select the VLAN Type
	9.5 802.1Q Static VLAN
	9.5.1 VLAN Status
	9.5.2 VLAN Details

	9.6 Private VLAN Status
	9.7 VLAN Configuration
	9.7.1 Configure a Static VLAN
	9.7.2 Configure VLAN Port Settings
	9.7.3 Subnet Based VLANs
	9.7.4 Protocol Based VLANs

	9.8 Voice VLAN
	9.9 MAC Based VLAN
	9.10 Port-based VLAN Setup (Standalone Mode)
	9.10.1 Configure a Port-based VLAN


	Static MAC Forward Setup
	10.1 Overview
	10.2 Configuring Static MAC Forwarding

	Static Multicast Forward Setup
	11.1 Static Multicast Forwarding Overview
	11.2 Configuring Static Multicast Forwarding

	Filtering
	12.1 Configure a Filtering Rule

	Spanning Tree Protocol
	13.1 STP/RSTP Overview
	13.1.1 STP Terminology
	13.1.2 How STP Works
	13.1.3 STP Port States
	13.1.4 Multiple RSTP
	13.1.5 Multiple STP

	13.2 Spanning Tree Protocol Status Screen
	13.3 Spanning Tree Configuration
	13.4 Configure Rapid Spanning Tree Protocol
	13.5 Rapid Spanning Tree Protocol Status
	13.6 Configure Multiple Rapid Spanning Tree Protocol
	13.7 Multiple Rapid Spanning Tree Protocol Status
	13.8 Configure Multiple Spanning Tree Protocol
	13.8.1 Multiple Spanning Tree Protocol Port Configuration

	13.9 Multiple Spanning Tree Protocol Status

	Bandwidth Control
	14.1 Bandwidth Control Overview
	14.1.1 CIR and PIR

	14.2 Bandwidth Control Setup

	Broadcast Storm Control
	15.1 Broadcast Storm Control Setup

	Mirroring
	16.1 Port Mirroring
	16.1.1 Local Port Mirroring
	16.1.2 Remote Port Mirroring
	16.1.3 Source
	16.1.4 Destination
	16.1.5 Connected Port


	Link Aggregation
	17.1 Link Aggregation Overview
	17.2 Dynamic Link Aggregation
	17.2.1 Link Aggregation ID

	17.3 Link Aggregation Status
	17.4 Link Aggregation Setting
	17.5 Link Aggregation Control Protocol
	17.6 Static Trunking Example

	Port Authentication
	18.1 Port Authentication Overview
	18.1.1 IEEE 802.1x Authentication
	18.1.2 MAC Authentication

	18.2 Port Authentication Configuration
	18.2.1 Activate IEEE 802.1x Security
	18.2.2 Guest VLAN
	18.2.3 Activate MAC Authentication


	Port Security
	19.1 About Port Security
	19.2 Port Security Setup
	19.3 VLAN MAC Address Limit

	Time Range
	20.1 About Time Range
	20.2 Time Range Setup

	Classifier
	21.1 About the Classifier and QoS
	21.2 Classifier Status
	21.3 Classifier Configuration
	21.3.1 Viewing and Editing Classifier Configuration

	21.4 Classifier Global Setting Configuration
	21.5 Classifier Example

	Policy Rule
	22.1 Policy Rules Overview
	22.1.1 DiffServ
	22.1.2 DSCP and Per-Hop Behavior

	22.2 Configuring Policy Rules
	22.3 Policy Example

	Queuing Method
	23.1 Queuing Method Overview
	23.1.1 Strictly Priority
	23.1.2 Weighted Fair Queuing
	23.1.3 Weighted Round Robin Scheduling (WRR)

	23.2 Configuring Queuing

	VLAN Stacking
	24.1 VLAN Stacking Overview
	24.1.1 VLAN Stacking Example

	24.2 VLAN Stacking Port Roles
	24.3 VLAN Tag Format
	24.3.1 Frame Format

	24.4 Configuring VLAN Stacking
	24.4.1 Port-based Q-in-Q
	24.4.2 Selective Q-in-Q


	Multicast
	25.1 Multicast Overview
	25.1.1 IP Multicast Addresses
	25.1.2 IGMP Filtering
	25.1.3 IGMP Snooping
	25.1.4 IGMP Snooping and VLANs
	25.1.5 MLD Snooping-Proxy
	25.1.6 MLD Messages

	25.2 Multicast Setup
	25.3 IPv4 Multicast Status
	25.3.1 IGMP Snooping
	25.3.2 IGMP Snooping VLAN
	25.3.3 IGMP Filtering Profile

	25.4 IPv6 Multicast Status
	25.4.1 MLD Snooping-proxy
	25.4.2 MLD Snooping-proxy VLAN
	25.4.3 MLD Snooping-proxy VLAN Port Role Setting
	25.4.4 MLD Snooping-proxy Filtering
	25.4.5 MLD Snooping-proxy Filtering Profile

	25.5 MVR Overview
	25.5.1 Types of MVR Ports
	25.5.2 MVR Modes
	25.5.3 How MVR Works

	25.6 General MVR Configuration
	25.6.1 MVR Group Configuration
	25.6.2 MVR Configuration Example


	AAA
	26.1 Authentication, Authorization and Accounting (AAA)
	26.1.1 Local User Accounts
	26.1.2 RADIUS and TACACS+

	26.2 AAA Screens
	26.2.1 RADIUS Server Setup
	26.2.2 TACACS+ Server Setup
	26.2.3 AAA Setup
	26.2.4 Vendor Specific Attribute
	26.2.5 Tunnel Protocol Attribute

	26.3 Supported RADIUS Attributes
	26.3.1 Attributes Used for Authentication
	26.3.2 Attributes Used for Accounting


	IP Source Guard
	27.1 IP Source Guard Overview
	27.1.1 What You Can Do
	27.1.2 What You Need to Know

	27.2 IP Source Guard
	27.3 IPv4 Source Guard Setup
	27.4 IPv4 Source Guard Static Binding
	27.5 DHCP Snooping
	27.6 DHCP Snooping Configure
	27.6.1 DHCP Snooping Port Configure
	27.6.2 DHCP Snooping VLAN Configure
	27.6.3 DHCP Snooping VLAN Port Configure

	27.7 ARP Inspection Status
	27.7.1 ARP Inspection VLAN Status
	27.7.2 ARP Inspection Log Status

	27.8 ARP Inspection Configure
	27.8.1 ARP Inspection Port Configure
	27.8.2 ARP Inspection VLAN Configure

	27.9 IPv6 Source Guard Overview
	27.10 IPv6 Source Binding Status
	27.11 IPv6 Static Binding Setup
	27.12 IPv6 Source Guard Policy Setup
	27.13 IPv6 Source Guard Port Setup
	27.14 IPv6 Snooping Policy Setup
	27.15 IPv6 Snooping VLAN Setup
	27.16 IPv6 DHCP Trust Setup
	27.17 Technical Reference
	27.17.1 DHCP Snooping Overview
	27.17.2 ARP Inspection Overview


	Loop Guard
	28.1 Loop Guard Overview
	28.2 Loop Guard Setup

	VLAN Mapping
	29.1 VLAN Mapping Overview
	29.1.1 VLAN Mapping Example

	29.2 Enabling VLAN Mapping
	29.3 Configuring VLAN Mapping

	Layer 2 Protocol Tunneling
	30.1 Layer 2 Protocol Tunneling Overview
	30.1.1 Layer-2 Protocol Tunneling Mode

	30.2 Configuring Layer 2 Protocol Tunneling

	sFlow
	31.1 sFlow Overview
	31.2 sFlow Port Configuration
	31.2.1 sFlow Collector Configuration


	PPPoE
	32.1 PPPoE Intermediate Agent Overview
	32.1.1 PPPoE Intermediate Agent Tag Format
	32.1.2 Sub-Option Format
	32.1.3 Port State

	32.2 The PPPoE Screen
	32.3 PPPoE Intermediate Agent
	32.3.1 PPPoE IA Per-Port
	32.3.2 PPPoE IA Per-Port Per-VLAN
	32.3.3 PPPoE IA for VLAN


	Error Disable
	33.1 Error Disable Overview
	33.1.1 CPU Protection Overview
	33.1.2 Error-Disable Recovery Overview
	33.1.3 What You Can Do

	33.2 The Error Disable Screen
	33.3 Error-Disable Status
	33.4 CPU Protection Configuration
	33.5 Error-Disable Detect Configuration
	33.6 Error-Disable Recovery Configuration

	MAC Pinning
	34.1 MAC Pinning Overview
	34.2 MAC Pinning Configuration

	Private VLAN
	35.1 Private VLAN Overview
	35.1.1 Configuration


	Green Ethernet
	36.1 Green Ethernet Overview
	36.2 Configuring Green Ethernet

	Link Layer Discovery Protocol (LLDP)
	37.1 LLDP Overview
	37.2 LLDP-MED Overview
	37.3 LLDP Screens
	37.4 LLDP Local Status
	37.4.1 LLDP Local Port Status Detail

	37.5 LLDP Remote Status
	37.5.1 LLDP Remote Port Status Detail

	37.6 LLDP Configuration
	37.6.1 LLDP Configuration Basic TLV Setting
	37.6.2 LLDP Configuration Basic Org-specific TLV Setting

	37.7 LLDP-MED Configuration
	37.8 LLDP-MED Network Policy
	37.9 LLDP-MED Location

	Anti-Arpscan
	38.1 Anti-Arpscan Overview
	38.1.1 What You Can Do
	38.1.2 What You Need to Know

	38.2 Anti-Arpscan Status
	38.3 Anti-Arpscan Host Status
	38.4 Anti-Arpscan Trust Host
	38.5 Anti-Arpscan Configure

	BPDU Guard
	39.1 BPDU Guard Overview
	39.1.1 What You Can Do

	39.2 BPDU Guard Status
	39.3 BPDU Guard Configuration

	OAM
	40.1 OAM Overview
	40.1.1 What You Can Do

	40.2 OAM Status
	40.2.1 OAM Details

	40.3 OAM Configuration
	40.4 OAM Remote Loopback

	ZULD
	41.1 ZULD Overview
	41.1.1 What You Can Do
	41.1.2 What You Need to Know

	41.2 ZULD Status
	41.3 ZULD Configuration

	NLB
	42.1 NLB Overview
	42.1.1 What You Can Do
	42.1.2 What You Need to Know

	42.2 MAC Forwarding
	42.3 IP Configuration

	Wol Relay
	43.1 Wol Relay Overview
	43.2 Wol Relay Screen

	Static Route
	44.1 Static Routing Overview
	44.2 Static Routing
	44.3 Configuring IPv4 Static Route
	44.4 Configuring IPv6 Static Route

	Policy Routing
	45.1 Policy Route Overview
	45.1.1 Benefits

	45.2 Configuring Policy Routing Profile
	45.2.1 Policy Routing Rule Configuration


	RIP
	46.1 RIP Overview
	46.1.1 Administrative Distance

	46.2 RIP Screen
	46.3 Configuring IPv4 RIP
	46.4 Configuring IPv6 RIP

	OSPF
	47.1 OSPF Overview
	47.1.1 OSPF Autonomous Systems and Areas
	47.1.2 How OSPF Works
	47.1.3 Interfaces and Virtual Links
	47.1.4 OSPF and Router Elections
	47.1.5 Configuring OSPF

	47.2 OSPF Screen
	47.3 IPv4 OSPF Status
	47.4 IPv4 OSPF Configuration
	47.5 Configure IPv4 OSPF Areas
	47.5.1 View OSPF Area Information Table

	47.6 Configuring IPv4 OSPF Redistribution
	47.7 Configuring IPv4 OSPF Interfaces
	47.8 IPv4 OSPF Virtual-Links
	47.9 IPv6 OSPF Status
	47.10 IPv6 OSPF Configuration
	47.11 IPv6 OSPF Redistribution
	47.12 IPv6 OSPF Interfaces
	47.13 IPv6 OSPF Virtual-Links

	IGMP
	48.1 IGMP Overview
	48.1.1 How IGMP Works

	48.2 Port-based IGMP
	48.3 Configuring IGMP

	DVMRP
	49.1 DVMRP Overview
	49.2 How DVMRP Works
	49.2.1 DVMRP Terminology

	49.3 Configuring DVMRP
	49.3.1 DVMRP Configuration Error Messages

	49.4 Default DVMRP Timer Values

	Differentiated Services
	50.1 DiffServ Overview
	50.1.1 DSCP and Per-Hop Behavior
	50.1.2 DiffServ Network Example

	50.2 Activating DiffServ
	50.3 DSCP-to-IEEE 802.1p Priority Settings
	50.3.1 Configuring DSCP Settings


	DHCP
	51.1 DHCP Overview
	51.1.1 DHCP Modes
	51.1.2 DHCPv4 Configuration Options

	51.2 DHCP Configuration
	51.3 DHCPv4 Status
	51.3.1 DHCPv4 Server Status Detail

	51.4 DHCPv4 Relay
	51.4.1 DHCPv4 Relay Agent Information
	51.4.2 DHCPv4 Option 82 Profile
	51.4.3 Configuring DHCPv4 Global Relay
	51.4.4 DHCPv4 Global Relay Port Configure
	51.4.5 Global DHCP Relay Configuration Example

	51.5 Configuring DHCP VLAN Settings
	51.5.1 DHCPv4 VLAN Port Configure
	51.5.2 Example: DHCP Relay for Two VLANs

	51.6 DHCPv6 Status
	51.7 DHCPv6 Information
	51.8 DHCPv6 Prefix Delegation
	51.9 DHCPv6 Relay

	VRRP
	52.1 VRRP Overview
	52.2 VRRP Status
	52.3 VRRP Configuration
	52.3.1 IP Interface Setup
	52.3.2 VRRP Parameters
	52.3.3 Configuring VRRP Parameters
	52.3.4 Viewing VRRP Summary

	52.4 VRRP Configuration Examples
	52.4.1 One Subnet Network Example
	52.4.2 Two Subnets Example


	Router Setup
	53.1 Router Setup Overview
	53.2 Configuring Router Setup

	ARP Setup
	54.1 ARP Overview
	54.1.1 How ARP Works
	54.1.2 ARP Learning Mode

	54.2 ARP Setup
	54.2.1 ARP Learning
	54.2.2 Static ARP


	Maintenance
	55.1 The Maintenance Screen
	55.2 Erase Running-Configuration
	55.3 Save Configuration
	55.4 Reboot System
	55.4.1 Load Stacking Default
	55.4.2 Factory Default
	55.4.3 Custom Default

	55.5 Firmware Upgrade
	55.6 Restore Configuration File
	55.7 Backup Configuration File
	55.8 Auto Configuration
	55.9 Tech-Support
	55.10 Certificates
	55.10.1 HTTPS Certificates

	55.11 FTP Command Line
	55.11.1 Filename Conventions
	55.11.2 FTP Command Line Procedure
	55.11.3 GUI-based FTP Clients
	55.11.4 FTP Restrictions


	Access Control
	56.1 Access Control Overview
	56.1.1 What You Can Do

	56.2 The Access Control Main Screen
	56.3 About SNMP
	56.3.1 SNMP v3 and Security
	56.3.2 Supported MIBs
	56.3.3 SNMP Traps
	56.3.4 Configuring SNMP
	56.3.5 Configuring SNMP Trap Group
	56.3.6 Enabling/Disabling Sending of SNMP Traps on a Port
	56.3.7 Configuring SNMP User

	56.4 Setting Up Login Accounts
	56.5 SSH Overview
	56.6 How SSH works
	56.7 SSH Implementation on the Switch
	56.7.1 Requirements for Using SSH

	56.8 Introduction to HTTPS
	56.9 HTTPS Example
	56.9.1 Internet Explorer Warning Messages
	56.9.2 Mozilla Firefox Warning Messages
	56.9.3 Google Chrome Warning Messages
	56.9.4 The Main Screen

	56.10 Service Access Control
	56.11 Remote Management

	Diagnostic
	57.1 Diagnostic

	System Log
	58.1 Overview
	58.2 System Log

	Syslog Setup
	59.1 Syslog Overview
	59.2 Syslog Setup

	Cluster Management
	60.1 Clustering Management Overview
	60.2 Cluster Management Status
	60.2.1 Cluster Member Switch Management

	60.3 Clustering Management Configuration

	MAC Table
	61.1 MAC Table Overview
	61.2 Viewing the MAC Table

	IP Table
	62.1 IP Table Overview
	62.2 Viewing the IP Table

	ARP Table
	63.1 ARP Table Overview
	63.1.1 How ARP Works

	63.2 The ARP Table Screen

	Routing Table
	64.1 Overview
	64.2 Routing Table
	64.3 Viewing the IPv4 Routing Table
	64.4 Viewing the IPv6 Routing Table

	Path MTU Table
	65.1 Path MTU Overview
	65.2 Viewing the Path MTU Table

	Configure Clone
	66.1 Configure Clone

	IPv6 Neighbor Table
	67.1 IPv6 Neighbor Table Overview
	67.2 Viewing the IPv6 Neighbor Table

	Port Status
	68.1 Status
	68.2 Port Status
	68.2.1 Port Details
	68.2.2 DDMI
	68.2.3 DDMI Details
	68.2.4 Port Utilization


	Service Register
	69.1 Service Register Overview
	69.2 Service Register Screen

	Troubleshooting
	70.1 Power, Hardware Connections, and LEDs
	70.2 Switch Access and Login
	70.3 Switch Configuration

	Customer Support
	Common Services
	IPv6
	Legal Information
	Index


